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Send Us Your Comments

Oracle® Retail Macro Space Management  User's Guide, Release  13.2

Oracle welcomes customers' comments and suggestions on the quality and usefulness 
of this document.

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example:

■ Are the implementation steps correct and complete?

■ Did you understand the context of the procedures?

■ Did you find any errors in the information?

■ Does the structure of the information help you with your tasks?

■ Do you need different information or graphics? If so, where, and in what format?

■ Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell 
us your name, the name of the company who has licensed our products, the title and 
part number of the documentation and the chapter, section, and page number (if 
available).

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number 
(optional).

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services. 

If you require training or instruction in using Oracle software, then please contact 
your Oracle local office and inquire about our Oracle University offerings. A list of 
Oracle offices is available on our Web site at www.oracle.com.

Note: Before sending us your comments, you might like to check 
that you have the latest version of the document and if any concerns 
are already addressed. To do this, access the new Applications Release 
Online Documentation CD available on My Oracle Support and 
www.oracle.com. It contains the most current Documentation Library 
plus all documents revised or released recently.
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Preface

The Oracle® Retail Macro Space Management User Guide describes the  application 
user interface and includes information that enables you to use the application 
effectively.

Audience
This User Guide is for users of Oracle Retail Product. This includes merchandisers, 
buyers, business analysts, and administrative personnel.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

TTY Access to Oracle Support Services
To reach AT&T Customer Assistants, dial 711 or 1.800.855.2880. An AT&T Customer 
Assistant will relay information between the customer and Oracle Support Services at 
1.800.223.1711. Complete instructions for using the AT&T relay services are available 
at http://www.consumer.att.com/relay/tty/standard2.html. After the 
AT&T Customer Assistant contacts Oracle Support Services, an Oracle Support 
Services engineer will handle technical issues and provide customer support 
according to the Oracle service request process.
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Related Documents
For more information, see the following documents in the Oracle Retail Macro Space. 
Planning Release 13.2 documentation set:

■ Oracle Retail Macro Space Management Administration Guide

■ Oracle Retail Macro Space Management Administration Online Help

■ Oracle Retail Macro Space Management Advanced Users Guide 

■ Oracle Retail Macro Space Management Configuration Guide

■ Oracle Retail Macro Space Management Configuration Online Help

■ Oracle Retail Macro Space Management Data Importer Online Help 

■ Oracle Retail Macro Space Management Online Help

■ Oracle Retail Macro Space Management Release Notes

■ Oracle Retail Macro Space Planning Installation Guide

■ Oracle Retail Macro Space Planning Licensing Information

See also for In-Store Space Collaboration Documentation set:

■ Oracle Retail In-Store Space Collaboration User's Guide

■ Oracle Retail In-Store Space Collaboration Online Help

■ Oracle Retail In-Store Space Collaboration Release Notes

Conventions
The following text conventions are used in this document:

Customer Support
To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

■ Product version and program/module name

■ Functional and technical description of the problem (include business impact)

■ Detailed step-by-step instructions to re-create

■ Exact error message received

■ Screen shots of each step you take

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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Review Patch Documentation
When you install the application for the first time, you install either a base release or a 
later patch release. If you are installing the base release, additional patch, and bundled 
hot fix releases, read the documentation for all releases that have occurred since the 
base release before you begin installation. Documentation for patch and bundled hot 
fix releases can contain critical information related to the base release, as well as 
information about code changes since the base release.

Oracle Retail Documentation on the Oracle Technology Network
Documentation is packaged with each Oracle Retail product release. Oracle Retail 
product documentation is also available on the following Web site:

http://www.oracle.com/technology/documentation/oracle_retail.html

(Data Model documents are not available through Oracle Technology Network. These 
documents are packaged with released code, or you can obtain them through My 
Oracle Support.)

Documentation should be available on this Web site within a month after a product 
release.
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1Macro Space Management

Macro Space Management (MSM) is a complex, integrated program that allows users 
to carry out highly sophisticated store planning, fixturing, and merchandising 
operations. It allows them to monitor retail performance using KPIs and reports. MSM 
is primarily intended for centralized planning and is typically located at head or 
regional offices.

The results of Macro Space Management activities are stored in the central Macro 
Space Management database. This database can be accessed via the internet by 
authorized users.

MSM activities can be split into three main areas:

■ Organization

■ Store Planning

■ Performance Measurement

Figure 1–1 Macro Space Management Workflow



In-Store Space Collaboration

1-2 Oracle® Retail Macro Space Management  User's Guide

In-Store Space Collaboration
Macro Space Management and In-Store Space Collaboration are members of a family 
of products from Oracle. Macro Space Management is used in head or regional offices 
to plan and control store layouts and In-Store Space Collaboration allows you to 
develop or revise store layouts on site.

Macro Space Management allows users to carry out highly sophisticated store 
planning operations involving fixturing and merchandising. These operations can 
either be carried out in a Computer Aided Design (CAD) environment (Planner), or in 
3D Virtual Reality Environment (Merchandiser).

In-Store Space Collaboration is a web-based portable version of Macro Space 
Management that has most (but not all) of its functionality. In-Store Space 
Collaboration allows Internet or Intranet based access to store planning, 
merchandising and performance information held within the central Macro Space 
Management database. It enables users with laptop or tablet computers to develop or 
edit store plans on site within the actual stores.

In-Store Space Collaboration can be used either with a wireless Internet connection 
continuously updating the central database or by connecting to a company intranet 
after developing the store plan. This combination of remote access and the use of small 
tablet or laptop computers make the software highly portable, allowing the users to 
update information on-site in the varying retail outlets within the organization.

Depending on the user's access rights, these can include:

■ Selecting a store plan.

■ Selecting departments within the store plan to display.

■ Viewing, adding, editing and deleting fixtures, fittings and gondolas.

■ Viewing, adding, editing and deleting products and planograms.

■ Using scanning or manual entries to update information on which planograms are 
physically present in a store.

■ Using Key Performance Indicators (KPI) to look at every aspect of a stores 
operation including correctness of fixturing and merchandising, turnover and 
profitability and other performance information.

The data is first read from the central database. After adding, editing and deleting 
fixtures and merchandise within In-Store Space Collaboration, the results are saved 
back to the central Macro Space Management database.

A Quick Tour of Macro Space Management
This section provides a quick tour of Macro Space Management. It includes the 
following sections:

■ Control of a Retail Organization

■ Macro Space Management Modules

■ Common Macro Space Management Components

■ Macro Space Management Activities

Control of a Retail Organization
Controlling a retail organization can be a complex activity, particularly if the 
organization has many stores. Macro Space Management is designed to make this task 
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as easy as possible, allowing managers to focus on improving profitability, not on 
routine administrative tasks.

Macro Space Management allows four main activities to be carried out:

This allows you to carry out the following repeated sequence of events:

Plan Store Layout
Normally carried out in the Planner environment, this allows users to plan a precise 
arrangement of fixtures, fittings and gondolas within the store. This is far more than a 
simple drawing, for Macro Space Management tools allow the user to determine 
which fixtures can be connected to one another, lists of required components, etc.

Macro Space Management also allows users to see (for example) what the sight-lines 
are for customers for the present arrangement of fixtures, or what percentage of the 
floor space is being utilized efficiently.

Merchandise Store Layout
Store layouts can be merchandised with products, planograms or a combination of the 
two. Both products and planograms can be designed within Macro Space Management 
if required. Macro Space Management tools allow the user to pre-configure which 
fixtures will accept which products or planograms.

Merchandising can be carried out in either the Planner or Merchandiser environments. 
If carried out in Merchandiser then a 3D virtual reality representation of the store can 
be seen, allowing users to see the store through the eyes of a customer.

Send Store Layout to Store
Macro Space Management contains provisions to activate pre-prepared store plans on 
specified dates. These plans can be automatically sent to the designated stores, 
allowing them to implement the revised layout.

Review Store Performance
Macro Space Management has the facility to import EPOS data, so it is possible to 
graphically performance by color coding the fixtures within the store according to 
performance. For example fixtures could be color coded for profit, turn over, stock 
turns or any other designated criteria. This allows managers to see at a glance which 
areas of the store are performing and which is not.

Decide on Required Changes
Once the performance of a store has been analyzed, it is possible to decide on what 
changes are required. These could be routine, for example switching from one seasons 

Table 1–1 Macro Space Management activities

Activity Description

Store planning Designing store layouts by placing fixtures, fittings and 
gondolas accurately within the bounds set by an architectural 
drawing.

Merchandising Populating the store layouts with products or merchandise.

Information Management The import or export of information to and from Macro Space 
Management. Such information could include EPOS (Electronic 
Point of Sale) data.

Performance measurement Measuring the performance of the stores.
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goods to another, or they could be more far reaching, for example switching for one 
type or merchandise to another.

Macro Space Management provides powerful tools for managers to maximize 
profitability.

Macro Space Management Modules
Macro Space Management consists of a series of interdependent modules. These can 
be bewildering for new users, so their main purpose is listed below.

Admin Module Overview
The Admin Module enables a series of fundamental settings within Macro Space 
Management to be configured. This module is only available to those with 
Administrative privileges.

Some settings in the Admin Module are transferred to the Configuration Module and 
vice versa.

Table 1–2 Macro Space Management Modules

Module Purpose

Administration Used to change fundamental settings within Macro Space 
Management. Changes made in the Admin module will 
generally affect all users.

Data Import Used to import data from third party software into Macro Space 
Management.

Fixture Studio Used to set the properties for the Fixtures, Fittings, and 
Gondolas used in Macro Space Management.

Import Used to import standard lists of data into Macro Space 
Management such as store details.

Merchandiser Merchandiser has two purposes:

■ Design of Planograms.§

■ Store planning in a 3D (Virtual Reality) environment.

Product Studio Design of products for placement in either Planner or 
Merchandiser

Planner Store planning in a CAD (Computer Aided Design) environment

Report Studio Allows users to get customized reports in data within Macro 
Space Management
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Figure 1–2 Administration Module

Settings in the Administration Module
The following facets of Macro Space Management operations can be configured within 
the Admin Module.

Individual Module Purpose

Calendars The Calendars module allows the dates to be set for any specified 
period within Macro Space Management. An example would be 
the start and finish dates for accounting quarters.

Hatch Styles Hatch Styles are the markings that are used to color or otherwise 
delineate zones.

Manufacturers The Manufacturers module allows Macro Space Management 
users to build up a customized list of suppliers and service 
providers for use elsewhere in the software.

Planogram 
Substitution

Planogram substitution allows the Macro Space Management 
user to administer the substitution of one planogram for another 
when a specified conditions for example a trigger date, is met.

Processes Currently not enabled.

Product Code Types This Module enables Macro Space Management users to specify 
the form of varying Product Code types.

Ranges This Module allows the user to specify permissible ranges for 
specified products. An example would be acceptable 
temperatures for chilled and frozen goods.

Scales Scales allow the scale to be set for drawings, etc.

Severity Types Severity types are a pre-defined list that specifies the desirability 
of placing specific types of products or planograms next to each 
other.
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The administration module is explained in detail in the Oracle Retail Macro Space 
Management Administration Guide.

Data Import Module Overview
The Data Import module is used to define and execute import information that needs 
importing on a regular basis.

Status The Status option allows Macro Space Management 
Administrators to configure the available status for Stores, 
Floors, Revisions, Drawings and other objects.

System Variables System variables allow a number of basic parameters for Macro 
Space Management to be set globally. This module is used in 
conjunction with the Configuration module.

Tax Codes Tax Codes enables the user to customize the tax rates used for 
accounting purposes.

Data Security The Data Security section allows Administrators to specify which 
Stores, Products and Planograms individual users can access.

Functional Security Functional Security allows Administrators to specify which 
sections of Macro Space Management individual users can 
access.

Security Options Security Options allow Administrators to configure the nature of 
the passwords used.

Seasons The Seasons Module allows date ranges to be set for specific 
merchandising seasons. These could be general, such as Spring 
and Summer, or specific, such as Halloween.

Styles Styles allow the detail of fixtures and gondolas to be customized 
to allow only specific planograms to required style to be placed.

Text Styles Text Styles allows the font size and type to be specified for the 
different forms of annotation.

Title Blocks Title bocks allows the user to define the size, etc., of the title 
blocks that hold information on the issue date, revision number, 
etc., of a drawing.

Units The Units option allows users to specify the units of 
measurement to be used within Macro Space Management.

User Defined 
Attributes

User Defined Attributes allows the user to specify the form of 
certain types of user defined data.

Zone Types Zone types are broad classes of zones.

Zone Definitions Zone definitions are zones for specific purposes. Each Zone 
definition is assigned to a Zone type.

Individual Module Purpose
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Figure 1–3 MSM Data Importer

Data is exported from third party databases in a specified CSV (Comma Separated 
Value) format. This data can then be imported into the central Macro Space 
Management database using the data import module.

Some import routines are provided as standard with Macro Space Management. These 
include:

■ Calendar allows users to carry out data imports to fill the Calendar fields in the 
central database. Once imported, results can be maintained using the Admin 
Module.

■ Suppliers allow users to carry out data imports to fill the Supplier (or 
Manufacturer) fields in the central database. Once imported, results can be 
maintained using the Admin Module.

■ Products allow users to carry out data imports to fill the Products fields in the 
central database.

■ Sales allow users to import EPOS (Electronic Point of Sale) data into for 
performance measurement purposes.

Other import routines can be customized according to requirement. This can be done 
by using the data importer option (only available to administrators).
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Figure 1–4 Edit Import Definition

This allows the import of non-standard data from third party software to be set up for 
customer specific requirements.

Planogram Import Module Overview
The Import Module is used to import planograms in bulk from external software such 
as Apollo or Spaceman.

Fixture Studio Module Overview
Fixture Studio is a stand-alone module used to assign Macro Space Management 
properties to Fixtures, Fittings and Gondolas. These are intelligent properties that 
allow Macro Space Management to gather and analyze a wide variety of data when 
the fixture, etc. is placed in a store layout drawing.
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Figure 1–5 Fixture Studio

A wide range of properties can be assigned including:

Property Effect

Category Information on the general class the fixture falls in, 
what areas is calculated to occupy and how product is 
stacked onto it.

Insertion How the fixture is inserted into the drawing and how 
product is inserted onto the fixture.

Size The fixture dimensions and whether those dimensions 
are variable (stretchable).

Connection How the fixture connects to other fixtures

Parts What parts the fixture is made up from. (Bolts, castors, 
etc.)

Fixture How shelving and products fit onto a fixture

UDAs What information (User Designed Attributes) is 
assigned to a fixture.

Styles/Ranges What styles of shelving and products can be put on the 
fixture - and what range of temperatures and weights 
any product placed on the fixture can be.

Merchandisable 
Areas

What volume can be taken up by merchandise.

Shelf Details about the angles of any shelving placed on the 
fixture.

Preview Allows some aspects of the fixture to be previewed.
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In addition, Gondolas can be created, edited and deleted.

Merchandiser Module Overview
Merchandiser has two main functions:

■ Design of Planograms.

■ Store planning in a 3D (Virtual Reality) environment.

Figure 1–6 Merchandiser Window

Planograms can be designed in varying levels of detail. These planograms can be 
arranged in a hierarchy and subsequently used to populate a store.

Merchandiser also allows the planograms, and the fixtures on which they have been 
placed, to be viewed in a Virtual Reality (VR) 3D environment. Using the provided 
controls, the Macro Space Management user can 'fly' round the VR store.

If required, the user can also take snapshots or short movies of the VR store to 
demonstrate its appearance to colleagues, suppliers and customers.

Planner Module Overview
The Planner Module is primarily used for the layout of zones, fixtures, and fittings 
within a store. It can do this with extreme accuracy. It can also be used to merchandise 
a store, but will show less detail than the same store if viewed in Merchandiser.
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Figure 1–7 Planner Module Window

Starting with an architectural drawing:

■ Zones can be placed

■ Fixtures and Gondolas can be placed.

■ The fixtures and gondolas can be merchandised with placeholders or planograms.

■ Reports can be obtained on the store.

Product Studio Module Overview
Product Studio allows the design and editing of product information. This information 
has two main purposes:

■ It allows the dimensions, space around the product, maximum and minimum 
number of products, etc., to be specified. This allows Macro Space Management to 
calculate how the product will fit onto a fixture or shelf when the store is 
merchandised.

■ It allows images to be associated with products. This allows a virtual reality 
representation to be displayed when the product is viewed in a merchandised 
store in Merchandiser.

These images are arranged in a hierarchy that can be accessed in the Planner and 
Merchandiser environments.
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Figure 1–8 Product Studio Window

Report Studio Module Overview
Report Studio allows the design, production, and review of customized reports giving 
an overview of the current and historical performance of the varying stores, floors, 
and revisions within Macro Space Management.
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Figure 1–9 Report Studio Window

Reports can be designed using specifying customized lists of data and can be run to 
generate current information on performance by the retail outlets within Macro Space 
Management. Already generated reports can be reviewed to provide a comparison 
between historical and current performance.

Common Macro Space Management Components
Some Macro Space Management components can be accessed from a number of 
modules.

Component Modules Purpose

Configuration 
Module

Admin Module

Data Import Module

Fixture Studio

Merchandiser

Planner

Product Studio

Used to make changes to Macro 
Space Management settings that 
are mainly local in effect.

Store Manager Planner

Merchandiser

Used to administer the available 
stores belonging to a retail 
organization.

Object Browser Planner

Merchandiser

User to control operations for 
zones, fixturing, merchandising 
and KPIs (performance 
measurement).

Object Grid Planner

Merchandiser

Used to select fixtures, fittings, 
gondolas, products and 
planograms from the list of those 
available.
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These components are used to carry out tasks common to the modules. For example, 
the configuration module is used to set parameters that can affect how the Admin 
Module, Data Import Module, Fixture Studio, Merchandiser, Planner and Product 
studio operate.

Configuration Module Overview
The Configuration Module allows many of the features of Macro Space Management 
to be switched on or off. It also allows details of servers, directories, files to be 
customized, and a number of fundamental values set.

Changes made in the Configuration Module can change information held in the 
Admin Module and vice versa. For more information, refer the Oracle Retail Macro 
Space Management Configuration Guide.

Store Manager Overview
Store Manager is a module within Macro Space Management that allows the 
administration of Clusters, Stores, Floor, Revisions, and Files.

Macro Space Management contains large amounts of information. This can be as 
specific as the current contents of a shelf in a single store or as general as the floor 
plans to be implemented business wide in 6 months time. This mass of information 
has to be organized and administered. Within Macro Space Management this is 
achieved by the Store Manager module. For more information, refer the section on 
Store Manager Overview.

Object Browser
The Object Browser is a separate window on the main screen. It is found in both the 
Planner and Merchandiser environments and is used to control the various activities 
within those environments.

Refer section on Object Browser.

Object Grid
The Object Grid provides an alternative to selecting lower level objects in the Object 
Browser, including the following:

■ Zones

■ Fixtures

■ Products

■ Planograms

It is a window that is used in conjunction with the hierarchies visible in the Object 
Browser and is available in both the Planner and Merchandiser environments.

Macro Space Management Activities
This section lists some of the common activities performed in Macro Space 
Management. It includes the following sections:

■ Organizing Stores

■ Zones Overview

■ Fixturing Overview

■ Merchandising Overview
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■ KPIs (Performance Measurement)

■ Reporting

■ Distributing Store Plans to Stores for Implementation

Organizing Stores
Stores are organized using Store Manager. This can be accessed from either Planner or 
Merchandiser.

Figure 1–10 Store Manager Window

Store data can either be imported from a third party database or it can be created 
within Macro Space Management.

Zones Overview
Zones allow the internal area of the store to be subdivided into areas of different 
purposes. Some Zones have Sales functions; for example, electrical goods, fruit and 
vegetables, or women's fashion. Other Zones are used for non-sales purposes; for 
example offices, stock rooms, or toilets.

Zone Types are configured in the Admin Module. Zones are added, edited, and, 
deleted in Planner using the Zones Tab on the Object Browser.
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Figure 1–11 Object Browser - Zones

Fixturing Overview
Fixturing is the placement of fixtures, fittings, and gondolas into a drawing to form a 
coherent arrangement within a store. (The fixtures and gondolas can then be 
populated with merchandise).

Fixtures are drawn in the Planner environment, then imported into Fixture Studio and 
given intelligent (Macro Space Management) properties. Once in Fixture Studio, 
fixtures can be combined to form gondolas. These fixtures and gondolas then become 
available to Planner and Merchandiser where they can be added, edited, and deleted 
from the active drawing using the Fixtures Tab on the Object Browser
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Figure 1–12 Object Browser - Fixturing

Merchandising Overview
Merchandising is the placement of Products or Planograms on the fixtures and 
gondolas within a store. Products are created, edited, and deleted in Product Studio. 
Planograms can be imported or created, edited, and deleted in Merchandiser.

Products and Planograms are added, edited, and deleted to fixtures in the drawing 
using the Merchandising Tab on the Object Browser.
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Figure 1–13 Object Browser - Merchandising

Macro Space Management allows some constraints on what can be placed where. For 
example styles which will only allow products to be placed on fixtures with a 
compatible style. Another example is planograms which can only be placed on fixtures 
that match preset criteria for that planogram.

KPIs (Performance Measurement)
Key Performance Indicators are available within Planer and Merchandiser. They can 
be applied to imported data (for example EPOS data) or to data within Macro Space 
Management (for example fixtures that have multiple planograms placed in error).
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Figure 1–14 Examples of KPI

KPIs work as follows:

■ The base data is selected by means of a SQL script.

■ Maximum and minimum expected values are assigned to the data.

■ The data range is then assigned to color coded bands.

■ The fixtures in Merchandiser are color coded according to the specified criteria.

KPIs can either be configured by the customer or customized by Oracle if required.

Reporting
Reports can be obtained either by Report Studio or by other Oracle tools. The figure 
below is a Report Studio report.
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Figure 1–15 Reporting Studio Window

This enables the production of tabulated reports of data. Customizable filters allow the 
user to extract the precise data required.

Distributing Store Plans to Stores for Implementation
There are several ways of distributing store plans to stores for implementation. One 
way is to use the AutoCAD Plot option. This is invoked from the File Menu.
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Figure 1–16 Planner - Plot Option

This will bring up the Plot dialog box.

Figure 1–17 Plot Dialog Box

This allows you to output store plans in several forms including printed, PDF, and 
DWF file. These can then be sent to the designated store.
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Some Useful Concepts
This section introduces you to some of the following useful concepts:

■ Hierarchy

■ Status and Life Cycles

■ Synchronization and Adjacencies

■ Checking in and checking out

■ Read Only Files

Hierarchy
Lot of information in Macro Space Management is arranged in Hierarchies. Examples 
include:

■ Stores

■ Fixtures

■ Gondolas

■ Products

■ Planograms

A hierarchy is simple a logical way of arranging a list of data. It is in the form of a tree, 
where you can open out branches in the tree as you move through it.

Figure 1–18 Data Hierarchy

In the simplified example below, you can view the hierarchy started at the root (All) 
and opened it to show 3 level 1 options - Clothing, Electrical Goods and Food & Drink.

Hierarchies can be imported from third party databases or set up within Macro Space 
Management. The main hierarchies can be added to, edited or deleted from as follows:

Hierarchy Where Maintained

Stores Store Manager

Fixtures Fixture Studio

Gondolas Fixture Studio

Products Product Studio

Planograms Merchandiser
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Status and Life Cycles
Objects within Macro Space Management go through a life cycle.

Macro Space Management needs to keep track of where these objects are in their life 
cycle and it does this through Statuses. A status is no more than a label attached to an 
object which tells the software (and the user) where it is in its life cycle.

Considering the example of the store above, it would go through the following 
statuses during its life cycle.

Figure 1–19 Status Example

These statuses could either be changed manually, or be changed automatically when 
they reach specific dates. (The exact details will depend on how Macro Space 
Management is configured).

What you can do with objects within Macro Space Management often depends on 
their status. For example, only one store layout at a time for a floor within a store can 
have Current status - because in real life you can only have one possible arrangement 
for a store layout.

In similar vein, once a store layout becomes Historical - because it has been 
superseded by another more current layout - it is locked from any further changes.

Object Life Cycle

Store A store could start as a management proposal, then be 
built and opened. Over the years it could become 
obsolescent and the decision be taken to close it.

Store Plans Stores plans go through a series of stages. They could 
start as a concept, be approved by a manager, go into 
service at a specified date, become outdated by the 
passage of time and be retired.

Fixtures Fixtures could be designed, go into service, then 
ultimately be replaced by a newer version.

Products Products (for example special offers) could have a 
specified life.

Planograms Planograms (just like products) could have a specified 
life.
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Synchronization and Adjacencies
Synchronization and Adjacency Calculations are essential to the correct functioning of 
Macro Space Management.

Figure 1–20 Synchronization Flowchart

After fixtures have been placed (and edited), Synchronization is run to ensure the 
details in the central database are the same as those on the drawing. Running 
Calculate Adjacencies then successively calculates Fixture Adjacency and Product 
Adjacency. These respectively calculate the relationship of fixtures and products to 
each other.

Checking in and checking out
The central Macro Space Management database holds many files. It is important that 
only one person at a time can make changes to a specific file. This is done by Checking 
Out and Checking In files.

When an In-Store Space Collaboration or Macro Space Management user opens a file, 
it is automatically registered as Checked Out. Checked Out files can only be altered by 
the user who has checked it out. Other users can view the file in Read Only mode, but 
they cannot make alterations in it.

Note:  Sometimes you cannot carry out an action in Macro Space 
Management because the status of the object does not allow it. For 
example, if a fixture has had its status changed from Current to Old it 
will no longer be possible to see it in the hierarchy of available fixtures 
in Planner or Merchandiser (although it can be accessed via Fixture 
Studio).
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Checked In files are files that have been closed (and normally saved) by their current 
user. Checked in files can be opened and altered by any In-Store Space Collaboration 
or Macro Space Management user.

Checking Out and Checking In are normally automatic, but some files may have to be 
manually checked in if there has been a system failure. Manual Checking In can only 
be done using Store Manager in Macro Space Management. In-Store Space 
Collaboration users have no way to manually check in files.

Read Only Files
Read Only files are files the user has permission to view but not to change. Within 
Macro Space Management there are three common reasons why files open as Read 
Only:

■ The file has is in use by another user and has been Checked Out to them.

■ The user does not have the privileges to make changes to the file.

■ A file has been set to Read Only status by Macro Space Management. An example 
would be files of Historical status.

Logging On to Macro Space Management
When Macro Space Management is started a login dialog box appears to enter User 
Name and Password.

Figure 1–21 User Login Window

The User Name identifies the individual and specifies the privileges (access rights) 
they have. The Password which should be kept secret, confirms the identity of the 
individual logging in.

Figure 1–22 Configure Login

Note: The Configuration Module can be accessed directly from the 
log in window for users with Administrator's privileges. The 
Configure button can be toggled into view by use of <Ctrl + A>. You 
will not be able to use this option unless you have Administrator's 
Privileges.
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Access Rights and Privileges
This section provides information on the access rights and privileges in Macro Space 
Management. It includes the following sections:

■ Macro Space Management Privileges

■ Passwords

■ Assigning and Changing Passwords

■ User Privileges

■ Security Server

Macro Space Management Privileges
Access Rights allow Macro Space Management users different levels of access to the 
software. They are set in the Admin Module.

Setting Access Rights is done by means of the Functional Security option, which can be 
accessed from the Security option.

Figure 1–23 Functional Security

Passwords are also initially assigned in the Admin Module, but can be changed by the 
user. 

Passwords
The Password Format is set in the Admin Module using the Security Options.

Note: Access to the Admin Module is restricted to a limited number 
of users. This is because the Admin Module can be used to set a wide 
variety of parameters affecting how Macro Space Management 
operates.
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Depending on these settings a password should have:

■ A maximum and minimum length

■ A number of permissible log in attempts before the program

■ A time period between mandatory password changes

Certain passwords can also be excluded by the Administrator. These would normally 
be easy to guess passwords such as Password, Admin or Sysop.

Figure 1–24 Security Options

Assigning and Changing Passwords
Passwords are initially assigned in the Admin Module when a new user is given 
access rights by an Administrator.

This password can be changed by the user at any time during log in by clicking on the 
Change Password button. This will bring up an additional dialog that will allow the 
user to select and confirm a new password.

Figure 1–25 Change Password

Note: Access to the Admin Module is restricted to a limited number 
of users. This is because the Admin Module can be used to set a wide 
variety of parameters affecting how Macro Space Management 
operates.
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Depending on settings within the Admin Module, users may also be forced to change 
passwords at preset intervals. This interval could be daily, weekly, monthly, yearly or 
never.

User Privileges
The user Privileges (access rights) are determined by the User Group he/she is put 
into by an Administrator. User Groups are defined within the Admin Module. Each 
User Group is given access to specified parts of Macro Space Management. For 
example, users assigned to the Admin User Group would have access to all parts of 
the program.

Users assigned to the Store Planners group may have access restricted to the Store 
Manager, Configuration and Fixture Studio Modules, as well as general access to the 
main part of Macro Space Management.

Users assigned to the Merchandiser group may have access restricted to the Store 
Manager, Configuration, Planogram and Product Studio Modules, as well as general 
access to the main part of Macro Space Management.

Attempts by the user (with Store Planners or Merchandisers privileges) to gain access 
to other parts of the program they have not been assigned rights, for example Admin 
Module, is not allowed. If users do not have access rights to a specific part of a 
module, those options are not activated and not available to that user.

Security Server
Security Server is a part of Macro Space Management that runs in the background. 
Once a user has logged into Macro Space Management, Security Server retains a 
record of the user's access rights. Each time a Macro Space Management user attempts 
to open another module, Security Server either allows or prevents it, depending on the 
user's rights.

This means that a user only has to log into Macro Space Management once per session. 
Its operation can be verified via the Windows Task Manager.

Figure 1–26 Security Server Window
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2Common Components of MSM

Macro Space Management application shares some common components across some 
of the modules. These components are used to carry out tasks common to the MSM 
modules. For example, the configuration module is used to set parameters that can 
affect how the Admin Module, Data Import Module, Fixture Studio, Merchandiser, 
Planner, and Product studio operate. 

The common components of MSM are:

■ Configuration Module Overview

■ Store Manager Overview

■ Object Browser

■ Object Grid

The Macro Space Management components can be accessed from a number of 
modules.

Configuration Module Overview
The Configuration Module allows many of the features of Macro Space Management 
to be switched on or off. It allows details of servers, directories, files to be customized, 
and a number of fundamental values to be set.

Table 2–1 Common Components of MSM

Component Modules Purpose

Configuration 
Module

Admin Module

Data Import Module

Fixture Studio

Merchandiser

Planner

Product Studio

Used to make changes to Macro Space 
Management settings that are mainly local 
in effect.

Store Manager Planner

Merchandiser

Used to administer the available stores 
belonging to a retail organization.

Object Browser Planner

Merchandiser

User to control operations for zones, 
fixturing, merchandising and KPIs 
(performance measurement).

Object Grid Planner

Merchandiser

Used to select fixtures, fittings, gondolas, 
products and planograms from the list of 
those available.
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The Configuration module allows various Macro Space Management operations to be 
set to suit the user. The effect of some of these changes are global-changes made affect 
all users of Macro Space Management and some changes are local-changes made only 
affects the performance of Macro Space Management on the individual users machine. 
Current settings for individual users are stored in their active Profile.

For detailed information on the Configuration module, refer the Oracle Retail Macro 
Space Management Configuration Guide or refer the Online help of Configuration 
module.

Figure 2–1 Configuration Module

Making Changes in the Configuration Module
A number of Configuration Module changes significantly affect the way Macro Space 
Management operates. Some of these changes not only affect the user's machine, but 
also affect all other computers running Macro Space Management.

Note: It is recommended that changes are only made if the expected 
effects are understood. If necessary, discuss the intended changes with 
your System Administrator, or consult Oracle's Technical Support 
team.

Recommendation: If you need to make major changes in the 
Configuration Module, it is recommended that all modules are closed 
with the exception of the Administration Module. The Configuration 
module can then be called from the Administration module.
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Store Manager Overview
Store Manager is a module within Macro Space Management that allows the 
administration of Clusters, Stores, Floor, Revisions, and Files.

Figure 2–2 Store Manager Window

Macro Space Management contains large amounts of information. This can be as 
specific as the current contents of a shelf in a single store or as general as the floor 
plans to be implemented business wide in 6 months time. This mass of information 
has to be organized and administered. Within Macro Space Management this is 
achieved by the Store Manager module.

Store Manager operates in a similar way to Windows Explorer. It has been designed to 
be easy to use and allows information to be grouped in a way that reflects the 
structure of the organization.

Using Store Manager you can:

■ Assign your retail outlets to logical groupings, allowing comparisons and analysis 
of sales to be made between individual stores or groups of stores.

■ Assign or change floor plans for stores, allowing the effects of differing store 
layouts or merchandising mixes to be evaluated.

■ Carry out routine administration on the files used within Macro Space 
Management.

■ Get reports on the data used within Macro Space Management.

■ Interface with external programs allowing import and export of data to and from 
those programs.
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Overview of Store Manager Module
Oracle Retail Macro Space Management application combines the traditional 
merchandising approach with store planning, construction, operation, and inventory 
management. It is designed to maximize profitability and returns by enabling the 
optimum layout and mix of products to be efficiently planned right across an 
organizations's range of retail outlets.

Macro Space Management contains large amounts of information. This can be as 
specific as the current contents of a shelf in a single store or as general as the floor 
plans to be implemented business wide within a specified time period. This mass of 
information has to be organized and administered. Within Macro Space Management 
this is achieved by the Store Manager module.

Store Manager operates in a similar way to Windows Explorer. It has been designed to 
be easy to use and allows information to be grouped in a way that reflects the 
structure of the organizations. 

Store Manager Flowchart

Figure 2–3 Store Manager Flowchart

The Store Manager module contains the following sections:
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■ Basic Concepts

■ Accessing Store Manager

■ System Variables

■ Setting up Store Manager

■ Maintaining Store Manager

■ Advanced Administration

Basic Concepts of Store Manager
Some of the concepts of Store Manager are:

■ Objects

■ Hierarchical Structure 

■ Parent-child relationships

■ Status

■ Publish dates and effective dates

■ Birth Dates and Death Dates

Objects  

There are varying types of data used within Store Manager. Each distinct type of data 
is described as an Object. Objects include:

■ Clusters

■ Sub-clusters

■ Stores

■ Floors

■ Revisions

■ Files

For administrative purposes, these objects are organized within a hierarchy. They 
often have a status and their use is governed by rules.

Cluster
A Cluster is a logical grouping of Sub-clusters or Stores that meet specified criteria. 
Examples of possible groupings for Clusters include sub-clusters or stores that are:

■ In the same country.

■ In the same region.

■ Of the same size.

■ Of the same turnover.

■ Of the same internal layout.

Clusters of a specific type can be further divided into sub-clusters. A cluster is purely 
used as a container to arrange groupings of stores and behaves in the same way as a 
folder within Windows Explorer.
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Sub-cluster
A Sub-cluster is a sub-division of a Cluster. Sub-clusters are used to allow a finer level 
of detail when analyzing the performance of groups of stores. For example the cluster 
of stores labelled England might be further sub-divided into sub-clusters called north, 
central and south.

If necessary, this process could be continued further, with the north sub-cluster being 
further divided into, for example, city and suburban sub-sub-clusters.

Prototype store
In some implementations of Macro Space Management a Prototype Store is a store that 
is used as a basis for comparison for other stores within the Store Manager hierarchy. 
Prototype Stores can be theoretical, in that they can be designed by marketing staff as 
an exemplar of what a store should be. They can also be practical examples selected 
from operational stores.

There can be many Prototype Stores, but each operating store can only have a single 
Prototype Store assigned to it at one time. Prototype status can be assigned to a store 
by editing its properties.

Stores
A Store is the unique description of a specific retail outlet. Stores are made up of one 
or more floors. Stores are normally associated with one or more clusters; although they 
can, (less usually), be directly associated with the Store Root.

Stores can be associated with more than one cluster. However, this multiple 
association is merely a series of links to the same store within the central database. 
Stores act as containers for floors and their associated files.

Floor
A Floor is a distinct physical level within a store. A Floor can contain one or more 
revisions, (arrangements of fixtures and fittings), associated with it.

Revision
Revision is the name given to a version of the arrangement of fixtures and fittings on a 
floor. Floors can have many revisions. For example a floor could have Spring, 
Summer, Autumn and Winter revisions, each representing a planning arrangement to 
be used at the appropriate time.

Revisions are often color coded to show their status. Floors can also have different 
revisions showing different marketing mixes, fixture arrangements, etc. Only one 
Revision can be active at any one time.

Files
A File is a general description for a category of records. Stores, floors and revisions are 
all types of file. Note that files can be of different types. For example, a Planogram 
might be an Planner drawing, while an architectural drawing might have been 
produced using a different form of software.

Hierarchical Structure  

A Hierarchical Structure is one where objects are organized in levels in the form of a 
tree. This allows objects to be set out in a logical relationship to each other. The more 
fundamental data is close to the trunk, while the more dependent data is further out 
on the branches. The most fundamental part of the hierarchical structure is the Store 
Root.
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Figure 2–4 Example of Hierarchy

Parent-child relationships  

Some objects within Store Manager are linked together in such a manner that changes 
to one object may result in changes to other objects linked to it. Such objects are 
described as being in a parent-child relationship. The object that has dependent objects 
associated with it is known as the parent, while the objects that are associated with the 
parent object are known as the children.

In a hierarchical structure, children of one parent can be parents of their own children 
in turn.

When the status of a parent object is changed; it can often result in changes to the 
status of child objects. Similarly, the status of parent objects can sometimes only be 
changed when the status of the appropriate child object is correct. When a parent 
object is deleted, it affects all the associated child objects. Conversely, a child object can 
often be deleted without affecting the parent.

Status  

Status defines the current standing of an object within the system. For example, Stores 
and Floors generally have three statuses.
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Figure 2–5 Statuses of Stores

At the beginning of the process, the Store or floor has a Proposed status as it is only at 
the design status. When the store (or floor) has been built, its status will change to 
Open. Finally, if the store (or floor) has reached the end of its useful life, it will be 
assigned Closed status.

Similarly, an arrangement of fittings for a floor layout can be defined as either a 
Proposal, (at the design stage), Authorized, (approved for use in the future), Current, (in 
use), or Historical, (taken out of service).

The status of an object thus changes as Macro Space Management users move through 
the business cycle.

Publish dates and effective dates  

Publish and Effective dates are associated with the status of the drawing of a floor 
plan in some implementations of standard Macro Space Management and the 
automated Enterprise version of Macro Space Management. The Publish date is the 
date at which the drawing is issued to the stores. Drawings are typically published a 
number of days in advance of the time the changes are required.

The Effective date is the date at which the published drawing becomes current. 
Publish and Effective dates can be turned on by making changes to the OracleTB_
SYSTEM_VARIABLE table in the database.

Once enabled, Publish and Effective dates can be used to automatically change the 
status of revisions and drawings by making use of the UpdateStaus.exe file in the 
Macro Space Management/Tools sub-directory.

Note: It is recommended that users discuss this with Oracle's 
Technical Support team before making the changes.
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Birth Dates and Death Dates  

Birth Dates and Death Dates are associated with the status of a revision. The Birth Date 
is the date at which the Revision becomes active, and the Death Date is the date at 
which the Revision ceases to become active and becomes Historical.

RFBin  

The RFBin is Macro Space Management's equivalent of the Recycle Bin. Files marked 
for deletion are sent to the RFBin, but will not be permanently deleted until the Purge 
option is used in the Tools menu.

XREFS  

XREF is a method Planner uses to link drawings. When you attach a drawing as an 
XREF, you link that referenced drawing to the current drawing. Any changes to the 
referenced drawing are then displayed in the current drawing when it is opened.

This is used within Macro Space Management where an architectural drawing can be 
attached as an XREF to multiple drawings at the same time. This allows a single 
architectural drawing to be used as a framework on which multiple arrangements of 
zones, fixtures, aisles and merchandise may be planned.

Accessing Store Manager
The Store Manager module is accessed by clicking the Open file option in the Macro 
Space Management menu bar.

Figure 2–6 Store Manager Button

After clicking the Open file icon, the Store Manager window opens.

Note: UpdateStatus.exe can be set to run on a daily or weekly basis 
by the Windows task manager, allowing some degree of automation 
of common tasks. However, for full automation of common tasks, it is 
recommended that Macro Space Management users use the Enterprise 
version of Macro Space Management.

Note: Using XREF's reduces the quantity of data stored, as each 
architectural plan is only used once for each floor, not copied under 
multiple file names.
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Figure 2–7 Store Manager window

■ The menu and tool bars can be seen to the top left of the window.

■ A frame showing the hierarchical tree of Clusters, Stores, Floors, and Revisions 
can be seen to the left of the window.

■ The files associated with a particular Revision can be seen in the frame to the 
upper right.

■ A preview of the drawing to be selected can be seen towards the lower right.

Store Manager Menu Bar  

The Store Manager Menu bar contains the following options:

■ File Menu

■ Edit Menu

■ View Menu

■ Tools Menu

File Menu Options
The File Menu option activates a menu with options primarily concerned with 
operations on files. This menu can be used to add, edit and delete files and to associate 
files and architectural plans.
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Figure 2–8 Store Manager File Menu

To add a file:

1. From the File menu, select Add. 
Depending on the hierarchy level you are at, the corresponding Add dialog box 
opens. For example, if you clicked at the cluster level, Add Cluster dialog opens; 
from the store level, Add Store dialog opens. 

Figure 2–9 Add Store

2. Enter the Store Code and the Store Name. The Directory name is auto-populated.

3. Enter the Latitude, Longitude, and Status details of the store.

4. Select the Opened Date and Closed Date of the store.

5. On the Store Prototype field, from the list of store prototypes, select one of the 
option.

6. If you wish to set this store as a prototype, check the box against Set as Prototype.

7. Click OK to continue, or Cancel to cancel adding the store.

Note: Some of these may be grayed out depending on the Store 
Manager function being used.
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To edit a file:

1. From the File menu, select Edit. The Edit dialog opens. 
Depending on the hierarchy level you are at, the corresponding Edit dialog box 
opens. For example, if you clicked at the cluster level, Edit Cluster dialog opens; 
from the store level, Edit Store dialog opens.

2. Edit the required fields and click OK.

To delete a file:

1. From the File menu, select Delete. A confirmation message appears.

2. Click Yes to delete the file or No to cancel the deletion.

The deleted files are displayed in Store Manager with the crossed symbol. You 
may retrieve the deleted files by selecting the Undo Delete option.

To undo delete:

1. Select the file that you want to retrieve.

2. Select the Undo Delete option from the File menu.

Properties: The Properties window displays detailed information on the selected file. 
For more information, refer sections Significance of Dates and File Identification 
Numbers.

Associate File: For a revision to be fully active, it needs files to be associated with it. 
This can be done via the file menu. For more information, refer section Associating 
files.

Associate Architectural Plan: Architectural Plans can be associated with Floors. For 
more information, refer section Associating Architectural Plans.

Edit Menu Options
The Edit Menu options allows you to cut, copy, or paste files.

Figure 2–10 Store Manager Edit Menu

View Menu Options
The View Menu options activates a menu with various options controlling the way 
Store Manager appears. These can be used to change the way Store Manager displays 
information.

Note: Some of these may not be available depending on what Store 
Manager function is being used.
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Figure 2–11 Store Manager View Menu

You can select the file display by selecting the Large Icons, Small Icons, List, or Detail 
from the View Menu option.

■ The Arrange option allows you to arrange the data displayed on the Store 
Manager as per you choice. You can choose to arrange the data by name, status, 
type or by date.

■ The Find options helps you search for data in the Store Manager. The Refresh 
option refreshes the data in the Store Manager.

■ Options enables you to customize the view, editing, and performance options in 
the Store Manager. For more information, refer section Customizing 
Administration Options.

Tools Menu Options
The Tools Menu option is available only to administrators and is toggled on and off by 
using <Ctrl + A>.

Figure 2–12 Store Manager Tools Menu

It contains the following options:

■ List Checked Out Files

■ Purge

■ Stores / Cluster View

■ Directory Integrity Check

Store Manager Toolbar  



Store Manager Overview

2-14 Oracle® Retail Macro Space Management  User's Guide

Figure 2–13 Store Manager Toolbar

The Store Manager toolbar contains a series of options for administering the objects 
and files in Macro Space Management. Depending on which operation is being carried 
out, one or more options may be inactivated (unavailable).

Configuring System Variables
Some of the variables affecting how Macro Space Management and Store Manager 
operate can be customized. For example, if you change the status of a parent file, the 
status of its associated children files gets affected automatically.

Configuring System Variables is done by accessing the Admin Module making 
changes using the System Variable option. Some of these system variables only affect 
the operation of Macro Space Management Generic, others affect the operation of both 
the Generic and Enterprise versions of Macro Space Management.

■ ENABLE_FILE_TRIGGER_DATE

This system variable may be set to 0 or 1. If set to 0 all file status changes must be 
made manually. If set to 1 then the file status changes when the Update Status 
module is run and generates an additional status of Published between the 
Authorized and Current statuses.

Depending on the settings within the DIVORCE_FILE_REVISION_STATUS 
system variable, changing the status of a parent file automatically changes the 
status of any children files, with the proviso that there can only be one Current file 
at any one time.

■ DIVORCE_FILE_REVISION_STATUS

This system variable may be set to 0 or 1. If set to 0, all child files change status 
automatically. If set to 1 the status of any associated child files has to be changed 
manually when the status of a parent file changes.

■ PUBLISH_DATE_LEAD_PERIOD

This system variable may be set to any positive integer. It determines the number 
of days between a file being Authorized and it being Published. It primarily affects 
the operation of Macro Space Management Enterprise.

■ EFFECTIVE_DATE_LEAD_PERIOD

This system variable may be set to any positive integer. It determines the number 
of days between a file being published and it becoming effective. Note that when a 
file becomes effective it becomes the Current file. The previous Current file then 
has its status changed to Historical. It primarily affects the operation of Macro 
Space Management Enterprise.

Note: Changing these variables can have a significant effect on how 
Macro Space Management operates. It is strongly recommended that 
changes are made only after consulting the Oracle technical support 
team.
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Configuring System Variables affecting In-Store Space Collaboration  

Configuring System Variables is done by accessing the System Variable option in the 
Admin Module.

■ IN_STORE_SUBMITSTATUS

This system variable determines which status a Survey drawing is changed to 
when the Save Submit option is used in In-Store Space Collaboration. It is 
normally set to Submitted, but can be set to other statuses.

Setting up Store Manager
Before Macro Space Management can be used, it is necessary to set up a Hierarchical 
Tree within Store Manager. This structure enables the stores to be arranged in logical 
groupings by means of Clusters and Sub-clusters. The performance of individual 
Stores can be compared against selected Prototype Stores, while the performance of 
one cluster of stores can be compared against another cluster.

The structure of this hierarchical tree should be carefully considered as it will affect 
the quality of information that can be produced using Macro Space Management, and 
hence determine the effectiveness of Macro Space Management as a tool for improving 
the profitability of a business.

Planning the Structure
Typical information needed to plan how individual stores should be assigned within 
the structure includes:

■ Store Size

■ Store Turnover

■ Store Location

■ Store Demographics

Criteria can then be developed as to cluster types and whether individual stores 
should be assigned to single or multiple clusters. For example, a store could be 
associated with three separate and distinctive clusters. One cluster would enable the 
store to be compared against those in other regions, one against stores of similar 
turnover, and the third against stores of similar size.

Consideration should also be given to which stores can be designated as Prototypes 
for comparison purposes. Correctly assigned prototype stores will allow swift and 
effective comparison of individual store performance against an exemplar. A correctly 
planned structure can significantly improve the performance of a retail organization - 
a poorly planned structure could prevent the full power of Macro Space Management 
being used.

Data Import
You can import data using the Data Import module of the Macro Space Management 
application. This enables data to be imported from external databases into the Macro 
Space Management central database.

Note: Changing these system variables can have a significant effect 
on how Macro Space Management operates. It is strongly 
recommended that changes are made only after consulting the Oracle 
technical support team.
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To import data:

1. Open the Data Import module from Start > All Programs > Oracle Corporation > 
MSM > Data import.

2. Select the data that you want to import by checking the box.

3. Click Import Data. You can view the Log files by selecting Import Log / Import 
error log from the View option.

4. When done, click OK.

Some companies set up Macro Space Management starting from scratch, manually 
entering all data as it is developed. Most of Oracle's customers have pre-existing data. 
Oracle's consultants can find the most effective way of importing this data into Macro 
Space Management. 

Maintaining Store Manager

Significance of Dates
There are a series of dates associated with individual files. These can be seen both in 
the Store Manager file display and in the properties tab for each file.

Figure 2–14 Store Manager 

Note: Oracle's consultants can configure the exact nature of the data 
import so that specified data is selected from the designated databases 
and imported into the required fields within Macro Space 
Management's central database.
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Figure 2–15 File Properties User Interface

■ Created is the date at which the file was created.

■ Accessed is the date at which the file was last viewed (without making any 
changes to the file).

■ Modified is the last date at which changes to the file were saved.

■ Last Modified by is the user name of the last individual to modify the file.

■ Last Published is the last date at which the file was published.

■ Archived indicates if the file has been moved to the Archive database.

■ Publish is the date the file is set to be published on. (If the file has been published 
this date will be greyed out).

■ Effective is the date at which the file will become current at. (If the file is Current 
or Historical this date will be greyed out).

■ Died is the date at which the file has lost or will lose current status. (This date will 
be in the future if the file has Current status, and in the past if it has Historical 
Status).

File Identification Numbers
Each drawing within Macro Space Management has a File Identification Number. This 
can be found by opening the Properties dialog box associated with that drawing. The 
File ID can be seen on the lower right.

Saving and back-ups
The Planner Module can be set to automatically save Planner drawings at regular 
intervals. This can be done during installation of Macro Space Management - consult 
Oracle's Technical Support Team for further information.

The database for Macro Space Management should be saved at regular intervals and 
back-up data stored in a safe place.
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Building the Structure

Adding Clusters
Clusters are containers used to group together stores of a specific type. For example, 
all stores in a geographic region, all stores of a particular size, or all stores serving a 
particular population demographic. Unlike stores (and their associated child objects) 
they do not result in a folder in the Windows file structure. Clusters can have other 
clusters, called sub-clusters, as child objects.

Multiple clusters improves options for reporting and manual finding of stores within 
the Store Hierarchy.

To add a cluster:

1. From the hierarchy tree in Store Manager, click the Store Root to highlight it.

2. With the mouse pointer over the Store Root icon, right click to bring up the drop 
down menu.

Figure 2–16 Add Cluster Window

3. Select Add Cluster. The Add Cluster dialog box appears.

Figure 2–17 Add Cluster Dialog Box

4. Enter Cluster Name and Code and select the Cluster Type from the drop down 
list. Selecting the correct Cluster Type is important as this information will be used 
for reporting purposes. If clusters are allocated to the wrong type, errors will occur 
in reporting.
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Figure 2–18 Add Cluster Dialog Box - Cluster Type

5. Click OK.

Editing Clusters
To edit a cluster or add sub-cluster to an existing cluster:

1. Click on the existing cluster to highlight it and right click to view the drop down 
options.

Figure 2–19

2. Select Add cluster. The Add Cluster dialog box appears. If you want to edit the 
cluster details, select Edit. The Edit Cluster dialog box appears.

3. Enter the required information and click OK.

Adding Stores and Prototype Stores
Stores can be associated with one or multiple clusters. Stores act as containers for 
floors and their associated files.

To add a Store:

1. From the hierarchy tree in Store Manager, click the Cluster icon to highlight it.

2. With the mouse pointer over the cluster or sub-cluster icon, right click to view the 
drop down list. Alternatively, highlight the select cluster and select Add from the 
File menu option or select the plus sign from the Tool bar.

Note: The list of drop down options is customizable. Please consult 
Oracle's Technical Support team for information.
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Figure 2–20 Add Store

3. Select the Add Store option. The Add Store dialog box appears.

Figure 2–21 Add Store Dialog Box

4. On the General tab, enter the following information:

■ Store code

■ Name

■ Latitude

■ Longitude

■ Status

■ Opened Date

■ Closed Date

■ Store Prototype: If the store is not a prototype, select the Prototype Store from 
the drop down list at the bottom of the dialog box.If the store is designated as 
a Prototype, then selecting a prototype store from the drop down list is not 
possible.

■ Set as Prototype
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5. Select on the Units tab and select the required units for Display and Input measure 
of units.

The units set in the Units tab are for information purposes only, and will not have 
any direct effect in current implementations of Macro Space Management.

6. Select on the Address tab and enter the required information.

7. Select the Attributes tab and enter the value for each of the property.

8. Click OK when done.

You can edit the information for a store by selecting the Edit option.

Prototype Stores
Stores can be designated as Prototype Stores. Once designated as prototype stores, 
they can be assigned to other stores to act as a basis for comparison. For example when 
laying out zones, fixtures, and merchandise in a new store, it is possible to compare 
the parameters for those in the new store with those present in the prototype store.

Prototype Stores can be used in reports for comparing stores with prototype store, can 
be used in Summary Window in Object Browser to compare Store with Prototype and 
can be used in Custom SQL in Object Grid, for example to color code results.

Comparing Store to Prototype
Once a store has been assigned a prototype, comparisons can be drawn between the 
store and its prototype. Examples of comparisons that could be made are:

■ Areas of zones

■ Numbers and types of fixtures placed

■ Numbers and types of merchandise placed

■ Financial performance

Once a store has been assigned a prototype, there are number of ways of making 
comparisons. Examples include:

■ Using the Object Browser

■ Using KPIs

■ Using external reports such as Oracles BI Publisher.

For example, the Summary Window in the Object Browser contains information on the 
Zones, Fixtures and Merchandise in the current store and its assigned prototype. By 
use of custom SQL, comparisons can be made between the area of a zone (department) 
in the current store and the prototype it is being compared to.

Figure 2–22 Summary Window
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Adding Floors
A floor can only be associated with a store. Floors have types used to indicate if the 
floor is a ground, basement, first floor etc. A floor can contain revisions, associated 
files, drawings & architectural drawings.

To add a floor:

1. From the hierarchy tree in Store Manager, select the store to which you want to 
add floor.

2. With the mouse pointer over the store icon, right click to view the drop down list.

Figure 2–23 Add Floor

3. Select the Add Floor option. A dialog box comes up. Alternatively, click on the 
plus sign to add an Item in the toolbar.

Figure 2–24 Add Floor Dialog Box

4. Select the Floor Type.

5. If you want to enter additional information, edit the Description of the floor; else 
you may retain the default value which is the Floor type.

6. If necessary, edit the Directory. (This is the name that will be given to the 
associated directory).

7. Select the Status of the floor. Available options are:

■ Proposed
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■ Existing

■ Closed

8. Set the Allocated Area % Tolerance to any figure up to 100%. This figure is used to 
check the allocated area of the floor meets a specified level of efficiency. For 
example, setting the percentage to 95 % will result in a warning if the planning of 
fixtures and fittings results in less than 95% of the floor area being allocated.

9. Enter the Elevation value. The Elevation option allows the merging of floors for 
planning purposes.

10. Select the Edit Levels option to edit the levels. It allows fixtures to be located at 
higher than floor level. An example would be display cabinets placed high on the 
wall.

Figure 2–25 Level Details

11. Click OK to add the floor.

Adding Revisions
Revisions are alternative layouts for floors. Changing from one Revision to another 
allows the layout of a floor to be changed, (for example), from the Spring to the 
Summer arrangement.

To add a revision:

1. From the hierarchy tree in Store Manager, select the floor.

2. With the mouse pointer over the store floor, right click to view the drop down list.

Note: Only one floor at each level can have Existing status at a time. 
If a floor at the level being added already has Existing status, a 
message stating "A floor already exists of this type" will appear. To 
give the new floor Existing status, the status of the floor with current 
Existing status will have to be changed.



Store Manager Overview

2-24 Oracle® Retail Macro Space Management  User's Guide

Figure 2–26 Add Revision

3. Select the Add Revision option. A dialog box comes up. Alternatively, click on the 
plus sign on the tool bar to add an Item.

Figure 2–27 Add Revision Dialog Box

4. Enter the Revision Number. If you inadvertently select an existing revision 
number, the revision number will default to the next available number.

5. Enter the Revision Description and Revision Directory Name.

6. Select the status of the revision from the available options:

■ Proposal

■ Authorized

■ Current

7. Set the season to one of the available options.

■ Spring

■ Summer

Note: At this stage it will only be possible to set the revision status to 
"Proposal".
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■ Autumn

■ Winter

■ All

8. The Birth date will automatically set to the current date. The Death date will 
automatically set to 31st December 9999. Neither the Birth nor Death date need 
changing at this stage.

9. If you want to add a proposal drawing, check the box against Add Proposal 
Drawing.

10. Click OK to add the Revision.

Associating Architectural Plans
Architectural Plans can only be associated with Floors. An example of a file of this 
type would be a Planner drawing (file extension *.DWG).

To associate an Architectural Plan with a Floor:

1. From the hierarchy tree in Store Manager, select the floor to which you want to 
associate plan.

2. With the mouse pointer over the floor, right click to view the drop down list, and 
select Associate Architectural Plan.

Figure 2–28 Associate Architectural Plan

Alternatively, you can select the Associate Architectural Plan icon from the 
toolbar.

The Associate Architectural Plan dialog box comes up.

Figure 2–29 Associate Architectural Plan dialog box
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3. Click on the Browse button and select the required file.

4. Select the file and click Open to confirm. This will return you to the Architectural 
Plan dialog box.

5. Click OK on this dialog box to confirm the Architectural Plan to be associated.

Associating Files
For a revision to be fully active, it needs files to be associated with it. This can be done 
via the file menu.

Figure 2–30 Associate File

To associate a file:

1. From the hierarchy tree in Store Manager, select the revision by clicking on it.

2. With the mouse pointer over the revision, right click to bring up the drop down 
list. Alternatively, you can use the associate file icon on the toolbar.

Figure 2–31 Associate File

3. Select the Associate File option. The File Association dialog box comes up.
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Figure 2–32 File Association dialog box

4. Click the Browse button and select the required file.

5. Click OK to confirm. Or you may link or copy a file.

Modifying and Deleting the Structure

A Note on Parent-child Relationships
When deleting clusters, sub-clusters, stores, floors or revisions, it should be noted that 
all associated child files will be deleted along with the parent file.

These files are not permanently deleted and can be recovered by use of the purge 
option in the Admin functions in the Store Manager module, (accessed by <Ctrl + A>).

Changing the status of a revision may also affect the status of an associated child file.

Moving Stores between Clusters
To move a store from one cluster to another:

1. Select the store.

2. Click the right mouse key and select Cut.

3. Paste the store on to the required cluster.

Alternatively, you can move the store by dragging the store icon to the required 
cluster. Multiple stores can be selected by using the mouse key in conjunction with 
the <Shift> or <Control> keys.

Putting stores into multiple clusters
A cluster, (or sub-cluster), is used to group together stores sharing a common 
characteristic such as size or geographical location. Stores can logically belong to more 
than one category when they meet more than one criteria. Accordingly, stores can be 
assigned to more than one cluster.

To put stores into multiple clusters:

1. Select the store from an existing cluster.

2. Click the right mouse key and select Copy.

3. Click the right mouse key and select Paste on to the second cluster or sub-cluster.

Note: Macro Space Management will automatically update files that 
are linked if they are changed or modified by an external program. 
Copied files updated by Macro Space Management may not have their 
original versions changed.
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This process can be continued until the required store(s) have been put into all the 
appropriate clusters or sub-clusters.

Modifying and Deleting Clusters
Existing clusters can be modified to deleted.

To edit a cluster:

1. Select the cluster you want to edit.

2. Click the right key of the mouse and select the Edit option. Alternatively, you can 
select the Edit option from the File menu option after selecting the cluster you 
want to edit.

Figure 2–33 Edit Clusters

The Edit Cluster dialog box appears.

Figure 2–34 Edit Cluster dialog box

3. Enter the following details on the dialog box.

■ Cluster ID: The Cluster ID is allocated on creation and cannot be changed. It is 
unavailable for editing.

■ Cluster Name: Enter a suitable name.

■ Cluster Type: Select the type from the drop down list.

■ Cluster Code: Enter a specific code for the cluster.

4. Click OK.
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Deleting Clusters
The cluster and all its associated child files are removed from the hierarchical tree and 
moved to the RFBin. At this stage the files have not been permanently deleted and can 
be restored via the Administrator menu, (accessed via <Ctrl + A>). When deleting a 
cluster, all copies of the stores associated with are removed, but copies of the stores 
associated with other clusters are not affected.

Modifying and Deleting Stores
You can edit most of the characteristics of a store and may delete any existing store.

Editing Stores
To edit a store:

1. Select the store to be edited.

2. Right click on the store and select the Edit option.

Figure 2–35 Edit Stores 

The Edit Store dialog box comes up.

Figure 2–36 Edit Store dialog box
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3. Enter the following information:

4. The store ID is allocated on creation and cannot be changed.

5. Enter the Store Code and the Store Name. The Directory name is auto-populated.

6. Enter the Latitude and Longitude, although this information is not required at this 
stage.

7. Enter the Status of the store from the drop down list.

8. Select the Opened Date and Closed Date of the store.

9. On the Store Prototype field, from the list of store prototypes, select one of the 
option.

10. If you want to set this store as a prototype, check the box against Set as Prototype.

11. Click OK to continue, or Cancel to cancel adding the store.

Deleting Stores
To delete a store from all the clusters it is associated with, right click and select the 
Delete option. The store and all its associated child files are removed from the 
hierarchical tree and moved to the RFBin. At this stage the files have not been 
permanently deleted and can be restored via the Administrator menu, (accessed via 
<control> A).

To remove a store from a specific cluster, left click on the store to select it. With the left 
mouse key held down, drag the store icon to another cluster that the store is associated 
with. Release the mouse key to drop the store. The store will be removed from the 
original cluster.

Modifying and deleting Floors
Most of the characteristics of the floor can be edited by right clicking and selecting the 
Edit option.

Figure 2–37 Edit Floor

The Edit Floor dialog box comes up.

Note: The units set in the Units tab are for information purposes 
only, and will not have any direct effect in current implementations of 
Macro Space Management.
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Figure 2–38 Edit Floor dialog box

The store ID is allocated on creation and cannot be changed. Provide information in 
other fields and click OK.

Deleting Floors

To delete a floor from the store it is associated with, right click and select the Delete 
option. The floor and all its associated child files are removed from the hierarchical 
tree and moved to the RFBin. At this stage the files have not been permanently deleted 
and can be restored via the Administrator menu, (accessed via <control> A).

Modifying and deleting Revisions
Most of the characteristics of a Revision can be edited by right clicking and selecting 
the Edit option.

Figure 2–39 Edit Revision

The Edit Revision dialog box comes up.
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Figure 2–40 Edit Revision dialog box

The revision ID is allocated on creation and cannot be changed. Enter other 
information on the user interface and click OK.

Deleting Revisions

To delete a revision, right click on the revision and select the Delete option. The 
revision and all its associated child files are removed from the hierarchical tree and 
moved to the RFBin. At this stage the files have not been permanently deleted and can 
be restored via the Administrator menu, (accessed via <control> A).

Modifying and Deleting Architectural Plans
Architectural Plans can be modified or deleted.

To access a list of Architectural Plans:

1. Select the appropriate floor. Files on which operations are to be carried out on can 
be selected by use of the:

■ Select All option.

■ Deselect All option.

■ Using the mouse, (using the <Shift> or <Ctrl> keys for multiple selections).

2. Right click on a selected file in the right hand frame to bring up a list of options.

Note: Architectural Plans can only be associated with Floors.

Note: When adding an Architectural Plan to a floor it is normally 
advisable to link it, rather than copy it as linked files are automatically 
updated within Macro Space Management when the original file is 
modified. Copied files remain unchanged if the original is updated.
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Figure 2–41 Modify Architectural Plans

Files for external editing, (for example drawings to be changed using Planner), 
will be shown as Checked Out by Store Manager.

3. To modify the properties of the Architectural Plan, right click on the file and select 
properties. This displays the Properties dialog box.

Figure 2–42 Properties dialog box

The file attributes reflect the current status of the file. There will be checks in the 
appropriate check boxes if opened Read-Only or if Checked Out.

Deleting Files

To delete an Architectural Plan, right click on it and select Delete. The file will be 
removed from the hierarchical tree and moved to the RFBin. At this stage the 
Architectural Plan has not been permanently deleted and can be restored via the 
Admin menu, (accessed via <Ctrl+A>).
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Modifying and deleting Associated Files
Associated files can be edited or deleted.

To access a list of associated files:

1. Select the appropriate revision.

2. Right click on the list of files to bring up a list of options.

Figure 2–43 Edit Associated Files

Files on which operations are to be carried out on can be selected by use of the:

■ Select All option.

■ Deselect All option.

■ Using the mouse, (using the <Shift> or <Control> keys for multiple 
selections).

Files for external editing, (for example drawings to be changed using Planner), 
will be shown as Checked Out by Store Manager.

To modify the properties of the file, right click on the file and select properties. 
This brings up the Properties dialog box. The Details tab gives a series of 
information about the file.
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Figure 2–44 Details tab

The file attributes reflect the current status of the file. There will be checks in the 
appropriate check boxes if opened Read-Only or if Checked Out.

Auto-Archive and Auto-Replenish relate to Automation features.

The Notes tab can be used to store information on the changes made to the 
drawing.

Figure 2–45 Notes tab

Notes can be added and deleted using the two buttons to the upper right of the 
dialog box.

Deleting files

To delete a file, right click on it and select Delete. The file will be removed from the 
hierarchical tree and moved to the RFBin. At this stage the file has not been 
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permanently deleted and can be restored via the Administrator menu, (accessed via 
<Ctrl + A>).

Business Flows
Stores can vary in status; starting from proposed, spending the bulk of their life open 
and finally closing. Similarly, Floors can start their lives as proposals, open for 
business, and finally close if their purpose is changed or the Store itself closed.

However, the most common change due to the business cycle is the ever changing 
configuration and merchandising of a floor. The configuration and product mix on the 
Floor is controlled by selecting the appropriate Revision - the Revision selected being 
governed by its status.

The ability to revise and continually update the details of stores and their contents 
allows the full power of Macro Space Management to be used.

Putting together the data for a new Revision  

Creating a new Revision

If necessary, create a new revision for the floor, naming it appropriately. This revision 
should have the status of proposed. Import or create the necessary drawings. These 
will also have the status of proposed. At this stage the folder icon is buff color.

Changing the Revision status to Approved

Two options are available; firstly, the revision alone can be changed to Authorized, 
with the drawing remaining at Proposed status. Alternatively, the drawing and then 
the revision can be changed to Authorized status.

If the revision alone is changed to Authorized status, then before the revision can be 
made Current, the drawing will have to be changed to Authorized status. For this 
reason, it is recommended that the drawing status be changed at the same time as the 
revision status.

On changing to approved status the folder icon changes to a green color.

Changing the Revision status to Current

Use the properties option to change the revision status to current. The drawing 
automatically changes to current status. On changing to current status the folder icon 
changes to a pink color.

The birth date for the revision will be set to the current date.

Historical status

When the approved revision is being set to current, the previously current revision 
will automatically be set to historical.

Note: Only one drawing and one revision can have the status of 
Approved. If another authorized version exists, you will be prompted 
as to whether the previously authorized revision should be set to 
proposal.

Note: Only one drawing and one revision can have the status of 
current.
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The death date for the revision will be set to the current date.

Status  

The status of an object is continually changing as it moves through the business cycle. 
For example stores start as Proposed. After approval they become Open. When the 
store reaches the end of its life it will become Closed.

Understanding the changing status of objects is fundamental to the operation of Macro 
Space Management. All objects except clusters and sub-clusters have a status. Clusters 
and sub-clusters are administrative devices for arranging stores in logical groupings, 
and hence do not have status. Stores and floors have independent status and their 
status can be changed without affecting the status of any objects below them in the 
hierarchical tree. Changing the status of a revision may affect the status of its 
associated child files. Changing the status of a revision may also affect the status of 
any other revisions for that floor.

Some status changes are reversible. For example a store can be changed from open to 
closed status for a major refurbishment. On completion of the refurbishment, the 
stores' status can then be changed back to open.

Some status changes are irreversible. For example, once a floors' status has been 
changed from current to historical it cannot be changed back. Whether a status is 
reversible or irreversible is determined when Macro Space Management is first 
implemented.

Changing the status of Stores
■ Stores can have the following status:

■ Proposed

■ Open

■ Closed

They can also be set to Prototype status

Status of a Store is changed through the Edit Store dialog box. This is accessed by right 
clicking on the Store icon in the hierarchical tree and selecting the Edit option.

Figure 2–46 Edit Status of Store

Note: All drawings within a revision set to historical status are also 
set to historical status, irrespective of their previous status.
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Figure 2–47 Edit Store dialog box

The status of the Store can be changed by means of the drop down list. A stores' status 
can be changed without affecting status of the floors, revisions or files below it in the 
hierarchy.

Changing the status of Floors
Floors can have the following status:

■ Proposed

■ Existing

■ Closed

Status of a Floor is changed through the Edit Floor dialog box. This is accessed by right 
clicking on the Floor icon in the hierarchical tree and selecting the Edit option.

Figure 2–48 Edit Floor dialog box

A floors' status can be changed between Proposed to Existing without affecting status 
of the revisions or files below it in the hierarchy.

Changing the status to Closed turns any Current file to Historical status.
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Changing the Status of Revisions
Revisions within Macro Space Management can have the following generic statuses:

■ Proposal

■ Authorized

■ Current

■ Historical

Status of a Revision is changed through the Edit Revision dialog box. This is accessed 
by right clicking on the Revision icon in the hierarchical tree and selecting the Edit 
option.

Figure 2–49 Edit Revision dialog box

■ Only one Revision can have the status of Authorized for a specific Store.

■ Only one Revision can have the status of Current for a specific Store.

Changing the status of a Revision can affect the status of its associated child files.

Note: Revisions cannot be directly changed to Historical status - they 
are automatically changed by Macro Space Management when 
another Revision becomes Current.

Table 2–2 Changing the Revision Status of Files

Changing from Changing to Result

Proposal Authorized Children not affected by status change.

If another revision has currently has authorized 
status, this revision will automatically have its 
status changed back to proposal.

The change back to proposal will require 
confirmation by a prompt.
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The status of a Revision can be seen from the color of its associated folder.

Figure 2–50 Revision Status

Changing the status of Files
Files can exist at the store, floor or revision level in Macro Space Management. Within 
Macro Space Management, files at Revision level can have a generic status of:

■ Proposed

■ Authorized

■ Current

■ Historical

If Macro Space Management is being used in parallel with In-Store Space 
Collaboration, then other generic statuses are possible:

■ Survey

Authorized Current A revision can only be changed to current if it has 
only one related drawing, or if only one drawing 
has been given authorized status.

If another revision within the same floor has a 
status of current, that revision will have its status 
changed to historical.

The change to historical will require confirmation 
by a prompt.

"Current" children of the revision which is having 
its status changed to historical will also have their 
status changed to historical. Other children of that 
revision could also have their status changed.

Current Historical This change is automatic, all pertinent children 
being changed automatically.

This change is irreversible.

Note: Files cannot be directly changed to Historical status, they are 
automatically changed by Macro Space Management when another 
Revision becomes Current.

Table 2–2 (Cont.) Changing the Revision Status of Files

Changing from Changing to Result
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■ Submitted

Status of a Revision is changed through the Edit Revision dialog box. This is accessed 
by right clicking on the Revision icon in the hierarchical tree and selecting the Edit 
option.

The status of a file can only be reversed if the status has been marked as reversible in 
the database. If the file is the child of a revision currently changing its status to current, 
the file automatically has its status changed. If the file is the child of a revision 
automatically having its status changed from current to historical, the file 
automatically has its status changed.

Only one drawing within a revision can have a status of authorized. If you are 
attempting to change a second file to authorized status, the initial file with authorized 
status is automatically changed back to proposed first. The automated change to of a 
revision to historical requires confirmation by a prompt.

Macro Space Management Files and In-Store Space Collaboration
Two types of drawings are often present in Macro Space Management and derived 
from the use of In-Store Space Collaboration:

■ Survey drawings

■ Submitted drawings

Survey Drawings are created in Macro Space Management to represent store layouts 
that are currently in place, but where there the information is to be updated. They 
consist of a building outline and dummy fixtures, fitting and gondolas. A surveyor 
then walks the store and updates the drawing using In-Store Space Collaboration so 
that it reflects the actual arrangement in place.

Fixtures, Fittings, Gondolas, Products and Merchandise can be updated on a Survey 
Drawing using In-Store Space Collaboration. Survey drawings start at Survey status. If 
they are saved using the In-Store Space Collaboration Save option, their status remains 
at Survey status.

Submitted drawings are drawing that have been fully updated using In-Store Space 
Collaboration and are being saved back to the central Macro Space Management 
database with a modified status.

When they are saved using the Save Submit option within In-Store Space 
Collaboration, their status is automatically changed to Submitted.

The status of the drawing cannot be further changed by In-Store Space Collaboration.

Advanced Administration

Underlying directory structure
Macro Space Management holds all the information for a retail organization. A retail 
organization can contain lots of information on stores. Each store may have multiple 
floors and each floor can have hundreds of fixtures and fittings on it. Each fixture may 
have multiple products or planograms placed on it.

This information must be organized in a such way that you can quickly find the 
information you want. Macro Space Management does this by means of hierarchies. 

Note: Other statuses can be selected using the IN_STORE_
SUBMITSTATUS system variable.
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The hierarchy is split into a number of levels, each a child of the one above. The top 
level is the starting point for the hierarchy. It cannot be edited or deleted. Each level 
within the hierarchy can store files against itself, with the exception of File type 
objects. The general format of the directory structure is thus 
All/Cluster/Sub-cluster/Store/Floor/Revision/File.

Figure 2–51 Directory Structure

Searching the directory structure
The search facility can be activated by clicking the search icon on the toolbar.

This brings up a dialog box with a dialog box with a series of options. Select the 
required options and click OK.

Figure 2–52 Search Directory Structure

The search function in Store Manager performs an in-string search and does not 
support wild-cards. It will thus only return exact matches. The search starts from any 
selected node, and can be set to search up or down from that node.

Note: Clusters and sub-clusters will not have a Windows folder 
associated with them.
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Customizing Administration Options
Some of the operations of the Admin module can be customized via the Options menu 
on the View menu.

Figure 2–53 Store Manager Options Menu

This brings up the Options dialog box.

Figure 2–54 Options dialog box

Log Files
Log files are files recording events and problems during operation of Macro Space 
Management. This enables problems to be investigated at a later date. They can be 
found at the location specified in the Configuration Module. Double click a specific file 
to bring up a log of a particular Macro Space Management’s operation.

The Store Manager Menu Bar
The Store Manager Menu bar contains the following options:

■ File Menu

■ Edit Menu

■ View Menu

■ Tools Menu
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File Menu Options
The File Menu option activates a menu with options primarily concerned with 
operations on files. This menu can be used to add, edit and delete files and to associate 
files and architectural plans.

Add a file
From the File menu, select Add. Depending on the hierarchy level you are at, the 
corresponding Add dialog box opens. For example, if you clicked at the cluster level, 
Add Cluster dialog opens; from the store level, Add Store dialog opens.Note: Some of 
these may be grayed out depending on the Store Manager function being used.

1. Enter the Store Code and the Store Name. The Directory name is auto-populated.

2. Enter the Latitude, Longitude, and Status details of the store.

3. Select the Opened Date and Closed Date of the store.

4. On the Store Prototype field, from the list of store prototypes, select one of the 
options.
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5. If you wish to set this store as a prototype, check the box against Set as Prototype.

6. Click OK to continue, or Cancel to cancel adding the store.

Edit a File
1. From the File menu, select Edit. The Edit dialog opens. Depending on the 

hierarchy level you are at, the corresponding Edit dialog box opens. For example, 
if you clicked at the cluster level, Edit Cluster dialog opens; from the store level, 
Edit Store dialog opens.

2. Edit the required fields and click OK.

Delete a File
1. From the File menu, select Delete. A confirmation message appears.

2. Click Yes to delete the file or No to cancel the deletion.

Undo Delete
The deleted files are displayed in Store Manager with the crossed symbol as shown 
below.

You may retrieve the deleted files by selecting the Undo Delete option.

■ Select the file that you want to retrieve.

■ Select the Undo Delete option from the File menu.

Properties
The Properties window displays detailed information on the selected file. For more 
information, refer sections Significance of Dates and File Identification Numbers.

Associate File
For a revision to be fully active, it needs files to be associated with it. This can be done 
via the file menu. For more information, refer section Associating files.

Associate Architectural Plan
Architectural Plans can be associated with Floors. For more information, refer section 
Associating Architectural Plans.

Edit Menu Options
The Edit Menu options allow you to cut, copy, or paste files.
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View Menu Options
The View Menu options activate a menu with various options controlling the way 
Store Manager appears. These can be used to change the way Store Manager displays 
information.

You can select the file display by selecting the Large icons, Small icons, List, or Detail 
from the View Menu option.

The Arrange option allows you to arrange the data displayed on the Store Manager as 
per you choice. You can choose to arrange the data by name, status, type or by date.

The Find options helps you search for data in the Store Manager. The Refresh option 
refreshes the data in the Store Manager.

Options enable you to customize the view, editing, and performance options in the 
Store Manager. For more information, refer section Customizing Administration 
Options.

Tools Menu Options
The Tools Menu option is available only to administrators and is toggled on and off by 
using <Ctrl + A>.

It contains the following options:

■ List Checked Out Files

■ Purge

Note: Some of these may not be available depending on what Store 
Manager function is being used.
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■ Stores / Cluster View

■ Directory Integrity Check

The Store Manager Toolbar

The Store Manager toolbar contains a series of options for administering the objects 
and files in Macro Space Management. Depending on which operation is being carried 
out, one or more options may be inactivated (unavailable).

System Variables
Some of the variables affecting how Macro Space Management and Store Manager 
operate can be customized. For example, if you change the status of a parent file, the 
status of its associated children files gets affected automatically.

Configuring System Variables is done by accessing the Admin Module making 
changes using the System Variable option. Some of these system variables affect the 
operation of Macro Space Management Generic, others affect the operation of both the 
Generic and Enterprise versions of Macro Space Management.

For detailed information on configuring the system variables, refer the Oracle Retail 
Macro Space Management Configuration Guide.

Object Browser
The Object Browser is a separate window on the main screen. It is found in the Planner 
and Merchandiser environments and is used to control the various activities within 
these environments. 

It offers Macro Space Management users a single point of access to the Zone, Fixture, 
Product, and Planogram libraries and the Key Performance Indicators (KPIs).

Note: Changing these variables can have a significant effect on how 
Macro Space Management operates. It is strongly recommended that 
changes are made only after consulting the Oracle technical support 
team.
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Figure 2–55 Object Browser

The Object Browser is made up of four tabs positioned on the left-hand side. The four 
tabs are as follows:

■ Zones - this includes tools for drawing boundaries to represent departments etc. in 
to the store plan.

■ Fixturing - this includes tools for adding and removing fixtures, fittings and 
gondolas etc. in to the store plan.

■ Merchandising - this includes tools for adding and removing product categories 
and planograms etc. in to the store plan.

■ KPI - this includes tools for displaying Key Performance Indicators (KPIs) on the 
store plan.

Turning off and Accessing the Object Browser
The Object Browser can be turned off by clicking on the close button (x) in the upper 
right corner.

The Object Browser can be opened by selecting the Show Object Browser option on the 
View drop down menu.
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Figure 2–56 Show Object Browser

Parts of the Object Browser
The Object Browser has a series of parts. These are described below.
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Figure 2–57 Parts of Object Browser 

■ Tabs allow the Object Browser to be switched from one function to another. The 
Object Browser can be used to add, edit and delete Zones, Fixtures, and 
Merchandise. Each tab has the same general components.

■ A Toolbar at the top allows various functions to be accessed. These typically allow 
adding, editing and deleting of the required objects, together with searching, 
filtering and refreshing options.

■ The Fixturing and Merchandising tabs have Switch Buttons. In Fixturing, you can 
click on one or other button to select Fixturing or Gondola operations. In 
Merchandising you can use the buttons to switch between planograms and 
products.

■ Each tab has a series of Information Windows. These vary from each tab but can 
include:

■ Hierarchical trees: these give information on what objects can be added, 
edited or deleted in the drawing. In the Zones Tab for example, the 
hierarchical tree allows you to select different types of zones.

■ The Properties window gives details of the selected object.
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■ The Summary window gives totals of types of objects placed in the drawing.

■ The Preview window shows a low resolution image of the selected object. In 
the Fixturing tab for example, this would be an image of the selected fixture.

■ The Information windows can be opened or closed by clicking the Splitter Bars.

Refresh Option
All the toolbars in the various Object Browser tabs contain a Refresh button.

When clicked, it updates the hierarchies in that particular tab with the latest 
information from the central Macro Space Management database. Once the hierarchies 
have been refreshed, the latest information from the database can be incorporated in 
the drawing. For example, once the refresh button has been used in the Fixturing tab, 
the hierarchies contains the most recent fixture and gondola information for insertion 
into the drawing. This allows to update these definitions in Fixture Studio then make 
them immediately available within Merchandiser.

However, all new fixtures and gondolas added to the open drawing will use the new 
data.

Using Object Browser

Opening and Closing the Object Browser
The Object Browser is open by default the first time you log in to Macro Space 
Management.

There are two ways to close the Object Browser.

■ Press the button at the top right of the Object Browser.

■ Right click the double bar on the Object Browser and click the Close option.

There are two ways to open the Object Browser.

■ Use the View - Show Object Browser menu option.

■ Use <Crt> + <Shift> + B.

Moving the Object Browser
The Object browser behaves differently in the Planner and Merchandiser 
environments. In the Planner environment it can be docked on any side of the screen 
or can be floated. In the Merchandiser environment it can be docked on any side of the 
screen, but not floated.

Planner
By default the Object Browser is docked on the left-hand side of the screen the first 
time you log in to the Planner module. The Object Browser can be moved to dock on 
any of the four sides of the screen. To move the Object Browser, click and hold the 
double bar on the Object Browser and drag to it to a new position.

Note:  In this instance, if the drawing is already open then fixtures 
already placed in the drawing will not use any changes loaded in the 
refresh operation until the drawing is closed and re-opened.
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The Object Browser can also be un-docked or float on the screen. This can be done in 
two ways.

■ Right click the double bar on the Object Browser and deselect the Allow Docking 
option.

■ Click and hold the double bar on the Object Browser and drag it to the middle of 
the screen.

Figure 2–58 Object Browser Docking

When the Object browser is floating, it can be minimized to save space while still 
leaving it visible on the screen.

The Object Browser can be re-docked by right clicking the title bar on the left and 
selecting Allow Docking, then drag the Object Browser to the side of the screen where 
you want to dock it.

Figure 2–59 Object Browser - Allow Docking

Merchandiser
By default the Object Browser is docked on the left-hand side of the screen the first 
time you log in to the Merchandiser module. The Object Browser can be moved to 
dock on any of the four sides of the screen. To do this, right click on the double bar at 
the top and select the required location.
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Figure 2–60 Object Browser - Merchandiser

Anchoring the Object Browser
The Object Browser can also be anchored in the Planner environment only. It can 
anchored on the left or right side of the AutoCAD window. By anchoring the Object 
Browser it remains on screen, but in a minimized state, which allows you to bring it 
back up when needed. This also helps to increase the amount of visible drawing area. 
This can be done from the right click menu.

Figure 2–61 Object Browser - Anchor

Adjusting the Object Browser
The width of the Object Browser can be adjusted by moving the mouse cursor to the 
right-hand edge and dragging the mouse to the desired width. The windows 
displayed on the Object Browser can be minimized by clicking on the title buttons at 
the top of each window.

Saving Settings for the Object Browser
Settings for the Object Browser are saved by Macro Space Management so if closed, it 
re-opens in the same state as it was closed. Individual settings are saved to the profile 
currently selected in the Profiles tab of the Configuration module.
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Figure 2–62 Object Browser - Settings

The Object Browser opens at the same width and height and in the same tab as when it 
was closed, if the user profile remains selected. The application retains the appearance 
of the hierarchy displayed and the information window from the last session.

Zones Tab
Macro Space Management uses Zones to assign space to different departments and 
non-sales areas. The zone types available to your business are customized within the 
Administration module. Zones can also be used to help you select fixtures or 
merchandise.

The Zones tab is divided into four sections:

■ The Toolbar - provides controls to add, modify, and delete zones from a store 
plan.

■ The Zones Window - shows a hierarchy of available zones.

■ The Properties Window - when a Zone is selected from the hierarchy, its 
properties are visible in this window.

■ The Summary Window - shows details of the zones based on the open store plan.

Zones Tab Toolbar
Zones are 'read-only' in the Merchandiser environment. Accordingly, the majority of 
the functionality that is present when the Object Browser is used in the Planner 
module is absent.

Note: If you have not used that machine or profile before, then 
default settings will be used. Similarly, if you logs onto another 
machine, then the settings used will be the same as when you last 
used that machine.
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Figure 2–63 Zones Tab in Object Browser of Planner

Figure 2–64 Merchandiser Zones Toolbar

The Hierarchy, Properties and Summary Windows

The Hierarchy Window
The hierarchy window displays the zone hierarchy. This hierarchy is defined in the 
Administration module and shows all the zones that can be added to a store plan. The 
hierarchy can be expanded using the plus control next to each item on the hierarchy. It 
can also collapsed by using the minus control next to each item.

The Properties Window
The Properties window displays information for the zone that has been selected in the 
zone hierarchy. The content of this window is customizable by an Oracle Retail 
consultant.

The Summary Window
The Summary window displays information on the zones placed in the open store 
plan. The content of this window is customizable by an Oracle Retail consultant. If set 
up to do so, this window can also show the zones drawn in the prototype store plan 
and their areas. This allows you to see what zones should be added to the new store 
plan and the target areas.

Fixturing Tab
The Fixturing tab allows you to add fixtures, fittings, gondolas, and other equipments 
to the store plan. Fixtures and fittings can be placed one at a time if required. Fixtures, 
fittings, and other equipments that are placed one at a time are known as blocks.

Gondolas are a collection of fixtures and fittings that have been designed to be placed 
in a specific layout. Gondolas can place the correct number of fixtures and fittings for a 
given size by using a simple control.

The Fixturing tab is divided in to 5 parts as follows:

■ The toolbar - provides controls that allows you to add, edit, and delete Fixtures 
and gondolas.

■ The Fixtures window - shows a hierarchy of available blocks and gondolas.

■ The Properties window - after selecting a block from the hierarchy, this window 
shows the details for the selected block. 

■ The Summary window - shows details of equipment placed based on the active 
store plan. The content of this window is customizable by an Oracle Retail 
consultant.
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■ The Preview window - shows a sample picture of the block selected in the block 
hierarchy.

Fixturing Tab Toolbar
The Fixturing tab toolbar in the Object Browser enables you to control all aspects of 
adding, editing, and deleting fixtures and gondolas within the Planner and 
Merchandiser environments.

Clicking on the Switch Buttons determines whether the Fixturing or Gondola options 
are active.

Figure 2–65 Fixturing Toolbar

Gondola Toolbar

Figure 2–66 Gondola Toolbar

When editing fixtures, care must be taken that the information held in the central 
Macro Space Management database continues to reflect the actual details of the 
graphic. If information in the central database does not match the graphic, then there 
could be problems with alignment in the Virtual Reality environment, adjacency 
calculations, etc.

Hierarchy, Properties, Summary and Preview Windows

Hierarchy Window
The Hierarchy window displays both the block and the gondola hierarchies. To toggle 
between the hierarchies use the Blocks or Gondolas buttons respectively. The 

Note: In Merchandiser, fixtures can only be added by dragging and 
dropping from the hierarchy. The Add icon is not active.

Note: When Fixtures are added, the Add Fixture dialog box (present 
in the Planner Environment) does not appear in Merchandiser.

Note: The graphics for fixtures are created in the Planner 
environment.
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hierarchies are defined in the Fixture Studio environment and show all the fixtures 
and gondolas that can be added to a store plan.

The hierarchy can be expanded using the plus control next to each item on the 
hierarchy. It can also collapsed by using the minus control next to each item. An item 
in the hierarchy can be highlighted by clicking on the name of the block or gondola.

The Properties Window
The Properties window displays information for the block that has been selected in the 
blocks hierarchy. The content of this window is customizable by an Oracle Retail 
consultant.

The Summary Window
The Summary window displays information on the blocks placed in the open store 
plan. The content of this window is customizable by an Oracle Retail consultant.

The Preview Window
The Preview window shows a sample picture of the block selected in the block 
hierarchy.

Figure 2–67 Preview Window

The preview is not updated when the Gondola hierarchy is displayed.

Placing Fixtures and Gondolas
To add a block to the store plan, highlight the required block in the hierarchy. You can 
then either press the Add Fixture button on the tool bar, or drag and drop the fixture 
to the store plan drawing. When a block is added the Insert fixture dialog opens.

Figure 2–68 Insert Fixture Dialog Box

These controls allow blocks to be positioned accurately in the store plan. Pressing the 
left mouse button places the block in an initial position. Pressing the right mouse 
button or the <Esc> key finishes placing the block.
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When placing fixtures or a block to the store plan in the Merchandiser module, 
highlight the required block in the hierarchy then drag and drop the fixture to the 
store plan drawing. The Insert Fixture dialog box does not appear in Merchandiser.

Placing Gondolas
To add a gondola to the store plan:

1. Select the required gondola in the hierarchy.

2. Press the Add Gondola button on the toolbar or drag and drop the gondola to the 
store plan drawing. You are prompted to select a start point for the gondola.

3. Press the left mouse button and the Gondola Run dialog box opens.

Figure 2–69 Gondola Run dialog box

4. Select the dimensions of the blocks to use in the gondola.

5. Select the Row details of the gondola.

6. Select the Start Position of the gondola.

7. Once the options are set, press the OK button. The dialog box closes and places all 
the blocks required for the gondola run in to the store plan.

Merchandising Tab
The Merchandising tab allows you to add product placeholders (products), and 
planogram placeholders (planograms) to the store plan. A product is any category, 
sub-category, or SKU that is included in the product hierarchy, i.e. any level in the 
hierarchy. Planograms are also organized in to a hierarchy of planogram groups. 
However, you can only place planograms in to the store plan. Planogram groups 
cannot be placed. Placeholders are markers that can be placed on to fixtures to indicate 
the product category, sub-category or planogram that will be used.

The Merchandising tab is divided in to 5 parts:

■ The toolbar - provides controls that allow products and planograms to be added, 
edited, and deleted
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■ The Merchandise window - shows a hierarchy of available products and 
planograms

■ The Properties window - shows details for the product that has been selected in 
the product hierarchy. Similarly it will show details of a planogram that has been 
selected in the planogram hierarchy. The content of this window is customizable 
by an Oracle Retail consultant.

■ The Summary window - shows details of products and planograms placed based 
on the active store plan. The content of this window is customizable by an Oracle 
Retail consultant

■ The Preview window - shows a sample picture of product display styles selected 
in the product hierarchy

Merchandising Tab Toolbar
The Merchandising tab Toolbar in the Object Browser enables you to control all 
aspects of adding, editing, and deleting products and planograms within the Planner 
and Merchandiser environments.

Clicking on the Switch Buttons will determine whether the Product or Planogram 
options are active.

Products Toolbar

Figure 2–70 Products Toolbar

Planogram Toolbar

Figure 2–71 Planogram Toolbar

Note: Product display styles are only available in Merchandiser.

Note: In Merchandiser, products and planograms can only be added 
by dragging and dropping from the hierarchy. The Add icon is not 
active
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The Hierarchy, Properties, Summary and Preview Windows

The Hierarchy Window
The hierarchy window displays the product and the planogram hierarchies. To toggle 
between the hierarchies use the Products or Planograms buttons.

The Product hierarchy is defined in the Product Studio module and shows all the 
products that can be added to a store plan. The Planogram hierarchy can be 
configured in Merchandiser and shows all the planograms that can be added to a store 
plan. The hierarchies can be expanded using the plus control next to each item on the 
hierarchy. It can also be collapsed by using the minus control next to each item.

An item in the hierarchy can be highlighted by clicking on the name of the product or 
planogram.

The Properties Window
The Properties window displays information for the merchandise that has been 
selected in the products or planograms hierarchy. The content of this window is 
customizable by an Oracle Retail consultant.

The Summary Window
The Summary window displays information on the merchandise placed in the open 
store plan. The content of this window is customizable by an Oracle Retail consultant. 
The window can show the merchandise allocated per zone in the prototype store plan. 
This allows you to see what merchandise should be added to the new store plan.

The Preview Window
The Preview Window is blank for both Products and Planograms.

Figure 2–72 Preview Window

KPI Tab
The KPIs tab of the Object Browser allows you to see performance of a store plan at a 
glance. The available KPIs can be customized and more KPIs can be added either by 
an Oracle Retail consultant or a trained Macro Space Management super user.

The KPI tab is divided into different parts:

■ The toolbar - provides controls that allow KPIs to be run and modified.

■ The Indicators window - shows a hierarchy of available KPIs.

■ The Layers window - shows a list of KPIs that have been run against the store 
plan.

■ The Legend window - shows the color bands associated with a KPI that has been 
run.

When the tab is first opened, the Layers and Legend windows are blank. These 
windows are populated when a KPI is run.
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KPI Tab Toolbar
The KPI tab toolbars in the Object Browser are used to add and edit KPIs and to edit 
the list of KPIs selected for display in the ViewPorts.

Figure 2–73 KPI Toolbar

Running a KPI
To run a KPI:

1. Select the KPI that is to be run from the hierarchy of Indicators that are shown on 
the Object Browser.

2. Press the Add KPI button to open the Key Performance Indicator dialog for the 
highlighted KPI.

Figure 2–74 KPI - Details tab

The Details tab shows the name of the selected KPI in the Name field.

3. Edit the name is required. This will only change the name that is shown in the 
Layers section of the KPI tab on the Object Browser and not the name of the KPI 
definition saved in the database. The Group By field is automatically populated 
with the KPI Type that was saved in the KPI definition.

4. Press the OK button to close the dialog and apply the KPI to the store plan 
drawing. The Layers frame shows the KPI that has just been run and the legend is 
updated with the Color Theme for the KPI.
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Turning Off KPIs

Figure 2–75 KPI - Turn Off

KPIs can be turned off in the store plan view by clear the check box next to the KPI 
name in the Layers pane on the Object Browser.

When no KPIs are checked the store plan view returns to the normal view mode.

Deleting KPIs
The Delete KPI button removes the highlighted KPI from the list in the Layers pane. If 
this is the KPI being displayed in the store plan view, then the results are cleared and 
the view returns to normal, that is, with no KPI applied.

Object Grid
The Object Grid provides an alternative to selecting lower level objects in the Object 
Browser, including the following:

■ Zones

■ Fixtures

■ Products

■ Planograms

It is a Object Browser window that is used in conjunction with the hierarchies visible 
in the Object Browser and is available in both the Planner and Merchandiser 
environments.

Note: The Delete KPI only stops the results from being displayed. 
The KPI definition is still saved in the database. If the KPI needs to be 
run again, this can be done by selecting it within the KPI hierarchy 
again and clicking the Add KPI button.
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Figure 2–76 Object Grid

Selecting Data from Object Grid
Information selected from a hierarchy in the Object Browser appears in the form of a 
list in the Object Grid. The user can then sort and filter the data to find the objects they 
want. Once the required object has been found it can be added to the drawing by 
dragging the item from the grid. In the Planner environment it can also be added by 
clicking the Add button. (The Add button is disabled in Merchandiser).

The higher the level selected in a hierarchy in the Object Browser, more items will 
appear in the list on the Object Grid. For example selecting 'Food' in the 
Merchandising tab would result in all food product (or planograms) appearing in the 
Object Grid. Selecting 'Fruit' would restrict the information displayed to just fruit 
items.

The type of information that is displayed in the grid (as well as the sort and filter 
panels) is determined by the active panel in the object browser (that is zones, fixturing, 
products or planograms).

The Object Grid contains three tabs:

■ Data - displays the actual object data.

■ Sort - allows you to sort the data by multiple columns.

■ Filter - allows you to filter the data by multiple columns.

The data is automatically filtered by clicking on a node in the object browser tree; for 
instance, clicking on a product sub-category shows all SKUs that are related that 

Note: The number of items displayed is set to a default maximum of 
250 items. This is to prevent the Object Grid having to filter and sort 
thousands of items each time these operations are carried out. This 
default value can be changed - consult Oracle Technical Support for 
further information.
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sub-category. This automatic filtering affects the filters on the Filter tab, which you can 
then modify.

This automatic filtering may only work for the following levels (dependant on the 
custom SQL):

■ Product Department (BA)

■ Product Category (RA)

■ Product Sub-Category (PA)

■ Planogram Group Parent

■ Fixture Group Parent

■ Zone Group Parent

It is also possible to trigger a change in the list of displayed products, if a different 
zone is selected. In this way, the application can restrict which products are placed in 
which zone.

Showing and Hiding the Object Grid
The Object Grid display can be turned On or Off using the Object Grid option on the 
View menu in both the Planner and Merchandiser environments.

Figure 2–77 Show Object Grid

Display can also be toggled On or Off by use of the F9 key.

Opening and Closing the Object Grid
There are two ways to open the Object Grid:

■ Use the View - Show Object Grid menu option.

■ Use <Ctrl> +<Shift> +<G> keyboard shortcut.
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There are two ways to close the Object Grid:

■ Press the button at the top right of the Object Grid.

■ Right click the double bar on the Object Grid and click the Close option.

Moving the Object Grid
The Object browser behaves differently in the Planner and Merchandiser 
environments. In the Planner environment it can be docked on any side of the screen. 
It can also be floated. In the Merchandiser environment it can be docked on any side of 
the screen, but not floated.

By default in Planner, the Object Grid is docked on the bottom of the screen the first 
time you log in to Macro Space Management. The Object Grid can be moved to dock 
on any of the four sides of the screen. To move the Object Grid click and hold the 
double bar on the Object Grid and drag to it to a new position.

The Object Grid can also be un-docked or float on the screen. This can be done in two 
ways.

■ Right click the double bar on the Object Grid and clear the Allow Docking option.

■ Click and hold the double bar on the Object Grid and drag it to the middle of the 
screen.

Figure 2–78 Allow Docking

When the Object Grid is floating, it can be minimized to save space while still leaving 
it visible on the screen. The Object Grid can be re-docked by right clicking the title bar 
on the left and selecting Allow Docking. Then drag the Object Grid to the side of the 
screen where you want to dock it.

Figure 2–79 Object Grid - Docking

By default in Merchandiser, the Object Grid is docked on the left-hand side of the 
screen the first time you log in to the Planner module. The Object Grid can be moved 
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to dock on any of the four sides of the screen. To do this, right click on the double bar 
and select the required location.

Figure 2–80 Object Grid in Merchandiser - Docking

Anchoring the Object Grid
Anchoring can be done in the Planner module only.

The Object Grid can be anchored on the left or right side of the AutoCAD window. By 
anchoring the Object Grid it remains on screen, but in a minimized state, which allows 
you to bring it back up when needed. This also helps to increase the amount of visible 
drawing area.

Figure 2–81 Anchoring Object Grid

To anchor the Object Grid press the minus sign on the bottom right. To restore the 
Object Grid to normal, press the Auto-hide button on the title bar of the Object Grid.

Adjusting the Object Grid
The width of the Object Grid can be adjusted by moving the mouse cursor to the right 
side edge and dragging the mouse to the desired width. Windows displayed on the 
Object Grid can be minimized by clicking the title buttons at the top of each window.

Saving Settings for the Object Grid
Settings for the Object Grid are saved by Macro Space Management. When reopened, 
it opens in the same state as it was closed by an individual user. Individual settings are 
saved to the profile currently selected in the Profiles Tab of the Configuration Module.
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Figure 2–82 Object Grid Configuration

When the user profile is selected, the Object Grid opens at the same state and tab as 
when it was closed. By default, the Object Grid opens at the Data tab. (For example, if 
closed in the Sort Tab, it reopens in the Data Tab). When reopened, the columns that 
were visible and hidden within the Object Grid Data panel when the module was 
closed, remain in the same state.

Using the Object Grid
The Object Grid has a series of controls which enable you to sort and filter data.

Note: If you have not used a machine with your profile on it, then 
default settings will be used. Similarly, if you log onto another 
machine, then the settings used will be the same as when you last 
used that machine.
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Figure 2–83 Object Grid Options

■ The Refresh button can be toggled on and off. It determines whether data in the 
Object Grid will be updated if a different point is selected in the current hierarchy 
in the object Browser.

■ The Add button allows you to add the currently selected object to the drawing.

■ The Data tab allows you to see the list of currently selected data.

■ The Sort tab allows you to set the selected sort sequences into ascending or 
descending.

■ The Filter tab allows you to filter the currently selected data.

■ The Use Sort checkbox enables you to toggle sorting On and Off.

■ The Use Filter checkbox allows you to toggle filtering On and Off.

■ The Search icon allows you to search for specific text strings.

■ The Total Records displayed are located at the bottom of the screen.

Note: If there are more records than the maximum specified in the 
software, a warning message appears at the bottom of the Object Grid 
as follows.
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Figure 2–84 Object Grid - Records

Selecting Data to Load into the Object Grid  

Data is selected from the currently selected hierarchy in the Object Browser. For 
example, if the products hierarchy is selected in the merchandising tab, then the 
selected list of products are loaded into the object grid.

Figure 2–85 Object Grid - Selecting Data

To select a list of products ensure the Refresh button on the Object Grid is selected.

Figure 2–86 Refresh Button
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Select an appropriate node from the hierarchy in the Object Browser, the appropriate 
list of information appears in the Object Grid. If there are more that the permitted 
number of entries a warning appears at the base of the Object Grid.

Selecting Objects  

You can select fixtures or planograms from the Object Grid.

■ Fixtures

To populate the Object Grid with Fixtures, from the Fixtures tab on the Object 
Browser, select a fixture group. The Object Grid populates with all fixtures that 
have been associated with that group.

■ Gondolas

Gondolas cannot be selected using the Object Grid.

■ Products

As most merchandising is done using planograms, the Object Grid populates with 
planograms even if a product is selected (down to sub-class level). That list of 
planograms is then displayed in the Object Grid.

■ Planograms

To populate the Object Grid with planograms, select a planogram group in the 
Object Browser. All planograms associated with that group are then displayed in 
the Object Grid.

Hiding and Changing Order of Columns  

Columns can be hidden by positioning the mouse cursor over the column you wish to 
hide, then right click to bring up the pop-up menu.

Figure 2–87 Object Grid - Columns

The same pop-up menu can be used to show all columns and copy data from the cell 
last clicked on by the mouse.

You can reorder the column position in the Grid by positioning the mouse cursor over 
the requited column heading, hold the left mouse key down and drag it to its new 
position. Release the mouse key in its new position.

Searching Data  

To search for data:

1. Select the Data Tab.
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Figure 2–88 Object Grid - Data Tab

2. Type a text string into the Find Text box. The Search String can include wild cards. 
The drop down list in the Find Edit Box displays the last 10 search criteria, 
allowing you to revert back to previous searches. You can use <Ctrl + X>, <Ctrl + 
C> and <Ctrl + V> to cut, copy and paste date between the Windows clipboard 
and the Find Edit Box.

3. Click the Find icon, the first matched item appears highlighted in the list of 
objects. Successive clicks on the Search icon brings up further matches. When the 
list of matches has been exhausted (or if there are no matches) then a warning 
message appears.

Figure 2–89 Find Warning Message

Sorting Data  

Data can be sorted in the Sort tab.
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Figure 2–90 Object Grid - Sort Tab

For Sorting to be enabled, the Use Sort checkbox must be enabled. If you sort the data 
in the data tab by clicking on a column header, this automatically clears the Use Sort 
checkbox. Select the required Field from the drop down list. The sequence fields that 
can be ordered are set by the drop down list.

Figure 2–91 Object Grid - Sort Data 

Settings can be removed by clicking the Clear button.

Filtering Data  

Data can be filtered from the Filter Tab.
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Figure 2–92 Object Grid - Filter Tab

For Filtering to be enabled the Use Filter checkbox must be selected. The Field to be 
filtered can be selected from a drop down list. The available fields include those from 
any columns that have been hidden.

The operator to be used for filtering is also selected from a drop down list. Operators 
include =, <>, <, <=, >, >=, IN, NOT IN, LIKE, NOT LIKE. A value can be typed into 
the Value text box. The Combination drop down list can be set to AND or OR.

AND means all the conditions specified have to be satisfied for a filtered object to be 
selected.

OR means that if either of the conditions specified met are specified, a filtered object is 
selected.

Working with Columns  

There are two actions that can be carried out with columns in the Object Grid; 
showing/hiding column and changing the column order. Columns can be hidden by 
positioning the mouse cursor over the column you wish to hide, then right clicking to 
bring up a pop-up menu.

Figure 2–93 Object Grid - Columns
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The same pop-up menu can be used to show all columns and to copy data from the 
cell last clicked on by the mouse. The column order can be changed by positioning the 
mouse cursor over the requited column heading, holding down the left mouse key and 
dragging it to its new position. Releasing the mouse key leaves it in its new position.

Adding an Object to the Drawing  

In the Planner Environment, objects can be added from the Object grid into the 
drawing in two ways:

■ Dragging and dropping

■ Add button in the Data Tab.

The Add button is enabled if an object is selected by clicking on it.

Figure 2–94 Object Grid - Add

Only a single object can be added to the drawing at one time.

In Merchandiser, objects can only be added by 'dragging and dropping' as the Add 
button is disabled in this environment. Only a single object can be added to the 
drawing at one time.

Technicalities
■ Operators

Operators are used to select or filter data. Valid operators that can be used 
depends on the type of data to be filtered.

Table 2–3 Operators

Compariso
n Means Boolean Numeric Text Date

= Equal to x x x x

<> Not equal to x x x x

< Less than x x x

<= Less than or 
equal to

x x x

> Greater than x x x
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In the case where the LIKE operator is used, it assumes wild cards (*Value*) unless 
you define them explicitly.

In the case where the IN operator is used, you need to separate the values using a 
space or the Operating System locale setting for the list separator.

The Operating System locale setting can be found by going to the Windows 
control panel and selecting the Regional and Language Option.

Figure 2–95 Regional and Language Options

Clicking on the Customize button in the Regional and Language Options dialog 
box brings up the Customize Regional Options dialog box. This shows the current 
setting for the List Separator.

Examples of Combinations  

>= Greater than 
or equal to

x x x

IN x x x x

NOT IN x x x x

LIKE x x

NOT LIKE x x

Table 2–3 (Cont.) Operators

Compariso
n Means Boolean Numeric Text Date
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The effect of multiple filters depends on whether AND or OR is selected.

■ Class = Tinned Goods AND Description = Beans will find all tinned goods with a 
description of 'beans'.

■ Class = Tinned Goods OR Description = Beans will find all tinned goods. It will 
also find any item with a description of 'beans'. (This could include dried beans in 
plastic packaging).

■ Use of AND will normally give a more specific result than OR.

Wild Card  

A wild card character can be used to substitute for any other character or characters in 
a search string.

■ The asterisk (*) substitutes as a wild card for any number of characters.

■ The question mark (?) substitutes as a wild card for any single character.

■ The hash mark (#) substitutes for any single number.

Example 2–1 Example of Wild Card

Beans 50g will find an exact match.
Beans* will find Beans 50g, Beans 100g, Beans - Special, Beans - barbecue, etc.
Be??? will find Beans and Beers.
Beans ##? will find Beans 50g, Beans 75g, etc.

Cut, Edit and Paste  

■ To cut data, highlight it and use <Ctrl + X>.

■ To copy data, highlight it and use <Ctrl + C>.

■ To paste previously selected data, position the cursor where you want the text to 
appear and use <Ctrl + V>.

Colored Rows  

The data is selected from the database by custom SQL. If the custom SQL includes a 
column named RGB, then the row is colored using the value in the column. This 
allows certain rows to be highlighted, which could be used to indicate high 
performing products or planograms, or simply indicate which products have already 
been placed.
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3Planner

The Planner Module is primarily used for the layout of zones, fixtures, and fittings 
within a store. It can do this with extreme accuracy. It can also be used to merchandise 
a store, but will show less detail than the same store if viewed in Merchandiser.

Starting with an architectural drawing, zones, fixtures and gondolas can be placed. 
The fixtures and gondolas can be merchandised with placeholders or planograms. 
Reports can be generated on the store.

This section contains following topics:

■ AutoCAD Menu Options

■ Zones

■ Fixturing

■ Merchandising

■ Calculations

■ Synchronization

AutoCAD Menu Options

File Menu
The File menu allows you to access to a number of general options.

Note: The screen captures in this section are taken using AutoCAD 
2008/2009. If you are using any other version of AutoCAD, the view 
may be different. 
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Figure 3–1 Planner - File menu

Table 3–1 Planner - File Menu

Functionality Source Comment

Open Macro Space 
Management

Opens Store Manager

Close Macro Space 
Management

Closes the current 
drawing

Save Macro Space 
Management

Saves the current 
drawing

eTransmit AutoCAD See AutoCAD Help 
File for further 
information.

Export AutoCAD See AutoCAD Help 
File for further 
information.

Publish AutoCAD See AutoCAD Help 
File for further 
information.

Plot AutoCAD See AutoCAD Help 
File for further 
information.

Options AutoCAD See AutoCAD Help 
File for further 
information.

Configuration Macro Space 
Management

Opens the 
Configuration 
Module
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Edit Menu
The Edit menu gives you access to the AutoCAD functionality.

Figure 3–2 Planner - Edit menu

Synchronize Macro Space 
Management

Opens the 
Synchronization 
Module

Refresh Browser Macro Space 
Management

Refreshed the Object 
Browser with the 
latest information 
from the database

Drawing Utilities AutoCAD Calls varying 
AutoCAD utilities - 
see AutoCAD Help 
File for further 
information.

Send AutoCAD See AutoCAD Help 
File for further 
information.

Drawing Properties AutoCAD See AutoCAD Help 
File for further 
information.

Exit Macro Space 
Management

Exits the Module

Table 3–1 (Cont.) Planner - File Menu

Functionality Source Comment
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Table 3–2 Planner - Edit Menu

Functionality Source Comment

Undo Macro Space 
Management

Allows the last 
command(s) to be 
undone. (The exact 
text will vary 
depending on what 
the last executed 
command was).

Redo Macro Space 
Management

Allows the last 
command(s) to be 
undone. (The exact 
text will vary 
depending on what 
the last executed 
command was).

Cut AutoCAD See AutoCAD Help 
File for further 
information.

Copy AutoCAD See AutoCAD Help 
File for further 
information.

Copy with Base Point AutoCAD See AutoCAD Help 
File for further 
information.

Copy Link AutoCAD See AutoCAD Help 
File for further 
information.

Paste AutoCAD See AutoCAD Help 
File for further 
information.

Paste as Block AutoCAD See AutoCAD Help 
File for further 
information.

Paste as Hyperlink AutoCAD See AutoCAD Help 
File for further 
information.

Paste to Original 
Coordinates

AutoCAD See AutoCAD Help 
File for further 
information.

Paste Special AutoCAD See AutoCAD Help 
File for further 
information.

Clear AutoCAD See AutoCAD Help 
File for further 
information.

Select All AutoCAD See AutoCAD Help 
File for further 
information.

OLE Links AutoCAD See AutoCAD Help 
File for further 
information.
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View Menu
The View menu provides the following options:

Figure 3–3 Planner - View Menu

Find AutoCAD See AutoCAD Help 
File for further 
information.

Table 3–3 Planner - View Menu

Functionality Source Comment

Redraw AutoCAD See AutoCAD Help 
File for further 
information.

Regen AutoCAD See AutoCAD Help 
File for further 
information.

Regen All AutoCAD See AutoCAD Help 
File for further 
information.

Table 3–2 (Cont.) Planner - Edit Menu

Functionality Source Comment
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Display 2D Macro Space 
Management

Displays the drawing 
in Macro Space 
Management 2D 
Mode. (The blocks 
must have been 
configured 
accordingly).

Display 3D Macro Space 
Management

Displays the drawing 
in Macro Space 
Management 3D 
Mode. (The blocks 
must have been 
configured 
accordingly).

Zoom AutoCAD See AutoCAD Help 
File for further 
information.

Pan AutoCAD See AutoCAD Help 
File for further 
information.

Orbit AutoCAD See AutoCAD Help 
File for further 
information.

Walk and Fly AutoCAD See AutoCAD Help 
File for further 
information.

Aerial view AutoCAD See AutoCAD Help 
File for further 
information.

Rotate View AutoCAD See AutoCAD Help 
File for further 
information.

Viewports AutoCAD See AutoCAD Help 
File for further 
information.

3D views AutoCAD See AutoCAD Help 
File for further 
information.

Visual Styles AutoCAD See AutoCAD Help 
File for further 
information.

Toolbars AutoCAD See AutoCAD Help 
File for further 
information.

color Products Macro Space 
Management

Allows products be 
to colored according 
to their general type.

Reports Macro Space 
Management

Allows simple 
reports to be 
produced on objects 
within the current 
drawing.

Table 3–3 (Cont.) Planner - View Menu

Functionality Source Comment
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Insert Menu
The Insert menu provides ways to attach further information to the store plan.

Figure 3–4 Planner - Insert Menu

Drawing Comparison Macro Space 
Management

Allows one drawing 
to be compared with 
another.

Show (Hide) Object 
Browser

Macro Space 
Management

Will show or hide the 
Object Browser.

Show (Hide) Object 
Grid

Macro Space 
Management

Will show or hide the 
Object Grid.

Table 3–4 The Insert Menu

Functionality Source Comment

Block AutoCAD See AutoCAD Help 
File for further 
information.

External References AutoCAD See AutoCAD Help 
File for further 
information.

DWF Underlay AutoCAD See AutoCAD Help 
File for further 
information.

Table 3–3 (Cont.) Planner - View Menu

Functionality Source Comment
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Format Menu
The Format menu allows you to control the layers, dimensions and units associated 
with the drawing.

Figure 3–5 Planner - Format Menu

Add Architectural 
Plan

Macro Space 
Management

X-Refs an 
architectural plan to 
the currently active 
drawing

Add Title Block AutoCAD See AutoCAD Help 
File for further 
information.

Update Title Block AutoCAD See AutoCAD Help 
File for further 
information.

Bay Numbering Macro Space 
Management

Add numbering to 
the fixtures in the 
store plan

Table 3–4 (Cont.) The Insert Menu

Functionality Source Comment
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Modify Menu
The Modify menu allows you to modify objects in the store plan.

Table 3–5 Planner - Format Menu

Functionality Source Comment

Layer Aliases Macro Space 
Management & 
AutoCAD

Calls a mixture of 
Macro Space 
Management and 
AutoCAD 
functionality.

Layer AutoCAD See AutoCAD Help 
File for further 
information.

Layer States Manager AutoCAD See AutoCAD Help 
File for further 
information.

Layer Tools AutoCAD See AutoCAD Help 
File for further 
information.

Dimension Style AutoCAD See AutoCAD Help 
File for further 
information.

Units AutoCAD See AutoCAD Help 
File for further 
information.

Drawing Set Up Macro Space 
Management

Allow the user to 
select the scales for 
Paper space.
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Figure 3–6 Planner - Modify Menu

Table 3–6 Planner - Modify Menu

Functionality Source Comment

Properties AutoCAD See AutoCAD Help 
File for further 
information.

Match Properties AutoCAD See AutoCAD Help 
File for further 
information.

Change to ByLayer AutoCAD See AutoCAD Help 
File for further 
information.

Object AutoCAD See AutoCAD Help 
File for further 
information.

Clip AutoCAD See AutoCAD Help 
File for further 
information.

Erase AutoCAD See AutoCAD Help 
File for further 
information.

Copy AutoCAD See AutoCAD Help 
File for further 
information.

Array AutoCAD See AutoCAD Help 
File for further 
information.
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Calculations Menu
The Calculations menu enables you to initiate various calculations that enter data into 
the central Macro Space Management database.

Figure 3–7 Planner - Calculations Menu

Express Menu
The Express menu provides quick access to commonly used AutoCAD functionality.

Move AutoCAD See AutoCAD Help 
File for further 
information.

Rotate AutoCAD See AutoCAD Help 
File for further 
information.

Blocks Macro Space 
Management & 
AutoCAD

Calls a mixture of 
Macro Space 
Management and 
AutoCAD 
functionality.

Attributes Macro Space 
Management

Allow the user to 
select the scales for 
Paper space.

Text Macro Space 
Management & 
AutoCAD

Calls a mixture of 
Macro Space 
Management and 
AutoCAD 
functionality.

Table 3–6 (Cont.) Planner - Modify Menu

Functionality Source Comment
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Figure 3–8 Planner - Express Menu

Help Menu
The Help menu contains a number of options that access Help and Assistance.

Table 3–7 Planner - Help Menu

Functionality Source Comment

AutoCAD Help AutoCAD See AutoCAD Help 
File for further 
information.

New Features 
Workshop

AutoCAD Not yet available

Planner Help Macro Space 
Management

Calls Macro Space 
Management's Help 
File for this module.

Additional Resources AutoCAD See AutoCAD Help 
File for further 
information.

Customer 
Involvement 
Program

AutoCAD See AutoCAD Help 
File for further 
information.

About AutoCAD Gives the AutoCAD 
version.

About Planner Macro Space 
Management

Gives the Planner 
version
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Store Manager
Oracle Retail Macro Space Management application combines the traditional 
merchandising approach with store planning, construction, operation, and inventory 
management. It is designed to maximize profitability and returns by enabling the 
optimum layout and mix of products to be efficiently planned right across an 
organization's range of retail outlets.

Macro Space Management contains large amounts of information. This can be as 
specific as the current contents of a shelf in a single store or as general as the floor 
plans to be implemented business wide within a specified time period. This mass of 
information has to be organized and administered. Within Macro Space Management 
this is achieved by the Store Manager module.

Store Manager operates in a similar way to Windows Explorer. It has been designed to 
be easy to use and allows information to be grouped in a way that reflects the 
structure of the organizations.

Using Store Manager you can:

■ Assign your retail outlets to logical groupings, allowing comparisons and analysis 
of sales to be made between individual stores or groups of stores.

■ Assign or change floor plans for stores, allowing the effects of differing store 
layouts or merchandising mixes to be evaluated.

■ Carry out routine administration on the files used within Macro Space 
Management.

■ Get reports on the data used within Macro Space Management.

■ Interface with external programs allowing import and export of data to and from 
those programs.

Zones

Business Flow for Zones
A Zone defines a section of floor used for a specific and clearly defined purpose, based 
on the floor layout specified by an architectural drawing. The Zone might define an 
area used for sales or storing stock, or it might define areas used for non-sales 
purposes such as offices, corridors or toilets. The starting point is a layout specified by 
a cross-referenced architectural drawing. This sets out the boundaries defined by 
external and internal walls.

From a technical standpoint, a Zone is a Macro Space Management Block that allows 
additional information to be put into an AutoCAD architectural drawing. This 
subsequently allows more structured Macro Space Management reports to be 
produced on the associated layout of fixtures, fittings, and Planograms within that 
drawing.

Note: In-Store Space Collaboration, a web-based module of Macro 
Space Management, can be used to access and edit drawings held in 
the central Macro Space Management database.
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Figure 3–9 Business Flow - Zones

A Zone is defined by an AutoCAD Polyline enclosing a specific section of floor. 
Further Polylines within the Zone can be used to define pillars or other obstructions. 
The designation of pillars and other obstacles allows taking these pillars and other 
obstacles into account when calculating sales areas. This results in a more accurate 
calculation of the area of usable floor, enabling sales performance analysis to take into 
account the effect of obstructions.

The Zone is used to assign a specified part of the total floor area to a specific function. 
Such functions include allocating to specific types of retail goods, (for example 
electrical goods), or designating the area as a non-sales area; for example a manager's 
office or a corridor. Zones thus allow the total floor area in the store to be split into 
sales and non-sales areas and then further sub-divided as to purpose. This 
sub-division of the store allows Planograms and fixtures to be filtered by Zone, 
allowing the store planner to rapidly establish which goods and which fixtures are in a 
specific part of the store.

Zones can also be designated as being excluded from certain types of reports. This 
allows fixtures and Planograms that have been placed in a storage area to be excluded 
from any calculations or reports on the performance of that part of the store. Many of 
the characteristics of Zones can be configured within the Administration Module.
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Basic Concepts of Zones

Hierarchical Tree
A Hierarchical Tree is one where objects are organized in the form of a tree. This 
allows objects to be set out in a logical relationship to each other. The more 
fundamental data is close to the trunk, while the more dependent data is further out 
on the branches. The most fundamental part of the hierarchical structure is the Store 
Root.

Figure 3–10 Hierarchical tree

Hierarchies can be defined to any level of detail. For example, the Sales Floor Space 
zone can be divided into a number of broad classes, such as Hardware, Food and 
Drink, and Concession Area.

The Food and Drink area can further be divided into a variety of departments (zones) 
like Frozen Foods, Bakery, Dairy, and Meat and Fish.

Internal Area
The basis for any store plan is generally an architectural drawing. This is normally 
cross referenced (xrefed) to another AutoCAD drawing to act as a blueprint for the 
arrangement of zones, fixtures, fittings, and merchandise.

The first zone to be drawn is often the Internal Area Zone. This defines the maximum 
area available for sales activities. The Internal Area can include both Sales and 
Non-Sales areas.

It is also possible to draw both sales and non-sales Zones outside of the internal area. 
Any Zones outside the Internal Area will not be included in any Area Calculations.

Net Area - Zones  

Net Area is the area remaining in a Zone after Holes have been taken into account.

Gross Area - Zones  
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The Gross Area of a Zone is the total area of a Zone before any Holes or other 
non-usable areas have been taken into account.

Holes, (Cut Holes)
A Hole is an area cut into a Zone to represent a pillar or similar obstruction. The hole 
floor area is not allocated to a zone for the purpose of merchandising. For example an 
area allocated to the sale of Men's Clothing might have a pillar and a stairwell in it. 
This area is reduced for the calculation of actual area available for retailing and is 
taken into account when reviewing the performance of the zone.

The area is subtracted from the Gross Area of the Zone to give the Net Area. To allow 
for these obstructions, the zone can be modified by cutting holes in it - each hole 
representing an area that cannot be used for the intended purpose of the zone.

Layers
Planner drawings are often divided into layers. Each layer contains a specific type of 
information. For example one layer might contain information on fixtures, another 
data on electrical wiring.

Layers can be further sub-divided into aliases. Each aliased layer contains very specific 
information. For example, one aliased layer may contain details of all the fixtures 
capable of holding chilled goods; another all fixtures holding fruit and vegetables.

Layers are one of the methods used by Macro Space Management to filter fixtures, 
planograms, etc.

OSNAP AutoCAD Command
The OSNAP (Object Snap) AutoCAD command has significant effect on the way 
Zones are drawn. OSNAP can be turned on and off by clicking on the button at the 
bottom of the AutoCAD window.

If OSNAP is On, then when Zones are drawn, the lines snap to pre-specified points in 
any existing objects. Depending on AutoCAD setting, a series of small boxes appears 
as the mouse is moved about. These represent the points to which lines can be 
snapped.

Lines can only be drawn to these points.

If OSNAP is Off, then Zones can be drawn to any desired shape within the drawing.

Zone Type
A Zone Type is the broad class a zone falls into. Zone Types are user defined and can 
include:

■ Internal Areas

■ Departments

■ Non-Sales areas

Each Zone Type is drawn onto its own AutoCAD layer - only Zones on the same layer 
can be detected as clashing or overlapping.

Zone Definition
After defining the Zone Types (broad classes of Zones), individual types of Zones can 
be defined.

Examples of Department (Sales Zones) Definitions may include:
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■ Chilled Goods

■ Furniture

■ Ladies clothing

Examples of Non-Sales Zone Definitions might include:

■ Corridors

■ Offices

■ Toilets

In addition to the name and zone type, Zone Definitions can include the type of 
hatching used in the drawing, the color of the hatching and a user defined code.

Zone Toolbars and Display Windows on the Object Browser
Click the Zones tab on the Object Browser to display the Zones tab that has options for 
adding, editing, and deleting Zones.

Figure 3–11 Zones tab on the Object Browser

The Zones Toolbar
The Zones Toolbar is found on the Object Browser.

Figure 3–12 Zones Toolbar

It contains a series of icons allowing various operations to be carried out on Zones.
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The Zones Hierarchy Window
The Zones Hierarchy Window is found immediately below the toolbar.

Figure 3–13 Zones Hierarchy Window

It contains a hierarchical tree giving a list of all the available Zone types.

The Properties Window
The Properties Window gives details of the Zone Definition that has been selected in 
the hierarchy.

Figure 3–14 Properties Window

The Summary Window
The Summary Window shows a user defined list of fixtures placed in the drawing.

Figure 3–15 Summary Window

Click on a column heading to re-order that column. To reverse the sort order, click 
again.

The Summary window can be minimized by clicking the splitter bar.

Note: Zone types and descriptions can be added, edited or deleted 
using the Administration Module.
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Zone Operations

Adding Zones/Boundaries  

Adding zones is a simple process, initiated from the Object Browser.

To add zones:

1. Select the Zones tab on the Object Browser.

2. Select the required Zone Description from the Zones Hierarchy Window.

3. Select the Add Zone option from the toolbar.

4. Draw the required Zone shape and complete the drawing by using the 'close' 
command.

Selecting the Zone Description  

The Zone Description is selected from the Zones hierarchical tree window.

Figure 3–16 Zones hierarchical tree window

The tree can be expanded or contacted by clicking the + or - signs. Alternatively right 
click with the mouse to bring up a menu of options.

This can be used to expand or collapse the hierarchical tree. The required Zone can 
then be selected by left clicking it to highlight the zone. Details of the Zone appear in 
the Properties window.

Figure 3–17 Properties window

This enables the Zone Description to be confirmed as correct.
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Initiating Drawing a Zone
When the Zone description has been selected, the process of drawing the Zone is 
initiated by selecting the Add Zone option.

To draw a zone:

1. Select the Add Zone icon can be clicked in the tool bar to initiate drawing the 
Zone.

Alternatively, you can right click in the Zone Descriptions window to bring up 
menu options.

2. Select Add Zone Definition to initiate drawing the zone.

Drawing the Zone
After you have selected the Add Zone Boundary option, the cursor is active and ready 
to start specifying the Zone Boundaries.

Drawing a Simple Rectangle  

To draw a simple rectangle position the cursor at the required start point and left click 
to fix it. Draw the cursor to the diagonally opposite corner of the required rectangle 
and left click to fix it. Press <Escape>. A rectangle of the required dimension is 
immediately drawn.

Drawing Zones with OSNAP On  

When OSNAP is on, a series of symbols appear as the cursor moves about. These show 
the available points that can be selected. Click on successive points to draw the outline 
of the Zone.

Drawing Zones with OSNAP Off  

With OSNAP is off, Polylines can be drawn to any point of the drawing. Draw the 
required points, left clicking to fix each in turn. Entering 'Close' in the command line 

Note: The way the Zone is drawn depends on whether OSNAP 
(Object Snap) has been selected or not. If selected, Lines can only be 
drawn to specified points. If OSNAP is off, then lines may be drawn to 
any location on the drawing. OSNAP AutoCAD Command

Entering 'Close' in the command line completes the Zone drawing 
process by turning the currently drawn line into a Polyline enclosing 
the Zone.

Note: With OSNAP on, the Polylines can only be drawn to a limited 
number of specified points. To draw to a wider selection of points, 
turn OSNAP off.
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completes the Zone drawing process by turning the currently drawn line into a 
Polyline enclosing the Zone.

Editing Zones  

Zones can be edited in two ways:

■ Zone Types and Zone Definitions can be modified using the Administration 
Module. (This option is only available to those with Administrator's privileges).

■ The physical dimensions of a zone can be altered using AutoCAD tools.

Editing Zones with AutoCAD Tools
Zone shapes and dimensions can be changed using AutoCAD tools that are available 
by clicking on the zone boundary to highlight it, and then right click to bring up a 
menu of edit options.

Figure 3–18 Zones - edit menu

Zones can have vertexes added and deleted, segments bent and straightened and 
segments added. See the AutoCAD help File for further information.

Editing Zones with AutoCAD
Editing a Zone in AutoCAD can be done by using the AutoCAD grip points.

1. Click on the required Zone to get the grip points to show.
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2. Click on the required grip point and move it to the desired new location.

3. Left click to set the new location for the grip point and <Escape> to complete the 
AutoCAD editing process.

4. The Zone is now fixed in its new shape.

Zone Notation
If the shape of a Zone is substantially changed, the position of the notation remains in 
the original position. This should be selected using AutoCAD tools then dragged to a 
new and more appropriate position.

Cutting Holes
You can cut holes in the zones from the Object Browser.

To cut holes:

1. Select the Zones tab on the Object Browser.

2. Highlight the required Zone in the Zones Hierarchy.

3. Select the Cut Holes icon, and draw the shape of the hole.

4. Enter 'Close' in the command line to complete the hole drawing process by turning 
the currently drawn line into a Polyline enclosing the hole.

Selecting the Zone to Cut a Hole

If the name of the zone is known, the appropriate Zone Description can be selected 
from the Zones Hierarchical Tree window.

Figure 3–19 Zones Hierarchical Tree window

Alternatively, the Highlight zone in tree command can be used to select the 
appropriate Zone description in the Zones Hierarchy.

Note: Holes can only be cut in the Zone currently highlighted in the 
Zone Hierarchy
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Figure 3–20 Zones - Highlight zone

Figure 3–21 Validation message

Initiating Drawing the Hole
When you have selected the Zone description, initiate the process of drawing the Hole 
by selecting the Add Hole Option. This can be done by clicking on the tool bar to 
initiate drawing the Hole.

Figure 3–22 Add Hole Option

Defining the Hole
After you have selected the Cut Hole option, the cursor is active and ready to start 
specifying the Hole Boundaries.

Note: If the Zone Definition is not correctly selected before a hole is 
cut, the error message depicted will result.
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Drawing a Simple Rectangle  

To draw a simple rectangle position the cursor at the required start point and left click 
to fix it. Draw the cursor to the diagonally opposite corner of the required rectangle 
and left click to fix it. Press <Escape>. A rectangle of the required dimension is drawn.

Drawing Holes with OSNAP On  

When OSNAP is on a series of symbols appear as the cursor moves about. These show 
the available points that can be selected. Click on successive points to draw the outline 
of the hole.

Drawing Holes with OSNAP Off  

With OSNAP off, Polylines can be drawn to any point of the drawing. Draw the 
required points, left clicking to fix each in turn. Entering 'Close' in the command line 
completes the hole drawing process by turning the currently drawn line into a 
Polyline enclosing the hole.

Deleting Zones and Holes using MSM tools
You can delete zones from the drawing using either of the two options:

■ Delete all zones of that description

■ Delete a specific zone or hole

Delete all Zones of that Description  

To delete all examples of a specific Zone Description, first select the required zone in 
the hierarchical tree. Click on the Delete Zone icon in the toolbar to delete the Zone.

Note: The way the hole is drawn depend on whether OSNAP (Object 
Snap) has been selected or not. If selected, Lines can only be drawn to 
specified points. If OSNAP is off, then lines may be drawn to any 
location on the drawing. OSNAP AutoCAD Command

Entering 'Close' in the command line completes the hole drawing 
process by turning the currently drawn line into a Polyline enclosing 
the hole.

Note: With OSNAP on, the Polylines can only be drawn to a limited 
number of specified points. To draw to a wider selection of points, 
turn OSNAP off.
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Figure 3–23 Delete Zone icon

Delete a Specific Zone or Hole  

To delete a specific zone or hole, click on the Delete Boundary/Hole option on the 
toolbar.

Figure 3–24 Delete Boundary/Hole option

Click on a zone or Hole in the drawing to delete that zone or hole.

Deleting Zones using AutoCAD
You can delete Zones using the AutoCAD Erase tool. However, it is recommended 
users delete Zones using the Macro Space Management Delete Zone option as this is a 
simpler and more effective way of achieving deletion. To erase a Zone using 
AutoCAD tools select the zone so that the markers show.

Right click to bring up the menu and click on the Erase icon.

This removes the Zone from the drawing. The Zone is not removed from the Macro 
Space Management database until the Synchronize tool has been used. For more 
information, refer the chapter Synchronization.

Note: If there are multiple Zones of this type in the drawing, all 
Zones of this type are deleted.

If you need to identify the Zone type to be deleted, use the highlight 
Zone in Tree option. Highlight Zone in Tree
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Editing Holes
Hole shapes and dimensions can be changed using AutoCAD tools. A range of these is 
available by selecting the required hole, then right clicking. This will bring up a menu 
with a number of edit options.

Figure 3–25 Holes - Edit Menu Options

Holes can have vertices added and deleted, segments bent and straightened and 
segments added. 

One way of Editing Holes is by using the AutoCAD grip points.

1. Click the required Hole to get the grip points to show.

2. Click the required grip point and move it to the desired new location.

3. Left click to set the new location for the grip point and <Escape> to complete the 
AutoCAD editing process.

4. The Hole should now be fixed in its new shape.

Highlight Zone in Drawing
The Highlight Zone in drawing icon allows the location of a zone to be identified in 
the drawing.
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Figure 3–26 Highlight Zone

This operation can be toggled on and off by clicking the icon. When toggled on the 
icon appears pressed down.

When active, left clicking any Zone in the hierarchical tree causes that zone to display 
in the drawing.

Highlight Zone in Tree
The Highlight Zone in tree option allows you to highlight the zone boundary in the 
drawing.

Figure 3–27 Highlight Zone in tree

Find In Tree
Find in Tree allows you to search for Zone Names in the Zone Hierarchy.

Note: Only Zones currently in the drawing can be displayed. 
Selecting a zone which has not been placed has no effect. The precise 
way the zone highlights is determined by the setting in the Zones tab 
of the Configuration module.
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Figure 3–28 Zones - Find

Click the icon to bring up the Find Zone dialog box.

Figure 3–29 Find Zone dialog box

To use the dialog box:

1. Type a text string in the Find text box.

2. Click on the search icon. Zone names matching the search string are listed.

3. To select a zone in the hierarchy, highlight it and click the OK button.

Detect Clashes
The Detect Clashes option can be accessed from the Zones toolbar.

Figure 3–30 Detect Clashes option
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If this option is selected, then any Zones of the same type with overlapping 
boundaries are highlighted. Zones of the same type that share a common boundary 
are not highlighted.

Configuration Options
The Merchandising tab in the Configuration Module can be called by clicking on the 
Configuration icon on the Merchandising toolbar.

Figure 3–31 Merchandising toolbar

This brings up the Merchandising tab from the Configuration Module.

Figure 3–32 Configuration Module

Refresh
The Refresh option causes the hierarchical tree in the Zones window to be updated 
with any Zone Definitions that have been added or edited since the Planner module 
was opened for the current session. (This is useful if work is being carried out in 
parallel in the Administration module).

Note: Zones of different type are drawn on different AutoCAD 
layers. Zones on different layers that overlap will not be shown as 
clashing.
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Figure 3–33 Zones - Refresh

Hatching
Hatching can be added to or removed from zones using the appropriate option.

Figure 3–34 Zones - Hatchingl

In the example below the top zone is hatched, the bottom one is not.

Prototype Stores
If a Prototype Store has been assigned to the current store in store manager, 
comparisons can be made between the areas of the zones in the prototype store and 
the current store.
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In the above example, it can be seen that (for example) the Automotive, Books and 
Boys' Wear zones exist in both stores, but that the Commercial Bread and Domestic 
Goods zones do not yet exist in the current store.

It is also possible to compare the areas of the respective zones in the Prototype and 
current stores, and make adjustments if necessary.

Zones and Products
When using the Object Browser, it is possible to filter products by zone. This enables 
the user to select products from (for example) Floral products.

Selecting Active Zones
The Express Load option in the Merchandiser tab in the Configuration Module enables 
to load the active zones.

Figure 3–35 Express Load

This option is not active in the AutoCAD environment and only applies to 
Merchandiser.

Configuring System Variables
Some of the variables affecting how Macro Space Management operates can be 
customized. Within Macro Space Management these can be changed via the 
Administration Module.
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Fixturing

Planner Module and the Business Life Cycle
The Planner module is part of the Business Life Cycle.

Store Manager Activities start the business cycle

The Store Manager enables you to add, edit, or delete stores, floors, and revisions. 
Revisions contain store plans. These are often associated with architectural plans so 
that fixtures and gondolas can be placed relative to the walls of the store. Store 
Manager can be accessed from both Planner and Merchandiser.

Note: Changing these System Variables can have a significant effect 
on how Macro Space Management operates. It is recommended that 
any changes are made only after consulting the Oracle technical 
support team.
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Store Planning involves the placement of zones, fixtures and merchandise. Zones can 
only be placed in Planner, although they can be seen in Merchandiser.

Fixtures and merchandise can be placed in both Planner and Merchandiser. It is 
normally more convenient to carry out fixturing operations in Planner and 
merchandising operations in Merchandiser).

After the floor plan has been designed, each fixture can be subsequently populated by 
a predetermined quantity and arrangement of sales products using the Planogram 
Selection and Add Product modules. After the floor has been merchandised, Macro 
Space Management can be used to analyze and report on the effectiveness of the 
layout.

Using the Fixtures module, you can:

■ Place single or multiple fixtures, fittings and gondolas.

■ Move or rotate fixtures, fittings and gondolas.

■ Erase fixtures, fittings and gondolas.

■ Number bays in fixtures and gondolas.

■ Calculate effective sales areas.

■ Collate information on fixtures and fittings.

Result Management involves checking the completed store layout by means of Reports 
and Key Performance Indicators before releasing the layout to stores for 
implementation or starting on the next phase of planning.

About Fixture Studio
Fixture Studio is a stand alone module where fixtures and gondolas can be added, 
edited, and deleted. These fixtures and gondolas can be used in the Planner and 
Merchandiser environments. Fixture Studio can be opened from the Object Browser in 
the Planner module by clicking the Edit icon on the Fixturing toolbar.

Figure 3–36 Edit Gondola option

Fixture Studio allows the properties of fixtures and gondolas to be specified. It also 
allows the hierarchical tree in which they are organized to be modified.

Note: The Edit Fixture icon is activated only when working with 
fixtures and Edit Gondola icon when working with gondolas.
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Figure 3–37 Fixture Studio

About Merchandiser
The Merchandiser module is a virtual reality environment that can be used in 
conjunction with the Computer Aided Design (CAD) environment of the Planner 
module.
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Figure 3–38 Merchandiser module

The Merchandiser module is used to design planograms and floor layouts wherein 
fixtures, fittings and gondolas are placed and viewed in the 3D virtual reality (VR) 
environment. It is not as precise as the Planner environment, but gives a more visual 
representation of the store plan. The Merchandiser module also enables you to 
populate the fixtures and gondolas shelves, products and planograms in the 3D virtual 
reality (VR) environment.

Basic Concepts

Bays
Fixtures and gondolas can be allocated bay (or gondola) numbers to simplify 
identifying locations. A fixture is assigned a single bay number, where as gondolas, 
which comprise a number of fixtures, may have multiple bay numbers associated with 
them.

Note: Shelves can only be placed in the Merchandiser environment, 
although they can be seen in the Planner environment after 
Synchronization.

Products can only be placed at display style level in Merchandiser. 
Such products are not visible in Planner.
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Connection points
The Connection Point for a fixture or fitting is a representation of the physical 
connections that can be used to join one unit to another. They are typically on the left 
and right sides of a fixture, or on the back.

Clicking on the insertion point during addition of fixtures or fittings automatically 
aligns the fixture or fitting to be placed with the connection point.

Fixtures, Fittings, and Shelves
Fittings are items within a store that aid the retail effort, but do not themselves hold 
merchandise. For example, display material and checkout counters. Some fittings are 
used to support or augment fixtures. For example a shelving unit could be made up of 
support legs and shelves. Fittings always remain separate items on the drawing.

A fixture is a structure designed to hold merchandise for sale. It can take many forms 
including runs of shelving, display cabinets, and kiosks. A fixture can hold product 
directly, or via shelves. A shelf always has a parent fixture.

A shelf is equipment within a fixture which can hold products. For example, a 
backboard might hold several support bars. The support bars could in turn have rods 
attached. Product could then be hung from those rods. The arrangement of rods 
emanating from a single support bar is generically called a shelf for planning 
purposes. Each shelf or fixture always has a product block associated with it. This 
serves as a placeholder for any merchandise placed on it.

Fixtures and fittings are often color coded on purpose. For example, fixtures holding 
groceries might be drawn in green, fixtures holding chilled goods in blue.

Gondolas
A Gondola is an arrangement of two or more fixtures linked together by means of 
connection points or in sufficiently close proximity to meet the definition of adjacency. 
For example, a run of 10 fixtures placed back to back, with end caps on each end to 
maximize the area devoted to sales.

Gondolas are internally sub-divided into sections, each new section beginning where 
fixtures go through more than a 30o change of angle when connected. Gondolas are 
often color coded on purpose. For example, gondolas holding groceries might be 
drawn in green, fixtures holding chilled goods in blue. Note that single fixtures are 
numbered as gondolas if the gondola numbering option is used.

Hierarchical Tree
A Hierarchical tree is the structure of objects organized in the form of a tree. This 
allows objects to be set out in a logical relationship to each other. The more 
fundamental data is close to the trunk, while the more dependent data is further out 
on the branches. The most fundamental part of the hierarchical structure is the Store 
Root.

Insertion Points
The Insertion point is the point where a fixture, fitting, or gondola is located on the 
drawing. It can be designated anywhere within the fixture during the drawing stage 
and appears as a small blue square. Insertion points can be revealed by left clicking on 
any line within the drawing of the fixture, fitting, or gondola.
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Synchronization
When fixtures, fittings, and gondolas are placed on the drawing, they are also sent as 
data to the Macro Space Management central database. If fixtures in the drawing are 
modified with AutoCAD tools, this changes the drawing, but not the central database.

Synchronization is the process of synching the AutoCAD drawing and the Macro 
Space Management Central database information.

Figure 3–39 Synchronization Flowchart

After the drawing has been synchronized with the central database, the Adjacency 
calculations can be run.

Fixture Adjacency calculations establish the physical relationship of one fixture to 
another. These relationships are used for both bay numbering and as the basis for 
subsequent Product Adjacency calculations. Product Adjacency calculations establish 
the relationship of one type of product to another. They cannot be run until the Fixture 
Adjacencies have been calculated.

Accessing the Configuration Options
The Configuration Options can be accessed by clicking the Properties icon on the 
Fixturing toolbar.
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Figure 3–40 Configuration Options

This brings up the Fixturing tab from the Configuration Module.

Figure 3–41 Configuration Module

Fixture Module Toolbars and Windows
The Fixturing tab on the Object Browser allows you to add fixtures, fittings, gondolas, 
and other equipments to the store plan. Fixtures and fittings can be placed one at a 
time if required. Fixtures, fittings, and other equipments that are placed one at a time 
are known as blocks.

Click the Fixturing tab on the Object Browser to bring up a series of options for 
adding, editing, and deleting fixtures and gondolas.

Fixturing tab on the Object Browser provides:

■ Toolbar access to a series of options concerning fixtures.

■ Buttons to toggle between Fixtures (Blocks) and Gondolas.

■ Hierarchy Window to select fixtures (or gondolas) from the list available.

■ Properties Window shows the properties assigned to the selected fixture.

■ Summary Window shows the number of instances of the selected fixture placed in 
the drawing.

■ Preview Window shows a preview of the selected Fixture
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The Fixturing Toolbar
The Fixturing toolbar is found on the Object Browser. It is selected by clicking Blocks 
in the Fixturing window.

Figure 3–42 Fixturing toolbar

It contains a series of icons allowing various operations to be carried out on fixtures. 
Some of the icons may not be available for use.

The Gondolas Toolbar
The Gondolas toolbar is found on the Object Browser. It is selected by clicking 
Gondolas in the Fixturing window.

Figure 3–43 Gondolas toolbar

It contains a series of icons allowing various operations to be carried out on fixtures. 
Some of the icons may not be available for use.

The Fixtures Hierarchy Window
The Fixtures Hierarchies window shows a hierarchical tree of all the available fixtures 
or gondolas.

Figure 3–44 Fixtures Hierarchies window
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The tree can be expanded or contracted by clicking on the + or - icons. The Fixturing 
window can be minimized by clicking on the splitter bar.

The Blocks or Gondolas buttons immediately above the window determines whether 
the hierarchical tree shows fixtures or gondolas. The hierarchical tree can be 
configured in Fixture Studio using the Add Group, Edit Group, and Delete Group 
icons on the toolbar.

The Properties Window
The Properties window shows the properties for the currently selected fixture.

Figure 3–45 Properties window

The Properties window can be minimized by clicking on the splitter bar.

The Summary Window
The Summary Window shows a user-defined list of products or planograms placed in 
the drawing.

Select a column heading to re-order the column. Click again to reverse the sort order. 
The Summary window can be minimized by clicking on the splitter bar.

The Preview Window
The Preview window shows a low resolution image of the fixture selected in the 
hierarchical tree.
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Figure 3–46 Preview window

The window can be resized in the horizontal plane by dragging the edge of the Object 
Browser with the mouse. It can be resized in the vertical plane by dragging the bottom 
of the window with the mouse. The Preview window can be minimized by clicking on 
the splitter bar.

The image can be rotated by positioning the mouse pointer in the screen and holding 
down the left mouse key. The position of the mouse cursor determines the direction of 
rotation, while the distance of the mouse cursor from the object determines the speed 
of rotation.

The image can be moved up and down using the central wheel on the mouse. The 
image can be resized by holding down the <Ctrl> key, then left clicking the mouse and 
dragging the object.

Fixture Module Operations

Restructuring the Drawing
Restructuring the drawing can be initiated from the Retail Toolbar. This enables users 
to select blocks in a drawing, then carry out one or more operations on those blocks. 
These results in the blocks being reset to match the latest definitions associated with 
that block.

Figure 3–47 Retail Toolbar

Table 3–8 Options include

Option Effect

Redefine Blocks from 
Disc

Update the drawing 
with the latest 
version of the block 
(.dwg file) that is 
held on disc.



Fixturing

3-42 Oracle® Retail Macro Space Management  User's Guide

Selecting Blocks for Restructuring
Selecting Blocks for Restructuring is done by using the varying selection options and 
building up a list of blocks for the Restructuring operations to be carried out on.

Each selection is added to the current list (Add to Selection radio button) or removed 
from the current list (Remove from Selection radio button). A list containing several 
types of blocks can thus be built up - the total number of blocks currently selected 
being shown in the dialog box.

Clicking on the Select button temporarily hides the Restructure Drawing dialog box 
and takes the user to the drawing. The required blocks can be individually selected by 
left clicking on each individual block. When all the blocks have been selected, the 
selection process is completed by right clicking in the drawing.

Clicking on the Select by Block button temporarily hides the Restructure Drawing 
dialog box and takes the user to the drawing. The required type of blocks can be 
selected by left clicking on an example. All other blocks of that type on the drawing 
will then be selected. Multiple types of blocks can be selected before the selection 
process is completed by right clicking in the drawing.

Clicking on Select All Blocks will select all blocks in the drawing. The OK button will 
remain grayed out until one or more options are ticked in the Options frame.

Restructuring Options
Once the blocks have been selected, varying restructuring options can be chosen.

Explode Composite 
Blocks

Explodes any 
composite blocks into 
their individual 
parts.

Reset Level Changes the level the 
block is placed to the 
level currently 
defined in Fixture 
Studio.

Reset color, Line 
Type and Line 
Weight to BYLAYER

Resets the block 
properties to 
BYLAYER - i.e. it 
resets the block color, 
line type and line 
weight to the defaults 
for that layer.

Reset Layer Changes the layer the 
block is currently 
placed on to the one 
currently defined in 
Fixture studio.

List Unknown blocks Lists any blocks in 
the drawing that are 
not registered in the 
central database.

Table 3–8 (Cont.) Options include

Option Effect
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Redefine blocks from Disk  

It is possible to edit the block definition of a specific block within the drawing. The 
block properties will not then match the generic block details held in the dwg file 
stored within Macro Space Management.

Redefine Blocks from Disk compares each block definition selected in the drawing 
and, if different from the dwg file stored in Macro Space Management, changes the 
block definition in the drawing to match that stored in the software.

Explode Composite Blocks  

This option will take any selected blocks and determine if they are composite (made 
up of two or more previously combined blocks).

If any blocks are composite, they will be separated into their component blocks and 
any connection points associated with the composite blocks removed. (If individual 
blocks within the composite have connection points assigned, these will not be 
affected).

Reset Level  

This option results in any selected blocks being reassigned to the level they are 
assigned to in the block Definition in Fixture Studio.

If the level is set to 'undefined', no changes will be made in the level for the block.

Reset color, Line Type and Line Weight to BYLAYER  

If the colors, line types and line weights of any selected block are different from the 
default properties of the layer on which they have been placed, the properties of the 
selected blocks will be set to those defaults.

Reset Layer  

If the selected block is on a different layer to that defined for that block in Fixture 
Studio, the block will be moved to that layer in the drawing.

List Unknown Blocks  

Note: Block names will be ignored if they are not registered in the 
database.

Note: Composite blocks cannot be reassembled after this operation, 
except by means of an 'undo' command.

Note: Both shelves and products should be on undefined levels and 
should not be affected by this command.
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It is possible for blocks to exist in the drawing, but not be registered in Fixture Studio. 
These sorts of blocks are shown in the Processing Blocks dialog box that appears when 
the drawing is being restructured.

The Retail Layers Toolbar
The Retail Layers toolbar enables you to quickly control which layers pertinent to 
Retailing are visible.

Figure 3–48 Retail Layers toolbar

Display 2D and 3D
The Display 2D and Display 3D options are available from the View menu.

Figure 3–49 Planner - View menu

They are also available from the Retail Layers toolbar.

This command works on fixtures that have had their drawing (dwg) file configured to 
have the base on the 2D layer and the remainder of the drawing on the 3D layer.

■ If Display 2D is selected, only the base of the fixture will be displayed, giving an 
outline plan view.

■ If display 3D is selected, all of the fixture will be displayed, giving a three 
dimensional view if the drawing is viewed from an oblique angle.
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The advantage of display 2D over the AutoCAD plan view is that it displays a simple 
outline of the fixture. If seen in plan in 3D mode, all the construction lines are visible. 
This may make the plan view look much cluttered when the drawing is printed out. 
This can be seen in the example below where the fixture can be seen in both 3D (top) 
and 2D (bottom).

Placing Fixtures

Insert/Edit Feature Dialog Box
The Insert/Edit Fixture dialog box appears when the Add Fixture icon is clicked on 
the Fixtures toolbar.

Figure 3–50 Insert/Edit Fixture dialog box

This dialog box contains a series of options for manipulating the fixture during 
placement.

Click on each button to activate the required option. When fixture placement options 
are satisfactory; complete insertion by clicking on the cross in the upper right corner of 
the Insert/Edit Fixture dialog box, or press <Escape>.

Note: The availability of some of these options depends on settings 
within the Fixturing tab of the Configuration Module. For example the 
arraying option is not available if the Auto Reinsert option is checked.
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Move Fixture option
The Move Fixture option is active when the Insert/Edit Fixture dialog box appears. It 
enables you to insert the fixture in the drawing at a point determined by the mouse 
cursor. Moving is completed by clicking on the x in the upper right part of the 
Insert/Edit Fixtures dialog box, or pressing <Escape>.

Attach Fixture to Another option
The Attach Fixture button allows you to attach one (or more) fixtures to another when 
both have compatible connection points. If the connection points are not compatible, 
the fixtures cannot be attached.

To use this option, place a fixture and then click the Attach Fixture to another icon. 
The fixture can them be moved around and snaps to any compatible connection 
points.

Move and Align Fixture option
The Move and Align fixture option allows you to move the fixture to another position 
and, if necessary, align with an existing fixture.

Move Fixture Between Others option

1. Click the Move Fixture icon to bring up a dialog at the cursor asking for the start 
position of the line on which the fixture is placed at the midpoint.

2. Left click to select the start point. The dialog then asks for the endpoint of the line 
on which the fixture is placed at the midpoint.

3. Left click in the fixture to place at the midpoint of the selected line.

Place Fixture on Top of Another option
The Place Fixture button allows one fixture to be placed on top of another when both 
have compatible connection points.

Offset the Fixture option
Click the Offset fixture icon to bring up the Offset dialog box.

Figure 3–51 Offset dialog box

To select the object to be offset from, click the Offset from Object button. Click on an 
object to select it. The fixture is temporarily placed at this point. There are then two 
ways of determining the offset.

When the fixture is first positioned in the drawing, a dialog box appears giving the 
offset from the selected fixture:

Note: At present this feature is not enabled in Macro Space 
Management.
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This can be used to select the required offset. Left click to return to the Offset dialog 
box, which now has the X, Y, Distance and Angle co-ordinates showing.

Alternatively, when the fixture is selected, press <Escape> to return directly to the 
Offset dialog box. The X and X coordinates of the offset can then be input. 
(Alternatively, they can be entered as a distance and an Angle).

Click Apply or OK places the fixture at the desired offset.

In-Line the Fixture option
Click the In-Line fixture option to bring up the In-Line dialog box.

Click the appropriate button to select how the fixture being inserted is placed relative 
to the selected fixture. On clicking the button for the first time, you are invited to select 
a fixture.

On selecting the fixture, you are returned to the dialog box. Click OK to complete the 
process.

Change Justification option
Click the Change Justification icon to bring up the Justification dialog box.

Click the appropriate button to change the justification of the annotation for that 
particular type of fixture.

Rotate the Fixture option
Click the Rotate fixture icon to bring up the Rotate Block dialog box.

Figure 3–52 Rotate Block
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Click the Align with Object button to enable you to select a previously placed fixture. 
The new fixture is placed at the same angle as the selected fixture. Alternatively, the 
angle required for the fixture being placed can be entered directly into either the 
Relative Angle or Absolute Angle boxes.

Rotate the UCS option
Click the Rotate the UCS icon to enable the orientation of the Universal Co-ordinate 
System (UCS) to be changed.

WCS (World Co-ordinate System) and UCS (Universal Co-ordinate System)

MSM AutoCAD has two coordinate systems: a fixed system called the World 
Co-ordinate System (WCS) and a movable system called the User Co-ordinate System 
(UCS). The UCS is useful for entering coordinates, defining drawing planes, and 
setting views. Changing the UCS does not change your viewpoint. It changes only the 
orientation and tilt of the coordinate system.

If you are working in a drawing, you can continually relocate the UCS to simplify your 
work. For example, if you have created a 3D object, you can edit each of its six sides 
easily by aligning the UCS with each side as you edit it.

If you change the UCS relative to the WCS, you can always make the two align again 
by using the World option of the UCS command.

Create an Array of Fixtures option
Click the Create an Array icon to bring up the Array dialog box.

Figure 3–53 Array dialog box

The usual method is to select the numbers of row and columns for the array by means 
of the number radio buttons. Alternatively, click the Measure button to define a 
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rectangle. Left click returns you to the dialog box where the number of rows and 
columns are defined.

Click OK or Apply completes the process.

Change the Size of the Fixture option
This button will allow the fixture to change in size during insertion. This option will 
only work for fixtures that are stretchable - it will not work for non-stretchable ones.

Insert the Same Fixture as Last Added
The Insert a Copy option allows you to insert another instance of the last block to be 
inserted by clicking the icon.

Undo the Last Change option
The Undo the Last Change option undoes the effect of the last action.

Modify the Options for this Fixture
Selecting this option brings up the Fixturing tab from the Configuration Module.

Figure 3–54 Configuration Module

This allows you to configure some options as to how fixtures behave.

Editing and Deleting Fixtures
Fixtures can be edited and deleted from the drawing using AutoCAD tools in addition 
to editing and deleting them using Macro Space Management tools.
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The properties of fixtures can be also modified using the fixture editing capabilities of 
Fixture Studio.

Editing and Deleting Fixtures using AutoCAD Tools
Fixtures can be edited using AutoCAD tools. These can be accessed from the Modify > 
General drop down menu options.

Figure 3–55 General menu options

This allows objects to be erased, moved or rotated.

Moving Fixtures
Moving Fixtures can be done by selecting the Move option from the Modify Menu.

Note: Editing and deleting using AutoCAD tools does not write the 
changes into the Macro Space Management database. This must be 
done using the Synchronize option.

Note: Objects manipulated using the AutoCAD tools do not have 
those changes registered in Macro Space Management's central 
database. The Synchronization option has to be run before the central 
database is updated.
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Figure 3–56 Modify Menu

This brings up a prompt asking you to select the fixtures to be moved.

Any objects selected changes from solid to dotted lines.

Right click to complete the selection process. You need to specify a base point.

Following specification of a base point, you are now prompted to specify a second 
point.

In both cases the points can be specified either by left clicking, or by typing in the X 
and Y coordinates. The two points specified define a vector. This indicates how far and 
in what direction the selected fixtures are to be moved.

Rotating Fixtures
To rotate a fixture:

1. Select the Rotate option from the Modify menu.

Note: Using MSM AutoCAD tools changes the drawing, without the 
changes being recorded in the central Macro Space Management 
database. Run Synchronize then Adjacencies to ensure the central 
database contains the effects of all AutoCAD changes.
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Figure 3–57 Modify menu

This brings up a prompt asking you to select the fixtures to be rotated.

Selected objects change from solid to dotted lines.

2. Right click to complete the selection process. 

3. Now, specify a base point. The point can be specified either by left clicking, or by 
typing in the X and Y coordinates.

4. Following this, enter a rotation angle.

The rotation angle can be specified by typing it in. Alternatively, the mouse cursor 
can be used to draw a line at the required angle. 

5. Left click to cause the specified objects to be rotated.

Erasing Fixtures
To erase a fixture:

1. Select the Erase option from the Modify menu.

Note: Using AutoCAD tools changes the drawing, without the 
changes being recorded in the central Macro Space Management 
database. Run Synchronize then Adjacencies to ensure the central 
database contains the effects of all AutoCAD changes.
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Figure 3–58 Modify menu - Erase

This brings up a prompt asking you to select the fixtures to be erased.

Selected objects change from solid to dotted lines.

2. Right click to complete the selection process; the selected objects are removed from 
the drawing.

Undoing changes
Moved, rotated, or erased fixtures can generally be restored to their original position 
by making use of the Undo command on the AutoCAD toolbar.

Editing Fixtures using Fixture Studio
Fixture Studio allows the properties of a fixture of fitting to be edited. It is accessed 
from the Object Browser by clicking on the Edit Fixture icon on the Fixturing tool bar.

Figure 3–59 Fixturing toolbar

Note: Using AutoCAD tools changes the drawing, without the 
changes being recorded in the central Macro Space Management 
database. Run Synchronize then Adjacencies to ensure the central 
database contains the effects of all MSM AutoCAD changes.

Note: Using MSM AutoCAD tools changes the drawing, without the 
changes being recorded in the central Macro Space Management 
database. Run Synchronize then Adjacencies to ensure the central 
database contains the effects of all AutoCAD changes.
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In Fixture Studio a wide range of properties for the selected fixture or fitting can be 
customized. These include:

■ Insertion points

■ Size

■ Connection points

■ Parts

■ Shelving

■ Merchandisable areas

Changes made to a fixture or fitting in Fixture Studio affects all blocks of that type.

The Fixture Studio window contains two main parts.

Figure 3–60 Fixture Studio

On the left is a hierarchical tree of all the available gondolas, on the right window you 
can customize the block details of the currently selected gondola.

Deleting Fixtures
It is recommended that fixtures are deleted using Macro Space Management tools. 
This can be achieved by means of the Delete Fixture option on the Fixturing toolbar.

To delete fixture(s) click the fixtures required. Alternatively, use the AutoCAD 
selection tools.

The outline of the fixture(s) turns to dotted and the insertion point shows. At the same 
time the Delete icon changes from inactive to active button, while the Add Fixture and 
Edit Fixture icons are inactivated.
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Figure 3–61 Planner - Delete Blocks

Click the Delete icon to remove all selected fixtures (and gondolas).

Fixture Operations

Highlighting Selected Item in View
The Highlight option highlights the selected item in view and can be accessed by 
clicking the Highlight icon in the Blocks toolbar of the Object Browser.

Figure 3–62 Blocks toolbar

This option can be toggled On and Off by selecting it. When toggled on, the button is 
pressed down. When the Highlight Selected Item in View option is selected, clicking a 
fixture in the hierarchical tree of fixtures results in that type of fixture in the visible 
portion of the drawing being highlighted.

Highlighting Selected Item in Tree
The Highlight option highlights the selected item in the hierarchical tree. This option is 
only available in the Blocks toolbar and not activated in the Gondolas toolbar.

Figure 3–63 Gondolas toolbar
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Using the Find Function
The Find function is used to search for blocks or gondolas in the drawing and can be 
accessed by clicking the Find icon in the Fixturing toolbar.

Figure 3–64 Fixturing toolbar - Find

To search for blocks:

1. Click the Find icon to bring up the Find Block dialog box.

Figure 3–65 Find Block dialog box

2. In the Find field, type the required search string and click the Find icon to the right 
of it. This brings up a list of any blocks matching the search string.

3. Left click any result to return to the Fixtures window, where the selected block is 
highlighted in the hierarchy tree.

Refreshing
The Refresh icon refreshes both fixtures and gondola information in the respective 
hierarchical trees.

Figure 3–66 Fixturing toolbar - Refresh
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Click the Refresh button in the Gondolas tab to load the latest gondola information 
from the database into the gondola hierarchy. At the same time, the latest fixture 
information from the database is also refreshed in the fixture hierarchy.

Dragging and dropping a gondola from the appropriate hierarchy after the refresh 
button is pressed adds that gondola to the drawing using the latest definition from 
Fixture Studio. Similarly, using the Add button adds a gondola to the drawing using 
the latest definition from Fixture Studio.

If a drawing is already open then gondolas already placed in the drawing do not use 
any changes loaded during the refresh operation until the drawing is closed and 
reopened. However, new gondolas added to the open drawing use the new data.

Fixture Attributes
Fixture Attributes can be set by selecting a fixture or fixtures and clicking on the 
Fixture Attribute icon in the toolbar.

Figure 3–67 Fixturing toolbar - Fixture Attribute

The Fixture attributes dialog box appears when clicked on the Fixture Attributes icon.

Figure 3–68 Fixture attributes dialog box

This enables you to add or edit fixture information. If multiple fixtures are selected, 
only fields with common data display information. These attributes are configurable 
in Fixture Studio, for detailed information, refer chapter Fixture Studio.

Promotional Fixtures
Promotional Fixtures are fixtures that can be allocated for the specific purpose of 
rapidly changing offers. Promotional Fixtures are normally used for reporting 
purposes.
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Figure 3–69 Fixturing toolbar - Promotional Attribute

It can be assigned by selecting a fixture or fixtures and selecting the Fixture Attribute 
icon in the toolbar. You can assign, unassign and highlight the fixture used for 
promotional purpose.

Figure 3–70 Fixturing toolbar - Promotional Attribute

Fixtures designated as Promotional can be identified by using the Highlight option. 
The fixtures are highlighted in the drawing by the configured method in the 
Configuration tab.

In the above example, Thicken has been used as the highlight option.

Alternatively, they can be identified by running a report on the drawing or by using a 
KPI.

Placing Gondolas
A Gondola is a collection of fixtures and fittings placed in a predetermined 
arrangement such as bases and spines. This enables long runs of fixtures to be placed 
very quickly. They can either be placed as an island, (away from a store wall), or as a 
perimeter run, (against a wall).

Figure 3–71 Gondolas

Gondola placement is in two stages:

■ gondola selection and
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■ gondola insertion

Gondola Selection
Gondolas are selected from the hierarchical tree in the Fixturing tab.

Figure 3–72 Gondolas selection

Gondola Insertion
Once the Gondola is selected in the hierarchical tree it can be placed in the drawing in 
one of two ways:

■ The required gondola can be dragged and dropped in the AutoCAD drawing.

■ The Add Gondola icon can be clicked on the toolbar.

After selecting an insertion point, the Gondola Run dialog box comes up, you can 
customized the gondola being placed.

Figure 3–73 Gondola Run dialog box
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The Gondola Run dialog box appears after the start point for the gondola run has been 
selected. The exact form of the dialog box that appears depends on how the gondola 
was specified.

Dimensions  

The dimensions allow parameters such as Width, Height, Number of Bays, Placement 
angle, etc. to be specified. Most of the options available to be selected are 
predetermined when the Gondola is defined in Fixture Studio.

Figure 3–74 Gondola Sizes

Gondola Parts and Positions  

Gondola parts and positions are specified in the Gondola definition dialog box.

Figure 3–75 Gondola definition dialog box

Note: Gondolas are specified in Fixture studio.
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Gondola Dimensions
The dimensions allow parameters such as Width, Height, Number of Bays, Placement 
angle, etc. to be specified. Most of the options available to be selected are 
predetermined when the Gondola is defined in Fixture Studio.

The Dimensions displays a list of sizes that can be selected for that particular gondola.

Figure 3–76 Gondola Run

The number of dimensions displayed is determined by those specified in the Gondola 
Definition dialog box in Fixture Studio. The actual dimensions available are defined in 
the Gondola Size dialog box in Fixture Studio. Dimensions can either be selected from 
the available list, or selected using the Match button.

Clicking on the Match button temporarily hides the dialog box and takes you to the 
drawing. You are prompted to measure a distance on the drawing. The Gondola Run 
dialog box then is re-displayed with the dimension closest to that measured 
highlighted.

Note: Adding a gondola requires the blocks corresponding to the 
chosen combination of sizes to be present in the database. If a block is 
not present, the gondola cannot be drawn and an error message is 
displayed.
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Figure 3–77 Gondola Run - Errors

The Options Frame
The Options Frame displays a list of parts that are optional for that particular gondola.

Figure 3–78 Gondola Run - Options Frame

Ticking the appropriate check box ensures the optional parts are included in the 
gondola when it is placed in the drawing.

Note: Optional parts are specified in the Gondola Definition dialog 
box in Fixture Studio.
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Figure 3–79 Gondola Definition dialog box

The Row Frame
The Row Frame allows the number of bays, placement angle, start position, etc., to be 
specified.

Figure 3–80 Gondola Run dialog box

Number can be any integer greater than 0. This number can be changed using the spin 
control.

Note: The maximum number of bays permissible may be restricted 
by settings in Fixture Studio.
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If you click the Measure button, you are prompted to pick a second point in the 
Planner drawing. This point is relative to the previously selected insertion point of the 
gondola. The distance between the two points determines the length of the gondola 
run, as well as its direction. Based on the length of the gondola run, Macro Space 
Management calculates the number of full bays that fit into the measured distance.

■ End caps are additional to the number of bays calculated using measure.

■ A calculated angle based on the displacement between the two points is 
calculated. (Angle is measured in degrees from East anti clockwise). Alternatively, 
an angle can be input. The direction bays added are dependent on the insertion 
angle. A gondola with an insertion angle of 180 degrees will be facing in a 
different direction to a gondola an insertion angle of 0 degrees.

■ Start Position determines whether the specified number of bays is added to the left 
or right of the insertion point.

■ The Extend option is primarily used when placing island gondolas, (i.e. away 
from walls). The number of bays calculated is normally less in length than the 
measured distance.

■ The Best Fit option is only enabled if the length dimension on the gondola 
definition contains more than one size. It is primarily used when placing a run of 
gondolas against a wall. It uses the selected length of the gondola for all but one 
fixture. The program selects an extension piece of the best practical length to fill 
the remaining space. The Extend option is only available if the Best Fit option is 
enabled. A drop down list enables you to choose whether to place the extension 
piece at the start of the gondola run, in the middle, or at the end.

Completing Insertion
Insertion is completed by clicking the OK button at the bottom of the Gondola Run 
dialog box.

Note: The distance occupied by the number of full bays is often less 
than the distance measured. To add another bay, check the Extend 
option.
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Figure 3–81 Gondola Run dialog box

Alternatively, the insertion can be aborted by means of the Cancel button.

Figure 3–82 Gondola Run - Error

Editing and Deleting Gondolas
Gondolas can be edited and deleted from the drawing using AutoCAD tools.

The properties of Gondolas can be modified using the Gondola editing capabilities of 
Fixture Studio. Gondolas can be deleted from the drawing using Macro Space 
Management tools.

Note: Adding a gondola requires the blocks corresponding to the 
chosen combination of sizes to be present in the database. If a block is 
not present, the gondola cannot be drawn and an error message is 
displayed.

Note: Editing and deleting using AutoCAD tools does not write the 
changes into the Macro Space Management database. This must be 
done using the Synchronize option.
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Editing and deleting Gondolas using AutoCAD
Gondolas can be edited using AutoCAD tools. These can be accessed from the Modify 
> General drop down menu options.

Figure 3–83 Planner - General Menu

This allows objects to be erased, moved or rotated.

Moving Gondolas
Gondolas can be moved by selecting the Move option from the Modify menu.

Figure 3–84 Planner - General Menu > Move

1. When you select the Move option, a prompt asks you to select the gondolas to be 
moved. When selected, the selected object changes from solid to dotted lines.

2. Right click to complete the selection process. Now specify a base point by left 
clicking or by typing in the X and Y coordinates.

3. After the base point, you are prompted to specify a second point by left clicking or 
by typing in the X and Y coordinates.

The two points specified define a vector. This indicates how far and in what 
direction the selected fixtures are to be moved.
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Rotating Gondolas
You can rotate a gondola in the drawing by selecting the Rotate option from the 
Modify menu.

Figure 3–85 Planner - General Menu > Rotate

1. When you select the Rotate option, a prompt asks you to select the fixtures to be 
rotated.

When selected, the selected object changes from solid to dotted lines.

2. Right click to complete the selection process. Next, specify a base point by left 
clicking or by typing in the X and Y coordinates.

3. After the base point, specify the rotation angle. The rotation angle can be specified 
by typing it in.

Alternatively, use the mouse cursor to draw a line at the required angle. Left click 
to rotate the specified objects.

Erasing Gondolas
You can erase a gondola from the drawing by selecting the Erase option from the 
Modify menu.

Note: Using MSM AutoCAD tools, changes made in the drawing are 
not automatically recorded in the central Macro Space Management 
database. To update the changes in the database, run Synchronize and 
Adjacencies to ensure the central database contains the effects of all 
MSM AutoCAD changes.

Note: Using MSM AutoCAD tools, changes made in the drawing are 
not automatically recorded in the central Macro Space Management 
database. To update the changes in the database, run Synchronize and 
Adjacencies to ensure the central database contains the effects of all 
MSM AutoCAD changes.
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Figure 3–86 Planner - General Menu > Erase

1. When you select the Erase option, a prompt asks you to select the fixtures to be 
erased.

When selected, the selected object changes from solid to dotted lines.

2. Right click to complete the selection process, after the selection the selected objects 
are removed from the drawing.

Deleting Gondolas
Gondolas can only be deleted using AutoCAD tools as the Delete Gondola option is 
not available for use in the Gondolas toolbar.

Figure 3–87 Delete Gondola option

Undoing Changes
Moved, rotated, or erased gondolas can generally be restored to their original position 
by making use of the Undo command on the Planner toolbar.

Note: Using MSM AutoCAD tools, changes made in the drawing are 
not automatically recorded in the central Macro Space Management 
database. To update the changes in the database, run Synchronize and 
Adjacencies to ensure the central database contains the effects of all 
MSM AutoCAD changes.

Note: After using AutoCAD tools, the drawing must be 
synchronized so that the changes are written to the central Macro 
Space Management database.
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Figure 3–88 Planner toolbar

Editing Gondolas using Fixture Studio
Fixture Studio allows the properties of a gondola to be edited. It can be accessed from 
Planner by clicking the Edit Gondola icon on the Fixturing tool bar.

Figure 3–89 Fixturing tool bar - Edit

While in Fixture Studio a wide range of properties for the selected gondola can be 
customized. These include:

■ Sizes

■ Fixture Positions

■ Whether parts are optional or not

Changes made to a Gondola while in Fixture Studio affects further placements of that 
type.

Gondola Operations

Highlighting Selected item in Tree
The Highlight Selected Item in Tree option enables you to highlight the selected item 
in the hierarchy tree by clicking the icon in the Blocks toolbar. Although the option in 
not available in the Gondolas toolbar, when selected from the Blocks toolbar, it 
highlights the selected item in the tree.

Note: Using MSM AutoCAD tools, changes made in the drawing are 
not automatically recorded in the central Macro Space Management 
database. To update the changes in the database, run Synchronize and 
Adjacencies to ensure the central database contains the effects of all 
MSM AutoCAD changes.
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Figure 3–90 Fixturing tool bar - Highlight

This button can be toggled On and Off by clicking on it. When toggled on, the button 
appears pressed down. When the option is toggled on, clicking on any fixture in the 
drawing results in that fixture type being highlighted in the hierarchical tree.

Refreshing
The Refresh option refreshes both blocks and gondola information in the respective 
hierarchical trees.

Figure 3–91 Fixturing tool bar - Refresh

Click the Refresh button in the Blocks tab to load the latest fixture information from 
the database into the fixture hierarchy. At the same time, it will load the latest gondola 
information from the database into the gondola Hierarchy.

Dragging and dropping a fixture or using the Add button to add a fixture to the 
drawing from the appropriate hierarchy after the refresh button is selected adds that 
fixture to the drawing using the latest definition from Fixture Studio.

If a drawing is already open then fixtures already placed in the drawing do not use 
any changes loaded during the refresh operation until the drawing is closed and 
reopened. However, new fixtures added to the open drawing use the new data.

Gondola Attributes
Attributes only apply to fixtures.

Note: Some of the options are not available in the Gondola toolbar 
such as Highlight Selected Item in View, Find, and Options.

Note: Some of the options are not available in the Gondola toolbar 
such as Highlight Selected Item in View, Find, and Options.
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Figure 3–92 Fixturing tool bar - Attributes

To get information in individual fixtures within a gondola, select the required fixtures 
within the gondola and click on the attributes icon.

Promotional Fixtures
Promotional Fixtures are fixtures that can be allocated for the specific purpose of 
rapidly changing offers. Promotional Fixtures are normally used for reporting 
purposes.

Figure 3–93 Fixturing tool bar - Promotional Fixtures

It can be assigned by selecting a fixture or fixtures and selecting the Fixture Attribute 
icon in the toolbar. You can assign, unassign and highlight the fixture used for 
promotional purpose.

Figure 3–94 Fixturing tool bar - Promotional Fixtures

Fixtures designated as Promotional can be identified by using the Highlight option. 
The fixtures are highlighted in the drawing by the configured method in the 
Configuration tab.

Alternatively, they can be identified by running a report on the drawing or by using a 
KPI.

Note: Some of the options are not available in the Gondola toolbar 
such as Highlight Selected Item in View, Find, and Options.
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Bay Numbering
Bay numbering assigns a unique identification code to each fixture within the drawing 
for reporting and identification purposes.

Bay numbering is based on either fixture or gondola:

■ Fixture based bay numbering numbers each fixture in an incremental sequence 
starting from a designated number.

■ Gondola based bay numbering numbers fixtures within a gondola with a four part 
sequential code unique to the drawing.

Before Bay Numbering can be carried out, the Synchronization module must be run to 
ensure the information from the drawing has been fully transferred to Macro Space 
Management's central database. Following this, the Adjacency option must be run so 
the central database has up to date information on which fixture is next to which 
fixture.

Figure 3–95 Synchronization Flowchart

Bay Groups are where two or more fixtures have been linked together for bay 
numbering purposes.

Figure 3–96 Bay Grouping
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Bay groups can contain any number of fixtures, but care should be exercised in using 
this feature. The Bay Number appears in the geometric centre of the selected fixtures, 
causing it to appear in an unpredictable place if the fixtures selected occupy too wide 
an area.

Preparations - Before Bay Numbering  

To synchronize the drawing, select the Synchronize option from the File menu or from 
the toolbar. This brings up the Synchronize dialog box.

In the Synchronize dialog box, select the Match the Drawing option, Fixtures, Other 
Blocks, and Zones check boxes (under the Items to Synchronize section), and then click 
the Synchronize button.

Fixture Adjacency  

Fixture Adjacency is used by the Planner application to calculate the fixtures that are 
adjacent to each other. If they are within a specified distance (usually just a few mm), 
they are treated as part of a gondola; otherwise they are treated as individual fixtures. 
If fixture adjacency is not run, then fixtures may have bay numbers in an odd 
sequence.

To run Fixture Adjacency, select the Calculate Fixture Adjacencies option from the 
Calculations menu or toolbar.

Figure 3–97 Calculations - Options

Select Bays Frame  
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The Select Bays frame provides options to select fixtures for bay numbering.

Figure 3–98 Bay Numbering - Select Bays

■ The Add or Remove radio buttons determine whether fixtures are added or 
removed from the list for bay numbering. The number selected is shown 
immediately below.

■ Clear Selection removes all fixtures from the list of those selected.

■ Preview shows the fixtures selected for bay numbering - these briefly blink on the 
drawing.

■ Select Bays >> enables you to select fixtures from the drawing. Multiple selections 
can be made by using AutoCAD selection techniques. The selected bays flash in 
the drawing three times.

■ By Bay Run enables you to select gondolas for bay numbering. You are returned to 
the drawing to select a gondola by left clicking on it. A dialog box appears.

If the Whole Run option is selected, every fixture in the gondola will be selected. If the 
whole run is not included, then only part of the gondola will be included; you will be 
asked to specify a stop position. This option should only be used by Macro Space 
Management users who understand the numbering sequence within gondolas. This 
option may also be used to select fixtures that have been placed individually. The 
selected bays flash in the drawing three times.

■ By Group enables fixtures to be selected that have already been designated as 
belonging to a Group. The selected bays flash in the drawing three times.

■ All Bays selects all fixtures on the drawing.

■ Unlabelled Bays selects all fixtures that have not been allocated a bay number.

■ Sort Bays when checked causes fixtures to be numbered according to the 
adjacency rules. It is inactivated unless the Sort Adjacencies option is checked. If 
Sort Bays is checked, the Direction radio buttons become available, allowing you 
to select the numbering direction. If Sort Bays is unchecked, then fixtures can be 
numbered using the sequence defined by a user specified AutoCAD option.
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Group Frame  

The Group frame enables you to specify a number of options concerning Bay 
Numbering.

Figure 3–99 Bay Numbering - Group

■ Name enables a specified selection of fixtures to be given a collective name. This 
must be entered prior to labeling the selected fixtures. For example, a group of 
fixtures designated for electrical sales might simply be named Electrical. 
Whenever this group is selected in the future, all fixtures that were designated as 
part of it are selected.

■ Prefix is added to any bay number as it is applied. For example, choosing a prefix 
of E- results in all selected fixtures being labeled E-1, E-2, E-3, etc. Prefixes are 
useful for giving visual indication that a fixture belongs to a specific group.

■ Start specifies the number at which bay numbering is to commence. This is 
important where grouping has been used, as it enables overlapping ranges of bay 
numbers to be avoided.

■ Label Block brings up a list of label blocks. These enclose the actual bay numbers.

Color enables bay numbers to be assigned a color. Clicking on the button with the 
ellipsis will bring up a color pallet.

The selected color is then applied to all selected bays. This is useful for color coding 
bays assigned to different groups.

The Labeling and Gondola Numbering buttons allow you to select whether Bay or 
Gondola numbering is used. (Gondola numbering uses a slightly different logic from 
Bay Numbering).

Action Frame  

The Action frame completes the bay numbering process.
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Figure 3–100 Bay Numbering - Action

■ Add: adds numbering to any selected fixtures.

■ Remove: removes any existing numbers from any selected fixtures.

■ Exit: enables you to leave the bay numbering routine, having completed all 
required actions.

Accessing the Bay Numbering Options  

Bay numbering is accessed from the Insert menu.

Figure 3–101 Bay Numbering - Insert menu

The Bay Sequence Numbering dialog box comes up.
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Figure 3–102 Bay Sequence Numbering dialog box

Adding Basic Bay Numbering  

To add basic bay numbering:

1. Select the Bay Numbering option from the Insert menu. The Bay Numbering 
dialog box appears.

2. The Select Bays section allows you to select the bays that will be numbered. Within 
the Select Bays frame, specify your selection:

■ Check the Add radio button

■ Check the Use Adjacencies check box

■ Check the Sort Bays check box

■ The Direction area specifies the direction bay numbering will operate in, select 
Left to Right radio button.

■ Click the All Bays button. This selects all fixtures in the drawing.

3. The Group section controls the notation that will be added. In the Group frame, 
set the following options:

■ Give the selected fixtures a collective name by typing in the Name text box.

■ Add a prefix in the Prefix text box. This will be added to all the bay numbers.

■ Select the Start number in the Start drop down list. The bay numbering will 
start from this value.

■ Select the shape of the block from the Label Block drop down list.

■ Select the color of the text from the Color dialog box.

■ Scale

■ Labeling determines what form of labeling will be applied.

■ Gondola Numbering

4. In the Action frame, click the Add button. The Bay Numbers are added.
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Advanced Bay Numbering  

There are several ways of carrying out more advanced bay numbering. The example 
used here uses a Fence selection method to select both the fixtures to be bay numbered 
and the sequence they are to be numbered in.

Figure 3–103 Advanced Bay Numbering

The Bay Numbers on the top (S1 - S10) were numbered in the usual manner and run in 
sequence up and down the selected bays of the gondola.

The Bay Numbers in the centre (F1 - F10) were numbered using a fence and can be 
precisely controlled as to the sequence they number in.

The Gondola on the bottom shows the path of the fence used to select the sequence the 
fixtures were numbered in.

Bay Numbering with a Fence  

To bay number using a fence:

1. From the View menu, launch the Bay Numbering dialog box.

2. In the Select Bays frame, select the Add button, and ensure the Use Adjacencies 
and Sort Bays check boxes are cleared.

Note: If the Use Adjacencies check box is not cleared, the fence 
method will not work.
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Figure 3–104 Bay Numbering dialog box

■ In the Group frame, set the following options

■ In the Name field, type in the required name for the group of fixtures to be 
selected.

■ In the Prefix field, type in the prefix that will precede the bay numbers.

■ In the Start drop down list, set the start number for the numbering.

■ In the Label Block drop down list, select the shape of the Label Block that will 
be used for bay numbering

■ In the Color dialog box, select the color for the bay numbering text.

■ In the Scale field, enter the value.

■ Select the Labeling radio button.

3. In the Select Bays frame, click the Select Bays button. The cursor will appear in the 
drawing.

4. Type in Fence and then press enter.

5. A Prompt appears next to the cursor to specify the first fence point. Left click to set 
it.
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6. Continue to draw the fence by clicking to set successive points.

7. When all the points in the fence have been drawn, press enter until the Bay 
Numbering dialog box reappears.

8. Click the Add button in the Action frame. The selected bays are numbered.

The above figure shows the bays numbered in the sequence specified by the fence.

Removing Bay Numbering  

You can remove the bay numbering from the fixtures.

To remove bay numbering:

1. From the Insert menu, select the Bay Numbering option. This brings up the Bay 
Numbering dialog box.

Note: It is important for the fence line to start and finish outside the 
fixtures to be selected. If the fence line starts inside a fixture, the 
numbering of that and the next fixture might become confused.
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2. Click the Select Bays button to have bay numbering removed from specific bays, 
or select the All Bays button to remove bay numbering from all bays.

3. Click the Remove button, and Bay Numbering is removed.

Defining Bay Groups

Accessing the Bay Groups option
The Bay Group options can be accessed from the Modify > Blocks option on the menu 
bar.

Figure 3–105 Bay Groups - Blocks

They can also be accessed from the Bay Numbering toolbar.

■ Group Bays allows you to select fixtures to group together a number of fixtures 
into a single bay.

■ Clear Bay Group converts grouped fixtures back into fixtures that will receive 
individual bay numbers.

■ Select Bay Group causes other members of a bay group to be highlighted when an 
individual fixture within the bay group is selected.

Making Fixtures into Bay Groups
To make Bay Groups from fixtures:

1. From the Modify>Blocks menu, click the Group Bays option. Alternatively use the 
Group Bays option from the Bay Numbering toolbar. A prompt appears next to 
the cursor to select the required fixtures.

2. Select the objects by left clicking on the required fixtures, or by a fence.

3. Complete the selection by a right click. The selected Bay Group is numbered as 
such when the fixtures are bay numbered.
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Removing Bay Groups
To remove fixtures in a bay group:

1. Select the Remove Bay Group option from the Modify > Blocks menu or from the 
Bay Numbering toolbar. A prompt appears next to the cursor to select the blocks 
to remove from the group.

2. Select a block from the bay group. All the blocks of the bay group are selected.

3. Right click to complete the selection, the blocks are removed from the group.

Showing Bay Groups
To show all the fixtures in a bay group:

1. Select the Show Bay Group option from the Bay Numbering toolbar or the Modify 
menu.A prompt appears next to the cursor to select a block.

2. Select a Block Prompt.

3. Select any block in the bay group and the other blocks are selected.

Merchandising

Business Flows in Merchandising
You need to have detailed information on the stores for Macro Space Management to 
operate effectively. The starting point is the Store Manager module. This allows stores 
to be organized into a logical structure and individual stores to be sub-divided into 
floors. Details of the floors can then be imported into Macro Space Management as 
Planner drawings. These floors can be subdivided into Zones dedicated to sales of 
particular product lines.

The Fixtures module within Macro Space Management then allows the detailed 
layouts of the floors to be planned (multiple plans for a floor within a store being 
administered by Store Manager). Each fixture can subsequently be populated by a 
predetermined quantity and arrangement of sales products using the Merchandising 
Tab on the Object Browser.

Within the Merchandising Tab, you can:

■ Select single or multiple bays to be populated with merchandise.

■ Quickly and efficiently select the required merchandise.

■ Substitute merchandise as required.
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Figure 3–106 Business Flow - Merchandising

You can see information on the effectiveness of the merchandising plan by switching 
to Merchandiser and looking at the Key Performance Indicators (KPI). After the floor 
has been merchandised, Macro Space Management Reports can be used to analyze 
and report on the effectiveness of the layout. These are available from the Report 
Studio standalone module.

Basic Concepts

Fixtures, Fittings, and Shelves

Fittings  

Fittings are items within a store that aid the retail effort, but do not themselves hold 
merchandise. Examples are display material and checkout counters. Some fittings are 
used to support or augment fixtures. For example a shelving unit could be made up of 
support legs, (a fitting), and shelves, (a fixture). Fittings always remain separate items 
on the drawing and can be hidden from view using the Hide Fittings command.
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Fixtures  

A fixture is a structure designed to hold products for sale. It can take many forms 
including runs of shelving, display cabinets, and kiosks. A fixture can hold product 
directly, or via shelves. A shelf always has a parent fixture. A shelf can be used as a 
generic description as equipment within a fixture which can hold product.

For example a backboard might hold several support bars. The support bars could in 
turn have rods attached. Product could then be hung from those rods. The 
arrangement of rods emanating from a single support bar is generically called a shelf 
for planning purposes.

Shelves  

Each shelf or fixture always has a product base associated with it. This serves as a 
placeholder for any merchandise placed on it. Fixtures and fittings are often color 
coded as to purpose. For example, fixtures holding groceries might be drawn in green, 
fixtures holding chilled goods in blue.

Layers
AutoCAD drawings are often divided into Layers. Each layer contains a specific type 
of information. For example, one layer might contain information on fixtures another 
data on electrical wiring. Layers can be further sub-divided into aliases. Each aliased 
layer contains very specific information. For example, one aliased layer might contain 
details of all the fixtures capable of holding chilled goods; another all fixtures holding 
fruit and vegetables.

Layers are one method used by Macro Space Management to filter fixtures, 
planograms, etc.

Product
A Product is a single specific category of merchandise. For examples, baked beans, 
television sets, and dining tables.

Planograms
Planograms are blocks within Macro Space Management that hold details of 
merchandise to be placed into the fixtures within a store. Planograms define the type, 
quantity, and arrangement of the sales goods to be placed in the bay(s). These are 
designed to maximize sales revenue by placing the optimum combination of products 
into the available sales space.

Planograms are infinitely flexible and can be configured to hold any combination of 
products. Planograms are placed in fixtures and gondolas, but must be of suitable 
configuration for that specific fixture or gondola.

Gondolas
A Gondola is an arrangement made up from two or more fixtures linked together by 
means of connection points (or in sufficiently close proximity to meet the definition of 
adjacency). An example of a gondola might be a run of 10 fixtures placed back to back, 
with end caps on each end to maximize the area devoted to sales.

Gondolas are often color coded to differentiate from one to another. For example 
gondolas holding groceries might be drawn in green, fixtures holding chilled goods in 
blue. Note that single fixtures are numbered as gondolas if the Gondola Numbering 
option is used.
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Configuration

Accessing the Configuration Options  

The Configuration options can be accessed by clicking on the Properties icon on the 
Merchandising toolbar. (This is available when either Products or Planograms are 
selected).

Figure 3–107 Merchandising toolbar - Configuration

This will bring up the Merchandising Tab from the Configuration Module.

Figure 3–108 Configuration Module
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Merchandising Toolbar and Display Windows

Merchandising on the Object Browser  

Clicking on the Merchandising tab on the Object Browser brings up a series of options 
for adding, editing, and deleting Products and Planograms.

Table 3–9 Configuration Module

Fields Description

Selection Fixture Selection Mode is selected from a drop down list.

Vertical Category Filter enables the user to select Planograms that 
have previously been assigned to a vertical category within an 
aliased layer.

Always show selection dialog permanently turns on the selection 
dialog window when planograms are deleted. If this option is not 
enabled, then the dialog will only show when multiple planograms 
are selected - single planograms will be deleted without the need for 
confirmation.

Select whole planogram is used when a Planogram requires multiple 
bays to be placed.

Highlight selected fixtures highlights fixtures previously selected 
using Macro Space Management tools.

Sort left-most sorts selected fixtures in a left to right order. If this 
option is not enabled, then fixtures are selected in the order they 
were placed on the drawing.

Product tooltip enables the type of tooltip to be selected from a drop 
down list.

Highlight Enables to highlight a fixture in the drawing by flashing or zooming 
to a set value.

Options Enables to set the tolerance levels.

Check Rules Enables to set the check rules for planograms.

Placement Rules Defines the placement rules.
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Figure 3–109 Merchandising Toolbar

The Product Toolbar  

The Product toolbar is found on the Merchandising Tab of the Object Browser. It is 
active when the Product button is selected.

Figure 3–110 Product toolbar

It contains a series of icons allowing various operations to be carried out on Products.

The Planogram Toolbar  

The Planogram toolbar is found on the Merchandising Tab of the Object Browser. It is 
active when the Planogram button is selected.
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Figure 3–111 Planogram toolbar

It contains a series of icons allowing various operations to be carried out on 
Planograms.

The Merchandising Hierarchy Window  

The Merchandising window shows a hierarchical tree of all the available products or 
planograms.

Figure 3–112 Merchandising window

The tree can be expanded or contracted by clicking on the + or - icons. The 
Merchandising window can be minimized by clicking on the splitter bar.

The Products or Planograms buttons determine whether the hierarchical tree shows 
products or planograms. The Products hierarchical tree can be configured in Product 
Studio using the Add Product, Edit, and Delete options on the menu available by right 
clicking.

Figure 3–113 Product Studio Window
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The Planograms hierarchical tree can be configured in the Merchandiser module using 
the Add, Edit, and Delete options on the menu available by right clicking.

Figure 3–114 Merchandiser module

The Properties Window  

The Properties Window shows the properties for the currently selected product or 
planogram.

Figure 3–115 Properties Window

The Properties window can be minimized by clicking on the splitter bar.

The Summary Window  

The Summary Window contains details of Zones within the currently active drawing. 
The information typically includes Zone Name, Zone Description, and Gross and Net 
Areas.

Zone Names and Zone Descriptions can be sorted by clicking on the column headings. 
If a zone has been selected in the drawing, it will be highlighted in the summary of 
zone properties.

Note: Information displayed can be customized by Oracle - contact 
Technical Support if necessary.
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The Preview Window  

The Preview Window shows an image of the product or planogram selected in the 
hierarchical tree.

Figure 3–116 Preview Window

The window can be resized in the horizontal plane by dragging the edge of the Object 
Browser with the mouse. It can be resized in the vertical plane by dragging the bottom 
of the window with the mouse.

The Preview window can be minimized by clicking on the splitter bar.

Merchandising Operations

Selection Methods for adding Products or Planograms to Fixtures
The Selection frame in the Merchandising Tab of the Configuration Module specifies a 
series of options determining how fixtures are selected for placement of Products or 
Planograms.
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Figure 3–117 Configuration Module - Merchandising Tab

■ Fixture Selection Mode is selected from a drop down list.

■ Pick Position Near selects the nearest position from a range of fixtures previously 
selected using Macro Space Management tools.

■ Standard Selection uses the standard Planner selection boxes to pick the fixture(s).

■ Vertical Category Filter enables you to select Planograms that have previously 
been assigned to a vertical category within an aliased layer.

■ Always show selection dialog permanently turns on the selection dialog window 
when planograms are deleted. If this option is not enabled, then the dialog only 
shows when multiple planograms are selected - single planograms are deleted 
without the need for confirmation.

■ Select whole planogram is used when a Planogram requires multiple bays to be 
placed.

■ Highlight selected fixtures highlights fixtures previously selected using Macro 
Space Management tools.

■ Sort left-most sorts selected fixtures in a left to right order. If this option is not 
enabled, then fixtures are selected in the order they were placed on the drawing.

■ Product Tooltip enables the type of tooltip to be selected from a drop down list.

Planogram Placement Options  

The Configuration Module also contains a series of options concerning how 
planograms are placed.
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Figure 3–118 Configuration Module - Merchandising Tab

■ Check Rules specify what warnings are given if the selected fixtures do not match 
the data specified in the planogram definition.

■ Options allow you to specify the tolerance allowed if the dimensions of the 
selected fixtures do not match that specified in the planogram definition.

■ Placement Rules specify what happens if the planogram is longer or shorter than 
the selected fixtures.

Adding Products or Planograms to Fixtures  

The flowchart below specifies the sequence of actions required to place Products or 
Planograms on Fixtures.
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Figure 3–119 Workflow - Placing Products/Planograms on Fixtures

Actions in the Configuration Module

■ Specifying the Fixture Selection Method enables you to choose how fixtures for 
population are selected.

■ Specifying the Planogram Placement method enables you to choose what options 
control how planograms are placed.

■ The options are specific to a user.

Actions in the Merchandising Module

■ Clicking on the appropriate button toggles between the Product and Planogram 
hierarchical trees, allowing you to select the class of object to be placed.

■ The required Product or Planogram can then be found in the hierarchical tree.

■ The Fixture on which the Product or Planogram is to be placed is selected.

■ The Product or Planogram is placed.

■ If a planogram is placed, you may receive one or more warnings if the selected 
fixtures do not match the details in the planogram definition.

■ You may chose to override the warnings, in which case the planogram will place.

Selecting Whether to Add Products or Planograms  

Whether Products or Planograms are added will depend on whether you have 
selected the Product or Planogram hierarchical tree.
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Figure 3–120 Product hierarchical tree

In the above example, the Products hierarchical tree has been selected.

Selecting the Product or Planogram Required  

There are two ways of finding the Product or Planogram required for merchandising a 
fixture. The first is to select the required Product or Planogram directly from the 
hierarchical tree. This can be done by clicking on the + or - sign to expand or contract 
the hierarchical tree as required, then highlighting the required Product or Planogram.

The second is to use the Find option in the merchandising toolbar. 

1. Type the required search string into the Find Product dialog box. The result brings 
up a list of any blocks matching the search string. Left click on any result will 
return to the Merchandising Window, where the selected Product or Planogram is 
highlighted in the hierarchy tree.

2. When the required Product or Planogram has been found, it can be selected for 
insertion into the drawing in one of three ways:

3. The Product or Planogram can be 'dragged' from the hierarchical tree and 
'dropped' into the drawing.

4. The Product or Planogram can be double clicked to activate it for insertion.

5. You can click on the Add Product or Add Planogram icons.

Constraints on Products that can be Added  

Product Effective or Product Expired dates outside File Effective date

When a drawing is created, Store Manager allows you to set an effective date for when 
that file will become active. Products that have a Product Effective Date (when they 
become current) after the File Effective Date will not be capable of being added to that 
drawing.

Products that have a Product Expired Date (when they become historical) before the 
File Effective Date will not be capable of being added to that drawing. This will 
prevent products that will not be current or will be historical at the date of 
implementation of the Store Plan being added to that drawing.

Products those are not current for the active store plan will be grayed out in the Object 
Browser and the Object Grid.
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Placed Products Expiring before File is Effective

Placed products that have Product Expired Dates (dates when the product will revert 
to historical status) before the File Effective Date will be transparent and colored grey 
in the graphic for the Merchandise Report and Merchandising window. The row in the 
Merchandise Report that refers to the expired product will also be grayed.

This will allow you to readily identify placed products that have become historical and 
need replacement.

Selecting the Required Fixture(s)  

The exact method of selecting the required fixtures will depend on the settings within 
the Configuration Module.

Pick Near Position selects the nearest position from a range of fixtures previously 
selected using Macro Space Management tools.

1. If there is more than one bay to be placed, then you are prompted to pick another 
point to indicate the direction of placement.

2. If one of the bays adjacent to the first selected fixture is already populated, that 
direction is automatically excluded as a possibility and the opposite direction 
selected.

3. If both fixtures adjacent to the first selected fixture are already populated, you are 
prompted to select another bay - the process continuing until the whole 
planogram has been placed.

4. You can cancel the product or planogram placement at any time by pressing 
<Enter>, <Escape> or right clicking.

Standard Select uses the standard Planner selection boxes to pick the fixture(s). If 
this method is used, Planner filters by layer, eliminating any fixtures that are not 
on the required layer. It will then determine groups of runs from fixture 
adjacencies and start placement at the left most fixture.

For all selection methods, selected fixtures change from solid to dotted outlines, 
and the insertion point will show as a small blue square.

Placing the Products or Planograms  

Once the required fixtures have been selected, together with the required products or 
planograms, clicking on the add product or add planogram icon results in the 
fixture(s) being populated.

The fixture(s) will be annotated with the number and description of the product or 
planogram placed.

Editing Definitions of Products or Planograms  

Editing Product Definitions  

Note: If a file has not been given an effective date, all products will 
be available. If products are copied from one drawing to another, they 
will be placed in the drawing even if their product dates are not valid 
for this file.

This functionality does not apply to planograms, which have parallel 
mechanisms for version change and planogram substitution.
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Clicking on the Edit Definitions icon in the Products toolbar opens Product Studio.

Figure 3–121 Products toolbar - Edit Definitions

If Product Studio is already open, it will be made the active window. The currently 
selected product is displayed for editing.

Figure 3–122 Product Studio - Edit

Once changes have been made and saved, they can be used within Merchandising 
after the Refresh option has been used on the Object Browser.

Editing Planogram Definitions  

To Edit a Planogram:

1.  highlight the required planogram in the hierarchy and right click to bring up the 
pop-up menu.

Note: The Product Studio dialog box that opens depends on what 
level in the product hierarchy has been selected.
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Figure 3–123 Planograms toolbar - Edit Planogram

2. If the merchandiser module is already open, it will be made the active window. 
The currently selected Planogram is displayed for editing.

Figure 3–124 Planogram - Edit

Once changes have been made and saved, they can be used within Merchandising 
after the Refresh option has been used on the Object Browser.

Removing Products or Planograms from Fixtures  

Products or planograms can be removed from fixtures using the remove icons.

Option that is currently active depends on whether you have selected Products or 
Planograms in the Merchandising hierarchical tree.

To remove a product or planogram:



Merchandising

3-98 Oracle® Retail Macro Space Management  User's Guide

1. Select the fixture from where they are going to be removed.

2. When all required fixtures have been selected, click on the appropriate remove 
icon.

If the Always show selection dialog is enabled in the Merchandising tab of the 
Configuration module, then a dialog box is displayed to confirm the items to be 
removed. If the Always show selection dialog is not enabled, then the dialog box is 
displayed if more than one fixture is selected.

Figure 3–125 Merchandising tab - Always show

The number at the top of the dialog box is the fixture number. Options available on the 
dialog box to delete bay and planogram are mutually exclusive options selected by a 
radio button.

■ Delete Bay removes the planogram from the selected bay only.

■ Delete Whole Planogram removes the planogram from all bays that it has been 
placed in.

When the selection has been made, click OK to remove the product or planogram, or 
cancel to retain it.

Reverse Planogram Population Direction  

Option that is currently active depends on whether you have selected Products or 
Planograms in the Merchandising hierarchical tree.

When placing the planogram, it reverses the order of the profiles, and within each 
profile, it reverses the positions of the products. A left justified planogram is right 
justified, and vice versa.
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Product and Planogram Operations  

Highlight Where Used in Store  

The Highlight where used in Store icon enables products or planograms selected from 
the appropriate hierarchical tree to be highlighted on the drawing.

Figure 3–126 Highlight Options

You can toggle this option On or Off. To toggle the option on, click the icon. which 
shows as pressed on the toolbar. To toggle the option off, click the icon again. When 
off, the icon is not pressed in.

To highlight a product or planogram find the required item in the hierarchical tree and 
click on it. The item is highlighted in the drawing - the exact method of highlighting 
depending in the options selected in the Configuration Module.

Highlight Selected Item from Tree  

The Highlight Selected Item from Tree option enables products or planograms selected 
from the appropriate hierarchical tree to be highlighted when they are selected in the 
drawing.

Figure 3–127 Highlight Options

You can toggle this feature On or Off. To toggle the option on, click on the icon, which 
then shows pressed on the toolbar. To toggled the option off, click on the icon again. 
When off, the icon is not pressed in.

Note: It is recommended this option be only selected when required. 
When activated, (toggled on), it takes up processing capacity. Leaving 
this option toggled on when not required will slow other operations.

Note: It is recommended this option be only selected when required. 
When activated, (toggled on), it takes up processing capacity. Leaving 
this option toggled on when not required will slow other operations.
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To highlight a product or planogram find the required item in the drawing and click 
on it. The item is highlighted in the hierarchical tree - the exact method of highlighting 
depending in the options selected in the Configuration Module.

Find Product or Planogram  

The Find Product/Planogram function is accessed by clicking on the Search icon in the 
Merchandising toolbar.

Figure 3–128 Find Product/Planogram

This brings up the Find Product (or Find Planogram) dialog box.

Figure 3–129 Find Product dialog box

Type the required search string into the Find box and click the Search icon. This will 
bring up a list of any blocks matching the search string.

Left click on any result to return to the Merchandising Products Window, where the 
selected Product or Planogram will be highlighted in the hierarchy tree.

Configuration Options  

The Zones tab in the Configuration module can be called by clicking on the 
Configuration icon on the Zones toolbar.
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Figure 3–130 Zones toolbar - Configuration

This brings up the Zones Tab.

Figure 3–131 Configuration - Zones Tab

This dialog box contains a series of check boxes controlling the way Zones display.

Options

■ Auto Close: if a point in the zone being drawn is within the specified Proximity of 
the first point drawn, the zone will automatically close or complete drawing.

■ Hatch Zones: determines whether the Zones drawn are color coded or not when 
the zone is first drawn. Hatching may be added later using the hatch commands.

■ Hatch over Text: determines whether the hatch pattern leaves a gap for the zone 
text or not.

■ Detect Clashes: determines whether Zones on the same layer, (i.e. the same type), 
overlap each other.

■ Prompt for Name: allows to locally rename the zone when first drawn.
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Highlight Options - determines how the zone highlights in the drawing if the 
'highlight in drawing' option is selected in the Object Browser.

■ Thicken Boundary: increases the thickness of the Polyline used to draw the Zone.

■ Flash: makes the Zone boundaries to flash.

■ Zoom: when the Zone is selected, it zooms, (expand) either to the limits of the 
drawing, or by the scaling factor set in the Max Zoom Scale parameter.

The Refresh Option  

The Refresh icon refreshes both Planogram and Product information in the 
hierarchical tree.

Figure 3–132 Products Tab - Refresh

Using Refresh ensures that the information is brought up to date with any changes 
made in Merchandiser or Product Studio, both to the hierarchical tree and to any 
products or planograms added to, edited, or deleted from it.

Annotation  

Annotation is used to label fixtures within a drawing. The number is the product or 
planogram identification code. Annotation also displays the name of the product or 
planogram. Products or planograms are annotated when placed, but the annotation 
requires refreshing when they are moved or deleted.

Refreshing Annotation  

To refresh annotation in the drawing:

1. From the Modify menu, select the Text options.

2. Select the required objects in the drawing.

3. Right click to stop selecting objects. All selected objects will be re-annotated.

Merchandiser  

Merchandiser module can be accessed from the Edit Planogram option from the 
pop-up menu in the Object Browser.
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Figure 3–133 Merchandising - Edit Planogram

Merchandiser allows the planograms and the fixtures on which they have been placed, 
to be viewed in a Virtual Reality (VR) 3D environment. Using the provided controls, 
you can move around the VR store.

Merchandiser is also used to design and edit planograms and to place them in a 3D 
environment.
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Figure 3–134 Merchandiser Module

Planograms can be designed in varying levels of detail. These planograms can be 
arranged in a hierarchy and subsequently used to populate a store.

Product Studio  

Product Studio module can be accessed using the Edit Definition option in the toolbar 
in the Merchandising tab of the Object Browser.

Product Studio allows the design and editing of product images. These images can be 
arranged in a hierarchy and subsequently used to populate a store. Options within the 
module allow attributes to be assigned to each product, giving it intelligent properties.
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Figure 3–135 Product Studio

Measuring Performance - Key Performance Indicators  

Key Performance Indicators (KPI) allows the performance of a merchandised layout to 
be evaluated. Click the KPI tab in the Merchandiser Object Browser to view the 
hierarchy of Key Performance Indicators. KPIs color-code the drawing according to 
configurable criteria. This allows views to see the performance of merchandised layout 
at a glance.

Calculations
Macro Space Management provides for the manual initiation of a series of calculations. 
Some of these assist functionality in the drawing. Others are useful for reporting 
purposes. They can be initiated from the Calculations menu or the Calculations 
toolbar.
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Figure 3–136 Calculations menu

Macro Space Management provides the following types of calculations:

■ Area Calculations

■ Space Measures

■ Face Planes

■ Fixture Adjacency

■ Product Adjacency

■ Aisle Adjacency

Area Calculations
Area calculations are used to apportion the area enclosed by the Total Building 
(Internal Area) zone to specific fixtures. Area calculations are initiated by selecting the 
Calculate Areas option from the Calculations menu or the Calculations toolbar.

Figure 3–137 Calculations menu - Area calculations

A window appears showing the progress of the calculation.
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Figure 3–138 Window Showing Calculation Progress

Once area calculations have been carried out, they can be used for several purposes:

■ Area apportioned to fixtures can be used to color a drawing using the appropriate 
KPI. This will show by means of color coding the area in square feet apportioned 
to each fixture.

■ Areas apportioned to fixtures can be output in the form of a tabulated report via 
the Reporting tool.

■ Areas apportioned to fixtures can be used for other calculations, for example to 
show the profit per square foot of allocated area for that fixture, via the Reporting 
tool.

Space Measures
Space Measures are used for reporting purposes. Space Measure calculations are 
initiated by selecting the Calculate Space Measures option from the Calculations menu 
or Calculations toolbar.

Figure 3–139 Calculations menu - Calculate Space Measures

A confirmation message appears when the calculation is complete.

The information can then be used in the Reporting tool to report such information as:

■ Base Linear for products

■ Shelf Linear for products

■ Product display volumes
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Face Planes
Face Planes are used to calculate the area (in percentage) each product (SKU) takes in a 
planogram when viewed from the front. For example, the Men's Shirts planogram 
might have a frontal area of 16 square feet, with Walmart Own Brand shirts taking up 
15% of the available space.

Face Planes are used for reporting purposes. Face Plane calculations are initiated by 
selecting the Calculate Face Planes option from the Calculations menu or Calculations 
toolbar.

Figure 3–140 Calculations Menu - Calculate Face Planes

Fixture Adjacency
When fixtures (blocks) are first inserted into a drawing the data is written into the 
central database. As yet the database contains no information on the physical 
relationship of one fixture to another.

When the fixtures adjacent to each other are known, the nature of the relationship of 
adjacent fixtures is further specified. They can then be defined as being to the left or 
right or a specific fixture. The calculation of Fixture Adjacency is initiated by selecting 
the Calculate Fixture Adjacencies option from the Calculations menu or Calculations 
toolbar.

Figure 3–141 Calculations Menu - Calculate Fixture Adjacencies

Once the relationships of fixtures are known relative to one another, this information 
can be used for several purposes. These include:

Note: If fixture positions are being modified or if fixtures are being 
deleted using AutoCAD tools, then the Synchronization Module must 
be run at intervals to ensure the information held in the Macro Space 
Management central database is the same as that held in the drawing.
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■ Determining what arrangements of fixtures should be treated as gondolas.

■ Bay Numbering and Bay Groups.

■ As a preparation for Product and Aisle Adjacency calculations.

Aisle Adjacency
Aisle Adjacency allows you to determine which fixtures (and hence which products) 
share an aisle. This information is used for reporting purposes.

Aisle Adjacency is used as follows:

■ Aisles are drawn in a store plan. (This can only be done in the Planner module).

■ The Aisle Adjacency option is run from the Calculate Menu.

■ Reports are used to establish which products or planograms share an Aisle.

Adding, Editing and Deleting Aisles
Aisles can only be added, edited, and deleted in the Planner Module. This is done 
using the Aisles toolbar.

Adding an Aisle
To Add an Aisle click on the Add Aisle option in the Aisles toolbar. This brings up the 
Aisle dialog box.

Figure 3–142 Aisle dialog box

Enter an Aisle name and click OK. This Aisle name must be unique within a store 
plan; else, a warning message is displayed.
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If the Aisle name is unique, the user will be taken to the drawing. The line 
representing an Aisle can be drawn using standard AutoCAD methods. Pressing 
<Enter> will complete drawing the aisle.

In the above example six Aisles have been drawn. Each fixture will belong to one (and 
only one aisle).

Editing an Aisle
To edit an Aisle, click on the Edit Aisle option in the Aisles toolbar. The cursor in the 
store plan will change to a box. Click on the required Aisle to select it. The outline will 
turn to dotted.

Right click to complete the selection process. The Aisle dialog box appears.
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The name of the Aisle can then be edited. On clicking OK, the aisle name will be 
changed (but must still remain unique).

Deleting an Aisle
To delete an Aisle, click on the Delete Aisle option in the Aisles toolbar. The cursor in 
the store plan will change to a box. Click on the required Aisle to select it. The outline 
will turn to dotted. (Aisles can be multi-selected with successive left clicks.

Right click to complete the selection process. The selected Aisles will then be deleted 
without any further confirmation.

Aisle Annotation and Scales
Each Aisle has annotation at the start. The size of the annotation is controlled by the 
Scale set for the drawing/store plan.

To set the scale for the drawing, select the Drawing Setup option from the Format 
menu. This will bring up the Setup dialog box.

Figure 3–143 Setup dialog box

Select a scale that will be appropriate when the store plan is set up for printing in 
paper space.

Running the Aisle Adjacency Calculation
The Aisle Adjacency calculation can currently only be run in the Planner Module. To 
do this first ensure the store plan has been synchronized as appropriate to ensure the 
drawing matches the database. Then select the Calculate Aisle Adjacencies option 
from the Calculations Menu.

Figure 3–144 Calculations Menu - Calculate Aisle Adjacencies
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The Aisle Adjacency calculations will then run and the results will be stored in the 
database. When complete, a confirmatory dialog will appear.

The results can then be accessed via a report - for example via a tool like BI Publisher.

Aisle Adjacency Calculation Technicalities
The following criteria apply to Aisle Adjacency Calculations:

■ Only Fixtures are included in Aisle Adjacency Calculations. Fittings and shelves 
are excluded from the calculations.

■ Each fixture can only be associated with a single aisle in a store plan. If there are 
multiple aisles within the distance specified by the ADJACENCY_AISLESIZE 
system variable, the fixture will be associated with the aisle within the shortest 
distance.

■ Fixtures are associated with an Aisle if the distance from the front of the fixture is 
within the distance set in the ADJACENCY_AISLESIZE System Variable. The 
ADJACENCY_AISLESIZE System Variable (set using the System Variables option 
on the General Menu in the Admin Module) determines the maximum distance a 
fixture can be from an aisle and still associated with it.

The distance to the Aisle is measured perpendicular to the centre of the front of the 
fixture. If the fixture is at an angle to the Aisle (as in the diagram above) the distance 
from the fixture to the Aisle may exceed the value set in the System Variable.

Distance from Start of Aisle  

Distance from the start of the aisle and distance from the aisle are measure relative to 
the centre of the front of the fixture. For a straight, single segment aisle, 'distance from 
start of aisle' is measured as follows. Note how the distance does not increase by linear 
increments.

Note: The Front Direction of the fixture is set on the Insertion Tab of 
the Block details dialog box in Fixture Studio.
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For a multi-segment aisle, the situation is more complex.

The distance is still measured from the start of the aisle, but may be deceptive. In the 
above example, Fixture 4 may show as closer to the start of the aisle than Fixture 3.

Distance from Aisle  

For a single segment aisle, the distance to the aisle is measured perpendicular to the 
centre of the front face of the fixture.

For a multi-segment aisle, the distance is measured from the nearest face.

Note how Fixtures 2 and 3 will have the distance measured to the second segment of 
the aisle.

Note: If the distance from the Aisle is greater than that set in the 
ADJACENCY_AISLESIZE System Variable, the fixture will not be 
shown as belonging to the aisle.
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Setting Up Aisle Adjacency Reports
Generating reports on Aisle Adjacency requires extracting information from the 
database. A simplified version of the table structure is shown below for 
Administrators wishing to customize reports. 

Synchronization
Data is stored in two ways within the Planner environment. Data stored in an 
AutoCAD drawing is retained in the dwg file that contains all the pertinent 
information. Macro Space Management also stores information in its central database. 
Macro Space Management is integrated with AutoCAD. However, some AutoCAD 
tools can modify AutoCAD drawings in ways that are not registered by Macro Space 
Management's central database. For example, if AutoCAD tools are used to move or 
delete fixtures or gondolas from the drawings, this does not alter the information held 
in the Macro Space Management database.

Potential differences between the AutoCAD drawing and the information held in 
Macro Space Management must be resolved. This is done using the Synchronization 
option. After data has been synchronized, the information held in the AutoCAD 
drawing is identical to that held in the Macro Space Management central database.

Merchandiser only operates on data held within Macro Space Management's central 
database. If a drawing is worked on the Merchandiser environment, any changes will 
not be reflected in the drawing when it is next opened in the Planner environment. 
Accordingly, when a drawing is opened in the Planner environment after being 
worked on in the Merchandiser environment, it must be 'synchronized to database' in 
order to bring the drawing up to date with the changes made in Merchandiser.

Adjacency Calculations
Adjacency calculations are used to establish the relationships of fixtures and 
merchandise to each other. Before running adjacency calculations, it is good practice to 
run Synchronization. This ensures that the information in the drawing matches that in 
the database and hence any adjacency calculations will be correct.

Note: Refer Oracle Retail Macro Space Management Data Model for 
more information.
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Figure 3–145 Relation between Adjacency and Synchronization

Saving and Synchronization
Each time a Macro Space Management command is used, the information is written 
directly to the database at the same time as a change is made in the drawing. (These 
commands are also held in temporary memory so that 'undo' commands can be used).

Each time an AutoCAD command is used, changes are made to the drawing, but are 
not written to the central Macro Space Management database. This can lead to 
differences between drawing and database.

When working in Planner, it is therefore good practice to synchronize the drawing 
immediately before saving and exiting.

The working environment in the Merchandiser is a virtual reality environment. All 
changes made to the store plan are written directly to the database.

When a drawing is subsequently opened in the Planner (CAD) environment, these 
changes are not incorporated in the drawing. Before the drawing can be worked on in 
the Planner (CAD) environment, it must first be updated with the latest information in 
the database. This is done through Synchronization.

Using Synchronize button
To synchronize data:

1. Select the Synchronize button from the Planner toolbar. Alternatively, select the 
synchronization option from the File menu.
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Figure 3–146 Synchronize Button

The Synchronization dialog box appears.

Figure 3–147 Synchronize Dialog Box

2. To synchronize the changes from the Merchandiser environment into the Planner 
(CAD) environment, select the following settings:

■ Set to Match the Database.

■ Check the following items to synchronize:

■ Fixtures

■ Shelves

■ Products

■ Other Blocks

3. Click the Synchronize button.

4. Click the Exit button.

The Planner (CAD) drawing now contains all the changes made in the Merchandiser 
environment.

Note: When opening a Planner (CAD) drawing after modifying it in 
the merchandiser diagram it is very important to select the Match the 
Database option. If the Match the Drawing option is selected, all 
changes made in the Merchandiser environment will be lost.
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Accessing the Synchronization Module
You can access the Synchronization option from the File menu in Planner.

Figure 3–148 Synchronization Option

This dialog box allows the type of synchronization to be selected by means of the 
Action frame in the upper right corner of the dialog box. The types of items to 
synchronize can be selected by means of the Items to Synchronize frame in the centre 
right of the dialog box. The current status of the synchronization can be seen in the 
main frame of the dialog box. This details the information held in the drawing only 
and in the database only. It also displays totals of identical and different items.

Selecting Items to be Synchronized  

The items that can be synchronized are detailed in a small check box frame in the 
Items to Synchronize dialog box s shown in the image above.

One or more options can be selected by ticking the appropriate check box:

■ Fixtures ensures all fixtures, fittings and gondolas are synchronized.

■ Shelves ensure all shelves are synchronized. This may be necessary when 
planograms have been used to populate features with product and the planogram 
contains information on what is on the varying shelves within the fixture. It may 
also be necessary if shelves have been added to fixtures in the Merchandiser 
environment.

■ Products ensure all products placed as products or using planograms are 
synchronized.

Note: The Planner (CAD) environment only displays products down 
to SKU level. Accordingly, shelves that were merchandised at display 
style level in Merchandiser shows as empty in the Planner (CAD) 
environment.
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■ Other Blocks enables additional drawing features such as blocks representing 
lights or power-points to be synchronized.

■ Zones enable Zone locations to be synchronized.

■ Views enables views (temporary tables in the database) to be synchronized.

■ Aisles enable the physical position of Aisles to be synchronized.

Setting Synchronization Options  

The varying options for synchronization are selected using radio buttons. Only one 
action may be selected.

■ Match the Drawing updates the central database with all AutoCAD changes to 
the drawing made since the last synchronization. No changes will be made to the 
drawing, and all new information in the drawing will be stored in the database.

■ Match the Database restores the drawing to the last version held in the central 
database. All AutoCAD changes made to the drawing since the last time the 
drawing was synchronized with the database will be removed.

■ Merge updates the database based on data held in both the drawing and the 
database. If objects exist in both the drawing and database, but there are slight 
differences between them (for example in position) which data will be used 
depends on whether merge priority is given to the drawing or to the database.

■ Only Keep Identical updates the drawing with only those objects common to both 
the drawing and the database. All objects in the drawing that are not identical 
with objects held in the central database will be removed from the drawing. 
Similarly, all objects in the central database that are not identical with objects on 
the drawing will be removed from the database.

Identifying Items in Specified Categories  

The Synchronization Module dialog box contains tabulated lists of objects in specified 
categories. For example there are 606 Fixtures that are Identical in both Drawing and 
Database and there are 24 shelves in the Database only.

If the mouse pointer is poised over a category of information with items in it, a 
question mark appears. This indicates that left clicking on the category will bring up a 
dialog box.

The dialog box contains a list of all objects:

Note: All changes made to drawings using Macro Space 
Management tools are stored in the central database at the same time 
as the action is carried out. All changes made to the drawing using 
AutoCAD tools are only stored in the drawing. Synchronization 
means drawing and database contain identical information.
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Figure 3–149 Synchronization

■ Item specifies the type of object. These are normally blocks, but can also be Views 
or other types of Macro Space Management options.

■ Name is the user input file name of the block.

■ Difference specifies whether the objects are in the drawing only, database only or 
are identical.

■ Handle is the AutoCAD handle. This handle is the unique alphanumeric tag for an 
object in that specific drawing.

Clicking OK returns the user to the main Synchronization dialog box.
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4Merchandiser

Merchandiser allows you to work in a 3D virtual reality environment and allows 
details to be seen at a greater level of granularity such as the shelf and display style.

Using the Merchandiser module, you can use store plan from Planner, fixtures from 
Fixture Studio, products from Product Studio and planogram definitions either 
imported or from Merchandiser. Some of the functions of Merchandiser are:

■ Ability to link to Store Manager to allow management of store plans.

■ Laying store plans using fixtures, fittings and gondolas.

■ Populate fixtures and gondolas with products or planograms.

■ Populate fixtures with shelves, pegs, and other equipment.

■ Populate fixtures, shelves, pegs and other equipments with SKU products in the 
appropriate display style.

■ Annotate drawings with information.

■ Display information such as sales areas allocated to fixtures.

Overview of Relationships between other Modules
The settings made within Merchandiser are affected by and interact with settings 
made within other modules within Macro Space Management.

Figure 4–1 Relationship between Merchandiser and other Modules

Administration Module
The following can be configured within the Admin module:
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■ Available Status

■ List of possible Styles

■ User Defined Attributes

Configuration Module
The following can be configured within the Configuration module:

■ Connection Point Appearance

■ Connection Point Filters

■ Merchandising Check Rules

■ Settings affecting how the Merchandiser environment displays.

Fixture Studio
The following can be configured within the Fixture Studio module:

■ Fixture and Gondola Hierarchies

■ Visual appearance of Fixtures

■ Fixture Definitions

■ Gondola Definitions

■ Connection Points

■ Fixture and Shelf Styles

Product Studio
The following can be configured within the Product Studio module:

■ Product Hierarchy

■ Visual appearance of Products

■ Styles

■ Peg Holes

Difference between Merchandiser and Planner
Some of the differences between the Planner and Merchandiser modules are:

■ Zones are read-only in Merchandiser

■ Shelves can only be added in Merchandiser

■ Products can be added at Display style level in Merchandise. In Planner they can 
only be added as placeholders.

■ Merchandiser allows details to be seen at a greater level of granularity. In Planner, 
you can only see data at Fixture Level and SKU. In Merchandiser, you can see data 
at shelf and display style level.

Relationships between Merchandiser and Other Modules

Merchandiser and the Admin Module
Some Administration Module settings determine how Merchandiser behaves.
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Styles  

Styles determine which fixtures, shelves and products are compatible with each other.

Statuses  

Statuses determine which fixtures, planograms and products appear in the hierarchies 
in the Object Browser.

UDAs (User Defined Attributes)  

UDAs determine what customer specific information can be associated with fixtures, 
shelves and products.

Configuring the Available Statuses
The list of Statuses can affect which fixtures, planograms and products appear in their 
respective hierarchies in the object browser. Objects of Proposed or Historical status 
many not appear.

The list of available Statuses can be configured using the Status option on the General 
menu in the Admin Module. For more information refer the Oracle Retail Macro Space 
Management Administration Guide.

Configuring the List of Styles
The List of Styles is used to determine which fixtures, shelves and products are 
compatible with each other. Objects with incompatible styles are not allowed to be 
placed on each other.

The List of Styles can be configured using the Styles option on the Merchandising 
menu of the Admin Module. For more information refer the Oracle Retail Macro Space 
Management Administration Guide.

Note: For more information consult the Admin Module Help File - 
please be aware that access to the Admin Module is only available to 
users with Administrator's privileges.
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Configuring User Defined Attributes
The list of User Defined Attributes is used to add user specific information to fixtures, 
shelves and products. The List of User Defined Attributes (UDAs) can be configured 
using the User Defined Attribute option on the Edit menu of the Admin Module.

For more information refer the Oracle Retail Macro Space Management Administration 
Guide.

Configuration

Merchandiser and the Configuration Module  

Settings in the Configuration Module affect how connection points and merchandising 
operate. They also determine some aspects of the visual appearance of Merchandiser.

Figure 4–2 Connection Points

The visual appearance of connection points can be changed in the Configuration 
Module, as can the filters determining whether one connection can mate to another.

Merchandising behavior  

Filters determining merchandising behavior can be set in the Configuration Module.

Merchandiser Appearance  

A number of parameters affecting how Merchandiser appears on screen can be set in 
the Configuration Module.

Connection Points  

Connection Points determine how one piece of equipment connects to another.
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They are configured in the Connections tab of the Block Details dialog box in Fixture 
Studio.
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Figure 4–3 Block Details dialog box

Connection point details can only be changed in Fixture Studio.

Merchandising  

Some details of how Merchandising operates are determined by settings in the 
Configuration Module.

Note: For more information consult the Fixture Studio Help File.
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Figure 4–4 Configuration Module

Specifically, some options in the Check Rules frame can be turned on or off. These 
include Size, Range and Style.

Merchandiser  

Some aspects of the visual appearance of Merchandiser are determined by settings in 
the Configuration Module.

Figure 4–5 Configuration Module
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These include:

■ Whether express load (only load specific zones) is active.

■ Whether changes can be made to equipment and merchandise when not in the 
specific tab (lock on Tab Change).

■ Default settings for front and back clipping distances.

■ Colors for Sky, Ground, etc.

■ For more information refer the Oracle Retail Macro Space Management 
Configuration Guide.

Merchandiser Controls

Shortcut Keys
These shortcut keys provide alternatives to call the required function from the toolbar 
menus. Some of the shortcut keys are listed below.

■ General Shortcuts

■ Display Shortcuts

■ Editing Shortcuts

General Shortcuts

Display Shortcuts

Table 4–1 General Shortcuts

Shortcut Keys Also available from Function

<Ctrl> + O File Menu or 
Standard Toolbar

Open Drawing (Via 
Store Manager)

<Ctrl> + P Standard Toolbar Show Print Preview

<Ctrl> + <Shift> + C File menu Show Configuration 
Module

<Ctrl> + S File menu Save Drawing

<Ctrl> + Q File menu Quit Application

<Ctrl> + N File menu Create New 
Planogram

F8 View Menu Show/Hide Object 
Browser

Delete N/A Delete all selected 
objects

Table 4–2 Display Shortcuts

Shortcut Keys Also available from Function

<Ctrl> + F Edit menu Display Find 
Dialogue
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Editing Shortcuts

Menu Bar

File Options Menu
The File menu gives access to creating and editing of planogram definitions, accessing 
Store Manager, Printing and accessing the Configuration module.

<Ctrl> + L Directions and 
Product Text Toolbar

Display Layers 
Dialogue

F12 View Menu Take snapshot of 
Virtual Reality Store

Table 4–3 Editing Shortcuts

Shortcut Keys Also available from Function

<Ctrl> + G Edit menu Toggle Group On or 
Group Off

<Ctrl> + A Edit menu Select All

<Ctrl> + E Edit menu Empty selected 
fixture/shelf of 
products

<Ctrl> + C Edit menu Copy the Selected 
Products to the 
Clipboard

<Ctrl> + X Edit menu Cut the Selected 
Products and Paste 
on Clipboard

<Ctrl> + V Edit menu Paste the Selected 
Products onto the 
selected fixture/shelf

<Ctrl> + Z Edit menu Undo last action

<Ctrl> + D Edit menu Deselect all selected 
objects

<Shift> + up or down 
cursor keys

N/A Move selected shelf 
up or down on 
parent object

Table 4–2 (Cont.) Display Shortcuts

Shortcut Keys Also available from Function
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Figure 4–6 Merchandiser - File Menu

Edit Options Menu
The Edit menu gives access to various editing options.

Figure 4–7 Merchandiser - Edit Menu

■ The Undo and Redo options allow you to undo or redo recent actions.

■ Cut, Copy and Paste allows you to carry out those operations on objects in the 
drawing.

■ Select all, De-select all, Empty and Delete enables you to carry out bulk operations 
on the drawing.

■ Group On or Snap Off determines how Families and Groups are selected.

■ Edit Mode ON allows you to toggle between the Walk and Edit mode.

■ Connections OFF allows to switch off or on the connection points.
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■ Size Rule allows you to specify if the product size has to be taken into account 
when placing products on shelves.

■ Undo 

■ Put Product on Nearest Shelf places a product onto the peg nearest to the mouse 
cursor when adding individual hung products. Select from the On or Off options.

■ Add Shelf With Product Silently allows you to set the option to On or Off when 
adding a product on a shelf that is not added in the drawing. If set to On, the 
product will be added along with the shelf. For example if a product goes on a 
peg, and the peg is not there, the peg will be added along with the product 
(providing a joint has been set up in the Styles option in Admin).

■ Check Merch Area on POG Save checks that the merchandise in a planogram 
(POG) design is within the bounds of the merchandisable area. If set to ON, it 
checks there is no merchandise overhanging the edges of shelves/fixtures.

■ Fixture Notation allows you to configure the fixture annotation.

View Options Menu
The View menu options allow you to specify a number of options affecting the view 
on screen.

Figure 4–8 Merchandiser - View Menu

■ Find enables you to find an object in the drawing.

■ Record Path, Stop Record Path, Replay Path and Delete Path allow you to 
configure a path specified though the drawing for the purpose of making a Virtual 
Reality movie of the store layout.
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■ Start Animation Recording, Stop Animation Recording and Replay Last 
Recorded Animation are options concerned with Virtual Reality movies of the 
store layout.

■ Set 4 ViewPorts determines how many views of the virtual store are available.

■ Pivot Around Selected Object enables you to select an object in the drawing to 
rotate around.x

■ Properties

■ Hide/Show Object Browser enables you to either hide or show the Object 
Browser.

■ Show Object Grid

■ Toolbars allows you to turn the display of specific toolbars On or Off.

■ Windows enables you to select the Move, Rotate, Views or Camera window 
dialog boxes.

■ Take Snapshot Image allows you to take a printable image of the Virtual Reality 
store.

■ Plan View, Grid Line, Zones and Layers all affect display options in the Virtual 
Reality environment.

■ Product Notation and Display Products As also affect display options in the 
Virtual Reality environment.

■ Reports brings up Quick Reports

Product Options Menu
The Product menu Options enables you to update Product Dimensions. It also allows 
access to Product Studio.

Figure 4–9 Merchandiser - Products Menu

Light Options Menu
Light sets the light intensity level in the Store Plan. Light levels can be increased or 
decreased by using the slider on the Merchandiser toolbar. The effect depends on 
whether the light is generic, or has been set up using the Edit Lights option.
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Figure 4–10 Merchandiser - Lights Menu

The Lights menu allows you to specify the light arrangements for the store. This 
allows you to specify the lighting arrangements for the store. This dialogue box may 
also be called from the Lights Toolbar.

Figure 4–11 Light Menu

Using the Lights Dialog box, you can add, delete, zoom in, zoom out, zoom to fit, and 
refresh the information in the drawing.

Calculation Options Menu
The Calculate menu Options gives you access to area, Face Plane, and Adjacency 
calculations.
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Figure 4–12 Merchandiser - Calculate Menu

Calculate Areas
Calculate Areas gives a visual indication of how efficiently space in the store has been 
allocated. Each registered fixture definition defines the directions in which it faces 
North, South, East, or West relative to the block. For each fixture, it will create a 
boundary around it in each direction until it hits another fixture or until it reaches its 
defined tolerances.

Selecting this option brings up the Area Calculation window.

Figure 4–13 Area Calculation window

Calculate Face Planes
Calculate Face Planes looks at space from a front view perspective, so that if there 
were two categories on a fixture, it determines what proportion of space is given to 
each category.
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Calculate Face Planes is a customer specific requirement, and may not be enabled in 
generic implementations of Merchandiser.

Calculate Adjacencies
Calculate Adjacencies calculates which fixtures and which products are adjacent to 
each other determines. Having determined which other fixtures are adjacent it then 
works out whether it is to the right, to the left, in front, behind, above, below or 
opposite. Next it will work out sequence numbers, and group fixtures together by 
giving them the same number.

While the calculation is in progress, a window will give a visual indication of the stage 
it has reached.

Window Options Menu
The Window menu options allows you to arrange multiple store plans (if open) and 
select the which store plan you wish to be active.

Figure 4–14 Merchandiser - Window Menu

Help Options Menu
The Help menu options gives access to the online help file and check the version of the 
software.

Toolbars

Animation Toolbar
The Animation Toolbar enables you to define store walk through paths for taking 
movies. It also allows you to record movies of the store layout in the Virtual Reality 
Environment.

Figure 4–15 Animation Toolbar

The varying Path options allow you to set, edit, or delete a path along which a 
recording takes place.
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The Recording options allow you to make movies of the Virtual Reality store, either by 
controlling the camera directly, or by setting it to follow a predefined path.

Directions and Product Text Toolbar
The Directions and Product Text toolbar is mainly concerned with views of selected 
objects.

Figure 4–16 Directions and Product Text Toolbar

After an object (or objects) has been selected it may be viewed from any of six axis or 
four isometric directions. Other options specify whether zones, gridlines, etc., display.

Formatting Toolbar
The Formatting toolbar has a whole series of options concerning the appearance of 
annotation in the Virtual Reality store.

Standard Toolbar
The Standard toolbar enables you to carry out a series of common actions.

View Toolbar
The View toolbar enables you to set varying options for viewing the Virtual Reality 
environment.

The Align Products Toolbar
The Align Products toolbar allows shelves or products to be aligned.

Movement in the Drawing
Moving in the drawing can be done in several ways. These are:

■ General movement with the mouse

■ Holding down the left mouse key enables you to move viewpoint forward and 
back and to rotate left and right.

■ Holding down the right mouse key enables you to move viewpoint up and 
down and left and right.

■ Using the mouse wheel enables you to rotate the viewpoint up and down.

Note: There are no tooltips for the Movement Speed, Texture 
Quality, Level of Detail, Front Clipping Plane and Back Clipping 
Plane sliders. Instead, they show as prompts towards the right hand 
end of the status bar.
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■ Pivoting about a selected object: This option allows you to circle around a selected 
object in the drawing.

■ Viewing objects from selected directions: This option allows you to view an object 
from one of ten perspectives by selecting it, then clicking on the appropriate icon.

In addition you can select a plan view, to choose the general section of the Virtual 
Reality environment to view.

Plan View
The plan view is a simplified overhead view of the Virtual Reality store. The mouse 
position within the store can be changed by 'dragging and dropping' the camera icon 
within this view.

The Plan View Option can be activated from the Plan View option on the View Menu.

Figure 4–17 Plan View

This shows a plan view of the store and the current position of the camera within the 
store. The camera position can be repositioned by holding down the left mouse key 
and dragging it to its new position.

Mouse Wheel
The mouse wheel behaves differently depending on whether movement within the 
Virtual Reality environment is Normal or Pivoting about an Object.

■ Normal Movement: The Mouse wheel is used to change the pitch of the Virtual 
Reality View. Rotating the wheel forward increases the angle of pitch, tilting the 
camera view upwards. Rotating the wheel backwards decreases the angle of pitch, 
tilting the camera view downwards.
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■ Pivot around object: The mouse wheel is used to move forward towards or back 
from the selected object. This option is toggled on and off using the View toolbar.

Mouse Buttons

Left Mouse Button
Normal movement while holding down the left mouse button allows movement in the 
X, Y plane. The viewpoint may be moved either forward or backward or rotated left 
and right.

The position of the mouse cursor relative to the centre of the drawing determines the 
type of motion. The further from the centre, the more rapid the motion.

Right Mouse Button
Normal movement while holding down the right mouse button allows movement in 
the Y, Z plane. The viewpoint may be moved either left or right or back or moved up 
and down.

The position of the mouse cursor relative to the centre of the drawing determines the 
type of motion. The further from the centre, the more rapid the motion.

Locking Movement in Planes
The View toolbar contains several controls for restricting the available movement in 
the drawing.

The options can be toggled on and off by clicking them.

■ Lock View Position will freeze the drawing with no movement possible

■ Lock X Axis Movement will freeze the drawing with respect to left and right 
movement.

■ Lock Y Axis Movement will freeze the drawing with respect to forward and back 
movement.

■ Lock Z Axis Movement will freeze the drawing with respect to vertical 
movement.

Pivoting About a Selected Object
The Pivot About Selected Object option in the View toolbar enables you to rotate about 
a specific point in the drawing. It is toggled On and Off by clicking it.

Note: General motion speed can be set using the appropriate slider 
control in the view toolbar.

Pivoting around an object will change left mouse button behavior.

Note: General motion speed can be set using the appropriate slider 
control in the view toolbar.

Pivoting around an object will change left mouse button behavior.
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Figure 4–18 View Toolbar - Pivot About Selected Object

Click an object to select it. If the Pivot About Selected Object option has been selected, 
all movement will be relative to the selected object. Only the left mouse button and the 
mouse wheel will be enabled when this option is selected. The right mouse button will 
be disabled.

Viewing Objects from Specified Directions
Objects can be viewed from specified directions by clicking on the appropriate icons 
on the Directions and Product Text toolbar.

Figure 4–19 Directions and Product Text Toolbar - View Objects

First select the objects to be shown by <Ctrl> and left clicking with the mouse. Next, 
click on an icon to show the specified viewpoint. Depending on the icon selected, the 
selected objects can be shown from the front or back, above or below, or left and right. 
They can also be shown from one of four isometric views.

Selecting with the Mouse
One or more objects in the drawing can be selected for editing or deleting. The objects 
chosen are known as a Selection set.

■ If the chosen objects are not in a Group or Family they are known as a Simple 
Selection Set.

■ If the objects selected have previously been included in a Group they are known as 
a Group Selection Set.

■ If the objects selected have previously been included in a Family they are known 
as a Family Selection Set.

■ The selection status of selected objects can be seen from their colors.

■ Simple Selection Sets are shown in red and blue.

■ Family and Group Selection Sets are shown in yellow and green (and sometimes 
cyan).

The behavior of the selected objects sometimes varies depending on whether they are 
in Simple, Family or Group Selection Sets.

Selecting and De-selecting Objects  

Objects can be selected by holding down the <Ctrl> key and left clicking on them with 
the mouse.

Note: If Pivot About Selected Object is enabled, the selected object 
will always remain in the centre of the selected field of view.
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Standard Selection Set  

Standard Selection Sets occur when the objects are not in a Group or Family. The first 
object selected for a Standard Selection Set is enclosed in a red frame. Subsequent 
objects selected for a set of objects are enclosed in blue frames.

Individual objects can be de-selected by holding down the <Ctrl> key and left clicking 
on them with the mouse for a second time. All objects in the Standard Selection Set can 
be de-selected by holding down the <Ctrl> key and clicking on the red fame for a 
second time.

Family and Group Selection Sets  

Objects that have been put into Families or Groups are enclosed by yellow and green 
frames.

If Grouping is Off it is also possible that cyan frames are visible.

If Grouping is On, then all objects in the set can be selected or de-selected by clicking 
on any member of the set. If Grouping is Off, individual objects can be de-selected by 
holding down the <Ctrl> key and left clicking on them with the mouse for a second 
time. All objects in the set can be de-selected by holding down the <Ctrl> key and 
clicking on the yellow frame for a second time.

General De-Selection  

All currently selected objects can be de-selected by <Ctrl + D>.

Editing Objects
Objects can be edited by holding down <Ctrl> and right clicking on them with the 
mouse. This brings up the Editing menu.

Figure 4–20 Editing menu

This gives access to a wide range of options.
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Viewing the Objects

Viewports
Merchandiser can be viewed using single or multiple ViewPorts. A single ViewPort 
shows one image of the Virtual Reality Store.

Figure 4–21 Single ViewPort

Changing to 4 ViewPorts shows four images of the Virtual Reality store.
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Figure 4–22 Four Viewports

These 4 ViewPorts can either be treated as separate entities or they can be 
synchronized. If used as separate entities, they can be used, for example, to move 
merchandise from one set of shelves to another. If used when synchronized, they can 
be used, for example, to show three different KPIs (Key Performance Indicators), for 
the same part of the store.

Setting Up and Switching Between ViewPorts  

When the drawing opens, it shows a single view of the store plan. If 4 ViewPorts are 
enabled when the drawing was last saved and closed, the top left ViewPort is 
displayed when the drawing is re-opened. Starting/returning to the 4 ViewPorts 
option can be achieved using the menus or toolbars. If using the View menu, clicking 
on Set 4 ViewPorts changes the display from one to four viewpoints.

If you are already using four viewpoints, then the menu reads Set 1 view point, 
enabling you to toggle back to a single view point.
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Figure 4–23 View Menu - Viewport Options

Alternatively, you can click on the appropriate icon in the toolbar. You can toggle 
between Show 4 ViewPorts and Show 1 viewport. The Next View icon toggles 
between the available views.

Saving and Restoring ViewPorts  

While working in a Virtual Reality store, it is possible to saveViewPorts for later 
restoration. To do this, select the Windows > Views option from the View menu.
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Figure 4–24 View menu

This brings up the Views dialog box.

Figure 4–25 Views dialog box

This enables you to either save or restore specific ViewPorts.

Synchronizing ViewPorts  

The views in the 4 ViewPorts can be synchronized if required. This is achieved from 
the toolbar.
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Figure 4–26 Synchronize Viewports

Click the Synchronize icon immediately switches all four viewpoints to mirror the 
viewpoint in the currently active window. Click the Synchronize icon again to 
desynchronize the four viewpoints so that they can be manipulated independently.

Changing the Visibility of Objects  

The way objects display in a store plan can be changed in three ways in Merchandiser. 
The drawing is subdivided into layers and each class of object (fixture, fitting, product, 
etc.), has its own specific layer. By changing the properties of the layer, you can change 
the display of objects on that layer.

■ Locking the Layer - Locking the layer prevents objects on that layer being moved 
or deleted.

■ Changing the Visibility - It is possible to turn layers on or off. If a layer is turned 
on, objects on it are visible. If a layer is turned off, they are hidden.

■ Changing the Transparency - The transparency values for a layer (and the objects 
on that layer) can be changed anywhere within a range of 0% - 100%. If the 
transparency is set to 0%, objects are completely opaque. If the transparency is set 
to 100% objects are completely transparent.

Locking the Layers  

It is possible to lock objects so that they cannot be altered when in place in the 
Merchandiser environment. This is done by using the locking option in the Layers 
dialog box, accessible from the View toolbar.

Note: If you have toggled from Show 1 Viewport to Show 4 
ViewPorts and 3 Viewports are blank, clicking on the synchronize 
icon is a quick way of populating the blank ViewPorts with views.
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Figure 4–27 Layers options

The lock for each layer can be toggled on or off by clicking on the appropriate icon.

If the system variable is enabled, when in the Fixturing Tab, all layers associated with 
merchandising are locked. Similarly, when in the Merchandising Tab, all layers 
associated with fixturing are locked.

Locking of specific classes of objects is achieved by locking the layers that those objects 
are placed on. The layer for the majority of objects, such as fixtures, fittings and 
shelves, are determined when the object is created in Fixture Studio.

Note: Depending on the system variable settings, some layers are 
automatically locked depending on which Object Browser tab you are 
in.
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Figure 4–28 Block Details

Layers for zones are determined by the Zone Type. Fixtures and fittings must be 
placed on specifically defined and consistent layers. Products are placed on their own 
specific layer.

Locking layers is particularly useful for any object that is on the building layer, that is, 
pillars, which should not be modified in the Merchandiser environment. Locked 
objects can still be selected, so that properties can be determined.

When locked objects are selected, a warning message appears at the bottom of the 
screen.

Note: Layers selected for classes of objects should be consistent. If 
they are not then only some of the class of objects is locked when a 
specific layer is turned off.

Note: If objects are locked, then they cannot be deleted, moved, etc. 
If it is desired to do this, the layer must first be unlocked.
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Changing the Visibility of Objects  

The visibility of objects can be changed so that they show or are hidden from view in 
store plans. This is done by using the Visibility option in the Layers dialog box, 
accessible from the View toolbar

Figure 4–29 View Toolbar - Objects Visibility

The visibility for each layer can be toggled on or off by clicking on the appropriate 
icon. If the layer is not visible, all objects on the layer will be hidden.

Changing the Transparency of Objects  

It is possible to change the transparency of objects so that they become more or less 
opaque when in place in the Virtual Reality environment. This is done by using the 
Transparency option in the Layers dialog box, accessible from the View toolbar.

The degree of transparency for each layer can be set anywhere within a range of 0% - 
100%. If the transparency is set to 0%, objects are completely opaque. If the 
transparency is set to 100% objects are completely transparent.

In the example below, the transparency is set to 0% - opaque.

In the example below, the products and back panels have been set to 75% 
transparency.

Groups and Families
Groups and Families are two ways of linking similar objects together and to associate 
combinations of objects together. The advantages of groups and families are:

■ All objects in these combinations can then be selected and de-selected in a single 
operation.

■ Objects in Groups or Families can be collectively manipulated using operations 
such as move, rotate or delete.

■ The spatial relationship between objects in Groups and Families taken into 
account by Macro Space Management when carrying out changes in fixturing or 
merchandising. This means (for example) entire runs of shelves can be 
merchandised at once.

Groups and Families operate differently depending on whether the objects involved 
are Fixtures, Shelves, or Products.

Groups
Groups are objects that share a horizontal alignment. Only objects of the same type can 
be grouped, for example, fixture with fixture, shelf with shelf and product with 
product. Groups can be Fixture Groups, Shelving Groups and Product Groups. They 
are used for operations on similar objects, such as shelves at the same level that span 
multiple fixtures.

An example is the shelf group above, which spans three fixtures and can now be 
treated as one long shelf for merchandising purposes.
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Families
Families are objects that share a vertical alignment. Families are used when grouping 
vertical combinations of objects and act as a parallel version of grouping. Families can 
be Fixture Families or Product Families. Shelves cannot be incorporated into Families. 
For instance, pallets may be placed in front of back panels, and made into a family. 
Their vertical alignments and interferences are taken into account. With products, 
families can be made of different (but probably broadly similar) products, for example, 
a family of small, medium and tall vases stacked in a vertical plane.

An example is the back panel and its associated shelves. This forms a family with the 
pallet. This means that when the pallet is merchandised, Macro Space Management 
will automatically calculate the clearance to the shelf above it, and adjust the amount 
of merchandise it places on the pallet accordingly.

Sets
A Set is an array of products that has been ungrouped. Grouped product can be 
turned into sets, but the process is not reversible.

Multiple Associations
Objects can only belong to one Group at a time. Similarly, objects can only belong to 
one Family at a time. However, there are circumstances where objects can belong to 
both a Group and a Family. When objects with multiple associations are selected for 
being part of a Group, horizontal alignments will be taken into account. When selected 
for being part of a Family, vertical alignments will be taken into account.

Turning Grouping On or Off
Grouping can be turned On or Off in one of three ways; the keyboard, the status bar 
and from the toolbar menus. Turning Grouping On and Off turns both Groups and 
Families On and Off.

Keyboard
Grouping can be toggled On or Off using <Ctrl> + G.

Status Bar
Grouping can be toggled On or Off by clicking on the Grouping option on the Status 
Bar.

Grouping can be toggled On or Off by clicking on the Grouping option in the Edit 
menu.

Note: Objects in Groups will have their horizontal alignments taken 
into account by Macro Space Management.

Note: Objects in Families will have their vertical alignments taken 
into account by Macro Space Management.

Note: Do not un-group products unless necessary. Un-grouping 
cannot be reversed. Too many un-grouped products will significantly 
increase the amount of calculation required by Macro Space 
Management and may degrade performance.
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Figure 4–30 Status Bar

Figure 4–31 Edit Menu

If Grouping is enabled, then if an object is selected that belongs to a Group or Family, 
then all other objects in that Group or Family will be automatically selected or 
de-selected. If Grouping is not enabled, then selecting or de-selecting on object in a 
Group or Family will have no effect on the other members of that Group or Family.

Turning Grouping On is not retrospective - the option must be enabled before 
selecting all the members of a Group or Family. If Grouping is turned On after an 
individual member of a Group or Family has been selected, it will not result in the 
selection of the remaining members of that Group or Family.

This is because with Grouping Off, the yellow fixture is acting like the first fixture in a 
normal (ungrouped) selection set.

Selection of Objects
Objects are selected by means of <Ctrl> and left click. They are de-selected by using 
<Ctrl> and left click.

Note: If Grouping is Off, then clicking on the first member of the 
Group or Family (the yellow fixture) will still de-select the whole 
Group or Family. However, re-clicking on this yellow fixture will not 
re-select all members.
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Initial Selection of Objects
When objects are initially selected for Groups or Families, the first object selected is 
outlined in red, and all subsequent selections are outlined in blue.

After objects have been selected and added to a Group or Family, the initially selected 
object is outlined in yellow, and all subsequent selections are outlined in green.

If Grouping is turned Off and objects are de-selected then re-selected by <Ctrl> + left 
clicking, then the re-selected objects are outlined in cyan.

Unselected objects remain in yellow (first selected object) and green (subsequent 
objects).

With Grouping turned Off, individual objects in the Group or Family can be 
manipulated as separate objects. However objects remain in the group, and can be 
selected or de-selected collectively once Grouping is turned back On.

Making Objects into Groups
Objects can be made into Groups if they are of similar type. Thus shelves can be made 
into Groups and products can be made into Groups, but a Group may not contain both 
shelves and products. Grouped objects are in Horizontal alignments.

Making and Removing Groups is only possible when the appropriate Tab has been 
selected in the Object Browser:

■ For Fixtures this must be the Fixturing tab.

■ For Shelves this may be either the Fixturing or Merchandising Tabs.

■ For Products this must be the Merchandising Tab.

To make a Group:

■ Select the objects required. The initial object selected is in red, subsequent objects 
in blue.

■ When all objects have been selected, hold down <Ctrl> and right click to bring up 
the pop-up menu.

Select the Join option and the selected objects will be made into a Group.

This is signified by the initially selected object from the selection set turning to a 
yellow color and subsequently selected objects turning to a green color.

Note: In the selection set, re-selecting the first object selected 
(outlined in red) deselects all objects in the selection set. Re-selecting 
any of the subsequent selections (outlined in blue) only deselects that 
object.

Note: While Grouping is turned on, clicking on any object in the set 
selects or deselects the set as appropriate.

Note: In the selection set, re-selecting the first object selected 
(outlined in yellow) deselects all objects in the selection set. Selecting 
any of the subsequent selections (outlined in yellow or cyan) only 
deselects that object.
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Fixture Groups

Fixture Group Operations  

The primary purpose of Fixture Groups is to form combinations of fixtures that can 
then be manipulated collectively. Fixture Groups can be selected or de-selected by 
clicking on any fixture within the group (as opposed to individually selecting the 
fixtures each time they are required).

Fixture Groups can then be manipulated (moved, rotated or edited) collectively.

Gondolas, Fixtures and Fittings  

When Gondolas are placed, they are automatically designated a Fixture Group.

When Fixtures and Fittings are placed they are not included in any groups and have to 
be selected and designated a Fixture Group before they can be collectively 
manipulated.

Group Members  

Fixtures and fittings can only belong to one group at a time. Fixture Groups cannot 
contain different types of objects such as shelves.

Group Functions  

Group Functions are accessed from the Group option on the pop-up menu accessed by 
<Ctrl> and right clicking.
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Figure 4–32 Group Functions

Join Group  

Join Group creates a group from the selected fixtures. If a fixture belongs to a group 
already, then it is removed from that group and added to the new group. A 
confirmation message appears before the group is created.

Remove from Group  

Remove from Group allows you to remove fixtures from the selected group. If 
Grouping is turned On, all objects are removed from the group.

If Grouping is turned Off, then individual objects can be removed from the group by 
first de-selecting all members of the Group, then re-selecting the objects it is desired to 
remove. Clicking on Remove then removes those objects from the group. A 
confirmation message appears before the object(s) are removed.

Select  

Select serves two functions. It reverses the effect of the Select Without Fixtures 
command and the group will now have both Fixtures and Fittings active. If Grouping 
is Off, then selecting any single member of the Group and using the Select option will 

Note: If the objects selected are not compatible for forming a Group, 
the Join option is not activated.
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result in the other members of the group being selected. If Grouping is On then all 
members of the family will automatically be selected by clicking on any member of it.

Select Without Fittings  

Select Without Fittings selects only the fixtures within the group. All subsequent 
operations only affects these fixtures until the fittings are included again using the 
Select command.

Shelf Groups
Shelf Groups are groups of shelves that are at the same height, at the same angle and 
form a continuous run.

Shelves can be added to Shelf Groups providing they are adjacent and their height and 
angle match the existing members of the group. Grouped shelves allow you to treat 
adjacent shelves as one long shelf. This enables you to place products that span more 
than one shelf.

Grouping can be applied to any type of shelf objects, such as open shelves, rods, bars, 
pegs, dividers etc.

Group Members  

Fixtures and fittings can only belong to one group at a time. Fixture Groups cannot 
contain different types of objects such as shelves.

Group Functions  

Group Functions are accessed from the Group option on the pop-up menu accessed by 
<Ctrl> and right clicking.

Note: Care should be taken in manipulating the Group while the 
Select Without Fixtures command is active. For example, only the 
fixtures will be moved, leaving any fittings in their original position.
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Figure 4–33 Group Options

The following functions are available:

Join Group  

Join Group option creates a group from the selected shelves. If a shelf belongs to a 
group already, then it removes the shelf from that group and adds to the new group. 
A confirmation message appears before the group is created.

Remove from Group  

The Remove from Group option allows you to remove shelves from an existing group. 
If Grouping is turned On, all objects are removed from the group.

If Grouping is turned Off, then individual objects can be removed from the group by 
first deselecting all members of the Group, then re-selecting the objects to remove. 
Click Remove to remove those objects from the group. A confirmation message 
appears before the object(s) are removed.

Select  

If Grouping is Off, then selecting a shelf and selecting this command causes all other 
shelves in the shelf group to be selected and displayed.

Editing Grouped Shelves
Grouped Shelves can be edited by selecting the Edit option from the right click pop-up 
menu.

Note: If the objects selected are not compatible for forming a Group, 
the Join option is not activated.
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Figure 4–34 Edit Shelf 

This brings up the Edit Shelf dialog box. This can be used to make changes to the 
Grouped Shelves.
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Figure 4–35 Edit Shelf Dialog Box

Product Groups
Product Groups are organized stacks of products. Product Groups are automatically 
generated when products are placed in the Virtual Reality environment as an array.

While Products are grouped, all the products within the Group can be treated as a 
single object that can be rotated, moved or deleted. Product Groups are highlighted 
using red and blue selection boxes.

If products are ungrouped, they become a set and can be manipulated as individual or 
collective items. Sets are highlighted using yellow and green selection boxes (if 
Grouping is On) and yellow, green or cyan selection boxes (if Grouping is Off).

Un-grouping is carried out by selecting in single product group by holding down 
<Ctrl> and right click to bring up the pop-up menu.
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Figure 4–36 Product Ungroup

Un-grouping is a one-way action; products cannot be regrouped once they have been 
ungrouped.

Editing Grouped Products
Grouped Products can be edited by selecting the edit options from the right click 
pop-up menu.

Edit allows the spatial orientation of the product group to be changed. Edit Group 
allows the number of instances of the product placed to be altered.

Group Operations

Moving and Rotating Families
Objects in Families can be moved or rotated by using the View > Windows menu. In 
addition they may be moved and rotated using <Ctrl> and the mouse keys.

Note: Un-grouping cannot be carried out if two separate product 
groups have been selected simultaneously.

Do not un-group products unless necessary. Un-grouping cannot be 
reversed. Too many ungrouped products will significantly increase 
the amount of calculation required by Macro Space Management and 
may degrade performance.
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Figure 4–37 Moving and Rotating Families

Move
Selecting the Move option brings up the Move dialog box.

Figure 4–38 Move Dialog Box
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This enables objects to be moved horizontally (Y axes) or vertically (Z axes).

If fixtures are to be moved then the Fixturing tab must be selected on the Object 
Browser. If products are to be moved then the merchandising tab must be selected on 
the Object Browser. Shelves can be moved with either the Fixturing or Merchandising 
tabs selected on the Object Browser.

Rotate
Selecting the Rotate option brings up the Rotate dialog box.

Figure 4–39 Rotate Dialog Box

This enables objects to be rotated in all three axis.

If fixtures are to be rotated then the fixturing tab must be selected on the Object 
Browser. If products are to be rotated then the merchandising tab must be selected on 
the Object Browser. Shelves can be rotated with either the fixturing or merchandising 
tabs selected on the Object Browser.

Using <Ctrl> and the Mouse Keys

Moving Fixture Groups  

To move a Fixture Group, first ensure that the Fixturing Tab is selected in the Object 
Browser. Now move the Fixture Group by holding down the <Ctrl> and left mouse 
key. The selected Group follows the mouse cursor.

Rotating Fixture Groups  

Rotating Fixture Groups by using the <Ctrl> and right mouse key is only available for 
individual fixtures.

Editing Fixtures
The properties of a specific fixture or fixtures by selecting those required. This is done 
by holding down the <Ctrl> key and left clicking on the desired fixtures. The first 
instance of a selected fixture is highlighted in red, subsequent ones in blue. Holding 
down the <Ctrl> key and right clicking then brings up the pop-up Menu.
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Figure 4–40 Edit Fixtures

Click on the Edit option to bring up the Edit Fixture dialog box.
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Figure 4–41 Edit Fixture dialog box

This can be used to set the preferences for that specific fixture or fixtures. If different 
types of fixtures have been included in a multiple fixture selection, only options 
common to the different types are shown. If there are no common options, then the 
affected fields are blank.

Editing Shelves
You can edit the properties of a specific shelf or shelves by selecting those required. 
This is done by holding down the <Ctrl> key and left clicking on the desired shelves. 
The first instance of a selected shelf is highlighted in red, subsequent ones in blue. 
Holding down the <Ctrl> key and right click then brings up the pop-up Menu.
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Figure 4–42 Edit Shelves

Click on the Edit option to bring up the Edit Shelves dialog box.

This can be used to set the preferences for that specific shelf or shelves. If different 
types of shelves have been included in a multiple shelf selection, only options 
common to the different types will be shown. If there are no common options, then the 
fields in the preferences box will be blank.

Editing Products
Products can be edited from the Merchandising tab in the Object Browser. Holding 
down <Ctrl> and right click brings up the pop-up menu.

There are two options: Edit and Edit Group.
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Figure 4–43 Edit Products

Edit  

The Edit dialog enables a product to be edited for Position, Angle and Size.

Edit Group  

Note: If dissimilar products are selected as part of the Group, only 
options that are common to those products are available for editing.
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The Edit Group dialog enables the Quantity, Alignment, Detail, Orientation and 
Properties of a Product Group to be edited.

Making Objects into Families
Similar type objects can be made into Families. Thus fixtures and products can be 
made into Families, but a Family may not contain both fixtures and products.

Families of objects are normally in Vertical alignments. Product families can be made 
from horizontally or vertically grouped products. Shelves may not be made into 
Families.

■ For Fixtures, use the Fixturing tab.

■ For Products, use the Merchandising Tab.

To make a Family:

Select the required objects from the Object Browser. The initial object selected will be 
in red, subsequent objects in blue.

Figure 4–44 Family Options

When all objects are selected, hold down <Ctrl> and right click to bring up the pop-up 
menu.

Note: If dissimilar products are selected as part of the Group, only 
options that are common to those products are available for editing.

Note: Making and Removing Families is only possible when the 
appropriate tab has been selected in the Object Browser.



Merchandiser Controls

4-46 Oracle® Retail Macro Space Management  User's Guide

Select the Join option and the selected objects are made into a Family.

This will be signified by the initially selected object from the selection set turning to a 
yellow color and subsequently selected objects turning to a green color.

Avoiding Alignment Problems with Families
Fixture Families are used to establish relationships between fixtures where vertical 
alignment is important. Once fixtures are associated in families, Macro Space 
Management calculates the spatial relationship between the fixtures in the family.

In the example below the pallet and the shelves on the back panel behind it belong to 
the same family. When product is placed on the pallet, the vertical height is 
automatically restricted to that of the shelf above the pallet.

If the pallet and the shelves on the back panel behind it do not belong to the same 
family, then Macro Space Management does not take into account the spatial 
relationship between the two fixtures. When product is placed on the pallet, it is 
inserted to the full dimensions allowed by the pallet block details. This can result in 
product being positioned so that it clashes with the shelves.

Fixture Families
The primary purpose of Fixture Families is to form combinations of fixtures that can 
then be manipulated collectively. Fixture Families can be selected or de-selected by 
clicking on any fixture within the Families (as opposed to individually selecting the 
fixtures each time they are required). Fixture Families can then be moved, rotated or 
edited collectively. They can also be used to prevent vertical alignment problems for 
fixtures and products within a specific family.

Family Members

Fixtures and fittings can only belong to one Family at a time. Fixture Families cannot 
contain different types of objects such as products.

Family Functions
Family Functions are accessed from the Family Option on the pop-up menu accessed 
by <Ctrl> and right click.
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Figure 4–45 Family Options - Join

Join Families  

Join option from the Family menu creates a Family from the selected fixtures. If a 
fixture belongs to a Family already, then it is removed from that Family and added to 
the new Family. A confirmation message is displayed before the Family is created.

Remove from Family  

Remove option allows you to remove fixtures from the selected Families. If Grouping 
is turned On, all objects are removed from the Family. If Grouping is turned Off, then 
individual objects can be removed from the Family by first de-selecting all members of 
the Family, then re-selecting the objects that need to be removed.

Click on Remove to remove objects from the Family. A confirmation message is 
displayed before the object(s) are removed.

Select  

When Grouping is Off, selecting any single member of the Group and using the Select 
Option results in other members of the group being selected. If Grouping is On, all 
members of the family are automatically selected by clicking on any member.

Family Operations

Moving and Rotating Families  

Note: If the objects selected are not compatible for forming a Family, 
the Join option is not activated.
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You can move or rotate Objects in Families by using the View > Windows menu. Or 
they may be moved and rotated using <Ctrl> and the mouse keys.

Figure 4–46 Rotate Objects in Families

Move  

You can move the objects horizontally (Y axes) or vertically (Z axes) using the Move 
option. Select the Move option to bring up the Move dialog box.

■ If you want to move the fixtures, then the Fixturing tab must be selected on the 
Object Browser.

■ If you want to move products, select the Merchandising tab on the Object Browser.

■ If you want to move shelves, use either the Fixturing or Merchandising tabs on the 
Object Browser.

Moving Fixture Groups  

If you want to move a Fixture Group using the Control key, select the Fixturing Tab on 
the Object Browser. Now move the Fixture Group by holding down the <Ctrl> and left 
mouse key. The selected Group follows the mouse cursor.

Rotate  

Using the Rotate option, you can rotate the objects in all three axes. Select the Rotate 
option to bring up the Rotate dialog box.

■ If you want to rotate the fixtures, use the Fixturing tab on the Object Browser.

■ If you want to rotate the products, use the Merchandising tab on the Object 
Browser.

■ If you want to rotate the shelves, use either the Fixturing or Merchandising tabs on 
the Object Browser.
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Rotating Fixture Groups  

Rotating Fixture Groups by using the <Ctrl> and right mouse key is only available for 
individual fixtures.

Editing Fixtures  

Fixtures can be edited from the Fixtures tab on the Object Browser. Hold down <Ctrl> 
and right click to bring up the pop-up menu.

Click on the edit option to bring up the Edit Fixture dialog Box.

This allows the Position, Angle, and Size of the fixtures to be edited.

Editing Shelves  

Shelves can be edited from either the Fixtures or Merchandising tabs on the Object 
Browser. Hold down <Ctrl> and right click to bring up the pop-up menu.

Click the edit option to bring up the Edit Shelves dialog Box.

This allows the Position, Slot Number, Angle, and Size of the shelves to be edited.

Editing Products  

Products can be edited from the Merchandising tab on the Object Browser. Hold down 
<Ctrl> and right click to bring up the pop-up menu.

There are two options: Edit and Edit Group.

Edit  

You can edit the Position, Angle and Size of the product using the Edit dialog box.

Edit Group  

The Edit Group dialog enables you to edit the Quantity, Alignment, Detail, 
Orientation, and Properties of a Product Group.

Note: If dissimilar fixtures have been selected as part of the Group, 
only options that are common to those fixtures will be available for 
editing.

Note: If dissimilar shelves have been selected as part of the Group, 
only options that are common to those shelves will be available for 
editing.

Note: If dissimilar products are selected as part of the Group, only 
options that are common to those products will be available for 
editing.

Note: If dissimilar products are selected as part of the Group, only 
options that are common to those products will be available for 
editing.
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Calculations
The purpose of calculations is to determine various metrics against data in a drawing 
and save these results in the database. Calculations can be run from the Calculate 
menu option located in the Merchandiser module of the Macro Space Management 
application. The various types of calculations are as follows:

■ Calculate Areas

■ Calculate Face Planes

■ Calculate Adjacency

Calculate Areas  

Area calculations are used to apportion the area enclosed by the Total Building 
(Internal Area) zone to specific fixtures. Area calculations are initiated by selecting the 
Calculate Areas option from the Calculations menu.

Calculate Areas gives a visual indication of how efficiently space in the store has been 
allocated. Each registered fixture definition defines the directions in which it faces 
North, South, East, or West relative to the block. For each fixture, it creates a boundary 
around it in each direction until it hits another fixture or until it reaches its defined 
tolerances.

Selecting this option brings up the Area Calculation window.

Calculate Face Planes  

You can calculate Face Planes to calculate the space each product occupies in a 
planogram. It looks at space from a front view perspective, so that if there were two 
categories on a fixture, it determines what proportion of space is given to each 
category. For example, the Men's Shirts planogram might have a frontal area of 16 
square feet, with Walmart Own Brand shirts taking up 15% of the available space.

Calculate Face Planes is a customer specific requirement, and may not be enabled in 
generic implementations of Merchandiser.

Calculate Adjacency  

Calculate Adjacency calculates which fixtures and which products are adjacent to each 
other. Having determined which other fixtures are adjacent it then works out whether 
it is to the right, to the left, in front, behind, above, below or opposite. Next it works 
out sequence numbers, and groups fixtures together by giving them the same number.

While the calculation is in progress, a window gives a visual indication of the stage it 
has reached.

Styles
Styles are used to define whether different types of objects fit together. They can be 
used to specify (for example) whether a shelf will fit on a fixture, or whether a product 
can be placed on a shelf.

Using Styles in Merchandiser requires settings to be configured in the Administration, 
Merchandiser, Fixture Studio, and Product Studio modules.

Each of these steps is discussed in more detail.

Assigning Fixture, Shelf, and Product Styles
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Types of Styles  

There are three broad classes of style (although others can be defined).

■ Fixture styles

■ Shelf styles

■ Product styles

In additions there are:

■ Joints

Fixture  

Shelf  

Product  

Table 4–4 Fixture Style

Fixture style Shelf style Product style

Fixtures must have 
one or more fixture 
styles.

The Fixture Style 
Relationships 
determine what 
shelves and products 
it can accept.

If shelving is to be 
placed on the fixture 
then a style 
relationship must 
exist between the 
assigned fixture style 
and the required 
shelf style.

For products to be 
placed a fixture, a 
style relationship 
must exist between 
the assigned Fixture 
Style and the 
required Product 
Style.

Table 4–5 Shelf Style

Fixture style Shelf style Product style

For shelves to be 
placed on a fixture, a 
style relationship 
must exist between 
the assigned Shelf 
Style and the 
required Fixture 
Style.

Shelves must have 
one or more Shelf 
Styles.

The Shelf Style 
Relationships 
determine what 
equipment the shelf 
can be placed on and 
what products it can 
accept.

For products to be 
placed on the shelf, a 
style relationship 
must exist between 
the assigned Shelf 
Style and the 
required Product 
Style.

Table 4–6 Product Style

Fixture style Shelf style Product style

For products to be 
placed a fixture, a 
style relationship 
must exist between 
the assigned Fixture 
Style and the 
required Product 
Style.

For products to be 
placed on the shelf, a 
style relationship 
must exist between 
the assigned Shelf 
Style and the 
required Product 
Style.

Products must have 
one or more product 
styles.

The Product Style 
Relationships 
determine what 
equipment and 
shelves the product 
can be placed on.
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Joints  

Allows products to be placed directly on fixtures, placing at the same time the 
associated shelf object.

Example 4–1 Style Relationship example

In the following Style Relationship (created in Admin) fixtures that have a Fixture 
Style of Metal assigned can accept shelves that have had an Open Shelf, Heavy Duty 
Shelf or Lateral Rod Shelf Style assigned.

Figure 4–47 Style Dialog Box

Note: Products can only be assigned styles at the Display Level. 
They cannot be assigned styles at SKU level and above.

Table 4–7 Joints

Fixture style Product style Shelf style

For products to be 
placed a fixture, a 
style relationship 
(using a joint) must 
exist between the 
assigned Fixture 
Style and the 
required Shelf style.

For products to be 
placed on the shelf, a 
style relationship 
(using a joint) must 
exist between the 
assigned Shelf Style 
and the required 
Product Style.

Products must have 
one or more product 
styles.

The Product Style 
Relationships 
determine what 
equipment and 
shelves the product 
can be placed on.

When creating a joint, if a fixture-shelf style relationship similar to 
the type being defined already exists it must be deleted before the 
joint (a combination of fixture, product and shelf styles) can be 
created.
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Conversely, if a shelf has only had a Peg Slatted Style assigned it cannot be placed on a 
Fixture that has only has a Fixture Style of Metal assigned.

Fixture Styles  

Each fixture should be associated with one or more Fixture Styles. An example of a 
fixture style might be 'Metal'. This style might also be associated with fitting and 
shelves and can be used to indicate that particular items of equipment can be fitted 
together.

If product is to be placed directly on any fixture, it also requires a shelf style.

Shelf Styles  

Each shelf must be associated with one or more Fixture Styles and also one or more 
Shelf Styles. The Fixture Style is used to ensure the shelf fits onto a compatible fixture. 
The Shelf Style only allows products with compatible styles to be placed.

Product Styles  

Each product must be associated with one or more product styles. These product 
styles will determine the compatible shelves the product can be placed on. For 
example shirts could be available in both Hung and Folded Product (Display) Styles.

If a product is dragged into a shelf at item level then it will automatically select the 
correct Product Style. For example if shirts are dragged into an open shelf, they will be 
placed as Folded Shirts. If shirts are dragged onto a peg or bar, then they will be 
placed as Hung Shirts.

If product is dragged onto a shelf at Display Level then it can only be placed on 
equipment compatible with that style. For example Folded shirts cannot be placed 
onto a bar.

Summary of Style Requirements and Style Relationships
Style Requirements and Style Relationships may be summarized as follows:

Joints allow products to be placed on fixtures simultaneously with shelf objects.
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Assigning Fixtures and Shelf Styles
Styles can be assigned to fixtures and shelves from Fixture Studio by highlighting 
them in the hierarchy and right clicking to bring up the pop up menu.

Click the Edit Block to bring up the Block Details dialog box. The Styles/Ranges tab 
can then be used to specify the available styles for a particular object.

Figure 4–48 Block Details - Styles/Ranges
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Styles can then be assigned or removed using the < and > arrows.

Assigning Product Styles

Styles can be assigned to Products from within Product Studio by highlighting them in 
the hierarchy and right clicking to bring up the pop up menu.

Click the Edit option to bring up the Product Display Style dialog box. The Styles tab 
can then be used to specify the available styles for a particular product.

Note: A shelf object will require a fixture style to ensure it can be 
assigned to fixtures, and a shelf style to allow product to be assigned 
to it.

Note: Products can only be assigned styles at the Display Level. 
They cannot be assigned styles at SKU level and above.
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Figure 4–49 Product Display Style dialog box

Styles can then be assigned or removed using the appropriate icons.

Using Styles in Merchandiser

Placing Fixtures  

Primary Fixtures can be placed without reference to their assigned Styles. The only 
criteria for placing fixtures are that they have been assigned a primary object that 
places at floor level.

Placing Shelf Objects  

Shelf Objects can only be placed if they meet two criteria.

Connection Points The connections 
points assigned to the 
shelf must be 
compatible with the 
connection points 
assigned to the 
fixture it is to be 
placed on.
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Setting Preferred Styles  

Some objects can be associated with multiple styles; specific instances of shelves 
within the drawing can be given preferred styles. For instance, a shelf could be 
associated with both a Stock shelf style as well as a Presentation shelf style; two 
display styles may then be defined for a particular product, a Display product style 
and a Boxed product style.

The Stock shelf style would be linked with the Boxed product style, and the 
Presentation shelf style would be linked with the Display product style. This would 
allow both the Boxed and Display version of the product to be placed on the shelf.

However, the user would be able to indicate the preferred style for a particular 
instance of a shelf as being Presentation, which would force the Display product to be 
placed for that particular shelf.

Using Preferred Styles  

Preferred styles can be specified for a specific shelf or shelves by selecting those 
required. This is done by holding down the <Ctrl> key and left clicking on the desired 
shelves. The first instance of a selected shelf will be highlighted in Red, subsequent 
ones in blue.

Hold down the <Ctrl> key and right click to bring up the pop-up Menu. Click the Edit 
option to bring up the Edit Shelves dialog box.

This can be used to set the preferences for that specific shelf or shelves. If different 
types of shelves have been included in a multiple shelf selection, only preference types 
common to the different types will be shown. If there are no common preference 
types, then the field in the preferences box is blank.

Styles The Fixture Style 
assigned to the shelf 
must be compatible 
with the Fixture Style 
assigned to the 
fixture it is to be 
placed on.
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Using Styles  

The diagram below indicates how styles interrelate.

The fixture has been assigned a Metal Fixture Style. The Open Shelf, Peg Board and 
Hanging Rod shelf objects have all been assigned Metal Fixture styles. This means any 
of these three types of shelf object can be placed on the fixture. If another type of shelf 
object (for example a slatted back panel) had been assigned the Lozier fixture style, it 
would not have a fixture style compatible with that assigned to the fixture itself, and 
could not be assigned to that fixture.

The Open Shelf, Peg Board and Hanging Rod shelf objects have also all been assigned 
appropriate shelf styles. The varying types of products have been assigned product 
styles. For example shirts have been assigned Boxed, Folded and Hung product styles. 
These styles determine what form of shelf object shift can be placed on. For example 
shirts with a Hung product style can only be placed on Hanging Rods. Conversely, the 
Open Shelf has been configured to accept both Boxed and Folded shirt styles. Ties only 
have Pegged product style and are restricted to the Peg Board.

Note: Where an object has multiple styles they can set in order of 
preference using preferred styles.
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Practical Use of Styles

Adding Style to Fixture in Fixture Studio Module  

To add a Fixture Style to a fixture:

■ Open the Fixture Studio module.

■ Select the required fixture and right click to bring up the pop-up menu.

■ Click the Edit Block option. The Block details dialog box opens.

■ Select the Styles/Ranges Tab.
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Figure 4–50 Styles/Ranges Tab

To add a Fixture Style (or styles) select the required style(s) from the list of available 
styles and click the right arrow > to move it over to the list of selected styles.
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Figure 4–51 Add Fixture Style

In the example above, the fixture will now accept any shelves or products that have 
Style Relationships with the Fixture - Batteries Fixture Style.

Adding Styles to Shelf in Fixture Studio Module  To Add Fixture and Shelf Styles to a shelf:

■ Open the Fixture Studio module.

■ Select the required shelf and right click to bring up the pop-up menu.
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Click the Edit Block option to bring up the block details dialog box.

Figure 4–52 Block details dialog box

■ Select the Fixture/Styles Tab.

■ To add a Fixture Style (or styles) and a Shelf Style (or styles) select the required 
style(s) from the list of available styles by using the right arrow > to move it over 
to the list of selected styles.
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Figure 4–53 Add Styles to Shelf

This shelf will now accept any fixtures or products that have style relationships with 
the Shelf - Batteries Shelf Style. Similarly, a Fixture style can be selected to determine 
what fixtures the shelf can be placed on.

Adding Style to Product in Product Studio  

To add a Product Style to a product:

1. Open Product Studio. Select the required product and right click to bring up the 
pop-up menu.
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Figure 4–54 Edit Product Dialog Box

2. Click Edit to bring up the Product Display Style dialog box. Select the Styles Tab.

Figure 4–55 Product Display Style dialog box

To add a Product Style (or styles) select the required style(s) from the list of available 
styles and move it over to the list of selected styles using the appropriate icon.

Merchandisable Areas
The merchandisable area, that is configurable, is the total amount of area on a fixture 
that is available to merchandise. You can decide the position and the dimensions 
where to place the merchandise on the object. The grayed out dimensional area inside

Note: Products can only be assigned styles at the Display Level. 
They cannot be assigned styles at SKU level and above.
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the red line, in the image below, indicates the merchandisable area on a fixture. The 
Merchandisable Area tab in the Fixture Studio allows you to configure the position 
and dimensions of the area that can be filled with merchandise. 

Figure 4–56 Merchandisable Area

To view the merchandisable area on a fixture:

1. Select the fixture by highlighting it in the Object Browser.

2. From the Fixturing toolbar, click Edit Fixture. Fixture Studio opens up.

3. On the Fixture Studio module, select the Preview tab. The Preview tab displays 
the graphical interpretation of the object with merchandisable area.

4. Select the checkbox against the field Merchandisable Area. The merchandisable 
area is displayed as the grayed out area within the red lines on the object.

Editing Merchandisable Area
You can edit the merchandisable area on the object by accessing the Merchandisable 
Area tab in the Fixture Studio.

To edit the merchandisable area:

1. From the Fixture Studio module, select a fixture from the Object Browser for 
which you want to edit the merchandisable area.

2. From the toolbar, select Edit Block Definition. Alternatively, right click on the 
block and select Edit Block. The Block Details dialog box appears.

3. Select the Merchandisable Area tab.
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4. On the Primary Area frame, enter the Offset 1 and Offset 2 X, Y, Z co-ordinates.

5. Click Save to save the changes made and click OK to exit. 

For more information on the concepts and defining the Further Merchandisable Area, 
see the section Merchandisable Area Concepts and The Further Areas Frame.

Zones
A Zone defines a section of floor that is used for a specific and clearly defined purpose, 
based on the floor layout specified by an architectural drawing. The Zone might define 
an area used for sales, it might define an area used for storing stock, or it might define 
areas used for non-sales purposes such as offices, corridors or toilets.

Zones can only be added, edited, and deleted in the Planner environment. Zones can 
be viewed but not edited in Merchandiser.

From a technical standpoint, a Zone is a Macro Space Management block that allows 
additional information to be put into a Store Plan. This subsequently allows more 
structured Macro Space Management reports to be produced on the associated layout 
of fixtures, fittings and Planograms within that drawing. A Zone is defined by a 
Planner Polyline enclosing a specific section of floor. Further Polylines within the Zone 
can be used to define pillars or other obstructions. The designation of pillars and other 
obstacles allows them to be taken into account when calculating sales areas. This 
results in a more accurate calculation of the area of usable floor, enabling sales 
performance analysis to take into account the effect of obstructions.

The Zone is used to assign a specified part of the total floor area to a specific function. 
Such functions include allocating to specific types of retail goods, (for example 
electrical goods), or designating the area as a non-sales area; for example a manager's 
office or a corridor. Zones thus allow the total floor area in the store to be split into 
sales and non-sales areas and then further sub-divided as to purpose. This 
sub-division of the store allows Planograms and fixtures to be filtered by Zone, 
allowing the store planner to rapidly establish which goods and which fixtures are in a 
specific part of the store.

Zones can also be designated as being excluded from certain types of reports. This 
allows fixtures and Planograms that have been placed in a storage area to be excluded 
from any calculations or reports on the performance of that part of the store.

Many of the characteristics of Macro Space Management Zones can be configured 
within the Admin Module.

Zone Toolbar and Display Windows on the Object Browser
Click the Zones Tab on the Object Browser to bring up the toolbar and information 
window for Zones.
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Figure 4–57 Zones Tab

■ The Zones Toolbar allows you to refresh and configure Zones.

■ The Zones Hierarchy contains a list of all the zone types currently configured in 
the Administration Module.

■ The Zone Properties Window contains information on the currently selected zone.

■ The Zones Summary Window contains brief information on all zones currently 
present in the drawing.

The Zones Toolbar
The Zones Toolbar is found on the Object Browser.

It contains two icons allowing operations to be carried relative to Zones.

Configuration button allows you to configure Zones. The Refresh button allows you 
to refresh the Zones Hierarchy information to reflect any changes made in the Admin 
Module since Merchandiser was opened for the current session.

The Zones Hierarchy Window
The Zones Hierarchy Window is found below the toolbar.
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It contains a Hierarchical Tree giving a list of all the available Zone types. A zone 
selected in the drawing is highlighted in the hierarchical tree.

The Properties Window
The Properties Window gives information on the selected Zone Definition.

The Zone Type and Area Properties are read only and cannot be edited.

The Summary Window
The Summary Window contains details of Zones within the drawing.

The information typically includes Zone Name, Zone Description, and Gross and Net 
Areas. Zone Names and Zone Descriptions can be sorted by clicking the column 
headings.

Express Loading
Express Loading is used to load only some of the zones available in the drawing. This 
allows Macro Space Management users to load just the sections of the store plan that 
are of interest to them. This reduces the amount of detail in the drawing that the user 
has to view.

Express Loading also helps the performance of the application as less data is being 
processed in the user's viewpoint moves.

Drawings that are express loaded with only some of the available Zones is displayed 
as checked out by the user, preventing anyone else from working on the Zones that 
have not been loaded.

Activating Express Loading
Express Loading can be enabled in the Merchandiser tab of the Configuration Module.

Note: Zone types and descriptions can be added, edited, or deleted 
using the Admin module.

Note: Information displayed can be customized by Oracle - contact 
Technical Support if necessary.
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Figure 4–58 Express Load

On the Merchandiser tab, Express Load checkbox can be checked to enable Express 
Loading. If the check box is not ticked, all zones are loaded into the selected drawing.

The Express Loading dialog box
The Express Load dialog box allows you to select which Zones, Fixtures, Shelves and 
Products are loaded.
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Figure 4–59 Express Load dialog box

The four radio buttons at the top of the dialog box control what is loaded in the 
selected zones:

■ Load entire drawing results in every zone in the drawing being loaded. This 
includes any fixtures not included within a zone.

■ Select all Fixtures selects the fixtures in every zone in the drawing.

■ Select all Fixtures and Shelves selects the fixtures and shelves in every zone in the 
drawing.

■ Select all Fixtures, Shelves and Products selects the fixtures, shelves, and 
products in every zone in the drawing.

Alternatively, the requirements for Individual Zones can be set by checking or 
unchecking the respective boxes for Fixtures, shelves and Products for those zones. 
Objects that are not at floor level (for example banners) are still associated with the 
zone they are within and is displayed accordingly. The level of an object does not 
affect whether it is associated with a zone.

The Include Groups and Families outside of the Zone checkbox (if selected) will 
result in all fixtures (and their associated shelves and products) belonging to a group 
or family that extend outside the selected zones being displayed. If this option is not 
checked, then only fixtures (and their associated shelves and products) that cross the 
boundary of the selected zones is displayed.

Note: Using the Select all Fixtures, Select all Fixtures and Shelves 
and Select all Fixtures, Shelves and Products options, application 
will not select from Fixtures, Shelves or Products that are not in the 
zone.
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Objects crossing Zone Boundaries

If only some of the available zones are enabled, some fixtures and fittings from the 
non-enabled zones may overlap with the boundaries of the selected zones. You can see 
these overlapping fixtures and fittings, together with their associated shelves and 
products. These overlapping fixtures, fittings, shelves and products are not locked, 
and you can edit, move or modify these objects.

Fixtures
Fixturing is the addition of equipment to a store plan. There are two ways that 
equipment can be added:

■ As individual fixtures

■ As Gondola Runs

The properties of fixtures and gondolas are defined in Fixture Studio.

Individual Fixtures
Fixtures can be placed as one-off's (or as simple arrays). In the example below, a pallet 
has been placed using photo realistic quality.

Gondola Runs
Gondola runs are predefined arrangements of fixtures that can be placed in variable 
sizes, variable parts and with variable numbers of bays determined at the moment of 
insertion.

Composites
Composites are predetermined arrangements of fixtures that cannot be varied. Their 
main use is for placing standardized assemblies of fixtures.

Composites can only be placed in the Planner Module environment. Accordingly, 
although their parent fixture group may be visible in the Object Browser fixture 
hierarchy, any composites will be hidden from view.

Adding Fixtures using the Object Browser
You can add fixtures in the drawing from the Fixturing tab of the Object Browser. The 
Fixturing tab has two buttons Blocks and Gondolas which you can select to view the 
available blocks or gondolas.

The available fixtures or gondolas are shown in the hierarchy. The properties of the 
currently highlighted fixture can be seen in the Properties window. Any available 
information on blocks or fixtures placed in the drawing can be seen in the Summary 
Window. (This information can be customized to user requirements). A preview of the 
currently highlighted fixture can be seen in the Preview Window.

There is a significant difference in the way fixtures are added in the Planner and the 
Merchandiser environment.
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To add fixtures:

Select the required fixture in the blocks hierarchy by highlighting it.

Holding down the left mouse button, then drag it to the drawing and drop it.The 
preview window in the object Browser contains an image of the selected fixture.

Moving a Fixture
There are two ways to move a fixture:

■ Cursor Keys

■ Edit dialog box

Moving using the Cursor Keys

To move a fixture, select it in the plan. It is highlighted.

It can then be moved left, right, forward, and back using the cursor keys. If multiple 
fixtures have been selected, they are simultaneously moved.

Moving by means of the Edit Dialog Box

To move (or rotate a fixture) by means of the Edit dialog box, double click the fixture 
to bring up the Edit Fixture dialog box.

This allows the following changes to be made to the fixture:

■ Position: Allows the position of the fixture to be changed to a specific point in the 
drawing.

■ Angle: Allows the fixture to be rotated in the X, Y, or Z planes.

■ Size: Allows the size of the fixture to be changed.

■ Material: Allows the material (color) of the fixture to be changed.

Planner Module 
Environment

Merchandiser 
Environment

Fixtures can be 
added by clicking on 
the Add icon or by 
dragging and 
dropping

Fixtures can be 
manipulated on 
addition by means of 
the Add Fixtures 
dialog box

Fixtures can only be 
added by dragging 
and dropping

Fixtures are placed 
immediately on being 
'dropped' - the Add 
Fixtures dialog box 
does not appear.

Note: The direction the selected fixture moves in the field of view 
will depend on whether the viewpoint has been rotated.
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Deleting a Fixture
Fixtures in the drawing can be deleted by highlighting them.

Pressing the delete key deletes the fixture from the drawing.

Fixturing Toolbar
The Fixturing toolbar has the following options:

■ Highlight

■ Find

■ Options

■ Refresh

■ Attributes

■ Promotional Fixtures

Highlighting Options
The Highlight Selected Item in View and Highlight Item in Tree option enables you 
to find items in the drawing and hierarchy. When the highlight option is selected in 
the toolbar, it is active.

Figure 4–60 Highlight Options

Find Option
The Find function enables you to search blocks in the drawing.

On the Find Block dialog box, enter the required search string and click the Search 
icon. This brings up a list of any blocks matching the search string. Highlight any 
result and click OK to return to the Object Browser, where the selected block is 
highlighted in the hierarchical tree.

Note: It is recommended that the sizes be left unchanged. If they are 
changed, they can be restored to the original size by clicking on the 
default button.
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Options
The Options function enables you to configure the fixturing options.

Refresh
The Refresh icon refreshes both Fixture and Gondola information in the respective 
hierarchical trees.

Click the Refresh button tab to load the latest gondola information from the database 
into the Gondola hierarchy. At the same time, it loads the latest fixture information 
from the database into the Fixture Hierarchy. This means that adding a fixture or 
gondola from the appropriate hierarchy after the refresh button has been pressed uses 
the latest definition from Fixture Studio.

If a drawing is already open then fixtures or gondolas already placed in the drawing 
will not use any changes loaded during the refresh operation until the drawing is 
closed and reopened. However, new fixtures or gondolas added to the open drawing 
uses the new data.

Attributes
The Attributes function enables you to view the user defined attributes of the selected 
block. Select the Attributes icon from the Blocks and Gondolas toolbar.

Some fixtures may not have any attributes assigned.
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Promotional Fixtures
Promotional Fixtures are fixtures that can be allocated for a specific purpose of rapidly 
changing offers.

Fixture Studio
Fixture Studio is a module of Macro Space Management where you can configure 
fixtures and gondolas.

Figure 4–61 Fixture Studio Module

Activities in Fixture Studio have a significant influence on Merchandiser.

■ The hierarchies of Fixtures and Gondolas that display in the Object Browser in 
Merchandiser are configured in Fixture studio.

■ Fixture properties are configured in Fixture Studio.

■ Gondolas are defined in Fixture Studio.

Gondola and Fixture Hierarchies
Gondolas and Fixtures for use in Merchandiser are selected from a hierarchy in the 
Object Browser.
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Figure 4–62 Fixturing tab

There is hierarchy for fixtures and gondolas. You can switch between the two by 
clicking on the Blocks or Gondolas button while in the Fixturing tab. They are made 
up of groups and fixtures (or gondolas). Groups are the equivalent of windows folders 
and serve to hold fixtures (or gondolas) of a specific type.

The fixture and gondola hierarchies cannot be altered in Merchandiser, you can 
modify the hierarchy only in Fixture Studio. In Fixture Studio groups, fixtures, and 
gondola definitions can be added, edited, and deleted. This allows the hierarchy to be 
customized to suit the user.

Fixture Properties
Fixture Properties are defined in the Block Details definition box in Fixture Studio.
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Figure 4–63 Block Details definition box

It contains a series of tabs that allow intelligent properties to be assigned to the graphic 
that appears in the drawing.

Table 4–8 Block Details Definition box

Tab Function

Category tab Basic parameters for the fixture including data on materials, 
manufacturer, how products fit onto the equipment, etc.

Insertion tab How the fixture is inserted into the drawing including the height 
above floor level and what direction the front of the fixture faces.

Size tab The dimensions of the fixture, including additional floor area 
assigned to allow for extra equipment to be placed on the fixture.

Connections tab Specifies which equipment can be connected to what other 
equipment.

Parts tab Specifies a list of parts for the equipment; for example bolts and 
castors required.

Fixture tab Allows to set the shelf spacing and fixture setting for the selected 
block.

UDAs tab Allows User Defined Attributes (text based information) to be 
assigned to the fixture. These UDAs can then be viewed in 
Merchandiser.

Styles/Ranges tab Defines the styles and temperature range for the selected fixture.

Merchandisable 
Areas tab

Defines the volume that merchandise is allowed to occupy.

Shelf tab Sets the default angle for any shelving to be attached to the 
equipment

Preview tab For use within Fixture Studio - it allows users to visually check 
connection points, merchandisable areas, etc.
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Gondola definitions
Gondola Definitions are managed in Fixture Studio.

Figure 4–64 Gondola Definitions

The settings assigned in the Gondola Definitions dialog box are reflected in the 
Gondola Run dialog box when a gondola is placed in Planner or Merchandiser.

Figure 4–65 Gondola Definitions dialog box

Settings affected by the Gondola Definitions dialog box include the available 
dimensions and whether any parts of the gondola are optional.
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Overview of Macro Space Management Equipment
A Store in the Merchandiser environment is populated by equipment. This can include 
fixtures, fittings, shelves and many other items of store furniture. The way these items 
behave is affected by the properties they have been assigned, how they are grouped 
together for collective manipulation and by what the System variables are set to.

Object Properties
Each of these items of equipment has been initially created as a graphic (using for 
example AutoCAD). The graphic contains basic properties such as dimensions and an 
insertion point. The graphic has then been imported into Macro Space Management 
and turned into a Macro Space Management Block. During this process, the Macro 
Space Management Block is assigned additional properties that allow it to act in an 
'intelligent' manner when in the Macro Space Management CAD and Virtual Reality 
Environments.

Knowledge of how these 'Intelligent Properties' affect the behavior of equipment 
within Macro Space Management is important in understanding the behavior of the 
software. Some of these properties are:

Grouping of Objects
Multiple objects (collections of either equipment or products) can be selected for 
collective operation. This is done by:

■ Selection sets: used for a single collective operation.

■ Groups: sets of objects in horizontal alignment that can repeatedly manipulated

■ Families: sets of objects in vertical alignment that can repeatedly manipulated

System Variables
In addition there are a number of System Variables that affect Macro Space 
Management. These may be set to different values - each of which will cause a 
modification to the behavior of the Macro Space Management environment.

Table 4–9 Intelligent Properties

Property Function

Insertion Points Determine the locations at which equipment and merchandise is 
placed in Merchandiser

Child Insertion 
Points

Determine the justification which products are placed on fixtures 
and shelf objects

Connection options Determines how one item of equipment connects to another.

Placement Options Determines the alignment, etc., when product is placed onto open 
shelves, pegs and other shelf objects

Styles Determines which items of equipment are compatible with another. 
Also determines which shelf objects products can be placed on.

Alignments Determines how groups of products on shelf objects can be aligned 
(justified) relative to that shelf object.

Product 
Orientations

Individual product items can be placed in specified orientations, for 
example with the front, side or top of the packaging facing forward 
on the shelf object.
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Equipment Types and Connection Points
The equipment used in building a store layout falls into three categories: Primary, 
Secondary and Tertiary.

Primary Equipment indicates the most fundamental form of equipment. All Primary 
Equipment is capable of being placed directly on the floor. Some Primary Equipment 
is capable of accepting subsidiary equipment, (Secondary Equipment). Only Primary 
Equipment has an Insertion Point that is directly placed in the floor plan of a store.

Secondary Equipment indicates items of equipment that attach directly to Primary 
Equipment. Secondary equipment cannot be placed directly on the floor. Some 
Secondary Equipment is capable of accepting further subsidiary equipment, (Tertiary 
Equipment). Secondary Equipment has an insertion point relative to the insertion 
point of its parent Primary fixture.

Tertiary Equipment indicates equipment that is attached to Secondary Equipment. 
Equipment can therefore be arranged in a hierarchy, as in the example below.

Figure 4–66 Equipment Hierarchy

Within the Merchandiser environment, store furniture can be assembled in standard 
or custom configurations by joining together items of equipment. For example, a back 
panel could be placed directly on the floor. This back panel could then have runs of 
shelving attached, and the shelves in turn have dividers placed on them.

Macro Space Management's internal rules determine exactly how items of equipment 
can connect together. Within the Merchandiser environment, connection points give 
visual indications as to how individual items of equipment can be assembled.

Location and Coordinate Systems
The central Macro Space Management database holds information on the location (and 
dimensions) of all objects placed on the floor of the Virtual Reality store. These 
normally are a limited number of fixtures and fittings such as legs, pallets, etc. Each 
object will be inserted at a specific Insertion Location with coordinates expressed in 
terms of X, Y and Z coordinates.

Each object to be inserted has two Insertion Points; a Graphical Insertion Point and a 
Macro Space Management Insertion Point. The graphical insertion point is created 
when the graphic is drawn (in for example AutoCAD). When the graphic is imported 
into Macro Space Management, the coordinates of the graphical insertion point are 
manually entered into the object details held by Macro Space Management. This 
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manually entered data must match the original graphical insertion point, or 
misalignments will occur in the Virtual Reality environment.

All other objects, (equipment of merchandise) are connected to the fixtures and fittings 
that have been placed on the floor. These objects are known as children of their parent 
objects.

Children have their own insertion locations specified relative to the insertion location 
of their parent objects. They also have their own individual graphical and Macro 
Space Management insertion points. Again, these must match to prevent 
misalignments.

Connection and Placement Options
Objects in Macro Space Management can be split into several broad categories. Two of 
these categories are Equipment and Products. They connect together in slightly 
different ways.

Equipment  

Equipment connects together using Connections. These may be either points (which 
simply snap two items of equipment together), lines (which allow equipment to be 
connected at intervals defined along a line), or planes (which allow equipment to be 
connected at intervals defined in a 2 dimensional grid).

Products  

Products connect together using Placement Options. These may be either Continuous 
Placement (where products can be placed anywhere within a specified boundary, for 
example an open shelf), or Point Placement (where products can be placed in clearly 
specified places, for example on an array of pegs).

Styles
Styles are used to specify which items of equipment are compatible with another, and 
which types of product can be placed on which shelf. Equipment has Fixture Styles. 
Only equipment with compatible styles can be connected together.

Shelves have both Fixture Styles and Shelf Styles. The Fixture style must be compatible 
with the equipment it is being placed on. The shelf style must be compatible with the 
product that can be placed on it.

Product has a Product Style. The Product Style must be compatible with the shelf on 
which it is being placed or placement will not be allowed.

Alignments
When objects are placed on shelf objects, they may not be in the best possible 
alignment to display them, or there may be gaps between products leading to 
inefficient use of shelf space.

Macro Space Management has a series of alignment options so that selected products 
on pre-determined shelves can be aligned (justified) to customer specified 
requirements such as the left of the shelf, the back of the shelf, etc.

Product Orientations
Products are normally placed with the front of the packaging facing the front of the 
shelf object. However, placing products in this orientation may not fill the shelf to its 
maximum capacity.
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Macro Space Management thus allows products to be placed in other orientations, for 
example on their side, so that the number of products placed on a particular shelf 
object can be maximized.

Products placed in orientations other than the main one are known as caps.

Equipment Details

Equipment Types  

Equipment is categorized under three types:

■ Fixtures: Equipment that can be placed on the floor and can be populated with 
shelves and/or products.

■ Fittings: Equipment that can be placed on the floor, but can't be populated.

■ Shelves: Equipment that is placed on a fixture and can optionally hold product.

■ In addition, there is a fourth class of objects, Other, any other item that is not 
equipment, for example an architectural column.

Attachment Options  

The equipment used in building a store layout falls into three categories: Primary, 
Secondary and Tertiary.

Primary Equipment indicates the most fundamental form of equipment. All Primary 
Equipment is capable of being placed directly on the floor. Examples of Primary 
Equipment include Metal Uprights, Back Panels, Pallets and Fittings, (such as legs). 
Some Primary Equipment is capable of accepting subsidiary equipment, (Secondary 
Equipment).

Secondary Equipment indicates items of equipment that attach directly to Primary 
Equipment. Secondary equipment cannot be placed directly on the floor. Examples of 
Secondary Equipment include shelves, peg boards and slatted back panels. Some 
Secondary Equipment is capable of accepting further subsidiary equipment, (Tertiary 
Equipment).

Tertiary Equipment indicates equipment that is attached to Secondary Equipment. 
Examples of Tertiary Equipment include pegs, rods and dividers.

Equipment can therefore be arranged in a hierarchy.

All Secondary Equipment must have an item of Primary Equipment as a parent. 
Similarly, every item of Tertiary Equipment must have an item of Secondary 
Equipment as its respective parent. Depending on the design, some items of Primary, 
Secondary and Tertiary Equipment can accept merchandise. Others cannot.

Equipment Placement Options  

The following table indicates how Macro Space Management fixtures and fittings can 
be inserted into the drawing and connected to each other.

Table 4–10 Equipment Placement Options

Shelf Style Name
Can be placed 
on floor

Attaches 
to Fixture

Attaches 
to Shelf

Accepts 
Equipment

Back Panel X X

Basket Shelf Basket X X
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Can be placed on floor indicates equipment that can be placed directly on the floor. 
All other equipment must be attached to and supported by these types of equipment. 
All equipment that places directly on the floor is Primary Equipment.

Attaches to Fixture indicates items of equipment that can be directly attached to a 
fixture. All equipment that cannot be placed directly on the floor and requires 
attaching to a fixture is Secondary Equipment.

Attaches to shelf indicate equipment that can only be placed on a shelf. All equipment 
that needs to be placed on a shelf is Tertiary Equipment.

Accepts equipment indicates that this item can have subsidiary items of equipment 
attached to it. For example, fixtures can accept shelves, shelves accept dividers and 
grilles and pegboards accept pegs.

Equipment Merchandising Options  

Macro Space Management equipment can be merchandised as follows.

(Fittings cannot hold products - only fixtures and shelves can hold merchandise).

Booster Shelf X

Crossbars, Lateral 
Rod

Crossbar X X

Divider Divider X

Fittings, i.e. legs X

Gravity Feed X

Grille/Riser Grille X

Hanging Bar Bar X X

Metal Upright X X

Obstruction, i.e. cross 
brace

Obstruction X

Pallet Pallet X

Pegboards Pegboard X X

Pegs Peg X

Products X

Rods Rod X

Shelves Open Shelf X X

Slatted Back Panels Slatted Back 
Panel

X X

Space Holder Space X X

Table 4–11 Equipment Merchandising Options

Shelf Style Name
Can Populate with 
Placeholder

Can Populate with 
SKU

Back Panel X

Table 4–10 (Cont.) Equipment Placement Options

Shelf Style Name
Can be placed 
on floor

Attaches 
to Fixture

Attaches 
to Shelf

Accepts 
Equipment
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Both fixtures and shelves (Open Shelves, Hanging Bars, etc.) can be populated with 
products. Other fixtures, such as back panels, cannot be populated with products 
directly but can hold shelves - which in turn can hold product.

Can Populate with Placeholder indicates that a placeholder can be placed on the 
fixture. Placeholders allow the user to indicate the fixture can be used for a general 
class of merchandise (for example men's clothing) than a more specific SKU (for 
example blue men's shirts).

Can Populate with SKU indicates that individual items of merchandise (SKU's or 
Stock Units) can be placed on the fixture.

Gondolas
A Gondola is a collection of fixtures and fittings placed in a predetermined 
arrangement. This enables long runs of fixtures to be placed very quickly.

When gondolas are placed, they do not contain shelves. The left hand two bays consist 
of a base unit, leg and back panel and that is how the gondola look on insertion. The 
right hand two bays have had shelves added.

Basket Shelf Basket X

Booster Shelf X X

Crossbars, Lateral 
Rod

Crossbar

Divider Divider

Fittings, i.e. legs

Gravity Feed X X

Grille/Riser Grille

Hanging Bar Bar

Metal Upright X X

Obstruction, i.e. cross 
brace

Obstruction X

Pallet Pallet

Pegboards Pegboard

Pegs Peg X

Products

Rods Rod X

Shelves Open Shelf X

Slatted Back Panels Slatted Back Panel

Space Holder Space

Note: Adding a gondola in Merchandiser is very similar to adding a 
gondola in Planner.

Table 4–11 (Cont.) Equipment Merchandising Options

Shelf Style Name
Can Populate with 
Placeholder

Can Populate with 
SKU
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Adding a Gondola
To Add a Gondola:

From the Object Browser, highlight a gondola in the hierarchy and 'drag and drop' it 
onto the drawing. The Add Gondola dialog box appears.

Figure 4–67 Add Gondola dialog box

■ Select the dimensions from the Options at the bottom left of the dialog box - 
depending on what is configured in Fixture Studio selections can be made from up 
to 6 options. In the above example, a variety of depths and heights can be selected. 
Options are used to select optional parts of the gondola - in this example the Start 
Cap and End Cap can be included or omitted depending on the user's choice.

■ Set the Number and Angle of the gondola. Alternatively, clicking on the 
appropriate measure button enables dimensions to be selected in the drawing.

■ Set the Start Position (left or right), whether the first bay of the gondola is drawn 
starting from the left or the right. This is useful when drawing a gondola starting 
from a corner.

■ When all the parameters have been set in the Add Gondola dialog box, click the 
OK button to draw the gondola.

Adding Shelves to Gondolas
Shelves can only be added in Merchandiser. They can be seen and deleted in the 
Planner Module environment after the information has been synchronized.

Shelves are added by highlighting the required shelf in the Object Browser.

Note: The Angle is particularly important for single sided gondolas. 
When the angle is 0o, the front of the gondola is pointing south (down 
the drawing). It can be changed to east (90o) north (180o) or west 
(270o) simply by inputting in an alternative angle
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Once the shelf has been highlighted it can be 'dragged and dropped' onto the required 
fixtures.

■ If no fixtures are selected, the shelves are added to the fixture onto which they 
have been 'dropped'.

■ If fixtures have been individually selected, shelves are added to the selected 
fixtures (even if the fixtures are not adjacent).

■ If a group of fixtures has been selected, shelves are added to all the fixtures in the 
group.

Once the shelf has been 'dropped' onto the required fixtures, the Add Shelves dialog 
box appears. It appears in its condensed form; click the Array button to expand the 
dialog box.

Note: The shelf selected should be compatible with the equipment 
being placed. For example the shelves should be the same width as 
the back panels on which they are being placed.
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Figure 4–68 Add Shelves dialog box

To add shelves set the quantity, height of the lowest shelf, spacing between shelves, 
and then click Add. The slots and heights can be edited if required. Click the OK 
button to add the shelves to the selected fixtures.

Deleting Shelves
You can delete shelves in two ways:

■ Using the <Delete> key.

■ Using the Empty Shelves command.

Using the Delete Key  

One way of deleting shelves is to select the required shelves, then click the <Delete> 
key.

If the selected shelves are not in a group, they will be highlighted in red or blue. If the 
shelves are in a group (and grouping is on) they will be highlighted in yellow and 
green.

Using the Empty Shelves Command  

To empty shelves:

■ Select the parent fixture. The highlight color for the fixtures depends on whether 
the fixtures are in a Group or not and whether Grouping is on or not.

■ Select the Empty shelves command from the right click pop-up menu.

The shelves are removed from the selected fixtures.
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Insertion Points
There are two types of insertion points; Insertion Points and Child Insertion Points. 
Insertion Points are used to locate objects in the Planner or Merchandiser 
environments. Child Insertion Points are used to locate objects onto already placed 
objects. An example would be the location of merchandise onto a shelf.

Each fixture or fitting used in Macro Space Management has an insertion point. This is 
a single set of co-ordinates that specify the point on the block that Macro Space 
Management uses to locate it in the Planner or Merchandiser environments. The 
graphics for the block have an AutoCAD insertion point. These are fixed when the 
AutoCAD objects are designed and cannot be changed from within the Macro Space 
Management environment.

It is important to specify an insertion point that matches the existing AutoCAD 
insertion point, because the AutoCAD insertion point cannot be changed. Failure to do 
so can lead to misalignments in the drawing.

Child Insertion Points
Child insertion points define how merchandise places onto that onto specific item of 
equipment. This is because products are not directly assigned an insertion point, but 
adopt those specified for the fixture they are being placed on.

If the fixture has an insertion point of Bottom Front Left any products will be placed 
with this point on the product used as a datum. Similarly, products with insertion 
points of Top Back Centre or Bottom back left will be placed using different datum 
points for those products.

If a shelf object (for example a open shelf) was intended to take boxed products, it 
might have its Child Insertion Position set to Bottom Back Left as the boxed products 
will sit on top of the shelf.

If a shelf object (for example a hanging rod) was intended to take products hanging 
from it, it might have its Child Insertion Position set to Top Back Centre so the 
products appear to hang from the rod when placed on it.

These points can be changed within Macro Space Management so it is important that a 
consistent convention is adopted for the position of Child Insertion Points.

Specifying Insertion Points
Insertion points can be specified within Fixture Studio.

■ Select the block to be modified.

■ Select the Edit Block command. This opens the block Details dialog box. The 
Insertion Tab allows the Insertion Position and Child Insertion Position to be 
specified.

Note: Insertion Positions are set in Fixture Studio.

Note: Child Insertion Positions are set in Fixture Studio.
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Figure 4–69 Block Details dialog box

If the Macro Space Management Insertion Position is changed, the AutoCAD or 3D 
Studio insertion position must also be modified by changing the graphic or vice versa.

Failure to do this results in differences between the AutoCAD/3D Studio insertion 
position and the Macro Space Management Insertion Position. This may result in 
misalignment when objects are placed in Macro Space Management. It results in errors 
when calculating adjacencies, etc.

Matching Macro Space Management to Graphical Insertion Points
Macro Space Management holds the insertion location of every object in a Virtual 
Reality Store in its central database. It also holds block details of every object to be 
inserted. These block details hold information including where Macro Space 
Management has assigned the position of the insertion point for the graphic for the 
object.

This graphic (produced by a program such as AutoCAD) contains its own insertion 
point produced when the graphic was first created. The Insertion Point specified 
within Macro Space Management must match the insertion point created when the 
graphic was drawn, or the graphic will be mis-aligned in the Virtual Reality 
environment.

This applies both to objects placed directly on the floor of a store layout (primary 
equipment) and to secondary and tertiary equipment attached to primary equipment.

Note:  The Insertion Position is this dialog box is a Macro Space 
Management insertion position. The original insertion position is an 
AutoCAD or 3D Studio graphics insertion position and the Macro 
Space Management Insertion Position is specified to match.
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Connection Points
Connection Points are used to attach items of equipment or fixtures together in a 
precise alignment. They can either be used singly, or aligned in lines, planes or boxes. 
They also act as filters to ensure that incompatible equipment cannot be connected 
together.

Connection Lines are used where items like crossbars have set positions along their 
length that can accommodate Tertiary Equipment such rods. The position of the arrow 
indicates the position of the connection point. The increments between set positions 
along a connection line are defined in Fixture Studio. The position of the connection 
arrow defines the left most position of the first point on the connection line.

Connection Planes are used where Secondary Equipment such as peg boards or 
slotted back panels have a 2 dimensional array of possible connection points for 
Tertiary Equipment such as pegs. The increments between set positions in a 
connection plane are defined in Fixture Studio. The position of the connection arrow 
defines the bottom left position of the first point on the connection plane.

In the above diagram, blue arrows (1) represent Connection Points; red arrows (2, 3, 4) 
represent Connection Lines and the green arrow (5) represents a Connection Plane. 
The arrow direction indicates the X axis and the arrow lies in the X, Y plane.

Slatted back panels use a connection plane with the X spacing set to 0 so that rods can 
be slip to any position along the slot. The Y spacing is set to the distance between slots.

It is also possible to use more than one connection line, as for example with racking.

The fixture could be defined as two uprights (front and back), plus the cross-bracing. 
This would allow beams (blue) to be added to either the front or the back. Macro Space 
Management will use the nearest connection arrow to the drop/pick point when 
deciding which to use.

Connection points are used to define the exact point on the dropped object (shelf or 
peg or rod) that attaches to the notch position. The connection line/plane filters must 
match the connection point filters. If no connection point is defined for the dropped 
object, it will use the insertion point of the shelf/peg.

Using Connecting Points
To use connection points, both items of equipment should be visible and the 
connection point display should be on. It is suggested that Edit Mode is selected so 
that the viewpoint in the drawing is fixed while connection points are used.

To connect points:
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Click a Connection Point. The first connection point can be selected by simply clicking 
it. It is enclosed by a box suggesting it is selected.

Once the first connection point has been selected, a prompt appears in the status bar.

Now select a Second Connection Point. The second connection point can then be 
selected by clicking it.

If compatible, the two fixtures then snap together in a precise orientation. The 
Equipment will not connect with incompatible connection Points. If the equipment has 
incompatible connection points, a warning message appears in the status bar.

Connections Tab in Fixture Studio
The Connections tab in the Block Details dialog box in Fixture Studio allows you to 
specify the connection options for Macro Space Management blocks.

A small Toolbar at the top lets you add, copy, and delete connections, while the 
Wizard on the toolbar allows you to add basic connections.

The Connections List below the toolbar lists all current connections for the Macro 
Space Management Block. The defined connection points are the defaults for that 
fixture type and are applied for every instance placed in the drawing.

Connections Tab and the Configuration Module
Settings in the Configuration Module can affect how connection points appear and 
behave. Settings are local and can be customized for any user. Access the 
Configuration Module by selecting the Configure Option in the File menu.

Within the Configuration module, select the Fixturing Tab. The Connection Points 
frame can then be used to change their appearance.



Fixtures

4-92 Oracle® Retail Macro Space Management  User's Guide

■ Pointer Size and Line Size affect the appearance of the connection points as 
displayed.

■ Colors for Neutral, Male and Female connection points can also be set.

■ Gender Filter determines whether connection genders are taken into account 
when deciding if connections are compatible.

■ Size Filter determines whether connection sizes are taken into account when 
deciding if connections are compatible.

■ Shape filter options determine whether connection shapes are taken into account 
when deciding if connections are compatible.

These settings are local and do not affect other users of Macro Space Management.

Connection Details
Each connection needs the following information to be specified for it in Fixture 
Studio.

■ Name

■ Type

■ Layer

■ Gender

■ Shape

■ Size

■ Position, Array, and Angle settings

For one item of equipment to connect to another the following must be true.

Table 4–12 Connection Details

Requirement
Optional or 
Mandatory

Gender The connection 
points must have 
compatible genders

This requirement can 
be disabled in the 
Configuration 
Module
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If any of these criteria are not true, then a connection cannot be made. In addition, if 
the details of the connections are not correctly specified relative to each other, 
equipment may connect together in unintended alignments.

Connection Point Parameters

Setting Connection Point Parameters  

The Connection Point parameters are set using the Block Details dialog box in Fixture 
Studio.

The Connections Toolbar  

The Connections Toolbar is found to the upper left of the Connections tab in the Block 
Details dialog box in Fixture Studio. It allows you to add, copy and delete 
Connections. It also allows you to access the Connections Wizard.

Figure 4–70 Connections Toolbar

Add a Connection  

Shape The connection 
points must have the 
same shape

This requirement can 
be disabled in the 
Configuration 
Module

Size The connection 
points must have 
compatible sizes

This requirement can 
be disabled in the 
Configuration 
Module

Icon Function

Add a Connection

Copy a Connection

Delete a Connection

Connection Point 
Wizard

Table 4–12 (Cont.) Connection Details

Requirement
Optional or 
Mandatory
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Clicking the Add a Connection icon causes a line to be added to the Connections List 
ready for further details of the connection to be added.

Figure 4–71 Add Connection

Copy a Connection  

Clicking the Copy a Connection icon causes a line to be copied again to the 
Connections List mirroring details of the connection to be added.

Before clicking the Copy icon, select the connection to be copied. Clicking on the icon 
brings up the connection naming dialog box.

Edit the name to one suitable for the new connection. In the example To be copied has 
been edited to Copied. On clicking OK, a duplicate connection is added, save for the 
changed name.

Delete a Connection  

To delete a connection, highlight the connection be to deleted and click the Delete icon. 
You are asked to confirm deletion.

Connection Wizard  

The Connections Wizard can be accessed from the Wizard icon in the toolbar in the 
Connections Tab in the Block Details dialog box in Fixture Studio.

This brings up the Connections Wizard dialog box.

Figure 4–72 Connections Wizard dialog box
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■ Checking the Add connection on Left checkbox will add a Connection on the left.

■ Checking the Add connection on Right checkbox will add a Connection on the 
right.

■ Checking the Add connection at Back checkbox will add a Connection at the back.

The left connection is male and the right female so that fixtures can only attach when 
they are facing the same way. The left connection is additionally set to be the default. 
The Back connection has no gender, so it attaches to any other connection.

Checking the Clear Existing Blocks checkbox removes any existing connections. On 
clicking OK on the Wizard, the selected default connections are added.

Turning Connection Display On and Off  

The Connection Display can be turned on and off for individual fixtures or a selection 
set of fixtures within the Merchandiser Module. Select one or more fixtures, then move 
the mouse pointer inside a fixture and use <Ctrl> plus right click to bring up the 
pop-up menu.

Clicking the Connection points option in the pop-up menu allows connection display 
to be turned on and off. Hide parent turns off the connection point displaying the 
parent fixture when (for example) a child object such as a shelf is selected.

Alternatively, connection point display can be toggled on or off on the status Bar.

Connection Point Appearance  

When visible, Connection Points are shown as triangles.

The color and size of the connection points can be specified in the Configuration 
Module. Their angle, gender, etc., for a specific fixture can be specified in Fixture 
Studio. Connection Points can appear in lines and arrays, as well as discrete points. 
The example below shows a Connection Line.

Using Connection Points  

Connection points can be used to attach one piece of equipment to another. For the 
equipment to connect, the connection points must be compatible. Some factors 
affecting compatibility are set in the Configuration Module.

Other fixture specific factors are set in the Configuration Tab of the Block Details 
dialog box in Fixture Studio.
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The combination of both sets of parameters determines whether two connection points 
are compatible with each other.

Checklist for Compatibility  

For one item of equipment to connect to another the following must be true.

Gender
The gender of a connection determines whether that connection is compatible with 
another. There are three genders; male, female and neutral. They connect as follows:

Table 4–13 Compatibility Checklist

Requirement
Optional or 
Mandatory

Gender The connection 
points must have 
compatible genders

This requirement can 
be disabled in the 
Configuration 
Module

Shape The connection 
points must have the 
same shape

This requirement can 
be disabled in the 
Configuration 
Module

Size The connection 
points must have 
compatible sizes

This requirement can 
be disabled in the 
Configuration 
Module

Table 4–14 Gender

Can connect with

Male Female Neutral
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Shape
The shape of a point connection can be specified from a list provided by Oracle. They 
connect as follows:

The shape of a connection point is a theoretical concept used to make it easier to 
remember what connects to what - i.e. fixtures with 'Oval' connection points can only 
connect to other fixtures with 'Oval' connection points.

(When displayed in Merchandiser, all connection points will appear visually as 
triangles).

Size
A maximum and minimum size for the connection can be set in Fixture studio. A pair 
of connection points must have compatible sizes to connect together. If the Match 
check box is ticked, then the connections must have identical maximum and minimum 
sizes. If they are not identical, the connections will not mate.

If the Match check box is not ticked, then the connections must have overlapping size 
ranges. If they are not overlapping, the connections will not mate.

Connecting two objects in Edit Mode  

Swap to Edit Mode
To connect two objects in edit mode, first ensure that edit mode has been selected by 
toggling from Walk Mode to edit mode on the status bar.

Female Male Neutral

Neutral Any other connection

Table 4–15 Shape

Can connect with

None Any other connection 
shape

Rectangle Rectangle None

Circle Circle None

Oval Oval None

Triangle Triangle None

Hexagonal None None

Table 4–16 Size

Connection 1 Connection 2

Size Range 0 - 50 25 - 75 Compatible

Size Range 0- 25 50 - 75 Incompatible

Table 4–14 (Cont.) Gender

Can connect with
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Turn Connection Points On
Next, ensure that the connection points have been toggled on by selecting a least two 
fixtures and use <Ctrl> plus right click to bring up the pop-up menu.

Connection Points - On/Off
Turn connection points on and they appears as triangles in the drawing. Click First 
Connection Point and Follow Prompts. Click on the first connection point. (Circled in 
red in the image below).

A prompt appears in the status bar asking to select another connection point.

Select a connection point on the other fixture. (Circled in red in the image below).
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As soon as the second connection point is clicked, the first object is connected to the 
second one.

Note how the two connection points now meet:
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Rotation
Rotations can be used to change the orientation of fixtures and fittings, shelf objects, 
and products.

Fixtures and fittings can be rotated about all three axes, but it would be more normal 
to just rotate about the Z axis. Fixtures and fittings can be rotated using the Edit option 
from the pop-up menu accessed by <Ctrl> and right clicking.

Changing the setting in the Angle section will result in the selected object(s) rotating.

Shelf objects can be rotated about all three axes, but it would be more normal to just 
rotate about the X axis. Shelf Objects can be rotated using the Edit option from the 
pop-up menu accessed by <Ctrl> and right clicking.

Changing the setting in the Angle section will result in the selected shelf object(s) 
rotating.

Products can generally be rotated in any axis. (This is known as product orientation). 
However, the possible rotations may be restricted by the working and stacking axes 
selected for the products' parent shelf object.

Products and Product Groups are best rotated using the Edit Group option from the 
pop-up menu accessed by <Ctrl> and right clicking.

The orientation can be changed to any of the nine options. (If size constraints prevent 
any rotations, the options will not be available).

Working and Stacking Axes  

Working and Stacking axis define how product is placed onto fixtures and shelf 
objects. Fixtures and shelf objects that do not have at least one working and one 
stacking axis defined cannot accept product.

Working Axis

When products are placed onto a shelf object they have to be aligned with each other 
during placement. The working axis's of an item of shelf equipment are the axis's 
which product that is being sequentially placed is aligned along.

■ The X working axis is from left to right.

■ The Y working axis is from front to back.

■ The Z working axis is used for vertical placement.

The working axis set should be appropriate for the type of fixture or shelf object. For 
example a shelf normally has only an X working axis as product is normally placed 
along the length of a shelf. A freezer cabinet might have an X and a Y working axis as 
product is placed both along the length of the cabinet and from back to front

The working axis set should be appropriate for the type of fixture or shelf object.
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Stacking Axis

The stacking axis (or axis's) is the direction(s) that products may be stacked on a 
fixture or shelf object.

■ The X stacking axis is from left to right.

■ The Y stacking axis is from front to back.

■ The Z stacking axis is used for vertical stacking.

The stacking axis set should be appropriate for the type of fixture or shelf object. An 
open shelf has objects placed along the length of the shelf (X working axis). It can have 
objects stacked next to each other (X axis) behind each other (Y axis) and on top of 
each other (Z axis). Accordingly an open shelf should have all three stacking axes 
checked.

A peg on the other hand can only have products placed along its length (Y working 
axis). A peg can only have products slid along its length - they are constrained so they 
can only move in that direction. Accordingly, a peg should only have its Y stacking 
axis enabled.

Setting Working and Stacking Axes  

Working and Stacking Axes are set in Fixture Studio.

The rotation of products is theoretically allowed in any axis. In practice this is 
constrained by the Working/Stacking axes of the shelf objects.

Child Insertion Points  

Child Insertion Points are used to provide a datum for product being inserted onto a 
fixture or shelf object. They are different from Insertion Points. Insertion points are 
used by Macro Space Management to specify the location of an object (fixture, shelf 
object, etc.) within a Virtual Reality store. Child Insertion Points are used by Macro 
Space Management to align product being placed on that fixture, shelf object, etc.

In the above diagram the shelf has an insertion point (red). This has been used to align 
the shelf relative to the back panel it has been placed on. Any moving or editing 
operations for the shelf will be carried out relative to this insertion point. The shelf also 
has a child insertion point (green). This will be used to align any product placed on the 
shelf. Any moving or editing operations for products placed will be carried out 
relative to this insertion point.

Setting Child Insertion Points  

Child Insertion Points are set in Fixture Studio.

SHELF X Y Z

Working X

Stacking X X X

PEG X Y Z

Working X

Stacking X
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Figure 4–73 Child Insertion Points

The Child Insertion Position can be set to any one of nine positions in a specific X - Y 
plane, and to any of three positions in the Z axis. This gives 27 options for the child 
insertion position.

Important: Wherever possible, child insertion positions should be standardized for 
particular classes of object. This will prevent misalignment problems.

Product Orientations  

Product is normally placed on the shelves with the front of the packaging facing the 
customer. However, this orientation can be changed; either during placement or when 
a product is edited.

Figure 4–74 Product Orientation

Front is the default orientation. The other orientations are achieved by the following 
rotations from the default.
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Effect of Rotations
Then the object is rotated to change its orientation, it occupies the same relative 
position on its parent object. This is done by means of child insertion points. In the 
example of the box on a shelf, the child insertion point (the datum for the boxes' 
position) is shown in blue. It is set at the front left of the shelf.

When the box is rotated, it is still aligned relative to the child insertion point, although 
the boxes' insertion point (shown in red) has moved. A similar effect can be seen in the 
example of a box being rotated relative to its parent peg.

The child insertion point (shown in blue) is at the front of the peg. When the box is 
rotated it remains in the same relative position to the child insertion point although its 
own insertion point has changed position.

Products and Planograms
Merchandising is the addition of items for sale to a store plan. There are two ways of 
adding merchandise to a store plan:

■ As individual products

■ As preconfigured arrangements of shelves and products called Planograms

The properties of products can be defined or edited in Product Studio. The properties 
of planograms can be imported, or defined in Merchandiser.

Products

Products can be added at all levels in the product hierarchy. If added at any level 
down to SKU (Stock Keeping Unit), merchandise is added as a placeholder. In 
Merchandiser, you can add products with an additional level of detail called Display 
Styles.

Table 4–17 Product Orientation

Orientation Rotation in X Axis Rotation in Y Axis Rotation in Z Axis

Front None None None

Front Side None 270o None

Back None None 180o

Left None None 90o

Right None None 270o

Left side None 270o 90o

Top 90o None None

Top side 90o 270o None

Bottom 270o None None
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In the above example, the lower shelf has been merchandised with a placeholder, and 
the upper shelf with a display style.

Placeholders

Placeholders are used to indicate that a particular class of merchandise is present on 
the shelf (for example paint) while display styles are used to indicate a very specific 
form of merchandise (for example 1 liter tins of paint).
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In the above example, placeholders could be placed at a number of levels. There are 
also two display styles, 'Hanging Display' for going onto pegs or rails, and 'Shelf 
Display' for placing onto shelves. The Display Styles has different dimensions 
reflecting the different forms they are displayed in.

Placing Products and Planograms
Products are placed by dragging and dropping from the Object Browser or Object Grid 
onto fixtures or shelves and their placement is controlled by a number of factors 
including:

■ What styles are associated with the equipment and with the merchandise

■ Whether the selected objects are in a group or not

■ Whether the size rule is on

■ Other options selected during the actual placement

Products can only be added to fixtures or shelf objects. Products cannot be added to 
fittings as fittings are not designed to accept products. Equipment only accepts 
merchandise at Display Style level if the style associated with the display style is 
compatible with the style associated with the merchandise.

A planogram, a pre-planned arrangement of shelves and fixtures, is designed to 
occupy multiple fixtures. Planograms provide a quick and effective way to rapidly 
place a standard arrangement of shelves and products. The example below displays a 
single bay planogram that occupies a single fixture with three shelves. Planograms can 
be either imported from third party software or they can be designed within 
Merchandiser.

Figure 4–75 Planograms
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Both Products and planograms can be placed either from the Object Browser or the 
Object Grid.

Product Appearance and Annotation
There are number of settings and options affecting how products and planograms 
appear when placed in the drawing.

Configuring Products and Planograms
A number of settings in the Merchandising tab of the Configuration Module affect 
how products and planograms are placed.

Table 4–18 Settings

Option Effect

Walk and Edit mode In walk mode, you can move your viewpoint around the store. If 
edit mode, your viewpoint is fixed.

Size Rule This determines whether products will be confined to the extents of 
the fixture or shelf they are being placed on, or whether they can 
overhang

Clash Detection If clash detection is on (recommended), products are not allowed to 
occupy the same space on a fixture or shelf.

Note: The Size Rule defaults to off each time Merchandiser is started. 
It is strongly recommended that it be reset to on before doing any 
merchandising.

Table 4–19 Options

Option Effect

Shelf and Fixture 
Groups

These determine whether product will place on a single shelf or 
fixture.

Styles The styles for the fixture (or shelf) must be compatible with the 
style assigned to the Display Style.

Table 4–20 Configuring Products and Planograms

Option Effect

Sort Leftmost Determines whether fixtures are populated in the sequence they 
were selected, or from the leftmost first

% over and under 
tolerances

Determines the amount of variation allowed if the length of a 
planogram does not match the selected fixtures

Check rules The options in this frame determine what warnings are given 
when a planogram is placed.

Extend if fixture is 
longer

This (and it's child options) determine what to do if a planogram is 
placed on a longer fixture than it was designed for

Truncate If selected, this will result in shelves being shortened if the selected 
fixture is shorter than the planogram was designed for.
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Walk and Edit Mode
Toggle between walk and edit mode using the options on either the Edit menu or the 
button on the status bar. Use walk mode to move the fixed viewpoint around the store. 
Use edit mode, to view the store with a fixed viewpoint.

It is recommended that you navigate in front of the fixtures or shelves you want to 
merchandise while in Walk Mode, then toggle to edit more. This fixes the viewpoint in 
the store and makes it easier to select fixtures or shelves to place products on.

Size Rule
The Size Rule determines whether products are restricted to the confines of the fixture 
or shelf, or whether they can overlap their extents. It is recommended the Size Rule is 
turned on. If it is not, it is possible that products overlap fixtures or shelves to the left, 
right or above.

Clash Detection
Clash Detection should be turned on when aligning or when products can overwrite 
each other.

■ If Clash Detection is turned on, products move until they are in contact.

■ If Clash Detection is turned off, products can be moved so they occupy the same 
physical space.

Clash detection is toggled On or Off by clicking on the clash Detection icon in the 
View toolbar.

Adding Product Items
When Products are added, they are added as a Product Group. Product Group is a set 
of linked individual products that can be manipulated as a single entity. Products are 
added by dragging them from the window in the Merchandising tab on the Object 
Browser onto the fixture or shelf that they are intended to populate.

They can only be placed if the dimensions of the receiving fixture and fitting are of 
sufficient size and if the styles of the fixture or shelf are compatible with the product 
being placed on it. If the product can be placed then the Add Products Dialogue box 
appears.

This enables the Quantity, Alignment, Detail, Orientation and Properties to be 
specified. Product quantities and alignments can either be placed manually or 
calculated automatically. The latter option is particularly useful when using caps.

Note: The Size Rule defaults to off each time Merchandiser is started. 
It is strongly recommended that it be reset to on before doing any 
merchandising.
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The above example has back and end caps. These could be placed manually, but this 
would be time consuming. They can be placed in a single operation when the quantity 
is calculated automatically.

Adding Products
How products place depends on whether a product placeholder (SKU level of above) 
or a Display Style is chosen to place. A placeholder is placed as soon as it has been 
'dragged and dropped'. If a Display Style is 'dragged and dropped', the Add Products 
dialog box appears.

To add a product:

■ Use Walk Mode to move in front of the fixtures or shelves it is desired to 
merchandise. If multiple fixtures or shelves are to be merchandised check they 
have been formed into a Fixture Group and that Grouping is On.

■ Select the product to be added by highlighting the product in the Merchandising 
tab of the Object Browser. Alternatively, go to the Object Grid and select the 
required product.

■ 'Drag and drop' the product onto the required fixture or shelf.

■ If a Display Style is being placed, set the required options in the Add Products 
dialog box.

Adding a Product at SKU level from the Object Browser
To add Products from the Object Browser,

■ From the Merchandise tab, select the Products sub-tab.

■ Locate the required item in the hierarchy and highlight it.

Note: It is recommended that the Size Rule (Edit Menu) be set to On. 
This will be defaulted to Off when Merchandiser is first started.
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■ Now, hold down the left mouse key and 'drag and drop' the selected item from the 
hierarchy onto the required fixture or shelf.

A + sign by the cursor indicates that the shelf has been selected. As soon as the mouse 
key is released, the placeholder is added.

The placeholder takes up the entire merchandisable volume of the item of equipment 
it has been placed on.

Adding a Product at Display Style level from the Object Browser
To add Products from the Object Browser,

■ On the Merchandise tab, select the Products sub-tab.

■ Locate the required item in the hierarchy and highlight it.

Hold down the left mouse key and 'drag and drop' the selected item from the 
hierarchy onto the required fixture or shelf.

A + sign by the cursor indicates that the shelf has been selected. As soon as the mouse 
key is released, the Add Products dialog box appears.
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Figure 4–76 Shelf Display

Select the appropriate settings, and click the OK button to place the merchandise.

Placeholders take up the entire merchandisable volume of the equipment they are 
placed on. Display Styles take up the space specified by the facing, depth and stacking 
parameters set on addition.
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Adding a Product at Display Style level from the Object Grid
Products can only be added at Display Style level from the Object Grid.

To add Products from the Object Grid:

1. Locate the required item in the list of data and highlight it.

Figure 4–77 Object Grid

In the above example, the 1 liter green display style has been selected.

2. Next, hold down the left mouse key and 'drag and drop' the selected item from the 
hierarchy onto the required fixture or shelf.

Figure 4–78 Adding Product at Display Style

3. A + sign by the cursor indicates that the shelf has been selected. As soon as the 
mouse key is released, the Add Products dialog box appears.
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Figure 4–79 Add Products dialog box

4. Select the appropriate settings and click the OK button to place the merchandise.

Figure 4–80 Adding Products on Shelf
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The Quantity Tab
The Quantity tab allows you to specify the number of instances a product can be 
placed.

Figure 4–81 Quantity tab

Two radio buttons allow you to specify whether quantities are set by the user (1) or 
calculated by the program (2).

■ Facings are the number of times the product can be placed along the shelf (X 
direction).

■ Depth is the number of times the product can be placed relative to the depth of the 
shelf (Y direction).

■ Stack is the number of times the product can be placed on top of itself (Z 
direction).

Note: Placeholders take up the entire merchandisable volume of the 
equipment they are placed on. Display Styles take up the space 
specified by the facing, depth and stacking parameters set on 
addition.
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Figure 4–82 The Quantity Tab - Setting by User

The Quantity tab allows you to specify the number of instances a product can be 
placed. Any quantity can be specified up to the maximum capacity of the fixture or 
shelf.

Figure 4–83 Quantity tab - Setting by User

Two radio buttons allows you to specify whether quantities are set manually by the 
user (1) or set automatically by the program (2).
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Set Manually by the User
For Facing, Stack and Depth, use the radio button to select whether to place a single 
product in that orientation, whether to fill in that orientation or whether to manually 
set the number for that orientation.

Spin controls (3) allow you to set the required quantities for facings, depths and stack 
height.

These quantities are constrained by the dimensions of the shelf or fixture. The 
minimum possible value in each direction is one, while the maximum number is 
determined by the dimensions of the product.

Set Automatically by the Program
Four buttons automatically set the facings, stack and depth values to the maximums 
possible for that option relative to the dimensions of the shelf.

■ The One button (4) sets facings, depth and stack values for a single instance of the 
product.

■ The Depth button (5) sets facings, depth and stack values for a single row of 
product to the full depth and height available.

■ The X,Y fill button (6) sets facings, depth and stack values for a single layer of 
product to the full length and depth of the shelf.

■ The Fill button (7) sets facings, depth and stack values to get the maximum 
number of products on the shelf without using caps.

Grouped (8) determines whether products are placed as product groups, or as a stack 
of ungrouped items.

Note: The Grouped checkbox should be checked.

Table 4–21 Placing Products - Settings

Spin Control Description

Facings The number of times the product can be placed along the shelf 
(the X direction).

Depth The number of times the product can be placed relative to the 
depth of the shelf (the Y direction).

Stack The number off times product can be stacked on top of each 
other (the Z direction).

Note: Automatic setting by the program does not place caps, but 
only places the product in the primary orientation. If your want to 
place products with side, rear or top caps, it is recommended they 
select the Calculate option by clicking on the appropriate radio button 
- (2) in the annotated diagram above.
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The Alignment Tab
The Alignment tab allows alignment to be adjusted in horizontally in the X, Y plane.

Figure 4–84 Alignment tab

The Alignment Tab and Child Insertion Positions
It is important to be aware of the different effects that the Child Insertion Position and 
the selection made in the Alignment tab have.

Child Insertion Position
The child insertion position for a fixture determines the insertion point of the products 
that is placed on the fixture. This is because products are not directly assigned an 
insertion point, but adopt those specified for the fixture they are being placed on.

Note: It is recommended that products are placed as grouped items 
as they can them be manipulated as a single object. If they are placed 
as a stack of ungrouped items, then each item in the stack has to be 
manipulated individually.
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Figure 4–85 Child Insertion Points

If the fixture has an insertion point of Bottom Front Left any products are placed with 
this point on the product used as a datum. Similarly, products with insertion points of 
Top Back Centre or Bottom back left are placed using different datum points for those 
products.

If a shelf object (for example a open shelf) was intended to take boxed products, it 
might have its Child Insertion Position set to Bottom Back Left as the boxed products 
sit on top of the shelf.

If a shelf object (for example a hanging rod) was intended to take products hanging 
from it, it might have its Child Insertion Position set to Top Back Centre so the 
products appear to hang from the rod when placed on it.

Alignment Tab
The setting made in the alignment tab determines the position of the product when 
placed on the object.

Note: Child Insertion Positions are set in Fixture Studio.
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Figure 4–86 Alignment Tab

For example if Back Left is selected, product will be placed at the back left of the shelf. 
Similarly, if front middle is selected for a rod, product will be placed starting at the 
front of the rod.

Summary
The Child Insertion Position determines how the product is placed relative to the 
object it is being placed on; above it, below it, centered on it, etc.

The Alignment Option determines which part of the object (for example a shelf) a 
product is placed starting from. For example if Front Right is selected, the first box of a 
product is placed at the front right of the shelf.

The Detail Tab
The Detail tab gives information on dimensions and quantities.
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Figure 4–87 Detail tab

■ Sizeis the size of one instance of the Product.

■ Gap is the gap between instances of the product. The gap is preset when the 
product is designed in Product Studio and may be necessary where merchandise 
like glass or crockery is concerned.

■ Min stack is the minimum quantity that can be placed.

■ Max stack is the calculated maximum quantity that can be placed.

■ Shelf Capacity is the dimension of the shelf on which the products are being 
placed.

The Orientation Tab
The Orientation tab allows the orientation of the product to be changed when it is 
placed on the shelf.
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Figure 4–88 Orientation tab

The maximum amount placeable for each orientation is shown, while non available 
orientations are inactivated. By default, the product is placed with the front of the 
packaging showing. It can be placed in a whole series of other orientations with the 
top, bottom, left or right sides of the packaging showing.
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Figure 4–89 Product Orientation

In the above example the product group on the left has been placed with the Front 
orientation. A second example of the same product group has then been placed to its 
right in the Top Side orientation.

The Properties Tab
The Properties tab displays a customizable list of properties associated with the 
products being placed. The values for this customizable list can be input into Macro 
Space Management directly or imported from an external program.

Note: Changing orientation will also change the quantity on the 
Quantities Tab to the maximum possible in that orientation. This is to 
allow you to see if changing the orientation increases the quantities 
that can be placed on the shelf.
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Figure 4–90 Properties tab

The information is advisory only and will not cause a warning to be issued if the 
product being placed falls outside of the set criteria.

Automatic Calculation of Product Quantities

Calculation Option Method  

This section details how the calculate option can be used to simplify maximizing the 
number of products placed on a shelf. There are two options for adding products in 
Merchandiser; by manually adding and by automatically adding them by using the 
calculate option.

To maximize the number of products on a shelf it is sometimes necessary to use end 
caps, as in the example below.
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Figure 4–91 Product Placing with End Caps

It is possible to achieve this manually by placing the main body of product, then 
placing the rear end cap and then the size end cap. This may require some time to 
achieve. It is also possible to achieve this in a single operation using the Calculate 
option. This can result in considerable savings in time when populating shelves.

Summary of Method  

Within Merchandiser:

■ Check the Size Rule is ON.

■ If necessary make shelves a Group.

■ Select the product to be placed from the product hierarchy.

■ Drag the product onto the required shelf.

■ Select the calculate option and use the spin controls to set the number of products 
required.

■ Set the tolerance and orientation in the Calculation screen.

■ Set priority for the working axes, specify if dimension is to be filled/ maximum 
number of products and specify if caps are allowed.

■ If solution is satisfactory, click on OK to confirm.

Automatic Calculation Method  

■ Check the Size Rule is On. When placing product it is recommended the Size Rule 
is turned on, either from the edit menu or the icon on the toolbar. This restricts the 
number of products added to those permitted by the confines of the shelf. If this 
option is not enabled, it is possible that product overlaps shelves to the left, right 
or above.

■ If necessary make shelves a Group. With the Size rule on, product is confined to a 
single shelf, unless two or more shelves have been made into a Group. Shelf 
Groups are groups of shelves that are at the same height, at the same angle and 
form a continuous run. Grouped shelves allow you to treat adjacent shelves as one 
long shelf. This enables you to place products that span more than one shelf.
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To make a Shelf Group:

1. Select the shelves.

2. Right click to bring up the pop-up menu and select Group > Join. Ungrouped 
shelves can be distinguished by their red and blue outlines. Grouped shelves have 
yellow and green outlines.

3. Select the product to be placed from the product hierarchy by clicking it to 
highlight it.

4. Drag the product onto the required shelf. Hold down the left mouse key and drag 
the selected product onto the desired shelf. A + sign by the cursor indicates that 
the shelf has been selected. As the mouse key is released, the Add Products dialog 
box appears.

Select the calculate option and use the spin controls to set the number of products 
required. The Add Products dialog box allows the user to control the quantity and 
orientation of the product being placed. The calculate option is selected by clicking on 
the appropriate radio button. The spin control can be used to set the required quantity 
of product to be placed. The Calculate button can then be used to open the calculation 
screen.

Set the tolerance and orientation in the Calculation screen. After the calculate button is 
clicked, the Quantities Calculator screen appears.

Note: If styles are in use the Shelf Style and the Display (Product) 
style must be compatible or the product cannot be placed.

Note: If it is desired to get the absolute maximum of products onto 
the shelf, the required quantity should be set significantly above what 
is required. This will ensure Macro Space Management calculates the 
maximum number of products that will fit on the shelf.
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Figure 4–92 Quantities Calculator screen

■ The Required Quantity (1) is set in the preceding Add Products dialog box. If 
necessary this can be edited to a different value while in the screen.

■ The Quantity Tolerance(2) allows you to set the permissible variation in quantity. 
If set to 0, Macro Space Management tries and calculates an exact solution. If set to 
>0 Macro Space Management accepts the first calculated solution that comes 
inside the permissible range. For example, if set to 60 ± 5, the first calculated 
solution that falls in the range 55 - 65 will be accepted.

■ The Main Orientation (3) of the product can be set from the drop down list. This 
determines which part of the products' packaging faces the front of the shelf.

■ Set priority for the working axes, specify if dimension is to be filled / maximum 
number of products and specify if caps are allowed.
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Figure 4–93 Quantities Calculator screen

The Priority (1) for the working axes can be set by clicking on the appropriate axis to 
highlight it (2) then using the + and - buttons (3) to change the order of priority. Macro 
Space Management calculates the quantities in the order the axes have been selected. 
For example, if the X axis has been chosen, the software will stack the maximum 
number of products along that axis then take the dimensions of those placed products 
in account when calculating how many products can be placed along the second 
priority axis.

If the Fill check box (4) is selected, then Macro Space Management places the 
maximum number of products in that direction. If the Fill checkbox is not selected, 
then a Fixed Quantity (5) can be entered in the appropriate box. If a Fixed Quantity is 
entered, this will also disable the Allow Caps (6) option as the fixed quantity only 
applies to products placed in the Main Orientation. If a quantity greater than the 
maximum number that will fit is entered then the number will default to the largest 
value possible.

Allow Caps (6) can be allowed or prevented by selecting or un-selecting the check box 
as appropriate.

When done, click OK to confirm. The calculate screen will continually update to show 
the effect of any changes.
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Figure 4–94 Quantities Calculator

The results will show in the Proposed Solution frame (1). A warning (2) will appear if 
the number of products that can be placed is below that in the Required Number (3) 
setting. If the details are correct, click on the OK button (4) to place the products.

Adding Products using Pegs  

To add products using pegs in Merchandiser, a series of preparatory parameters must 
be set in the Admin Module, Fixture Studio, and Product Studio. This then enables 
products to be added to pegs in Merchandiser. A pegboard might contain an array of 
10 x 20 pegs, 200 pegs in all. Merchandising these pegs is a potentially time consuming 
operation as this might involve 5 sizes of battery (N, AAA, AA, C & D) from three or 
four manufacturers (Duracell, Exide, Eveready, Energiser).

It is therefore normal to produce a planogram involving a specific combination of 
battery sizes and manufacturers. Once available, this planogram can then be placed 
multiple times in multiple stores. An example would be a battery planogram designed 
for an end cap on a gondola run.
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Figure 4–95 Workflow of Adding Products using Pegs

Setting up Styles in the Admin Module  

Styles serve as filters to determine what can be attached to what.

■ The parent fixture has a fixture and a shelf style.

■ The peg has a shelf style.
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■ The product has a product style.

For the peg to go onto the parent fixture, there must be a style relationship between 
the Fixture and Shelf Styles. For the product to go onto the peg there must be a style 
relationship between the Shelf and the Product Styles.

Settings Required in Fixture Studio  

For products to be placed on pegs, some fundamental settings need to be correct on 
the equipment onto which the products will be placed.

Connection Points
The pegs and their parent fixtures must have compatible connection points. This 
enables them to fit together.

Styles
The pegs and their parent fixtures must have appropriate styles assigned, and a style 
relationship must exist between them.

Merchandisable Areas
The merchandisable area for the peg must be compatible with the product being 
placed.

Connection Points for Pegs and Parent Fixtures  

Connection points are used to fit together one item of equipment to another in 
accurate alignment. For one item of equipment to connect to another the following 
must be true.

If any of these criteria are not true, then a connection cannot be made.

Table 4–22 Connection Points for Pegs and Parent Fixtures

Requirement
Optional or 
Mandatory

Gender The connection 
points must have 
compatible genders

This requirement can 
be disabled in the 
Configuration 
Module

Shape The connection 
points must have the 
same shape

This requirement can 
be disabled in the 
Configuration 
Module

Size The connection 
points must have 
compatible sizes

This requirement can 
be disabled in the 
Configuration 
Module

Table 4–23 Gender

Permissible Values Comment

Male, Female, 
Neutral.

Male connects with 
female.

Neutral connects 
with itself and both 
male and female.
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Male can connect with female, and it would be conventional to give the connections on 
the parent fixture female gender, with the peg having male gender.

Both peg and parent fixture should be assigned the same shape, or 'None'. This will 
allow them to connect.

It is recommended that both the parent fixture and peg are given identical connection 
sizes.

Assigning Styles for Pegs and Parent Fixtures  

Styles serve as filters to determine what can be attached to what.

■ The parent fixture has a fixture and a shelf style.

■ The peg has a shelf style.

■ The product has a product style.

For the peg to go onto the parent fixture, there must be a style relationship between 
the Fixture and Shelf Styles.

For the product to go onto the peg there must be a style relationship between the Shelf 
and the Product Styles.

Configuring Merchandisable Area for Pegs  

The merchandisable area for the peg is the area that merchandise can take up on the 
peg. It is configured in the Merchandisable Areas tab of the Block Definitions dialog 
box for the peg. It is generally set to be unbounded in the X direction using the 
appropriate check boxes.

Setting up the Peg Position in Product Studio  

Peg Positions are set up using the Peg Holes Tab in Product Studio.

Table 4–24 Shape

Permissible Values Comment

None, Rectangle, 
Circle, Oval, 
Triangle, Hexagonal.

Specific shapes will 
only connect with 
themselves and 
None.

Table 4–25 Size

Permissible Values Comment

Minimum size 0, 
maximum size 1000.

Two items of 
equipment must have 
overlapping 
connection sizes to 
connect.

Note: The above comments only deal with the connection between 
parent fixture and peg. Other connections may exist (for example 
between pegboard and supporting legs). These would have different 
genders, shapes and sizes to the connections specified above.
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Figure 4–96 Peg Holes Tab

Peg Hole positions can be added or deleted using the Add or Delete Peg Hole icons on 
the Toolbar:

Setting Up Peg Hole Positions  

To set up a Peg Hole Position requires the following stages.

Figure 4–97 Peg Holes Tab - Setting
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Figure 4–98 Add Peghole

1. Click on the Add Peg Hole icon to add a Peg Hole to the List.

2. The X, Y coordinates of the peg hole can then be set by clicking on the radio 
buttons. 

The selected X, Y coordinates can be seen in the list. These determine where on the 
top of the product the peg hole will be located.

3. The Style Filter allows you to select a Peg Style that the product can be placed on. 
If the product is to go onto two or more styles of peg, then multiple peg holes 
must be defined.

4. The Offsets can then be adjusted to allow for hole positions, etc. 

Selecting the Basic Offset using Radio Buttons  

The nine radio buttons allow you to set an offset in the X, Y plane relative to the top 
back left position of the product.
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In this case the selected radio button corresponds to the blue circle on the product. 
Offsets are calculated relative to the size of the object.

Figure 4–99 Peg Holes Dialog Box

In the above example the Width (X) and Depth (Y) offsets are calculated based on the 
area of the object, which is 100 x 100 mm. All offsets are calculated from the top, back, 
left corner of the package.

Changing Offsets to allow for Hole Positions  

Sometimes a small offset is required in the Z axis to allow for the position of the hole 
relative to the top of the product. The actual position should be the top of the hole, as 
indicated by the red dot in the diagram. This will then correspond with a connection 
line on the peg, which is defined on the top of the peg.
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Figure 4–100 Multiple Peg Holes

Multiple peg hole positions can be defined for a product. The first position is defined 
as the primary, which is the one used when positioning the product on a pegboard. 
The other hole positions determines where the extra pegs are placed.

To define a product with multiple peg holes, simply define two or more peg holes that 
have the same style.

Multiple Peg Types
It is possible to define different types of peg for different parent fixtures. This is done 
by specifying at least two peg holes for the product, and specifying different Styles for 
each from the Style Filter list.

Figure 4–101 Pegs Tab - Style Filter

The actual peg that is used is determined by the pegboard onto which the item is 
placed, as dictated by the style relationship rule. This ensures that the product is only 
placed onto certain types of peg.

Placing Product on top of Product  



Products and Planograms

Merchandiser 4-135

Macro Space Management allows products to be placed on top of other products. This 
is done by determining the height of the top face of the existing product and adjusting 
the elevation of the new product accordingly.

This is only enabled if the parent shelf/fixture of the product, on which it is being 
placed, allows stacking in the Z axis (working or stacking Z axis is enabled).

To place on product on top of another drag the required product from the options in 
the merchandising tab over to the product on top of which you wish to place it. Ensure 
the mouse cursor is just inside the object to be placed on top of, and release the mouse 
key. The desired products are placed on top.

Figure 4–102 Place Products on Other Products

The depth and number of facings of the object being placed on top cannot exceed those 
determined by the length and depth of the object of which it has been placed on top.

Caps
Caps are when the same product is placed over another product, using a different 
orientation, in order to fill space.

Note: If the mouse cursor is just above the object to be placed on top 
of when the key is released, then the object being placed is inserted to 
one side, rather than on top.
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Figure 4–103 Caps

These can be achieved by placing a separate instance of the product on top of another 
product and changing its orientation/rotation. In the first example above, two arrayed 
products would be placed, the first with 2 front facings, the second (on top) with 2 
facings with top orientation.

The second example above could be achieved with three sets of arrayed products: the 
first would be 1 facing with front orientation, then 2 facings with a left orientation and 
finally a 2 facings with top orientation.

Nesting
Nesting is where the same products are arrayed, but the each additional instance 
partially fits within another, as in the example below.

Currently only bottom nesting (as in the example of the cups) is available.

Nesting Different Products
On some occasions, you may want to place different products on top of other 
products, where nesting would apply, but the nesting value could not be determined 
in advance by a value in the database.

Note: Orientations can be changed during insertion by choosing the 
orientation from the Orientations tab of the Add Products dialog box.
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First the products have to be placed on top of each other. The nesting distance can then 
be manually adjusted by selecting the objects to be nested and right clicking to bring 
up the pop-up menu.

Figure 4–104 Edit Article Nesting

Click the Edit Article Nesting option to bring up the Edit Product Nesting dialog box.

The distance can be adjusted by means of the spin control. The units are automatically 
default to imperial or metric units depending on what was defined for the store in 
Store Manager.

Alignment  

Alignment defines the relative positions of product (and sometimes equipment) to 
each other. You can customize position using the various options available. Products 
can be aligned with each other, or with their parent fixture or shelf, depending on 
what is selected. The alignment works with equipment, as well as products.

Buttons for aligning along or across the shelf are enabled only if at least one object is 
selected and the drawing is not read-only.

Buttons for distributing across the shelf are enabled if at least 3 objects are selected and 
the drawing is not read-only.

Clash Detection  
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Clash Detection should be turned on when aligning or products can overwrite each 
other.

■ If Clash Detection is turned on, products move until they are in contact.

■ If Clash Detection is turned off, products can be moved so they occupy the same 
physical space.

Clash detection is toggled On or Off by clicking on the clash Detection icon in the 
Views toolbar

Figure 4–105 Views Toolbar - Detection Icon

Sequential Operations  

Each alignment operation only works on one plane at a time; that is, it only works in 
the X, Y or Z plane for that particular operation. It is thus possible to use sequential 
alignment operations to achieve the desired effect. For example it is possible to use the 
Align to Left operation (X axis) followed by the Align to Back operation (Y axis). This 
will result in all selected products being aligned to the left and rear of the selected 
shelf.

Align to Left
If one or more shelves/fixtures are selected before clicking the Align to Left button, 
then all child products will be aligned to the left. Alignment towards the front or back 
of the shelf will not be affected.

Products will first be sorted in order of position along the length of the shelf. The first 
product will then be placed at the left hand end of the shelf. The next product will be 
placed adjoining the first such that it is adjacent, but does not overlap. Successive 
products will be placed in a similar manner until all have been placed in a left justified 
alignment.

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected.

Products Selected
If only products are selected, then they will be aligned so that left-hand side of each 
product matches the right-hand side of the preceding product in the selection set.
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Figure 4–106 Shelf/Fixture and Products Selected

If the shelf/fixture, plus some of its child products are selected, then only those 
products will be aligned with the shelf, rather than all the products on the shelf.

Figure 4–107 Shelf/Fixture Selected

If the shelf is selected (and no products) and the alignment button is pressed, then it 
will assume all child objects are selected and align them to the shelf.
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Figure 4–108 Justify Left - Product Selection

Align to Centre
If one or more shelves/fixtures are selected before clicking the Align to Centre button, 
then all child products will be aligned to the centre. Alignment towards the front or 
back of the shelf will not be affected.

When all products have been aligned to centre, there will be an equal unoccupied 
space to either side.

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected.

Products Selected
If only products are selected, then they will be aligned so that centre-hand side of each 
product matches the centre-hand side of the first product in the selection set.

Note: It is recommended that Clash Detection be turned on. This will 
avoid one product being placed on top of another if only some of the 
products on a shelf are selected for alignment.
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Figure 4–109 Shelf/Fixture and Products Selected

If the shelf/fixture, plus some of its child products are selected, then only those 
products will be aligned with the shelf, rather than all the products on the shelf.

Figure 4–110 Shelf/Fixture Selected

If the shelf is selected (and no products) and the alignment button is pressed, then it 
will assume all child objects are selected and align them to the shelf.
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Figure 4–111 Justify Centre - Product Selection

Align to Right
If one or more shelves/fixtures are selected before clicking the Align to Right button, 
then all child products will be aligned to the right. Alignment towards the front or 
back of the shelf will not be affected.

Products will first be sorted in order of position along the length of the shelf. The first 
product will then be placed at the right hand end of the shelf. The next product will be 
placed adjoining the first such that it is adjacent, but does not overlap. Successive 
products will be placed in a similar manner until all have been placed in a right 
justified alignment.

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected.

Products Selected
If only products are selected, then they will be aligned so that right-hand side of each 
product matches the right-hand side of the first product in the selection set.

Note: It is recommended that Clash Detection be turned on. This will 
avoid one product being placed on top of another if only some of the 
products on a shelf are selected for alignment.
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Figure 4–112 Shelf/Fixture and Products Selected

If the shelf/fixture, plus some of its child products are selected, then only those 
products will be aligned with the shelf, rather than all the products on the shelf.

Figure 4–113 Shelf/Fixture Selected

If the shelf is selected (and no products) and the alignment button is pressed, then it 
will assume all child objects are selected and align them to the shelf.
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Figure 4–114 Justify Right - Product Selection

Align to Front
If one or more shelves/fixtures are selected before clicking the Align to Front button, 
then all child products will be aligned to the front. Alignment towards the left or right 
of the shelf will not be affected.

Products will first be sorted in order of position along the depth of the shelf. The first 
product will then be placed at the front edge of the shelf. The next product will be 
placed adjoining the first such that it is adjacent, but does not overlap. Successive 
products will be placed in a similar manner until all have been placed in a front 
justified alignment.

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected.

Products Selected
If only products are selected, then each selected product will be aligned so that front 
edge of each matches the front edge of the shelf.

Note: It is recommended that Clash Detection be turned on. This will 
avoid one product being placed on top of another if only some of the 
products on a shelf are selected for alignment.
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Figure 4–115 Shelf/Fixture and Products Selected

If the shelf/fixture, plus some of its child products are selected, then only those 
selected products will be aligned with the front of the shelf, rather than all the 
products on the shelf.

Figure 4–116 Shelf/Fixture Selected

If the shelf is selected (and no products) and the alignment button is pressed, then it 
will assume all child objects are selected and align them to the front of the shelf.
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Figure 4–117 Justify Front - Product Selection

Align to Middle
If one or more shelves/fixtures are selected before clicking the Align to Middle button, 
then all child products will be aligned to the middle. Alignment towards the left or 
right of the shelf will not be affected.

When all products have been aligned to the middle, there will be an equal unoccupied 
space to the front and rear.

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected.

Products Selected
If only products are selected, then each selected product will be aligned so that middle 
of each matches the middle of the shelf.

Note: It is recommended that Clash Detection be turned on. This will 
avoid one product being placed on top of another if only some of the 
products on a shelf are selected for alignment.
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Figure 4–118 Shelf/Fixture and Products selected

If the shelf/fixture, plus some of its child products are selected, then only those 
selected products will be aligned with the middle of the shelf, rather than all the 
products on the shelf.

Figure 4–119 Shelf/Fixture selected

If the shelf is selected (and no products) and the alignment button is pressed, then it 
will assume all child objects are selected and align them to the middle of the shelf.
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Figure 4–120 Justify to Middle - Product Selection

Align to Back
If one or more shelves/fixtures are selected before clicking the Align to Back button, 
then all child products will be aligned to the back. Alignment towards the left or right 
of the shelf will not be affected.

Products will first be sorted in order of position along the depth of the shelf. The first 
product will then be placed at the back edge of the shelf. The next product will be 
placed adjoining the first such that it is adjacent, but does not overlap. Successive 
products will be placed in a similar manner until all have been placed in a back 
justified alignment.

The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected.

Products Selected
If only products are selected, then each selected product will be aligned so that back of 
each matches the back of the shelf.

Note: It is recommended that Clash Detection be turned on. This will 
avoid one product being placed on top of another if only some of the 
products on a shelf are selected for alignment.
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Figure 4–121 Shelf/Fixture and Products Selected

If the shelf/fixture, plus some of its child products are selected, then only those 
selected products will be aligned with the back of the shelf, rather than all the 
products on the shelf.

Figure 4–122 Shelf/Fixture Selected

If the shelf is selected (and no products) and the alignment button is pressed, then it 
will assume all child objects are selected and align them to the back of the shelf.



Products and Planograms

4-150 Oracle® Retail Macro Space Management  User's Guide

Figure 4–123 Justify to Back - Product Selection

Distribute Left/Right
Distribution ensures that the spaces (or overlaps) between objects are equal.

Products
If only products are selected, then Distribute Left/Right will establish the total 
distance between the left edge of the left most product and the right edge of the right 
most product. It will then establish the combined length of all the products within that 
distance.

After comparing the total distance and the combined length, Distribute Left/Right will 
then move all selected products so that the gaps (or overlaps) between the selected 
products are equal.

If products are selected, the left hand and right hand products in the selection will not 
move, but all intermediate products may have their positions adjusted.

Parent Fixture/Shelf
If the parent fixture/shelf is also selected, then it will assume that all child products 
are selected; this will distribute products between the left hand edge and right hand 
edge of the merchandisable areas.

This means that unlike a Products selection, the left hand and right hand products in 
the selection will move to the respective left hand and right hand extents of the shelf 
respectively.

Note: It is recommended that Clash Detection be turned on. This will 
avoid one product being placed on top of another if only some of the 
products on a shelf are selected for alignment.
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Figure 4–124 Distribute - Product Selection

Distribute Front/Back
Distribution ensures that the spaces (or overlaps) between objects are equal.

Products
If only products are selected, then Distribute Top/Bottom will establish the total 
distance between the top edge of the lowermost product and the maximum height 
available. It will then establish the combined heights of all the products within that 
distance.

After comparing the total distance and the combined heights, Distribute Top/Bottom 
will then move all selected products so that the gaps (or overlaps) between the 
selected products are equal.

If products are selected, the top and bottom products in the selection will not move, 
but all intermediate products may have their positions adjusted.

Parent Fixture/Shelf
If the parent fixture/shelf is also selected, then it will assume that all child products 
are selected; this will distribute products between the front edge and rear edge of the 
merchandisable areas.

This means that unlike a Products selection, the top and bottom products in the 
selection will move to the respective top and bottom extents of the shelf respectively.

Note: It is recommended that Clash Detection be turned on. This will 
avoid one product being placed on top of another if only some of the 
products on a shelf are selected for alignment.
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Figure 4–125 Distribute - Product Selection

Other Aspects of Alignment Operations  

Aligning to Non-Rectangular Objects
Macro Space Management allows alignment to non rectangular objects such as 
semi-circular fixtures or corner shelves. The shape of the non-rectangular shelf is 
defined in Fixture Studio, all products placed on the shelf are confined to the bounds 
of the non-rectangular area.

Shelves
Alignment on non-rectangular objects should be carried out using the Shelf alignment 
options and with clash detection on.

Note: It is recommended that Clash Detection be turned on. This will 
avoid one product being placed on top of another if only some of the 
products on a shelf are selected for alignment.
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Figure 4–126 Products Alignment

Non-rectangular products are treated as boxes for alignment purposes.

Aligning to Snap Grid
It is possible to align objects to a regular grid. This can be toggled On or Off by 
clicking on the Snap option on the Status bar.

Figure 4–127 Status Bar - Snap Option

It is also possible to toggle it On or Off using the Edit menu. The grid itself can be set 
to be displayed using the Grid Lines Option in the View menu.
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Figure 4–128 Merchandiser View Menu

This brings up the Grid Lines dialog box which can be used to set the parameters of 
the grid.

Figure 4–129 Grid Lines Dialog Box

The grid appears in the Virtual Reality Environment.

To turn a grid off, go to the Layers dialog box and turn off the grid lines layer.
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Figure 4–130 Layers Dialog Box

Adding Planograms  

A planogram, a pre-planned arrangement of shelves and fixtures, is designed to 
occupy multiple fixtures. Planograms provide a quick and effective way to rapidly 
place a standard arrangement of shelves and products. The example below displays a 
single bay planogram that occupies a single fixture with three shelves. Planograms can 
be either imported from third party software or they can be designed within 
Merchandiser.

Planograms are designed to go on fixtures of specific dimensions. These are selected in 
the store plan. The actual planogram that is then placed consists of shelves and 
merchandise placed on those fixtures.
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Figure 4–131 Adding Planograms

Both Products and planograms can be placed either from the Object Browser or the 
Object Grid.

Planogram Hierarchy  

Planograms are organized in a Planogram Hierarchy. This can be found in the Object 
Browser.
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Figure 4–132 Planogram Hierarchy

Planograms can be added to the hierarchy in Macro Space Management in one of three 
ways:

■ Imported from third party software

■ Designed from new in Macro Space Manager

■ Created from existing equipment and merchandise in Macro Space Manager

The hierarchy can be modified in one of two ways: groups and planograms.

■ Groups: Groups are similar to directories in Windows Explorer - they provide 
folders in which planograms can be stored in a logical arrangement. Groups can 
be set up in a hierarchical structure - for example Summer Promotion is a child of 
Promotional Items.

■ Planograms: Planograms can only be assigned to groups.

Designing a Planogram  

Planograms are designed from new by selecting a parent group and highlighting it. 
There are then two options: using the menu options or using the right click pop up 
menu.

To add anew planogram:

1. Select the New Planogram option from the File Menu. Alternatively, planograms 
can also be added by using Ctrl + Right Click to bring up the pop-up menu and 
selecting Add Planogram.
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Figure 4–133 Add Planogram

2. Planogram dialogue box appears. The Planogram dialogue box allows you to 
specify complete details for the planogram.

Figure 4–134 Add Planogram - Details

■ The Details tab allows the planogram name, effective date, to be specified.

■ The Properties tab is not editable.

■ The Stores tab allows you to select which stores the planogram is intended for.

■ The Seasons tab allows you to select which time periods the planogram is 
intended for. 

■ The Fixture Styles tab allows you to specify which types of fixtures the 
planogram can be placed on. 

■ The Design tab allows the planogram design to be modified relative to the 
fixtures and merchandise selected in the store. 
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■ The Financial tab allows you to provide financial information about the 
planogram.

■ The UDA tab allows User Designed Attributes to be set for the Planogram. 

3. Click Save as option to save the planogram. On saving of the Planogram dialogue, 
the new planogram appears in the hierarchy.

Adding Planograms  

To add a planogram:

1. Use Walk Mode to move in front of the fixtures or shelves it is desired to 
merchandise

2. Select the fixtures the planogram is to be added to

3. Select the planogram to be added

4. Highlight the required planogram from the Merchandising tab of the Object 
Browser.

5. Alternatively, go to the Object Grid and select the required planogram.

6. 'Drag and drop' the planogram onto the required fixture or shelf.

Adding a Planogram from Object Browser  

To add Planograms from the Object Browser:

1. Select the required fixtures in the drawing.

Figure 4–135 Placement of Planogram

2. Identify which fixtures are required for the planogram by highlighting a 
planogram in the hierarchy and selecting Open Planogram from the file menu.

Note: It is recommended that the Size Rule (Edit Menu) be set to On. 
This will be defaulted to Off when Merchandiser is first started.

Note: Turn Grouping off in the status bar. This will make it easier to 
select the required fixtures.
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Figure 4–136 Planogram Studio - Open

This opens the Planogram Design Window.

Figure 4–137 Planogram Studio - Lightbulbs

3. Identifying the required fixtures can be done by holding the mouse pointer over 
them until the tooltip appears. Dimensions can be found by right clicking and 
choosing the edit option from the resulting pop-up menu.

4. Once the fixture details are known, go to the Merchandise tab in the Object 
Browser and select the Planograms sub-tab. Locate the required item in the 
hierarchy and highlight it.

Note: Fixtures required for the planogram appear in sequence from 
left to right and not in the positions they are in the drawing.
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Figure 4–138 Planogram Studio

5. Next, hold down the left mouse key and 'drag and drop' the selected item from the 
hierarchy onto the selected fixtures.

Figure 4–139 Drop Item on Fixtures

A + sign by the cursor indicates that the shelf has been selected.

6. Release the mouse key to add the planogram. How the planogram places depends 
on the settings in the Check Rules frame of the Configuration Module.
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Figure 4–140 Configuration Module - Merchandising

In the above example, the planogram length, depth, height, style and whether the 
planogram has been split have been set to give warnings. If some or all the check 
rules have been set to on, the warning dialog may appear.

Figure 4–141 Planogram Placement Errors

7. To stop placing the planogram click OK. To place the planogram click Ignore
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Figure 4–142 Placement of Planogram

Adding Planogram in a Object Grid  

To populate (or repopulate) the Object Grid with data:

1. Select a node in the Object Browser. Ensure the Refresh button is on in the Object 
Grid. The Object Grid will be populated with all child data below that node.

Figure 4–143 Add Planogram

2. To add planograms from the Object Grid, highlight the required planogram. (If 
necessary, use the Find, Sort and Filter options to simplify the list).
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Figure 4–144 Object Grid

3. Drag and drop into the drawing. On 'dropping' the planogram it is placed in the 
drawing.

Exploding and Imploding Planograms  

It is possible to place planograms in both the Planner and Merchandiser modules. 
There is a difference in how they appear.

■ In the Planner module they appear as placeholders - a single block without any 
detail.

■ In the Merchandiser module they appear with considerable detail including 
Display Style information for products appearing on specific shelves.

When a planogram placed in the Planner module is first viewed in the Merchandiser 
module, it appears as a single product block with little detail. The Explode option 
shows it in full detail, while the Implode option allows the level of detail to be 
reduced.

Exploding or Imploding Planograms in Merchandiser does not affect the level of detail 
shown in the Planner module.

Exploding a Planogram  

When a planogram is placed in the Planner Module and subsequently viewed in the 
Merchandiser module it initially appears as a placeholder.

In the above example, the planogram appears as simple product blocks on the left 
hand base and back panel. There are two modes of exploding planograms:
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■ If no fixtures are selected, all 2D planograms in the drawing are exploded.

■ If fixtures containing planograms are selected, only the planograms on those 
fixtures are exploded.

To explode planograms:

1. Select the option from the Directions and Product Text toolbar.

Figure 4–145 Planogram Studio - Explode

2. If no fixtures containing planograms are selected, a warning dialog box appears.

3. Click OK to explode all planograms in the drawing. If fixtures containing 
planograms are selected, those planograms are exploded (without the warning 
dialog box).

Exploded planograms can then be seen at their maximum level of detail.

Figure 4–146 Planogram Explode 
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Imploding a planogram  

Imploding planograms reverses the exploded planogram. The planogram is displayed 
at a lower level of detail.

To implode specific planograms:

1. Select the parent fixtures. To implode all planograms, ensure no fixtures are 
selected.

2. Click the Implode icon in the Directions and Product Text toolbar.

Figure 4–147 Planogram Studio - Implode

3. A warning dialog box appears if no fixtures are selected. Click Yes to implode. 

The planograms is imploded. 

Figure 4–148 Updating Planogram Versions

Imploding and exploding planograms has another use. Sometimes planogram designs 
are updated and a new version of the planogram is generated. This information is held 
in the Macro Space Management database. Imploding then Exploding all planograms 
in the drawing has the effect of replacing any outdated versions of planograms with 
the latest versions.
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Configuring Planograms
How planograms place is determined by settings in the Merchandising tab of the 
Configuration Module. This can be called from the File menu of Merchandiser or from 
the Properties icon on the Object Browser toolbar.

Figure 4–149 Configuring Planogram

Planograms are designed for fixtures of specific dimension and type. If placed on other 
fixtures the behavior of the planogram (and any subsequent warnings) depends on 
what settings are selected in the Configuration Module.

■ Options Frame: Settings in the Options Frame determine the degree of variation 
allowed if the length of the selected fixtures differs from those in the planogram 
design.

■ Check Rules Frame: Settings in the Check Rules frame determine what warnings 
are given if the planogram design does not match the selected fixtures.

■ Placement Rules Frame: Settings in the Placement Rules frame determine what to 
do with products if the planogram dimensions do not match the fixture 
dimensions.

Planogram Group Operations

Adding a Group

To add a group: 

1. Highlight a node in the hierarchy to which the group will be child of. 

2. Use Ctrl + Right Click to bring up the pop-up menu.
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Figure 4–150 Add Group

3. Next, select Add Group to bring up the Group dialogue box.

Figure 4–151 Group dialogue box

4. The Name and description can be typed in, and the pertinent icon selected from a 
drop down list. 

5. On clicking OK, the group is added to the hierarchy.

Editing a Group

Groups can be edited in one of two ways; their details can be modified, or their 
position in the hierarchy can be changed.

To edit details:

1. Highlight the required group in the hierarchy and use Ctrl + Right Click to bring 
up the pop-up menu.
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Figure 4–152 Edit Group

2. Select the Edit Group option. This brings up the Edit Group dialogue box. Modify 
it as required.

Figure 4–153 Edit Group dialogue box

3. Modify the information as required, click OK and the edited details are modified 
in the hierarchy.

Deleting a Group

To delete a group from the hierarchy:

1.  Highlight the group you want to delete and use Ctrl + Right Click to bring up the 
pop-up menu.

2. Click Delete Group, a confirmation to delete planogram appears.
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3. Click Yes and the Group and any child objects are deleted.

Editing Objects

Editing Fixtures

Fixtures can be edited on the Fixtures tab of the Object Browser.

To edit a fixture:

1. Select a fixture from the Fixturing tab of the Object Browser.

2. From the toolbar, select Edit fixture icon. The Edit Fixture dialog Box opens in the 
Fixture Studio.

Figure 4–154 Edit Fixture

This allows the Position, Angle and Size of the fixtures to be edited.

Editing Shelves

Shelves can be edited from either the Fixtures or Merchandising tabs in the Object 
Browser.

1. Hold down <Ctrl> and right click to bring up the pop-up menu.

2. Click on the Edit option to bring up the Edit Shelves dialog Box.

Note: If dissimilar fixtures have been selected as part of the Group, 
only options that are common to those fixtures will be available for 
editing.
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Figure 4–155 Edit Shelves dialog Box

This allows the Position, Slot Number, Angle and Size of the shelves to be edited.

Editing Products

You can edit single or grouped products by using Edit or Edit Group option.

To edit products:

1. Select the product by highlighting it.

2. With the cursor on the product, hold down the <Ctrl> and right click to bring up 
the pop-up menu.

3. Select Edit. The Edit Product dialog box appears.

Figure 4–156 Edit Product dialog box

4. Modify the position and orientation of the product. Changes made will affect the 
single instance of the product.

5. Click OK when done.

Edit Group

Note: If dissimilar shelves have been selected as part of the Group, 
only options that are common to those shelves will be available for 
editing.



Products and Planograms

4-172 Oracle® Retail Macro Space Management  User's Guide

The Edit Group option enables you to edit the products in the group.

1. Select Edit Group from the pop up menu to bring up the Edit Group dialog box.

Figure 4–157 Edit Groups Dialog Box

2. The changes made affect the grouped products.

Removing Products

There are two ways of removing products from fixtures or shelves.

■ Selecting the item of merchandise and using the <Delete> key.

■ Selecting the item of equipment and using the Empty command.

Using the Delete Key

To use the delete key:

1. Select the required items of merchandise. 
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Figure 4–158 Highlight Merchandise to Delete

2. Once the required merchandise has been selected, click the Delete key to remove 
it.

Using the Empty command

The Empty command is found on the Edit menu.

Figure 4–159 Empty Command

To use it, select the required shelves or fixtures. Once the fixtures are selected, use the 
Empty command (or Ctrl+E) and the fixtures or shelves are emptied of merchandise.
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Time Dependent Data
Macro Space Management data can come from two main sources: the program itself 
and data imported from external software. This data is stored in the central Macro 
Space Management database. The data can be analyzed in two ways: using Reporting 
Tools and Key Performance Indicators (KPI).

KPIs present data visually in the form of color coded objects within the Virtual Reality 
store. This enables an overview of performance to be seen at a glance. Reporting Tools 
present data in the form of ordered lists. This enables data to be analyzed in detail. The 
two methods are complementary, enabling you to see information in two different 
ways.

As data changes with time, Macro Space Management allows data to be analyzed for 
specific periods of time. Such information is known as Time Dependent Data. It is 
possible to review Time Dependent Data for a specific day, week, month, quarter or 
year. It is also possible to review the data for seasons or any other specified criteria.

Data Import
Data can be imported from external programs using Macro Space Management's Data 
Import module.

Figure 4–160 MSM Data Importer

This data is then stored in tables within Macro Space Management's central database. 
Such data might include sales values, product volumes, etc. Imported data can then be 
analyzed using Report Studio or KPIs, (Key Performance Indicators).

Store Manager

Status and Effective Dates

Status

Note: Macro Space Management has an internal reporting tool called 
Report Studio. Alternatively, reporting tools from Oracle can be used - 
an example is BI Publisher.
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Each store within a retail organization is subdivided into floors. Each floor in turn can 
have a number of revisions, and each revision can contain a number of drawings. Only 
one drawing at a time can be current (active) for a store. The current position of a 
drawing is indicated by its status. Although there will be some variation from 
customer to customer, statuses tend to follow the same general sequence.

■ Proposed drawings are tentative layouts for stores.

■ Authorized drawings are layouts that have been accepted for future 
implementation.

■ Current drawings are the layouts that are presently in use.

■ Historical drawings are drawings of layouts that have been superseded.

A specific store may only have one current drawing (the layout presently in use) and 
one authorized drawing (the layout due to come into use) at any one time. Drawings 
can be viewed with any status, but the amount of information available for KPIs and 
reports may vary depending on the status of the drawing. For example, drawings with 
Proposed status may not have sales data associated with them, while drawings with 
Current status will have sales data associated with them.

Publish and Effective Dates
When a drawing reaches Authorized status it may have Publish and Effective dates 
assigned to it. The Publish Date is the date at which an authorized drawing is sent to 
the affected stores so that they may begin preparations for implementing it. The 
Effective Date is the date at which the drawing becomes the active version of the 
layout within the affected stores.

Effect of Effective Date on Status
When an Authorized drawing is given an Effective date, this indicates the date at 
which it is to come into use. At the date when the drawing becomes Effective, its status 
is changed from Authorized to Current. Simultaneously, the drawing it replaces has 
its status changed from Current to Historical.

Figure 4–161 Status Flowchart

Setting Effective Dates in Store Manager

Note: Publish and Effective dates can only be set when a drawing 
has Authorized status.
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You can set the Effective Date for a drawing within Store Manager by accessing the 
Properties file of the drawing.

To set the effective date:

1. Selecting the required drawing by highlighting it.

2. Right click on the drawing to bring up drop down menu options.

Figure 4–162 Set Effective Dates

3. Select Properties to bring up the Properties dialog box.

4. Set the Publish Date and Effective Date by selecting the dates from the calendar.

5. Click OK.

KPIs
Key Performance Indicators (KPIs) allow fixtures to be color coded to show 
performance. They can be customized according to requirements and can use either 
Macro Space Management data or information from other databases.

Key Performance Indicators (KPIs) can be produced using data from the store 
associated with the current drawing, or from a user specified store. Macro Space 
Management enables you to select both the date and time period for the data to be 
displayed. This enables you to monitor performance with specified time periods.

KPIs can be selected from the Object Browser by clicking the KPI tab.

Note: Publish and Effective dates can only be set when a drawing 
has Authorized status.
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Figure 4–163 Merchandiser - KPI

Click on a particular KPI to bring up the Key Performance Indicator Dialogue Box.

Figure 4–164 Key Performance Indicator Dialogue Box

On this dialog box, you can specify the Details, Stores involved and Date Ranges 
required. You can specify which ViewPort(s) to use. When done click OK.
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Editing KPIs

KPIs are made up of three elements:

■ Data source: The data source provides the information that is going to be color 
coded. It may be a column in a database table or view, a simple SQL select 
statement, or a stored procedure. Whichever data source is used determines the 
results that will be displayed.

■ Color theme: The Color Theme defines the colors used to indicate the different 
results for the KPI. In the example below, colors have been assigned to bands of 
percentages.

Figure 4–165 KPI Color Themes

The colors and descriptions that are defined in the Color themes are displayed in 
the Legend pane of the KPI tab of the Object Browser.

■ Definition: The KPI definition combines the Color Theme and the data source. It 
defines what KPI type it will be, that is product, shelf, fixture or zone, which in 
turn determines which type of object will be colored in Planner. The definition 
also gives the KPI Name that is displayed in the Indicators section of the KPI tab 
of the Object Browser.
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Figure 4–166 KPI - Edit Indicators Dialog Box

Running Quick Reports

To run the reports:

1. From the View menu options, select Reports. The Reports dialog box comes up. 

Figure 4–167 Quick Reports Dialog Box

2. Select the Report by selecting from the drop-down list. You can switch between 
reports by choosing the reports in the drop-down box.

3. On selecting the report, the data is populated in the tables. 
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Figure 4–168 Quick Reports Results

Filtering Data
You can filter data by selecting a cell in the report and clicking the Filter button. 

On clicking the Filter button, the report will be filtered to only match items that are the 
same as the selected cell. 

Clear the filtered data by clicking the Refresh button. You can search for any item in 
the report by highlighting an appropriate cell and clicking the Find in Drawing icon.

Selecting Stores
To select stores:

1. On the KPI tab, select the required KPI by highlighting it. Ensure the store layout 
drawing is open.

2. Double click the KPI to display the Key Performance Indicator dialog box.

3. Select the Stores tab.

Figure 4–169 KPI - Stores

4. If the Current Store check box is selected, clear the Current Store checkbox to 
select any other store. When you clear the Current Store checkbox, available store 
names and codes are displayed in the box. You may sort the data by Store Code or 
Store Name by clicking the column header.
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5. Select the store and click OK. The KPIs are displayed for the store associated with 
the active drawing.

Selecting Dates Ranges
You can select the date range for the KPIs to be displayed by using the Date tab in the 
Key Performance Indicator dialog box.

Figure 4–170 KPI - Date

To select the dates:

1. On the KPI tab, select the required KPI by highlighting it. Ensure the store layout 
drawing is open.

2. Double click the KPI to display the Key Performance Indicator dialog box.

3. Select the Date tab.

4. You can select from the available options:

5. Effective Date - date on which the drawing becomes current

6. Current Date - system's current date

7. Other Date - user specified date

8. Active Date

9. Select appropriate data in the Data Type field from the drop down options. This 
specifies the time period relative to the selected date. All date ranges are after the 
selected date. For example, if the current date is 11/10/06 and a date range of a 
Month, then the application selects all data for October 2006

KPIs and ViewPorts
Each KPI can be associated with one or more viewports. This is specified in the Details 
tab of the Key Performance Indicator dialog box when the KPI is first opened.
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Figure 4–171 KPI - Details

In the above example, the KPI has been selected to show in ViewPort 1.

KPIs and using Multiple Viewports
You can use ViewPorts to display a single KPI reporting on data over different date 
ranges. You can also use ViewPorts to display performance data from different stores 
sharing the same layout. Each instance of the KPI can be set to show in a different 
ViewPort window, allowing the Macro Space Management user to compare how 
performance changes over time or how performance varies from store to store.

Figure 4–172 Key Performance Indicator dialog box



Time Dependent Data

Merchandiser 4-183

In the above example the Weekly Sales KPI has been set to show in four different 
ViewPorts, each showing a different weeks data. 

Renaming KPIs
Each instance of similar KPIs open in multiple ViewPorts has to be renamed because 
each KPI must have a unique name. If duplicate names occur, Macro Space 
Management places a warning at the bottom of the Key Performance Indicator dialog 
box.

Figure 4–173 Key Performance Indicator dialog box - Naming

In the example below the SubClass Forecast Sales (Fixture) KPI has been renamed to 
each instance has a unique name.

Figure 4–174 Key Performance Indicator dialog box - Rename

Selecting stores
Stores can be selected from the list on the Stores Tab of the Key Performance Indicator 
dialog box.
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Figure 4–175 Key Performance Indicator dialog box - Store Tab

Date Ranges
Start dates and Date Ranges can be set from the Date Tab of the Key Performance 
Indicator dialog box.

Figure 4–176 Key Performance Indicator dialog box -Dates Tab
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5Fixture Studio

The Fixture Studio Window has a number of parts.

Figure 5–1 Fixture Studio Window

■ The Menu Bar gives access to a number of menus.

■ The Toolbar allows the selection of a number of options relative to fixture and 
gondola creation.

■ The Block Browser has a hierarchical tree of fixtures or gondolas depending on 
which tab is selected.

■ The Preview Window in the Object Browser gives a simplified image of the 
selected object.

■ The Status Bar at the bottom of the screen gives information on the number 
objects selected, status of current action, etc.

■ The Gondola Definitions Window contains a list of all gondolas held in the 
central database.
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■ The Block Definitions Window contains a list of all blocks (fixtures, fittings, etc.) 
held in the central database.

Menu Bar and Toolbar Options 

Fixture Studio Menu Bar
The Menu Bar contains five options.

Figure 5–2 Menu Bar

■ The File menu allows blocks to be read and saved. It also allows blocks to be 
loaded to and saved from the drawing and allows the blocks to be subjected to 
operations such as normalizing or producing 3DS files.

■ The Edit menu allows block definitions to added, edited, and deleted.

■ The View menu allows the way block definitions display in Fixture Studio to be 
defined.

■ The Window menu allows you to specify the way the various windows and dialog 
boxes display in Fixture Studio.

■ The Help menu calls the Help module and allows you to see system information 
for the computer the software is running on.

File Menu
The File Menu has varying options concerned with reading and saving blocks, 
AutoCAD operations and connection to AutoCAD.

Figure 5–3 File Menu



Menu Bar and Toolbar Options

Fixture Studio 5-3

■ Read Blocks reads the details of all blocks from the central Macro Space 
Management database or the drawing into Fixture studio.

■ Save Blocks saves the details of all blocks back to the central Macro Space 
Management database from Fixture studio.

■ Save Gondolas saves the details of any newly created gondolas back to the central 
Macro Space Management database from Fixture studio.

■ Load Blocks into Drawing, Load Blocks From Disc, Lay Out Blocks in Drawing, 
Normalize Blocks, Create 3DS Files and Redefine blocks from disk are 
discussed in more detail here.

■ Block Factory is a wizard intended to assist in block creation. Clicking on Block 
Factory will bring up the Block Factory dialog box.

Figure 5–4 Block Factory

■ Configure brings up the Configuration module. This can be used to change 
fundamental settings in Macro Space Management.

Note: The Load Blocks into Drawing, Load Blocks From Disk, 
Layout Blocks in Drawing, Normalize Blocks, Create 3DS Files and 
Redefine blocks from disk options are not enabled unless the Connect 
to AutoCAD option has been checked.
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Figure 5–5 Configuration module

■ Connect to AutoCAD opens the AutoCAD environment (if not already open) and 
enables a number of block editing commands that cannot otherwise be used.

Edit Menu
The Edit Menu has varying options concerned with editing block descriptions.

Figure 5–6 Edit Menu

■ Add Block, Edit Block, and Delete Block result in a block being added, or the 
selected block being either edited or deleted.

■ Copy Data and Paste Data allow information to be copied from one block to 
another, or copied into a block being added. If data is going to be overwritten, a 
confirmatory warning appears.
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■ Copy Options brings up a dialog box allowing the data being copied to be filtered.

Figure 5–7 Copy Options

■ Clear all Blocks removes all blocks from the list of blocks currently loaded into 
Fixture Studio.

■ Filter Data brings up the Filter Listed blocks dialog box.
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Figure 5–8 Filter Listed Blocks

■ Edit Sizes brings up the Edit Sizes dialog box.

Figure 5–9 Sizes Window

Editing Sizes
Sizes are used to collect together a set of size rules. When a block is associated with a 
size, it is associated with all the size rules. This allows multiple sizes to be assigned to 
a block.
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Figure 5–10 Editing Sizes

Setting Up Size Groups
Size Group Classes are used to organize size groups into sub-divisions that make it 
easier to find the required Size Groups. Size Group Classes have an administrative 
function, but do not directly affect the data stored in Size Groups.

Figure 5–11 Setting Up Sizes

Adding a Size Group  

You can build a hierarchical tree using Adding a Size Group option. To add a Size 
Group, highlight the node in the hierarchical tree to which the new Size Group is to be 
added and click the Add a Size Group icon. The Size Group dialog box appears.

Note: If a Size is changed, all the blocks that reference that size will 
have their associated size rules changed.



Menu Bar and Toolbar Options

5-8 Oracle® Retail Macro Space Management  User's Guide

Figure 5–12 Size Group

Type in the name of the required Size Group and click OK. The Size Group is added to 
the hierarchical tree.

Editing a Size Group  

Size Group names can be edited. To do this, highlight the required Size Group and 
click the Edit a Size Group icon. The Size Group dialog box appears.

Figure 5–13 Renaming Size Group

Change the name of the Size Group then click OK. The Size Group is amended in the 
hierarchical tree.

Deleting a Size Group  

To delete a Size Group, highlight the group and click the Delete a Size Group icon on 
the toolbar.

Adding a Size
To add a size click the Add a Size icon in the section of the toolbar concerned with 
adding, editing, and deleting sizes.
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Figure 5–14 Adding a Size

When adding a size, first select the size group it is to be added to by clicking it. If this 
is not done, an error message appears.

Figure 5–15 Size Group - Error

If a Size Group has been selected, the Size dialog box appears.
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Figure 5–16 Size - Details tab

On the Details tab, enter a name, a description and a title for the size. Select the units 
from the drop down list. Click OK to confirm and the size group is added to the 
hierarchy.

Size Types
There are a number of options for setting size rules. These are selected from the Type 
drop down list.
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Figure 5–17 Size - Types tab

Options are:

■ Fixed

■ Variable

■ Choice

■ Match

■ Delta

■ Ratio

■ Locked

Fixed Sizes  



Menu Bar and Toolbar Options

5-12 Oracle® Retail Macro Space Management  User's Guide

Figure 5–18 Size - Fixed

When setting fixed sizes, only a single dimension can be input for length, depth, and 
height. All other options are unavailable.
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Variable Sizes  

Figure 5–19 Size - Variable

Variable Size allows you to set a number of discrete sizes that can be selected when the 
block is inserted into the AutoCAD or Virtual Reality environments. The application 
prompt enables you to type in a brief description of that dimension; for example 
length, Depth or Height. The Maximum and Minimum dimensions can then be set: in 
the above example, the length has been defined as having a minimum of 500 mm and 
a maximum of 1000 mm.

The Increment can be set to specify the change from one permissible dimension to 
another. For the above example, the length has a minimum value of 500 mm and a 
maximum value of 1000 mm. Because the increment has been set to 100 mm, you can 
set the length to 500, 600, 700, 800, 900 or 1000 mm when the block is inserted.

Choice allows you to set in a number of predefined size options.
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Figure 5–20 Size - Choices

When this option is selected from the Type drop down menu an additional Size 
Choices tab appears. The names entered in the prompt fields in the Types tab appears 
in the Size Choices tab as the names of the dimensions.
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Figure 5–21 Size - Size Choices

The actual dimensions can be added in the Size Choices tab.

The toolbar allows you to add, delete and re-order the list of dimensions.

Match Sizes  

Match Sizes enables you to link one dimension to another.
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Figure 5–22 Size - Match Sizes

At least one dimension must be defined using another size option, for example Fixed. 
The other dimension(s) can be saved to the specified dimension. For example if the 
length has been fixed at 2000 mm, then the depth and height can be specified as 
matching the length. This results in a block where the length, depth and height all 
match.

Figure 5–23 Size Details

Delta  

Delta allows you to select another dimension and specify the current dimension to 
match that plus/minus a specified increment.
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Figure 5–24 Size - Delta

This functionality is not implemented in this release of Macro Space Management.

Ratio  

Ratio allows you to select another dimension and specify the current dimension to be 
multiplied by a specific ratio.
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Figure 5–25 Size - Ratio

This functionality is not implemented in this release of Macro Space Management.

Locked  

Locked sizes enable the choices visible to you to be restricted to only one or two 
dimensions when the dialog appears during insertion.
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Figure 5–26 Size - Locked

For this option to work, lists of dimensions must first have been input into the Size 
Choices tab.

View Menu
The View Menu has varying options concerned with filtering and viewing blocks.

Figure 5–27 View Menu

■ Filter Listed Blocks brings up the Block Filter. This can be used to select specific 
classes of blocks.
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Figure 5–28 Filter Listed Blocks

■ Options bring up the Options dialog box. This can be used to set some options 
determining how Fixture Studio Functions

Figure 5–29 Filter Listed Blocks - Options

■ Block Browser toggles the Block Browser (Object Browser) on and off.

■ Checking or un-checking Preview toggles the preview window in the object 
browser on and off.
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■ Show Group by, Expand All and Collapse All are discussed in more detail here.

Grouping Operations - Edit Menu
There are three options on the View menu that allow blocks with common criteria to 
be grouped together, the list expanded or collapsed.

Figure 5–30 View Menu - Show Group By

Show Group By (<Ctrl> + G) brings up a box above the table of blocks descriptions 
titled 'Drag a column header here to group by that column'.

Figure 5–31 Block Definitions

When this is done the list of blocks is sorted into groups specified by the header 
dragged into the box.
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Figure 5–32 Block Definitions - List

Clicking on the dragged column header changes the direction the data is sorted. The 
grouped data can be expanded or collapsed using the options on the View menu. A 
collapsed view is as below.

Figure 5–33 Block Definitions - Collapsed View

Any individual section of grouped blocks can be expanded or collapsed by clicking on 
the '+' or '-' signs to the left of the section.

Window Menu
The Window menu has two groups of options.
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Figure 5–34 Window menu

The first set of options arranges the active windows within Fixture Studio.

Cascade stacks the columns sequentially across the diagonal of the screen.

Figure 5–35 Gondola Definitions - Cascade View

Tile Horizontal arranges them so they all share the available space horizontally.

Figure 5–36 Gondola and Block Definitions Window
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Tile Vertical arranges them so they all share the available space vertically.

Figure 5–37 Gondola and Block Definitions Window

Gondola Definitions and Block Definitions allow switching between the two 
windows. Clicking on either Gondola Definitions or Block Definitions makes that 
window active within Fixture Studio.

Help Menu
The Help menu has two options.

Figure 5–38 Help menu

Clicking on Fixture Studio Help (or pressing the F1 function key) calls the online help 
module.

Clicking on About Fixture Studio displays information on the version of Fixture 
Studio.

Figure 5–39 Fixture Studio Version

The System Info tab brings up the Windows System Information dialog box.
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Figure 5–40 System Information

Toolbar
The Toolbar gives access to a series of Fixture Studio options (some of which are also 
available from the menu bar).

Figure 5–41 Fixture Studio Toolbar

Reading Block Definitions
There are three possible ways of reading Block Definitions into Fixture Studio:

■ Reading from the database

■ Reading from the drawing

■ Merging data from the database and active drawing
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Figure 5–42 Fixture Studio - Reading Block Definitions

Reading from the database
Reading from the database allows the user to clear existing block definitions, or to 
overwrite the definitions; with or without filtering data.

Figure 5–43 Read Block Definition - Clear existing Block definitions

If this option is selected, all existing Block Definitions in Fixture Studio are deleted and 
new definitions read in from the central database.
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Figure 5–44 Read Block Definition - Overwrite existing Block definitions

If this option is selected, any block definitions imported from the central database will 
overwrite the corresponding data in the Block definitions with similar names in 
Fixture Studio.

Figure 5–45 Read Block Definition - Apply Data Filters
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If this option is selected, the filtered data from any block definitions imported from the 
central database overwrites the corresponding data in the Block definitions with 
similar names in Fixture Studio.

Figure 5–46 Copy Options

All data options from the central database can be filtered (unlike Block definitions 
imported from a drawing, where options are more limited).

Reading from the Drawing
Reading from the drawing is similar to reading from the database, in that existing 
Block definitions in Fixture Studio can be cleared or overwritten, with or without the 
use of filters. The difference in reading from the drawing is that only the AutoCAD 
based information is imported (and filtered).
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Figure 5–47 Read Block Definitions - Drawing

The information that can be read from the drawing is the Block Description, Category 
Data, Insertion Data, Size Data and Connection Points.

UDAs, Associated Parts, Fixture/Shelf Data, Styles and Merchandisable Areas are all 
information assigned in Macro Space Management. Block definitions imported into 
Fixture Studio from the drawing do not have this information.

Merging Information
If information is merged, data is imported into Fixture Studio from both the active 
drawing and the central database.

Note: If data has been imported from the drawing to overwrite 
existing data in Fixture Studio, exercise caution in saving this to the 
central database. It is possible that information on Styles, 
Merchandisable areas, etc, could be lost.
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Figure 5–48 Merging Information

If data is merged and the Block definition for a specific block differs between the 
central database and the active drawing, priority is given to information from the 
central database.

If the Load Blocks into Drawing option is checked, all Blocks held in the directory 
specified in the Configuration Module is loaded into the drawing. This is to ensure 
that the full complement of blocks is available from both the database and in the 
drawing.
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Figure 5–49 Configuration - Directories Tab

Saving Block Definitions
Clicking on the Save Changes icon brings up the Save Block Definitions dialog box.

Figure 5–50 Saving Block Definitions
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■ The Destination frame enables you to specify whether data is saved to the 
drawing or to the database.

■ Add New Definitions adds all definitions to the specified destination. This 
command should be used with caution as any block (including badly defined 
ones) will be saved to either the drawing or database.

■ Enforce Save saves all Block definitions currently loaded into Fixture Studio to the 
central database.

■ Save Dumb Blocks saves blocks without full information (for example insertion 
points) to the specified destination.

■ Only Save Selected Blocks saves only the Block definitions currently selected in 
Fixture Studio to the specified destination.

■ Write Block Files is only available when Save to Drawing is selected.

■ Update Database with Drawing is only available when the central database is 
selected as the destination.

Adding, Editing, and Deleting Groups
Groups are used to arrange Block and Gondola definitions into logical collections with 
the hierarchical tree visible in the Object Browser. Groups can be added, edited and 
deleted.

Adding a Group
To add a group, highlight the parent group to which it is going to be added. Click on 
the Add Group icon. The Group dialog box appears.

Note: DWG files are required for the Planner environment, 3DS files 
for Merchandiser. If 3DS files are not created, the graphics for fixtures, 
etc., will not display in Merchandiser.



Menu Bar and Toolbar Options

Fixture Studio 5-33

Figure 5–51 Add Group Dialog Box

Enter a description and select an icon from the drop down list. Click on OK to 
conform. The group to be added is a child of its selected parent group.

Editing Groups
Groups are analogous to clusters in Store Manager - they are containers used to collect 
together Block definitions of similar characteristics.

Groups are arranged in a hierarchy emanating from a root. The hierarchy should be 
chosen such that it facilitates locating any desired Block Definition. In the above 
example Block Definitions have been split into three broad classes; Fixtures, Fitting 
and Shelves. Shelves then have been subdivided into White, Metal and Wire 
categories.
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Block definitions can then be added to the appropriate Group - for example all the 
chilled food fixtures would be assigned to the Chilled Cabinets sub-group of the 
Fixtures Group.

Edit Group
To add a group, highlight the group which is to be edited. Click on the Edit Group 
icon. The Group dialog box appears.

Figure 5–52 Edit Group

Edit the description if requited. It is also possible to select an alternative icon from the 
drop down list. Click OK to conform. The Group details are now updated.

Deleting Group
To delete a group, highlight the group to be deleted. Click on the Delete Group icon. If 
the Group to be deleted has child groups or block definitions, a warning dialog 
appears. If there are no child objects, the group is deleted without any requirement for 
confirmation.

Filtering Blocks
The list of blocks showing in the Block Details dialog box may be filtered.
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Figure 5–53 Filter Listed Blocks

Filtering by Name
Filtering by name only works on exact matches, although wildcards ('*' and '?') are 
allowed.

Figure 5–54 Filtering Blocks by Name

Table 5–1 Filtering Blocks by Name

Search String Result

Wire Shelf Fail - no exact 
matches.

Wire Shelf* All examples of 
blocks beginning 
Wire Shelf

Wire Shelf 900 x 200 Find that exact file 
name
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Filtering by Block Status
The Block Status can be seen to the left of the Block Definitions Window.

Figure 5–55 Filter by Block Status

By using the Block Status frame it is possible to select blocks meeting specific criteria, 
such as new blocks, database blocks, drawing blocks, etc.

Figure 5–56 Block Status frame

The status of each block is indicated by a color code.

Find Block Definitions
Clicking the Find icon on the toolbar brings up the Find Block dialog box.

Wire Shelf 900 x ??? Find all examples of 
blocks beginning 
Wire Shelf 900 x

Table 5–1 (Cont.) Filtering Blocks by Name

Search String Result
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Figure 5–57 Find Block Definitions

Figure 5–58 Find Block Definitions Dialog box

To use the Find option, type in the required search string into the Find box and press 
Enter. A list of block definitions matching the search string appears in the box below.

To display a block definition in the hierarchical tree in the Object Browser, highlight it 
in the list of block definitions and click on the OK button. The block definition in the 
Object Browser is highlighted and the Find Block dialog box closes.

Setting Columns
The columns that display in the Block Definitions window can be configured by 
clicking on the Set Columns in Grid icon in the toolbar.

Note: The search string will not allow wild cards such as '?' and '*'. 
The search string will match any block description with a comparable 
string in the ID, Name or Description fields. In the above example the 
search string rack has matched 11 instances of the name Bracket.

Note: The columns displayed in the Gondola Definitions window 
cannot be configured.
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Figure 5–59 Setting Columns

This will bring up the Columns dialog box.

Figure 5–60 Columns dialog box

The Columns frame on the left contains a list of the columns that are currently 
displayed. The Available Frame on the right contains a list of columns that are not 
being currently displayed. The list of columns to be displayed can be modified by 
making use of the selection arrow in the middle of the dialog box.

When the selection has been made, clicking on OK results in the Block Definition table 
being rearranged accordingly.

Figure 5–61 Block Definition table



AutoCAD Operations from Fixture Studio

Fixture Studio 5-39

AutoCAD Operations from Fixture Studio
This section gives more information on a number of commands that interact with 
AutoCAD.

■ Laying Out Blocks

■ Load Blocks From Disc

■ Load Blocks Into Drawing

■ Normalize Blocks

■ Redefine Blocks from Disc

Laying Out Blocks
The Laying Out Blocks option takes blocks selected from the list of blocks in Fixture 
studio and lays them out in a grid in the currently active drawing in the AutoCAD 
environment. To activate this option select the required blocks in the Block Definitions 
window.

Click on the Laying out blocks option in the File menu. (The Connect to AutoCAD 
option on the File Menu must be selected).
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Figure 5–62 File menu

This brings up the Layout Options dialog box.

Figure 5–63 Layout Options dialog box

The spacing between blocks can be specified by the X, Y and Z spacing. Tick the 
appropriate check boxes to add the block name and/or description to each block when 
it is being drawn. Ticking the Clear Drawing check box will clear all previous blocks 
from the drawing.
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Load Blocks From Disc
Load Blocks from Disc enables you to select blocks from a source outside of the Macro 
Space Management database and load them into the currently active AutoCAD 
drawing. This is done in three stages:

■ Ensure that the Connect to AutoCAD option has been selected

■ Select the Load Blocks from Disk option

■ Select the Insert option in AutoCAD

Connecting to AutoCAD

Figure 5–64 File Menu - Connect to AutoCAD

The Connect to AutoCAD option on the File Menu must be selected. If the AutoCAD 
environment is not open, AutoCAD will be activated. If it is open, Fixture Studio will 
link to AutoCAD. When AutoCAD is selected, the AutoCAD based option will be 
available, and the Connect to AutoCAD option will be selected.
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Figure 5–65 File Menu - Connected to AutoCAD option

Using the Load Blocks From Disc option
Using the Load Blocks from Disc option will transfer the block definitions into the 
AutoCAD drawing. They will not become visible until instances have been placed in 
the drawing.

Figure 5–66 File Menu - Load Blocks from Disc option
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This will bring up Select blocks to Load dialog box. Navigate to the required directory 
and highlight the required blocks. Click on Open to transfer the block definitions to 
the active AutoCAD drawing.

Figure 5–67 Select blocks to Load dialog box

Using the Insert option in AutoCAD
When the block definitions have been transferred into the drawing, instances of that 
definition can be inserted into the drawing by typing Insert into the command line.

This will bring up the Insert dialog box.
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Figure 5–68 Insert dialog box

Block definitions can be selected using the Name drop down list. After specifying the 
Insertion Point, Scale, Rotation Angle and whether or not the components of the block 
are to be exploded, clicking on OK will place an instance of the block definition in the 
drawing.

Load Blocks Into Drawing
The Load Blocks into Drawing command is used to take blocks from the list defined in 
Fixture Studio and transfer a copy to the currently active drawing in AutoCAD. This is 
done in four stages:

■ Ensure that the Connect to AutoCAD option has been selected

■ Select the required blocks in Fixture Studio

■ Select the Load Blocks into Drawing option

■ Select the Insert option in AutoCAD

Connecting to AutoCAD
The Connect to AutoCAD option on the File Menu must be selected. If the AutoCAD 
environment is not open, AutoCAD will be activated. If it is open, Fixture Studio will 
link to AutoCAD. When AutoCAD is selected, the AutoCAD based option is available 
and the Connect to AutoCAD option will have a tick by it.

Selecting the requited blocks can be done in two ways in Fixture Studio; from the 
hierarchical tree, or from the Block Definitions window.
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Figure 5–69 Block Definitions window

They can be selected from the hierarchical tree by left clicking on an individual block, 
or by holding down <Ctrl> and left clicking to make multiple selections. They can be 
selected from the Block Definitions window by left clicking on an individual block, or 
by holding down <Ctrl> or <Shift> and left clicking to make multiple selections.

Using the Load Blocks into Drawing option
Using the Load Blocks into Drawing will transfer the block definitions into the 
AutoCAD drawing. They will not become visible until instances have been placed in 
the drawing.
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Figure 5–70 Load Blocks into Drawing

When the block definitions have been transferred into the drawing, instances of that 
definition can be inserted into the drawing by typing Insert into the command line.

This will bring up the Insert dialog box.

Block definitions can be selected using the Name drop down list. After specifying the 
Insertion Point, Scale, Rotation Angle and whether or not the components of the block 
are to be exploded, clicking on OK will place an instance of the block definition in the 
drawing.

Normalize Blocks
The Normalize Blocks command is used to modify the AutoCAD properties of 
selected blocks. It is the equivalent of the AutoCAD Object Properties toolbar. It is 
accessed from the File menu and is only active when Fixture Studio is connected to 
AutoCAD.
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Normalize Blocks
The Normalize Blocks dialog box enables any currently selected blocks to have their 
AutoCAD Layer, color, Line Type and Line Weight changed.

Figure 5–71 Normalize Blocks dialog box

Layer
If set to Ignore, layers will be unchanged.

If set to Ignore 2D/3D layers they will not be affected by any changes to other layers

If set to Reset to 0, all selected blocks will have their parent layer set to the default of 0.

Color
If set to Ignore, line weights will be unchanged.

If set to By Layer, then the selected blocks will have their color set to the default color 
for the layer they are on.
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If set to By Block, the selected blocks will have their settings changed to the default for 
the layer except when the blocks have previously had custom properties assigned.

If set to Custom, then the modified color for the selected blocks can be set by means of 
the spin control.

Line type
If set to Ignore, line types will be unchanged.

If set by ByLayer, the selected blocks will have their line type set to the default or the 
layer they are on.

If set to Byblock the selected blocks will have their settings changed to the default for 
the layer except when the blocks have previously had custom properties assigned.

Line Weight
If set to Ignore, line weights will be unchanged.

If set By Layer line weights will be set to the default for that layer.

If set ByBlock, the selected blocks will have their settings changed to the default for the 
layer except when the blocks have previously had custom properties assigned.

If set to a Custom level all selected blocks will be set to the line weight selected from 
the drop down list.

Redefine Blocks from Disc
Redefine Blocks from Disc allows you to overwrite any blocks currently active in the 
Drawing with information stored on disc. It is accessed from the File menu and is only 
active when Fixture Studio is connected to AutoCAD.

Figure 5–72 Redefine Blocks from Disc
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This command is useful when errors have been made in the drawing and it is desired 
to restore the blocks back to the state they were when last saved.

Getting the Basics Right
Once Fixture Studio is set up, it is difficult to make changes to its configuration. Time 
spent considering the optimum way to set up Fixture Studio will be repaid many 
times over when fixtures and gondolas are used in the Planner and Merchandiser 
environments.

There are a number of things to consider before beginning to set up Fixture Studio. 
These are:

■ Use of Directory Structure

Depending on the size of the retail organization there may be many fixtures. The 
graphics for these fixtures are stored in directories. Consider carefully the number 
of directories you need. With only a limited number of fixtures, one directory may 
be sufficient. With tens of thousands of fixtures, it may be more logical to create a 
number of directories. More Info

■ Use of Naming Conventions

Naming conventions have two purposes. Firstly, it can make it easier to identify 
the required block from a long list of available blocks. Secondly, and more 
importantly, it will affect the ease of defining gondolas. Without a good naming 
convention, you may need to define hundreds of gondolas. With a good naming 
convention you may only need to define ten or twenty gondolas. More Info

■ Setting up Logical Hierarchies

Fixtures and Gondolas are stored in hierarchies (a bit like the windows folders 
system). Setting up logical hierarchies will make it easier to maintain the Fixtures 
and Gondolas within Fixture Studio. It will also make it easier for users to select 
fixtures and gondolas in Planner and Merchandiser. More Info

■ Using Stretchable Fixtures

Stretchable Fixtures are fixtures that can be placed in the drawing, then configured 
to a range of preset sizes. Using stretchable fixtures reduces the number of fixtures 
required. However, if stretchable fixtures are used, it will not be possible to 
produce accurate reports on what fixtures and fittings are present in stores. More 
Info

■ About Connections

Connections determine which items of equipment can be connected to which other 
items of equipment. Having a simple and consistent scheme for connections will 
make it easier to define those connections. More Info
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■ About Styles

Styles determine which items of equipment can be placed on each other, and 
which styles of product can be placed on what items of equipment.

Having a logical list of styles and style relationships aids placement.

Summary of Fixture Studio Basics
The general flow for deciding on how Fixture Studio can be set up is as follows:

Note: Styles also influence what items of equipment can be attached 
to what.

Note: Connections also influence what items of equipment can be 
attached to what.
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About Categories for Fixtures
For a large retail organization, there may be many fixtures and fittings. These could be 
assembled into different types of gondola. Before setting up fixtures and gondolas 
within Fixture Studio, some thought must be given to how all this information is 
organized.

Unless it is arranged in a simple and logical manner, considerable time will be wasted 
later trying to find specific fixtures or gondolas, or trying to attach one pieces of 
equipment to another when the styles are incompatible.

It is recommended that a table on the lines of the following be produced as a basis for 
deciding how Fixture Studio is to be configured.

Directory Structures
Directories will mainly be used by people within Fixture Studio to store graphics and 
to select the graphics for editing or deletion. Too few directories will result in each 
directory containing hundreds of graphics files. Too many directories will make it 
difficult to remember which directories the graphics are in. It is recommended that 
users list out the total number of graphics that are expected to be used within Macro 
Space Management, together with suggested classes they fall into. The number of 

Table 5–2 Categories of Fixtures

Equipment 
Category

Equipment 
Sub-Division Connections to

Style Relationships 
with

Hussmann Primary

■ Legs (6)

■ Backpanels (20)

■ Slatwalls (12)

■ Other Primary 
Hussmann 
Equipment

■ Secondary 
Hussmann 
Equipment

■ Some items of 
Primary Generic 
Equipment

■ Other Primary 
Hussmann 
Equipment

■ Secondary 
Hussmann 
Equipment

■ Product Display 
Styles

Secondary

■ Open Shelves 
(30)

■ Wire Shelves (16)

■ Hanging Bars (6)

■ Lateral Rods (4)

■ Primary 
Hussmann 
Equipment

■ Other Secondary 
Hussmann 
Equipment

■ Tertiary 
Hussmann 
Equipment

■ Primary 
Hussmann 
Equipment

■ Other Secondary 
Hussmann 
Equipment

■ Product Display 
Styles

Tertiary

■ Dividers (2)

■ Grilles (4)

■ Secondary 
Hussmann 
Equipment

Lozier Primary etc

Secondary etc.

Tertiary etc.

Generic Primary etc.

Secondary etc.

Tertiary etc.
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fixtures that fall into each suggested class can then be estimated. This can be seen as 
the bracketed figures in the suggested table. When classes have been selected that 
contain a sensible number of fixtures, the directory structure can then be set up 
accordingly.

Depending on the size of the retail organization there may be thousands of fixtures. 
The graphics for these fixtures are stored in directories. Consider carefully the number 
of directories you need. With only a limited number of fixtures, one directory may be 
sufficient. With tens of thousands of fixtures, it may be more logical to create a number 
of directories.

In this example some sub directories have been set up in the folder where the Macro 
Space Management directories are stored.

Client data serves as a parent directory, then three sub-directories called 
Miscellaneous, Racking and Shelves serve to hold the graphics for those classes of 
fixtures.

The directories that the graphics have been assigned to need to have to have their 
paths specified in the Directories tab in the Configuration module.

Setting up Directory Structures
Directory Structures need to be set up before fixtures can be imported into them.

This is done in two stages:

■ Create the required directories using Windows Explorer.

■ Set up the required links in the Configuration Module.

Create the required directories using Windows Explorer
Using Windows Explorer, navigate to where the Macro Space Management data files 
are held. Create the required directories.

Note: Each fixture will normally have two classes of graphics 
associated: dwf files for display in the Planner environment and 3DS 
files for display in Merchandiser.
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Set up the required links in the Configuration Module
Open the Configuration Module by selecting the Configure option from the File menu.

Figure 5–73 Fixture Studio - Configure

Select the Directories Tab.

Note: You may require the appropriate permissions from your 
Systems Administrator to carry this out.
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Figure 5–74 Fixture Studio - Directories Tab

Use the Add button to allow paths to be added to the directories made using Windows 
Explorer.

Naming Conventions

A naming convention is a pre-thought out and logical way of assigning block names. If 
you give blocks names like Widget-187567 and Gizmo-ADRTYN, it is not obvious 
what the blocks are or their dimensions are.

With a well thought out naming convention, adding and recognizing fixtures is 
simpler.

In the above example, you can see that there are three types of block; Back Panels, L 
shaped uprights and T shaped uprights. You can also see that the back panels have 
widths of 600 and 900 mm, and that they have heights of 1400, 1600, 2500 and 2900 
mm. Similarly you can see that both the L and T shaped uprights come in four heights; 
1400, 1600, 2500 and 2900 mm. Widget-187567 might well be a back panel of width 600 
mm and height 2500 mm, but you cannot tell this from the block name.

Naming conventions are of the general form:

Prefix-parameter-parameter-parameter-suffix

Note: Naming conventions are vital to the efficient operation of 
Macro Space Management. They must be decided upon before any 
blocks are imported into Fixture Studio. Lack of a naming convention 
will make it more difficult to locate the require fixture blocks. Lack of 
a naming convention will result in users spending large amounts of 
time creating dozens (if not hundreds) of gondolas that could have 
been defined far more efficiently using a naming convention.
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These can be any combination of numbers and letters, together with several separating 
characters. The separating characters can be either a '-', '_' or an 'x', so each of the 
naming conventions below are equally valid:

■ Prefix-Parameter-Parameter-Parameter-Suffix

■ Prefix-ParameterxParameterxParameter-Suffix

■ Prefix_ParameterxParameterxParameterxSuffix

However, the use of naming conventions must be consistent. Naming blocks with a 
mixture of '-', '_' or 'x' may lead to errors. For example you may have problems if you 
name blocks as in the example below:

■ Backpanel-600-1400

■ Backpanel-600x1600

This is because Macro Space Management expects to find the same separating 
character for blocks within a naming convention. When the program draws a gondola, 
if it expects to see: Prefix-Width-Height, and some of the blocks are named: 
Prefix-WidthxHeight, it will find blocks with name like Backpanel-600-1400 because 
these are in the expected form. It may fail to find blocks with names like 
Prefix-widthxheight because there is an 'x' present where Retail FOCUS expected to 
find a '-'.

Similarly you must avoid misspellings. If you call a block Backpanal-600-1400 rather 
than Backpanel-600-1400, Retail FOCUS may fail to find the block because of the 
wrongly spelt Backpanel.

Examples of Naming Conventions
The examples below are all valid examples of naming conventions:

Example 5–1 Prefix-Size

Leg-1500
Leg-2000
Leg-2500

Example 5–2 Prefix-WidthxHeight

Backpanel-600x1500
Backpanel-900x1500
Backpanel-1200x1500

Example 5–3 Prefix-Width-Depth-Height

FreezerUnit-600-800-300
FreezerUnit-600-800-400
FreezerUnit-600-1000-500

Example 5–4 Prefix-Width-Depth-Height-Suffix

FreezerUnit-600-800-300-Lozier
FreezerUnit-600-800-400-Lozier
FreezerUnit-600-1000-500-Lozier

Note: Always check naming conventions for errors. If you have 
made an error when naming the block, Macro Space Management will 
not find it when drawing the gondola.
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FreezerUnit-600-800-300-Hoffmann
FreezerUnit-600-800-500-Hoffmann
FreezerUnit-600-1000-500-Hoffman

Example 5–5 Prefix-Size

Podium-Small
Podium-Medium
Podium-Large
In general, naming conventions should be specified such that the block name provides 
all the information required.

Prefix-Width-Depth-Height-Suffix

Block names of the form allows defining gondolas so that at the time of addition into 
the Planner or Merchandiser environments you can choose the:

■ Specific type - for example Freezer Units

■ Specific width - for example 600, 800 and 1000 mm

■ Specific depth - for example 800, 1000 and 1200 mm

■ Specific height - for example 400, 500 and 600 mm

■ Manufacturer - for example Lozier

Gondolas and Naming Conventions
If naming conventions are assigned to Fixture blocks, then these blocks can be 
automatically selected by including the correct options during Gondola definition.

Figure 5–75 Gondola Definitions

Note: One well thought out gondola definition allows placing 
dozens of different variants of that gondola in Planner or 
Merchandiser.
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When the gondola is placed in Planner or Merchandiser, a list of dimensions and 
options are available in the Add Gondola dialog box.

Figure 5–76 Add Gondola dialog box

In the above example a gondola can be placed with any combination of two widths 
and four heights (eight combinations in all).

If naming conventions were not used when defining this gondola, eight separate 
gondolas would have to have been designed in Fixture Studio.

Fixture and Gondola Hierarchies
Well designed hierarchies make it easier to find fixtures and gondolas, both in Fixture 
Studio and in Planner and Merchandiser. It also makes it easier to see which items of 
equipment have compatible connections and styles. Consider how your users will 
want Groups of objects organized, then design an appropriate hierarchy.

Note: In the above example, a width of 600 mm and a height of 2500 
mm have been selected. When the gondola is created in the drawing, 
it is done using by reconstructing the required block name based on 
information in the gondola definition. For example, the software 
would use a backpanel with a name of Backpanel-600-2500. If you had 
chosen dimensions of 900 mm and 1400 mm, the software would use a 
backpanel with a name of Backpanel-900-1400.

Note: Using gondola definitions in this way only works if a 
consistent naming convention has been used for the blocks that will be 
used to draw the gondolas. This means that blocks must be imported 
into Fixture Studio using a good naming convention from the start. If 
a good naming convention is not used, then users will end up with an 
inefficient way of defining gondolas, and consequent loss of time 
when planning gondolas in store plans
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Groups
Groups are a way of arranging collections of fixture or gondola definitions into a 
logical arrangement. Each group holds a logical class of objects. For example, one 
group could be created to hold all gondola descriptions for freezer units, another for 
chilled goods units and another for food and vegetable units. This facilitates finding 
the required gondola when it is desired to edit it, or to place it in a store layout in both 
Planner and Merchandiser.

Groups can be added, edited, or deleted using the Grouping icons on the Toolbar.

If you are in the Blocks tab, Fixture Groups can be added, edited, or deleted from the 
Fixture hierarchy. If you are in the Gondola tab, Gondola Groups can be added, 
edited, or deleted from the Gondola hierarchy. Individual fixtures and gondolas can 
then be associated with the appropriate group. The resultant hierarchical tree appears 
in the object browser in Fixture Studio. Note how you can readily find the required 
object.

Figure 5–77 Hierarchical tree

(The same hierarchy also appears in the Object Browser in Planner and in 
Merchandiser).
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Adding, Editing and Deleting Groups
Groups are used to arrange Block and Gondola definitions into logical collections with 
the hierarchical tree visible in the Object Browser. Groups can be added, edited, and 
deleted.

Adding a Group  

To add a group, highlight the parent group to which it is going to be added. Click on 
the Add Group icon. The Group dialog box appears.

Figure 5–78 Add Group

Enter a description and select an icon from the drop down list. Click OK to conform. 
The group to be added is a child of its selected parent group.

Editing Groups  

Groups are analogous to clusters in Store Manager - they are containers used to collect 
together Fixture or Gondola definitions of similar characteristics.
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Groups are arranged in a hierarchy emanating from a root. The hierarchy should be 
chosen such that it facilitates locating any desired Fixture or Gondola. In the above 
example Gondolas have been split into three broad classes; Food, Clothing and 
Electrical. Each of the Groups has then been further subdivided.

Gondola definitions can then be added to the appropriate Group - for example all the 
chilled cabinet gondolas would be assigned to the Chilled Cabinets sub-group of the 
Food Group.

Edit Group  

To add a group, highlight the group which is to be edited. Click the Edit Group icon. 
The Group dialog box appears.

Figure 5–79 Edit Group
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Edit the description if requited. You may select an alternative icon from the drop 
down list. Click OK to conform. The Group details will now be updated.

Delete Group  

To delete a group, highlight the group to be deleted. Click on the Delete Group icon. 
If the Group to be deleted has child groups or block definitions, a warning dialog 
appears.

Figure 5–80 Delete Group

If there are no child objects, the group is deleted without any requirement for 
confirmation.

Examples of Hierarchies  

Hierarchies can be set up in several ways. One of the examples is manufacturer based 
and another is based on equipment. Examples of both are shown below.
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Figure 5–81 Examples of Hierarchies

When setting up hierarchies, you must not only consider the logical groupings of 
fixtures and gondolas, but also how connections and styles are assigned. Laying out 
the equipment in a store layout in either Planner or Merchandiser is much facilitated if 
all items in a group have similar connections and styles assigned and those 
connections and styles are compatible with other groups.

For example the Hussman Primary Fixtures Group would be expected to have 
connections and styles compatible with the Hussmann Secondary Fixtures Group.

Overview of Stretchable Fixtures  

Stretchable fixtures are a special feature of Macro Space Management that allows those 
fixtures to take up a range of permitted sizes.

Placing stretchable fixtures reduces the number of fixtures required as the same fixture 
could be placed in (for example) 600 mm, 700 mm and 800 mm widths.

Reporting  

Note: Do not use stretchable fixtures if you want accurate reports on 
equipment present in stores.



Fixture and Gondola Hierarchies

Fixture Studio 5-63

It is possible to generate reports on what equipment is present in one or more stores. If 
a stretchable backpanel has been used in 600, 700 and 800 mm widths, the report only 
shows the present of the stretchable backpanel.

If 600 mm, 700 mm and 800 mm wide backpanels have been individually placed, it is 
possible to generate an accurate report on how many of each width of backpanel is 
present in a store.

Connections
Connections are used to determine what items of equipment can connect to what 
items of equipment.

For one item of equipment to connect to another the following must be true.

If any of these criteria are not true, then a connection cannot be made. In addition, if 
the details of the connections are not correctly specified relative to each other, 
equipment may connect together in unintended alignments. It is suggested the use of 
connection parameters is planned beforehand.

Planning the use of Connections
The following guidelines are recommended for planning the systematic use of 
connections.

Connection Names  

Connections should be assigned logical names such as Peg or Slatwall. This enables 
their purpose to be seen at a glance.

Note: Connection set-ups should be kept as simple as possible with 
regard to connecting together equipment in the correct alignment and 
ensuring non compatible equipment cannot be connected. 
Connections should also be used in conjunction with styles.

Table 5–3 Connections

 Requirement
Optional or 
Mandatory

Gender The connection 
points must have 
compatible genders

This requirement can 
be disabled in the 
Configuration 
Module

Shape The connection 
points must have the 
same shape

This requirement can 
be disabled in the 
Configuration 
Module

Size The connection 
points must have 
compatible sizes

This requirement can 
be disabled in the 
Configuration 
Module

Note: Connections can be made easier to use by means of well 
planned hierarchies. For example, all equipment in the Lozier group 
would be expected to have connections designed to be compatible.
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Gender  

Specify conventions such as male and female connections always point in opposite 
directions when defined. This means when two items of equipment are inserted in 
Merchandiser next to each other and facing the same way, the male and female 
connections will always mate when selected for joining. Also use logical conventions 
such as pegs, hanging rods, etc., always have male connection gender, and the holes or 
slots they fit into have female gender.

Shape  

Assign the shapes to equipment by function - for example assign connections of shape 
Rectangle to Legs, Slatwalls and Back Panels and connections of shape Circle to Pegs, 
Hanging Rods, etc. This means that Slatwalls and Back Panels can only connect to Legs 
and not (say) Pallets. Similarly, it means that Pegs can only connect to the appropriate 
connections on the Back Panel. Equipment that has to connect to multiple types of 
equipment can be assigned shape None.

Size  

Connection sizes can be assigned according to purpose. An example of such a scheme 
is:

Permissible Values Comment

Male, Female, 
Neutral.

Male connects with 
female.

Neutral connects 
with itself and both 
male and female.

Permissible Values Comment

None, Rectangle, 
Circle, Oval, 
Triangle, Hexagonal.

Specific shapes will 
only connect with 
themselves and 
None.

Permissible Values Comment

Minimum size 0, 
maximum size 1000.

Two items of 
equipment must have 
overlapping 
connection sizes to 
connect.

Size Purpose

11 - 15 Floor mounted 
(primary) equipment

6 - 10 Shelves and other 
secondary equipment

0 - 5 Dividers, grilles and 
other tertiary 
equipment
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This means that connection types intended to let floor mounted equipment only join to 
each other can be assigned one size range. Shelves can be assigned another size range 
of connection types that only lets them connect to the equivalently sized connections 
on primary fixtures such as backpanels and slatwalls. Dividers and grilles can be 
assigned another size range of connection types that only lets them connect to the 
equivalently sized connections on secondary fixtures such as shelves. If the size ranges 
are correctly assigned then although the gender and shape of a connection might be 
compatible, equipment will be prevented from joining inappropriately - for example a 
divider will only place on a shelf.

Styles
Styles are used to determine what is compatible with what. For example, the assigned 
fixture and shelf styles determine whether a shelf object can be placed on a specific 
item of equipment or not. Similarly the assigned product style determines whether the 
product can be placed on for example a shelf.

Styles and Style relationships should be kept as simple as possible with regard to 
making sure equipment connects together in a compatible manner and ensuring the 
correct display style goes onto shelves, pegs, etc. Styles should also be used in 
conjunction with connections.

Product of Pegged style can be constrained to only place on pegs, while products of 
Boxed Style can be constrained to only place on wire, open and heavy duty shelves.

Planning the use of Styles
In planning the use of Fixture and Shelf Styles, an effort must be made to keep the 
number of styles to the minimum possible because for Style Relationships:

■ Each shelf object that goes onto a fixture has to have a compatible style 
relationship with that fixture.

■ Each product that goes onto a fixture has to have a compatible style relationship 
with that fixture.

■ Each product that goes onto a shelf object has to have a compatible style 
relationship with that shelf object.

If there are large numbers of Fixture, Shelf, and Product Styles, it will be difficult to set 
up and maintain the list of style relationships. For example, it is best to avoid 
manufacturer specific shelf styles unless there are actual reasons for doing so. Thus it 
is better to have a 'General Shelf' style rather than 'Hussman Shelf', 'Lozier Shelf' and 
'Franklin Shelf' as having three separate shelf styles means three times as many style 
relationships need to be set up.

Note: These connection requirements can always be overridden by 
turning off the filters in the Fixtures Tab of the Configuration Module.

As well as Connections, Styles can be used to determine what item of 
equipment can be connected to what. If it is intended to join one item 
of equipment to another, both the Styles and the Connections must be 
compatible with that aim.

Note: Styles can be made easier to use by means of well planned 
hierarchies. For example, all equipment in the Lozier group would be 
expected to have styles designed to be compatible.
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About Blocks
Gondola creation relies on a convention for block naming. Accordingly blocks should 
be named in a systematic manner.

Figure 5–82 Blocks Naming Conventions

Naming conventions are often of the general form Block 
Type-dimension-dimension-dimension. In the above example, the convention is 
Backpanel-width-height.

Backpanel-600-1150 is a back panel 600 mm wide x 1150 mm high.

Backpanel-600-1500 is a back panel 600 mm wide x 1500 mm high.

Suffixes can be used to further restrict the list of available blocks for a specific gondola.

Block Details Dialogue Box
The Block Details dialog box allows additional information to be added to an 
AutoCAD Wblock (World Block). This additional information gives 'Intelligent 
Properties' to the resulting Macro Space Management block. These intelligent 
properties can then be used by the block to interact with other blocks within the 
AutoCAD and Virtual Reality Environments and carry out the range of its fixturing, 
merchandising, and reporting functions.

Note: As well as Styles, Connections can be used to determine what 
item of equipment can be connected to what. If it is intended to join 
one item of equipment to another, both the Styles and the Connections 
must be compatible with that aim.

Note: Components for gondolas will be selected using these name 
conventions, so it is important that a consistent scheme is used when 
creating blocks. If this scheme is not consistent, it may not be possible 
to select the required blocks for creating gondolas. Block names can 
also include suffixes, for example -HD and -HD-Foot.
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Data added to Block Details is stored in the central Macro Space Management 
database.

Figure 5–83 Block Details dialog box

The Block Name at the top of the dialog box must correspond to that of the AutoCAD 
Wblock it is associated with. If they do not correspond, the Macro Space Management 
block cannot be placed in the CAD or Virtual Reality environments. The Block 
Description allows the user to enter a more comprehensive description of the block.

Tabs
The tabs allow you to switch between various categories of Macro Space Management 
Block information. The tabs include:

■ Category

■ Insertion

■ Size
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■ Connections

■ Parts

■ Fixture

■ UDAs (User Defined Attributes)

■ Styles/Ranges

■ Merchandisable Areas

■ Shelves

■ Preview

Each tab is split into a series of frames. Each frame deals with one aspect of the 
information on that tab.

Category Tab  

The Category tab is used to set general parameters for the block being defined.

Figure 5–84 Category tab

The Equipment Type Frame  

The Equipment Type frame is used to specify basic parameters for the object.
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Figure 5–85 Equipment Type frame

■ Retail Type can be set from a drop down list.

■ Can Populate with Display Style determines whether products can be placed at 
the display level on this object.

■ Can Populate with Placeholder determines whether placeholders (representing a 
class of product) can be placed on this object.

■ Attaches to Primary Equipment allows the object to attach to primary equipment 
(equipment that stands on the floor).

■ Attaches to Secondary Equipment allows the object to attach to secondary 
equipment (for example shelves).

■ Accepts Secondary Equipment allows the object to accept secondary equipment 
(for example shelves and rods).

■ Corner Block determines if the block can be placed in the corner of the plan.

The Equipment Wizard  

The Equipment Wizard allows you to define certain basic parameters from the 
available menus options.

Note: Some of this data can also be set with the Wizard.
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Figure 5–86 Equipment Wizard

■ Equipment Type and Description can be selected from drop down lists.

■ Equipment Size, Depth, Height, and Base Height can be set using the spin 
controls.

■ Spacing is used for equipment like slatwalls and pegboards. It is used to set the 
spacing of slats or pegs.

The General Frame  

The General frame enables you to set a series of options concerning the general 
properties of the block.
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Figure 5–87 General frame

Directory  

The Directory specifies the sub-directory in which the block details are stored. This can 
be selected from a drop down list.

Figure 5–88 Directory List

The directory name should be the same as specified in the Directories tab of the 
Configuration Module.
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Figure 5–89 Configuration Module - Directories tab

Manufacturer  

Select the Manufacturer from the drop down list.

This list is configured in the Admin Module (Edit > Manufacturers).

Category  

Select the block category such as Freezer Unit, Furniture, Racking, or Miscellaneous 
Unit, from the drop down list.

Units  

Select the units of measurement for the block from the drop down list. Care should be 
taken to select a consistent system of units for equipment. Selecting Inches for some 
types of equipment and Millimeters for other types could result in strange effects 
when they are inserted into the same drawing or Virtual Reality environment. This list 
is configured in the Admin Module (Edit > Units).

Material  

Select the material from the drop down list.

Note: Each implementation of Macro Space Management will vary 
slightly in directory structure.
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Figure 5–90 Material Drop Down List

This is particularly significant in the Virtual Reality environment as the material 
affects the visual appearance of the block. This list is configured in Product Studio 
(View > Materials).

Status  

The Status can be selected from a drop down list.

Figure 5–91 Status Drop Down List

This list is configured in the Administration module (Edit > status). Depending on 
implementation, the status may affect the way the blocks display in the various 
hierarchical trees they appear in.

Code  

Figure 5–92 Code field

The code is entered by the user. An example would be a manufacturer's product code. 
It is used for reporting purposes. It is used for reporting purposes.

Icon  

You can select the icon for the block from a drop down list.
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Figure 5–93 Icon Drop down list

This list can only be customized by Oracle. The selected icon appears against the Block 
Definition in the various hierarchical trees.

The Type Frame  

The Type Frame specifies how the block is to be drawn in the AutoCAD drawing or 
Virtual Reality environment.

Figure 5–94 Type Frame

■ Fixed Size blocks are always drawn at a constant scale. This is how most blocks 
will be designated as it means they change in scale as the drawing scale is 
changed.

■ Symbol is used to indicate blocks that indicate information on the drawing. An 
example might be a directional arrow. Symbols remain a standard size, 
irrespective of the scale of the drawing. Because symbols need to be visible, they 
are generally drawn at a 50:1 scale and appear at this size in the drawing.
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■ Scaled size is a feature from earlier versions of Macro Space Management and has 
been included for compatibility with older versions. It is not now generally used. 
Fixed Size, Symbol and Scaled Size are mutually exclusive. Only one can be 
selected at a time via the associated radio buttons.

■ Drawn 1:1 is only applicable to blocks designated as symbol blocks. If they have 
been drawn to anything other than a 50:1 scale, they will be drawn at 50:1 in the 
drawing, unless Drawn 1:1 is checked. If this option is enabled, the symbol block 
will be drawn at its original scaled size (for example 100:1).

The Graphics Frame  

The Graphics frame specifies what sort of graphics is drawn in the AutoCAD 
environment.

Figure 5–95 Graphics frame

■ No Graphics is an option that can be used for blocks that are not visually 
displayed. An example would be an associated block (such as a bolt or castor) 
which doesn't need to have graphics, but can still be included in reports.

■ The 3D and 2D checkboxes determine which AutoCAD layer the object is to be 
drawn on. A 2D block will be placed on a different layer to a 3D block.

Furthermore, if the block is to be created using Block Factory, then the 2D or 3D 
settings will determine the actual graphics that are created.

The Working/Stacking Axes Frame  

The Working and Stacking Axes determine how products align and stack respectively 
on shelves in the Virtual Reality environment. They do not affect product placement in 
the Planner environment as products are represented by placeholders.

Note: If an object has only been drawn in 2D, it will still be drawn on 
the 3D layer if this checkbox is ticked. However, it will still only be 
viewable in 2 dimensions.
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Figure 5–96 Working and Stacking Axes

Working Axis  

The Working Axis defines the directions products can be aligned on. If a Working Axis 
is checked, it also allows stacking in that axis.

■ If the X axis is checked, products may be aligned along the length of the block.

■ If the Y axis is checked, products may be aligned over the depth of the block.

■ If the Z axis is checked, products may be aligned relative to the height above the 
block.

The working axes selected have to be appropriate to the equipment. For pegs the Y 
working axis has to be enabled, as product has to be aligned along the length of the 
peg. For peg boards the X and Z working axes have to be enabled as products have to 
be aligned in a vertical place. For chest freezers the X and Y working axes have to be 
enabled as product has to be aligned over the bed of the unit.

In the example shelf below, only the X Working Axis has been enabled. Product can 
therefore be aligned along the length of the shelf, but not relative to its depth and 
height.

The Stacking Axis determines the directions products can be stacked in. If only some 
of the Working Axes have been checked, the Stacking Axes can be used to allow 
product to be stacked in more directions than they can be aligned.

■ If the X axis is checked, products may be stacked along the length of the block.

■ If the Y axis is checked, products may be stacked down the depth of the block.

■ If the Z axis is checked, products may be stacked vertically.

In the example shelf below, stacking has been enabled in the X, Y and Z planes, 
allowing product to be stacked in both horizontal and the vertical directions.

The Area Calculation Directions Frame  

Note: If only some of the working axes are checked, then not all the 
alignment commands will be enabled in Merchandiser.
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The Area Calculations Direction frame is used to set the directions that the area 
calculation function uses when establishing the area apportioned to the object.

Figure 5–97 Area Calculations Direction frame

Area calculation works by "feeling" out from the object in the specified directions. The 
check boxes that are ticked should be appropriate to the function of the object. For 
instance, there would be no point in testing for other fixtures behind a wall bay, so 
only the front and two sides would be selected. Conversely, a table or pallet would 
probably be placed away from other fixtures, so it would be appropriate to feel out in 
all directions.

The Reporting Options Frame  

The Reporting Options frame allows you to specify whether the Block Definition 
should be excluded from reports or the central database.

Figure 5–98 Reporting Options frame

Not all blocks need be included in a report, for example Title Blocks and some symbols 
such as directional arrows. It may also be that is no need to store instances of a certain 
type of block in a database, for example Reference blocks, so there will not a record in 
the Fixtures table to represent the block.

Note: The direction of the Front of the fixture is set in the Insertion 
tab. The check boxes ticked should take this into account.
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■ Exclude from Reports allows the Block Definition to be excluded from Macro 
Space Management's reports.

■ Exclude Instances in DB allows you to exclude information from the drawing 
being stored in the database during a save.

■ Exclude Attributes allows certain attributes of the Block Definition to be excluded 
from being stored in the central database.

■ Include in Fixture Annotation allows you to include the block definition in fixture 
annotations.

Insertion Tab  

The Insertion tab is used to specify a number of details affecting how the block is 
inserted into the drawing.

Figure 5–99 Insertion tab

Note: If you exclude instances of a block from the database, then it 
will also be ignored when rebuilding the drawing from the database.

Note: This option is not enabled in this implementation of Macro 
Space Management.
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The Layers Frame  

The Layers frame specifies the layer on which the Block Definition will be inserted 
when placed in the drawing or Virtual Reality environment.

Figure 5–100 Layers frame

Selecting the correct layer is important as it will affect how the equipment behaves 
within the Planner and Merchandiser environments.

The Levels Frame  

The Levels frame determines what level the Block is inserted in the drawing.

Note: Selecting a layer controls how objects display in Merchandiser 
via the Layers dialog box. Layers selected should be consistent with 
the purpose of the block.
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Figure 5–101 Levels frame

Each level represents a physical height at which equipment can be inserted in the 
drawing. The level chosen should be compatible with the purpose of the equipment. 
Equipment would normally be inserted at Floor level, while Lights would normally be 
inserted at High Level which is 100 mm below Ceiling Level. An example of current 
settings is given below.

Table 5–4 Levels Frame

Level ID Level Description Default Elevation Relative to Level

0 Undefined 0 Floor

1 Top of Slab 0 Floor

3 Floor Level 0 Floor

4 Ceiling Level 13000 Floor

5 Under Slab 0 Floor

6 Low Level 75 Floor

8 Bench Level 1200 Floor

9 Chest Level 1500 Floor

10 High Level -100 Ceiling Level

12 Ceiling Void 200 Ceiling Level

13 Pelmet Level 1750 Floor

14 Banner Level -1500 Ceiling Level

99 User Defined 0 Undefined
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The Front Direction Frame  

The Front Direction frame represents the direction which the front of the fixture (the 
side the customer views) is first orientated when the item of equipment is first placed 
in the drawing.

Figure 5–102 Front Direction frame

The orientation of the Front Direction of the equipment can then be changed by 
rotating the equipment when it has been inserted.

The Placement Frame  

The Placement frame enables two forms of mounting options to be specified.

Note: Levels are not currently directly configurable by the user. They 
can however be imported via the Data Import module. Contact Oracle 
for further information.

Note: When assigning block details it is strongly recommended that 
all blocks be initially defined with the same Front Direction. If front 
directions vary from block to block, this will lead to confusion when 
blocks are inserted in the drawing or formed into gondolas.

The front direction is normally set at 270 degrees relative to the 
Planner coordinate system - this defines 0 degrees as 'west'.
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Figure 5–103 Placement frame

Space Mounted indicates this block can be inserted into any floor space.

Wall Mounted indicates this block can be attached to a wall on insertion.

The Insertion Position Frame  

The Insertion Position is a position specified within Macro Space Management that 
matches the insertion position created when the associated graphic for the block was 
drawing in AutoCAD (or some other graphics program).
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Figure 5–104 Insertion Position Frame

It is important that the Macro Space Management insertion point matches the insertion 
point already defined in the graphic. If they do not match, then the graphic will be 
inserted into the AutoCAD and Merchandiser environments at an incorrect position. 
This in turn will result in problems with adjacency calculations, placing of associated 
equipment and products, etc.

There are twenty seven possible insertion positions, aligned in three layers: top, (green 
circles), middle (yellow circles) and bottom (red circles). The layer can be selected by 
clicking on the appropriate radio button. Each layer contains nine possible insertion 
points ranging from left rear to front right. The required option can be selected by 
clicking on the appropriate radio button.

Note: The Insertion Position specified within Macro Space 
Management is passive - changing the Insertion Position does not 
change the position of the graphical insertion position created when 
the graphic was drawn.

Note: A consistent convention should be adopted for the position of 
the insertion point. If all blocks are drawn using this convention, then 
the potential for misalignment is sharply reduced.
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The Child Insertion Position Frame  

The Child Insertion Position frame enables the child insertion position to be specified.

Note: In the above example, the insertion position (blue circle) is 
bottom, left, rear.

Note: In the above example, the insertion position (blue circle) is 
middle, right, centre.
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Figure 5–105 Child Insertion Position frame

The Child Insertion Position is the datum point from which merchandise is inserted 
onto the object.

There are twenty seven possible insertion positions, aligned in three layers: top, (green 
circles), middle (yellow circles) and bottom (red circles). The layer can be selected by 
clicking on the appropriate radio button. Each layer contains nine possible insertion 
points ranging from left rear to front right. The required option can be selected by 
clicking on the appropriate radio button.

In the above example, the insertion position (blue circle) is bottom, left, rear.
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In the above example, the insertion position (blue circle) is middle, right, centre.

The Insertion Options Frame  

The Insertion Options frame specifies how the block will behave on being inserted into 
the AutoCAD environment.

■ Rotate Attribute, when enabled, ensures any non-constant attributes on the block 
will be rotated so they are upright and readable. For example, a text tag associated 
with a block. If the block is inserted in an orientation where the text would 
otherwise not be readable, the text will be rotated so it becomes visible.

■ The Explode Block on Insert option, when enabled, results in the block exploding 
into its constituent parts on insertion, so they can be manipulated separately.

■ Adopt Layer is no longer in use and has been included so as to be compatible with 
earlier versions of Macro Space Management.

Size Tab  

The Size tab is used to specify the maximum length, width, and height of a fixture.
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Figure 5–106 Size tab

It contains three frames.

■ Actual size is the maximum dimensions of the block

■ Size Details contains information on the ranges of permissible sizes.

■ Nominal Dimensions are the volume the fixture occupies once all equipments 
have been added to it.

Overview of Block Sizes  

Blocks are of two main types. Some blocks have a single, fixed set of dimensions 
assigned, and can only be placed into drawings with a single length, width, and 
height. Other blocks belong to a size type and have size rules applied, which means 
that when they are placed into a drawing, the required length, width, and height can 
be selected from a predefined list.

Figure 5–107 Block Sizes

Blocks with a single fixed set of dimensions have dimensions specified in the Actual 
Size frame. Most blocks are currently of this type. Blocks where size rules (and 
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corresponding multiple dimensions) apply, have additional information assigned in 
the Size Details frame.

Overview of Size Groups and Size Rules  

Size  

A Size contains definitions of all permissible dimensions that can be assigned to a 
block.

Size Group  

A Size Group allows sizes to be collected into similar within a hierarchical tree of sizes.

Size Rules  

Size rules are the settings or combinations of settings that determine the definitions of 
dimensions permitted when assigned to a block.

Overview  

Blocks that are assigned multiple possible dimensions conform to size rules.

A Size is a set of definitions (size rules) as to what sets of dimensions are allowed for a 
block that has been assigned to that size group. When any Block is assigned to a size, it 
inherits the set of size rules associated with that size group. When the Block is inserted 
into the drawing, a dialog appears showing the dimensions permitted by the size 
rules. A specific set of dimensions can be selected from those available, and the block 
is inserted into the drawing (or Virtual Reality environment) with those dimensions.

Size Operations  

■ Sizes can be created. This means that a set of size rules is defined and stored 
within a named size group.

■ Sizes can be edited. The existing set of size rules is changed to a newly defined set. 
In the process, any blocks that reference the Size Group being edited will have 
their size rules changed to the edited version.

■ Sizes can be deleted. When a Size is deleted all blocks that reference that Size will 
have their associated size rules removed and will require assigning to an 
alternative size group so that their size rules can be redefined.

Block Operations  

Various operations can be carried out to assign blocks to Sizes. Create Size results in a 
block being associated with a Size. The block may either be associated with an existing 
size group, or a new size group can be defined. Edit Size results in the Size associated 
with that block being edited.

Delete Size removes the Block Definition currently referenced. It does not delete the 
Size itself, but just removes the link between Size and Block definition.

Note: It is the Size that is being edited, and not the Block Definition. 
Changes made to the Size will affect all blocks that reference that Size, 
and not just the block that is having its definitions set.
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The Actual Size Frame  

The Actual Size frame specifies the default size for the block. If no details are entered 
in the associated Size Details Frame, the Actual Size Frame specifies the only 
permissible set of dimensions that can be used.

Figure 5–108 Actual Size Frame

For the Calculate and Pick options to work, the drawing must be loaded into the active 
AutoCAD drawing using the Load Blocks into Drawing command from the File menu. 
Clicking on the Calculate button results in the maximum dimensions being returned 
to Fixture Studio.

Alternatively, with the object open in the active AutoCAD drawing, click on the Pick 
button. Switch to the AutoCAD drawing and click on the required offset point. The 
selected coordinates will be transferred to Fixture Studio.

The Size Details Frame  

The Size Details frame is used to allocate blocks to specific Size Groups.

Note: Use of Sizes in this manner is implemented in In-Store Space 
Collaboration, but is not yet fully implemented in Macro Space 
Management.

Tip: The Calculate and Pick buttons will only be active if Fixture 
Studio is connected to Planner and the block being edited is inserted 
into the currently active drawing.
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Figure 5–109 Size Details Frame

A Size Group contains details of the size rules that govern the dimensions for a Block 
Definition. Size Groups can be configured in a number of ways.

The Nominal Dimensions Frame  

The Nominal Dimensions frame is used to associate a set of nominal dimensions to a 
fixture.

Figure 5–110 The Nominal Dimensions Frame

Nominal dimensions are primarily used for primary fixtures, where attached 
secondary equipment will substantially increase the volume. For example, consider a 
backpanel 600 mm long, 1900 mm high and 5 mm deep. If this backpanel has shelves 
attached, it will eventually occupy a significantly larger space. It could therefore be 
assigned nominal dimensions of 600 mm long, 1900 mm wide and 300 mm deep to 
allow for the eventual shelves.
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Tip: Any product or placeholders put onto a fixture with nominal dimensions will 
occupy a volume that corresponds to the larger of the Actual and Nominal Sizes.

Size Details Frame  

Creating Association to Size Group  

When a block can be assigned multiple dimensions, it needs to be associated with a 
Size Group. The block will then adopt the size rules associated with that Size Group 
and hence will have a range of permissible dimensions assigned to it.

The process is started by clicking on the Create Option. This brings up the Sizes dialog 
box.

Figure 5–111 Sizes dialog box

This gives two options:

■ Create new size or
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■ Select from existing.

These are selected by using the appropriate radio button.

Similarly Lozier or Hussmann could describe sets of dimensions specific to those 
manufacturers.

Create New Size  

Selecting this option brings up the Sizes dialog box.

Figure 5–112 Configure Sizes

This can be configured to set the size rules.

Select from Existing  

Select from Existing associates the block being defined with an existing set of size 
rules.

Note: Size Groups can have varying purposes: Stretchable could 
describe the size rules for fixtures that are to be made stretchable and 
Square or Circular could describe fixtures that must preserve that 
class of dimensions.
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Figure 5–113 Size - Select from Existing

When the required Size Group has either been Created or Selected and the OK button 
clicked, the associated size rules will be assigned to the block definition and will 
appear in the Size Associations frame.

Figure 5–114 Edit Size Rule Option

Editing Size Group

Clicking on the Edit button enables you to edit the Size Group details.
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Figure 5–115 Size Group details - Edit

This brings up the Size dialog box so that the size rules can be changed.

Figure 5–116 Size Dialog Box

Note: This operation edits the size rules, not the dimensions for the block being 
defined.

Editing the size rules will affect all blocks currently associated with that set of size 
rules.

Removing Size Group Association  

Removing a Size Group association can be achieved by clicking on the Remove button.
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Figure 5–117 Size Associations - Remove

This removes the link to the size group (and its associated size rules) but it does not 
delete the Size Group itself. The Size details frame will then show that no Size Group 
has been associated with this particular block.

Figure 5–118 Size Associations - Associate

Connection Tab  

The Connections tab allows you to specify the connection options for Macro Space 
Management blocks.
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Figure 5–119 Connections tab

A small toolbar at the top allows you to add, copy, and delete connections, while the 
wizard on the toolbar allows you to add three basic connections. The Connections List 
enlists all current connections for the Macro Space Management Block.

The Connections Tab and the Configuration Module  

Settings in the Configuration module can affect how connection points appear in 
Fixture Studio. Access the Configuration module by selecting the Configure Option in 
the File menu.
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Figure 5–120 Fixture Studio - Configure

Within the Configuration module, select the Fixturing tab. The Connection Points 
frame can then be used to change their appearance.

Figure 5–121 Connection Points
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A series of check boxes allow you to configure how connection points operate. These 
settings are local and do not affect other users of Macro Space Management.

■ Pointer Size and Line Size affect the appearance of the connection points as 
displayed.

■ Colors for Neutral, Male, and Female connection points can also be set.

■ Gender Filter determines whether connection genders are taken into account 
when deciding if connections are compatible.

■ Size Filter determines whether connection sizes are taken into account when 
deciding if connections are compatible.

■ Shape Filter options determine whether connection shapes are taken into account 
when deciding if connections are compatible.

The Connections Toolbar  

The Connections toolbar on the upper left of the Connections tab allows you to add, 
copy and delete connections. It also allows you to invoke the Connections Wizard.

Figure 5–122 Connections toolbar

Add a Connection
Clicking on the Add a Connection icon causes a line to be added to the Connections 
List ready for further details of the connection to be added.
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Copy a Connection
Clicking on the Copy a Connection icon causes a line to be copied again to the 
Connections List mirroring details of the connection to be added.

Before clicking the Copy icon, select the connection to be copied. Clicking on the icon 
will bring up the connection naming dialog box.

Figure 5–123 Copy Connection Point

Edit the name to one suitable for the new connection. On clicking OK, a duplicate 
connection will be added, save with the changed name.
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Delete a Connection
To delete a connection, highlight the connection to be deleted and click the Delete icon. 
When asked for confirmation, click Yes to delete a connection.

The Connections Wizard
The Connections Wizard can be invoked from the Wizard icon in the toolbar in the 
Connections tab.

Figure 5–124 Connections Wizard

This will bring up the Connections Wizard dialog box.



Fixture and Gondola Hierarchies

Fixture Studio 5-101

Figure 5–125 Connections Wizard dialog box

■ Checking the Add connection on Left checkbox will add a Connection on the left.

■ Checking the Add connection on Right checkbox will add a Connection on the 
right.

■ Checking the Add connection at Back checkbox will add a Connection at the back.

The left connection is male and the right female so that fixtures can only attach when 
they are facing the same way. The left connection is additionally set to be the default.

The Back connection has no gender, so it will attach to any other connection.

Checking the Clear Existing Blocks checkbox will remove any existing connections.

On clicking OK on the Wizard, the selected default connections will be added.

The Connections List
The Connections List is a list of all defined connections for the selected Macro Space 
Management block. In addition, many of the characteristics of the connection can be 
configured by means of selecting a connection, then changing the appropriate options 
within the Connections tab.
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Figure 5–126 Connections List

Name: The Connection Name is user editable and can be changed just by typing in the 
new name.

Type: The Connection Type is changed by means of the buttons in the Type frame

Figure 5–127 Connection Type

A Text Reference Point is used to specify the location for annotation to justify to.

A Connection is used to indicate how fixtures join.

Gender, Shape and Size

Gender, shape and size are set using the Filters frame.
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Figure 5–128 Filters frame

The gender of a connection determines whether that connection is compatible with 
another. There are three genders; male, female and neutral.

Shape  

The shape of a point connection can be specified from a drop down list.

Can connect with

Male Female Neutral

Female Male Neutral

Neutral Any other connection
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Figure 5–129 Filters frame - Shape Drop down list

They connect as follows:

The list of shapes available can only be defined by Oracle. They are stored in the 
directory and cannot be displayed if not present in that directory.

Size  

A maximum and minimum size for the connection can be set using the spin controls. 
A pair of connection points must have compatible sizes to connect together. If the 
Match checkbox is ticked, then the connections must have identical maximum and 
minimum sizes. If they are not identical, the connections will not mate. If the Match 
check box is not ticked, then the connections must have overlapping size ranges. If 
they are not overlapping, the connections will not mate.

Table 5–5 Filters frame - Shape Drop down list

Can connect with

None Any other connection shape

Rectangle Rectangle None

Circle Circle None

Oval Oval None

Triangle Triangle None

Hexagonal None None

Tip: The shape of a connection point is a theoretical concept used to 
make it easier to remember what connection point connects to what 
connection, that is, fixtures with 'Oval' connection points can only 
connect to other fixtures with 'Oval' connection points. When 
displayed in the preview tab, all connection points will appear 
visually as triangles.

Tip: Use this feature to ensure that equipment specific to one 
manufacturer can only connect to other equipment from that 
manufacturer. For example assign Rectangular shapes to Lozier 
equipment and Oval shapes to Hussmann equipment. The two types 
of equipment will not then be able to connect to each other.

Table 5–6 Size Ranges

Connection 1 Connection 2

Size Range 0 - 50 25 - 75 Compatible

Size Range 0- 25 50 - 75 Incompatible
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Default  

The Default Connection is the connection selected when an object with multiple 
connection points is offered up to be attached to a piece of equipment. It is specified 
from a drop down list.

It is set from the Type frame.

Figure 5–130 Filters frame - Type drop down list

For example, if the left (male) connection point is set to be the default, the object will 
only connect to other connection points of female and no gender.

The Position Frame
The Position frame is used to set the origin of the connection point.

Figure 5–131 The Position Frame

Pick can be used if Fixture Studio is connected to Planner and the block has been 
loaded into the active drawing. (See Options on File menu). Alternatively, the position 
of the connection point can be entered as a series of X, Y and Z coordinates relative to 
the insertion point of the fixture.

Note: Exercise caution when using connection lines and planes as 
the default.
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The Horizontal and Vertical Angle Frames
The Horizontal and Vertical Angles are used to control the direction of connection 
points, irrespective of whether they are assigned as a point, as a line or as a plane.

Figure 5–132 The Horizontal and Vertical Angle Frames

■ Changing the Horizontal Angle changes the direction the designated connection 
point faces over the floor.

■ Setting it to 0 degrees will make them face east; setting to 180 degrees will make 
them face west.

■ Setting the Vertical Angle affects whether the connection points are horizontal or 
face up or down.

■ Setting to 0 degrees will result in the connections being horizontal, 90 degrees 
pointing vertically up and 270 degrees vertically down.

Summary of Connection Requirements
For one item of equipment to connect to another the following must be true.

Tip: The position of the connection points can be checked by using 
the Preview tab.

Note: Setting to 180 degrees will result in the connection point 
turning upside down and facing in the opposite direction. Please use 
caution when using this option.
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If any of these criteria are not true, then a connection cannot be made. In addition, if 
the planes of the connections or the angles of the connections are not correctly 
specified relative to each other, equipment may connect together in unintended 
alignments.

Connection Examples
Connection Lines for a Slatwall

Connection lines for a slatwall have to go in the X, Z plane.

The following settings were used for a 575 x 900 mm backpanel.

Figure 5–133 Connection Lines for a Slatwall - Settings

Position  

The position was set with a -2 Y co-ordinate to put the connection line on the surface 
of the backpanel.

It was also given a +100 Z co-ordinate to move the lowest connection line above floor 
level.

Spacing  

The X spacing was set to 0 to give a continuous line.

Table 5–7 Connection Requirements

Requirement
Optional or 
Mandatory

Gender The connection 
points must have 
compatible genders

This requirement can 
be disabled in the 
Configuration 
Module

Shape The connection 
points must have the 
same shape

This requirement can 
be disabled in the 
Configuration 
Module

Size The connection 
points must have 
compatible sizes

This requirement can 
be disabled in the 
Configuration 
Module



Fixture and Gondola Hierarchies

5-108 Oracle® Retail Macro Space Management  User's Guide

The X extents were set to 575 to get the line running across the full width of the 
backpanel.

The Z spacing was set to 50 mm to put the connection lines 50 mm apart.

The Z extents were set to 800 mm to keep the top connection line below the top of the 
backpanel.

Result  

The result looks as follows:

Figure 5–134 Connection Lines for a Slatwall - Results

Connection Points for a Pegboard  

Connection lines for a pegboard have to go in the X, Z plane.

The following settings were used for a 575 x 900 mm backpanel.
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Figure 5–135 Connection Points for a Pegboard - Settings

Position  

The position was set with a +37.5 X co-ordinate to move the first column of points 
inside the edge of the backpanel

It was given a -2 Y co-ordinate to put the connection point tip on the surface of the 
backpanel.

It was also given a +100 Z co-ordinate to move the lowest connection point above floor 
level.

Spacing  

The X spacing was set to 50 to give the horizontal spacing

The X extents were set to 500 to keep the last column of points inside the edge of the 
backpanel

The Z spacing was set to 50 mm to put the connection lines 50 mm apart.

The Z extents were set to 800 mm to keep the top line of connection points below the 
top of the backpanel.

Result  

The result looks as follows:
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Figure 5–136 Connection Points for a Pegboard - Results

Tip: Anything connecting to this array of connection points will connect to the tips of 
each point.

Connection Box
A connection box allows objects to be placed anywhere within a defined 3 dimensional 
box.

Connections for a connection box have to go in the X, Y and Z planes.

The following settings were used for a 575 x 900 mm backpanel.

Note: If a connection box is given minimal thickness, it becomes a 
connection plane - i.e. two dimensional
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Figure 5–137 Connection Box - Settings

Position  

The position was set with a +37.5 X co-ordinate to move first edge inside the edge of 
the backpanel

It was given a -2 Y co-ordinate to put the back of the box on the surface of the 
backpanel.

It was also given a +100 Z co-ordinate to move the lowest edge of the box above floor 
level.

Spacing  

The X spacing was set to 0 to give a continuous box.

The X extents were set to 500 to keep the other edge inside the edge of the backpanel

The Y spacing was set to 0 to give a continuous box.

The Y extents were set to -50 to give the box a depth.

The Z spacing was set to 0 to give a continuous box.

The Z extents were set to 800 mm to keep the top line of connection points below the 
top of the backpanel.

Result  

The result looks as follows:
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Figure 5–138 Connection Box - Results

Parts Tab
The Parts tab enables a list of associated parts to be built up for a block. This list is 
used for reporting purposes and does not affect the Planner or Merchandiser 
environments.
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Figure 5–139 Parts Tab

The Available Parts frame contains a list of all available parts. The Associated Parts 
frame contains a list of all parts associated with that particular block.

Part Blocks
Part Blocks are specialized type of block that have no graphics and exist only within 
the Macro Space Management database. It is only used for reporting purposes.

Creating Groups for Part Blocks  

To create a Group for a Part Block, click on the Add Group icon on the Fixture Studio 
toolbar. This will bring up the Add Group dialog box.

Note: It is recommended that Part Blocks are kept in specific and 
separate Groups within the Fixture Studio Hierarchy.
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Figure 5–140 Add Group

Type in a suitable name and select a suitable icon. Click OK and the group will be 
created in the Fixture Hierarchy visible in the Object Browser.

Creating Part Blocks  

Select an appropriately named Group in the Fixture Hierarchy visible in the Object 
Browser. Click on the Add Block icon or right click on the selected group to bring up 
the Block Definitions dialog box.

Only a few parameters need to be defined.
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After entering an appropriate block name and description for the Category Tab, set the 
following:

■ Set Equipment type to Other

■ Set Manufacturer to an appropriate name

■ Set Material to an appropriate material

■ Set Status to Current

■ Set Units to an appropriate measurement

■ Ensure that No graphics is selected in the Graphics frame

■ Select an appropriate icon
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For the Insertion Tab, select a nominal layer.

If any User Defined Attributes need to be set (for example cost) these can be set in the 
UDA tab.

Note: A layer is not necessary for a block that is to be used purely for 
reporting purposes, but Macro Space Management will not allow the 
block to be saved until one has been set.



Fixture and Gondola Hierarchies

Fixture Studio 5-117

Once the parameters have been input into the Categories, Insertion and UDA tabs, the 
part block is ready for insertion into a list of parts.

Building up a Parts List
The Parts List can be added to and edited using the arrows in the centre of the Parts 
tab.

Note: The list of User Defined Attributes is customizable and will 
vary from implementation to implementation. The list is configured in 
the Admin Module.
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Building Parts List  

■ Available Parts: The Available Parts frame contains a list of all available parts. 
BlockNames, and Description can be sorted in ascending or descending order by 
clicking on the column header.

■ Associated Parts: The Associated Parts frame contains a list of all parts associated 
with that particular block. In the above example, the Podium is made up of a Top 
and Frame. Quantities, BlockNames, and Description can be sorted in ascending 
or descending order by clicking on the column header.

Building and Editing a Parts List  

To add a part to the Associated Parts list, highlight the part in the Available Parts 
frame and use the Add arrow.

Alternatively highlight and double click on the part in the Available Parts frame.

To remove a part from the Associated Parts list, highlight the part in the Associated 
Parts frame and use the Add arrow.

Alternatively highlight and double click on the part in the Associated Parts frame.

Changing the number of a specific part  

To change the number of a specific part in the associated parts list, highlight the 
required part then left click on the number in the Qty column.

The number can then be edited. Press Enter to confirm.

Fixture Tab
The Fixture tab is used to specify the behavior of shelving and the product block for a 
fixture.
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Figure 5–141 Fixture Tab

The Fixture Frame
The Fixture frame allows some details of how the fixture is to be merchandised to be 
specified.
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Figure 5–142 Fixture frame

Vertical Category allows the aliased layer to be occupied by the fixture to be further 
sub-divided. The default is 0, but fixtures can be assigned to further vertical categories 
within the aliased layer. For example TV's could be assigned to Vertical Category 1, 
CD Players to Vertical Category 2.

Setting the Vertical Category affects Adjacency calculations and annotation. Fixtures in 
different Vertical Categories are not shown as adjacent and if Vertical Categories are 
set, each category will receive its own separate annotation. Setting Vertical Categories 
affects the reporting options; material in different categories can be reported 
separately.

Tierage is used when the fixture has distinct merchandisable levels rather than 
shelves.

Examples of fixtures that have tiers are those used to display magazines or perfumes. 
If the Fixture has shelves, the Tierage value should be left set to 0. If the fixture has 
tiers rather than shelves, then the number of tiers should be specified.

The product base can be designed such that a single product base fits the tier structure. 
In this case the entire fixture can be merchandised, but only with a placeholder 
indicating a class of product, for example cards or lipsticks.

Note: Vertical Category and Tierage have been largely superseded 
by Styles in Macro Space Management.

Note: There are two ways of assigning a Product Base to a tiered 
fixture.
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Alternatively, each tier can be defined as a Merchandisable Area in the 
Merchandisable Areas tab. Each tier can then have a product base assigned to it. This 
would allow more specific placeholders to be used. For example CD's with artist's 
names beginning with A & B would be placed on the upper tier.

The Shelving Frame
The Shelving Frame is used to set parameters affecting the behavior of shelves on a 
fixture.

Figure 5–143 Shelving Frame

Slot Spacing gives the distance between successive shelves.

First Slot Number gives the height of the initial shelves.

Measure from Bottom and Include First Shelf are not active in this implementation of 
Macro Space Management.

The Product Block Frame
The Product Block Frame allows the details of the Product Block to be assigned to the 
Fixture.

Note: This functionality has now been largely superseded by 
connections. If specified, connection lines will overwrite this spacing.
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Figure 5–144 Product Block Frame

Product Blocks assigned in this frame are used to act as indications of the dimensions 
that can be merchandised when placeholders for a general class of product (for 
example shoes or canned goods) are assigned to the fixture.

The default Product Block is PBASE__, which is a simple rectangular block but other 
product blocks can assigned. For example a round product block would be assigned to 
a table top, and a stepped product base would be assigned to a display cabinet with 
tiers.

About Merchandisable Areas, Product Blocks and Display Styles

Merchandisable Areas  

A merchandisable area is an irregular cube shaped space associated with a specific 
fixture or shelf object. It delineates the volume relative to the dimensions of that object 
that can be filled with product.

Note: If a product block has not been specified for a fixture or shelf, 
it will not be possible to merchandise that item of equipment with a 
placeholder.

Note: Merchandisable areas are defined within the Merchandisable 
Areas Tab in the Block Definitions box.
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The merchandisable area is defined by specifying the two points that represent 
opposing corners of the cuboid. Accordingly, the geometry is simple and inflexible.

Placeholders and display Styles  

In the AutoCAD environment, all merchandise is displayed using placeholders. In the 
Virtual Reality environment, there are two forms in which merchandise can be 
displayed.

At Article (SKU) level and above, they are displayed in the form of placeholders, 
which indicate that a particular form of merchandise has been used to populate that 
section of the store.

Placeholders are simple geometrical shapes (such as cubes and cylinders) and have no 
surface detail. At Display Level, a product block containing a more detailed physical 
representation of the product is placed, the amount of detail depending on local 
settings.

Place holder  

In the above example, the lower shelf is populated with a placeholder; while the upper 
shelf has products displayed using three types of display style product blocks.

(The plates are shown as graphical style product blocks, the boxes on the left as simple 
boxes and the boxes on the right as textured boxes.

Because the merchandisable area is of simple geometry, fixtures and shelf objects need 
to have default product blocks associated with them in their block definitions.

These default product blocks can be of more complex shapes, for example cylinders, 
hemispheres, hexagons, etc. Only a single design of each class of product block is 
required as their dimensions are scaleable.

When placed on a fixture or shelf object product blocks expand to the maximum 
dimensions permitted by the merchandisable area. Thus a single cylindrical product 
block can be used for wide range of fixtures and shelf objects.

The Product Block will subsequently be used to define the volume occupied by a 
placeholder. For example, a circular table must still have a cubic merchandisable area 
defined, as all merchandisable areas have to be simple cuboids.

In the above diagram, the merchandisable area is represented by the cuboid with the 
heavy black outline. However, if this cuboid was merchandised directly with a 
placeholder, it would result in product being shown beyond the actual surface of the 
fixture. Accordingly, a cylindrical Product Block is associated with the fixture. This 
expands to the limits set by the merchandisable area and represents the limits that will 
be shown as occupied by a placeholder.

Merchandising with Placeholders and Display Style Product Blocks

If a fixture or shelf object is merchandised with a placeholder, it will occupy the 
extents defined by the Merchandisable Area defined in block definitions.

In the example below, the fixture on the left has a default Product Block assigned 
(green cylinder). It will not be required unless the fixture is merchandised by a 
placeholder.

Because the default Product Block is scaleable, it will take up the size determined by 
the merchandisable area of the fixture. When the placeholder is then shown (yellow 
cylinder), it takes up the volume defined by the product block, which has itself 
expanded to the extents determined by the merchandisable area.
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A similar logic applies to other shapes of Product Block - they allow placeholders to be 
displayed in a number of geometries.

Display Style Product Blocks  

If the same fixture is merchandised with a Display Style Product Block (the blue box in 
the right hand diagram) the display style product block will be placed within the 
limits set by the merchandisable area (the cuboid outlined in black).

The display style product block then has to be moved within the limits of the actual 
merchandisable surface of the fixture using the alignment options available within 
Merchandiser.

If a placeholder is used to represent merchandise, only a single instance is required, as 
this represents the volume occupied by a class of product, not individual items.

UDA (User Defined Attributes) Tab
The User Defined Attributes tab is used to specify customized information for a 
block.

Note: If the specified Product Block had been hexagonal, then the 
placeholder would have been shown as a hexagonal shape, scales to 
the extents of the merchandisable area.

Note: The display style product block represents the actual 
dimensions of an instance of the merchandise being placed on a 
fixture. This means multiple instances of display style product blocks 
can be placed until the available volume defined by the 
merchandisable area is filled.
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Figure 5–145 User Defined Attributes Tab

UDA details are configured in the Admin Module, allowing UDA information to be 
added for each block.

Entering UDAs
When the UDA tab is selected, a list of UDAs will come up. These will be blank if the 
fixture is being added, or if no UDAs have been previously added.

Figure 5–146 List of UDAs

Data can be typed in as require, pressing [Enter] to enter each item of data.
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Figure 5–147 Validation

UDA Data has a data type (assigned in the Admin module). If data does not match the 
specified type, it will not be accepted.

Mandatory UDAs  

Some UDAs are mandatory and must be entered before the block definition can be 
saved. Failure to enter these mandatory UDAs will result in an error message being 
displayed.

Styles/Ranges Tab
The Styles/Ranges tab has two purposes: to set the styles for items of equipment, and 
to specify any ranges for physical parameters limiting the products than can be placed 
on that equipment.
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Figure 5–148 Styles/Ranges tab

Available Styles frame contains a list of styles that have been defined in the Admin 
Module.
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Figure 5–149 Available Styles Tab

They can be used to build up a list of available styles for a block. Depending on the 
block, the styles will define the type of equipment it can connect with, and (if a shelf or 
fixture) the type of merchandise it can accept.

Building a Styles List  

To add a style to the Selected Styles list, highlight the part in the Available Styles 
frame and use the Add arrow.

Alternatively highlight and double click on the part in the Available Styles frame.

The Selected Styles Tab
The Selected Styles tab contains a list of styles that have been chosen from the 
Available Styles frame.
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Figure 5–150 Selected Styles Tab

Depending on the block, the styles will define the type of equipment it can connect 
with, and (if a shelf or fixture) the type of merchandise it can accept.

Removing from the Selected Styles List

To remove a part from the Selected Styles list, highlight the part in the Selected Styles 
frame and use the Remove arrow.

Alternatively highlight and double click on the part in the Selected Styles frame.

Range Options
The Range Options frame allows the user to set a permissible temperature range for 
the merchandise the block will accept.
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Figure 5–151 Range Options frame

This would most usefully be used for Freezer and Chilled Food units.

Styles
Styles are used to define whether different types of objects fit together. They can be 
used to specify (for example) whether a shelf will fit on a fixture, or whether a product 
will fit on a shelf.

There are three broad classes of style (although others can be defined).

■ Fixture styles

■ Shelf styles

■ Product styles

Fixtures must have one or more fixture styles. The fixture style specifies what form of 
shelving and other equipment can be attached to it. If product is to be placed directly 
on any fixture, it also requires a shelf style.

Shelves must have one or more fixture styles and also one or more shelf styles. The 
fixture style specifies what sort of fixture the shelf may be attached to. The shelf style 
specifies what form of product can be placed on the shelf.

Products must have one or more product styles. The product style specifies what form 
of shelving the product is compatible with.

Style Relationships can be configured using the Styles option in the Admin Module.

Assigning Styles can be done via the Block Details option in Fixture Studio.

Ranking Multiple Styles assigned to a type of object in order of priority can be done 
via the System Variables option in the Admin Module.

Note: This functionality is not enabled for this implementation of 
Macro Space Management.
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Preferred Styles can be assigned to individual shelves using the Edit option from the 
pop-up menu in the Merchandiser.

Types of Styles

Fixture Styles
Each fixture should be associated with one or more Fixture Styles. An example of a 
fixture style might be 'Metal'. This style might also be associated with fitting and 
shelves and can be used to indicate that particular items of equipment can be fitted 
together.

If product is to be placed directly on any fixture, it also requires a shelf style.

Shelf Styles
Each shelf must be associated with one or more Fixture Styles and also one or more 
Shelf Styles. The Fixture Style is used to ensure the shelf fits onto a compatible fixture. 
The Shelf Style only allows products with compatible styles to be placed.

Product Styles
Each product must be associated with one or more product styles. These product 
styles will determine the compatible shelves the product can be placed on.

For example shirts could be available in both Hung and Folded Product (Display) 
Styles. If a product is dragged into a shelf at item level then it will automatically select 
the correct Product Style. For example if shirts are dragged into an open shelf, they 
will be placed as Folded Shirts. If shirts are dragged onto a peg or bar, then they will 
be placed as Hung Shirts.

If product is dragged onto a shelf at Display Level then it can only be placed on 
equipment compatible with that style. For example Folded shirts cannot be placed 
onto a bar.

Using Styles
The diagram below indicates how styles interrelate.

The fixture has been assigned a Metal Fixture fixture style.

The Open Shelf, Peg Board and Hanging Rod shelf objects have all been assigned 
Metal Fixture fixture styles. This means any of these three types of shelf object can be 
placed on the fixture.

If another type of shelf object (for example a slatted back panel) had been assigned the 
Lozier fixture style, it would not have a fixture style compatible with that assigned to 
the fixture itself, and could not be assigned to that fixture.

The Open Shelf, Peg Board and Hanging Rod shelf objects have also all been assigned 
appropriate shelf styles.

The varying types of products have been assigned product styles. For example shirts 
have been assigned Boxed, Folded and Hung product styles. These styles determine 
what form of shelf object shift can be placed on.

For example shirts with a Hung product style can only be placed on Hanging Rods. 
Conversely, the Open Shelf has been configured to accept both Boxed and Folded shirt 
styles.
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Ties only have Pegged product style and are restricted to the Peg Board.

Preferred Styles
Some objects can be associated with multiple styles; specific instances of shelves 
within the drawing can be given preferred styles.

These preferred styles override the ranking set in the SPL_RANKING System variable 
for that specific shelf.

For instance, a shelf could be associated with both a Stock shelf style as well as a 
Presentation shelf style; two display styles may then be defined for a particular 
product, a Display product style and a Boxed product style.

The Stock shelf style would be linked with the Boxed product style, and the 
Presentation shelf style would be linked with the Display product style. This would 
allow both the Boxed and Display version of the product to be placed on the shelf.

However, the user would be able to indicate the preferred style for a particular 
instance of a shelf as being Presentation, which would force the Display product to be 
placed for that particular shelf.

Merchandisable Areas Tab
The Merchandisable Areas tab is used to indicate the location of merchandisable areas 
for an object.

■ The Primary Area Frame allows specifying the first merchandisable area.

Note: Where an object has multiple styles they can be ranked in 
order of preference using the appropriate system variables, or set in 
order of preference using preferred styles.
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Figure 5–152 Merchandisable Areas Tab

■ The Further Areas Frame allows specifying the second and subsequent 
merchandisable areas.

Merchandisable Area Concepts
Merchandisable areas are used to specify which volumes of a fixture can accept 
merchandise.

In the example above an idealized fixture consists of a base, back panel and ledge (left 
hand diagram). It is desired to create two merchandisable areas on the fixture. The 
Primary Merchandisable Area is to be created on the base (colored yellow) and a 
Further Merchandisable Area is to be created on the ledge (colored green).

For each area a cube is defined (right hand diagram). This cube sets the maximum 
limits which merchandise can occupy.

First Merchandisable Area

The First Merchandisable Area is designed to be compatible with fixtures that can be 
defined as stretchable. It is based on specifying two points relative to the bottom, back, 
left and top, front, right coordinates of a fixture.
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Figure 5–153 First Merchandisable Area

When specified, Offset 1 and Offset 2 specify opposing corners of a cube. Because 
these offsets are specified relative to the dimensions of the fixture, if the fixture 
dimensions change, then the dimensions of the cube change relative to it.

Example of First Merchandisable Area and Stretchable Fixture: Take a fixture of 
length 1200 mm, depth 400 mm and height 600 mm. This will have Offset 1 relative to 
the bottom, left, back of the fixture (coordinates 0, 0, 0) and Offset 2 relative to the top, 
front, right of the fixture (coordinates 1200, 400, 600). If the fixture is now stretched to 
length 1600 mm, the top, front, right of the fixture will have coordinates 1600, 400, 600. 
Offset 2 will now be relative to these modified coordinates and the merchandisable 
area will have been increased in size to match the new length.

Further Merchandisable Area

Further merchandisable areas are of fixed size and will not change relative to the 
dimensions of the fixture if the fixture is stretched. They are based on specifying a 
position relative to the bottom, left, back of the fixture. This set of coordinate's details 
one corner of a cube. A size is then specified relative to the position. This specifies the 
second corner of a cube.

Figure 5–154 Further Merchandisable Area

Example of Further Merchandisable Area: First the starting Position of the Further 
Merchandisable Area is specified relative to the bottom, back, left of the fixture. This 
might have coordinates 0, 50, 400. (Aligned with side of fixture, moved forward 50 
mm to allow for thickness of back panel, raised 400 mm to correspond to top of shelf). 
Next, the Size of the Further Merchandisable Area is specified. This is done by 
specifying coordinates for the opposing corners of a cube. These might be 600, 200, 
300. (Area is 600 mm long, 200 mm deep and 300 mm high).
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The Primary Areas Frame  

The Primary Area Frame allows the user to specify the Primary Merchandisable Area. 
Primary Merchandisable Areas can be used in conjunction with stretchable fixtures.

Figure 5–155 Primary Areas Frame

The datum points from which Offset 1 and Offset 2 are set together define the extents 
of the object. The datum point for Offset 1 is the back, bottom, left corner of the object, 
and the datum point for Offset 2 is the front, top, right corner of the object. The effect 
of putting in the offset coordinates can be seen from the diagram below.

Putting in positive coordinates moves the offset point inside the extents of the drawing 
(in the directions shown by the heavy black arrows). Putting in negative coordinates 
moves the offset point outside the extents of the drawing.

Offset 1 is specified relative to the bottom, back, left coordinates of the fixture.

Offset 2 is specified relative to the front, top, right coordinates of the fixture.

Positive X coordinate Decrease length of 
merchandisable area

Negative X 
coordinate

Increase length of 
merchandisable area

Positive Y coordinate Decrease depth of 
merchandisable area

Negative Y 
coordinate

Increase depth of 
merchandisable area

Positive Z coordinate Decrease height of 
merchandisable area

Negative Z 
coordinate

Increase height of 
merchandisable area

Positive X coordinate Decrease length of 
merchandisable area

Negative X 
coordinate

Increase length of 
merchandisable area
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The effect in two dimensions can be seen by considering the following example. (The 
base of the fixture is shown in yellow and the merchandisable area is shown in blue).

■ Offset 1 has been given X and Y coordinates of 50, 50. This moves the offset 
position inside the extents of the fixture. The effect is that the first corner of the 
merchandisable area has been moved inside the fixture.

■ Offset 2 has been given X and Y coordinates of -50, -50. This moves the offset 
position outside the extents of the fixture. The effect is that the opposing corner of 
the merchandisable area has been moved outside the fixture.

Setting the Offsets  

Figure 5–156 Offset Setting

Manual Settings  

The Offsets can be set manually, but before they are, knowledge of the dimensions of 
the object is required. The basic length, depth and height can be obtained from the size 
tab. If more detailed dimensions are required, the drawing can be loaded into the 
active AutoCAD drawing using the Load Blocks into Drawing command from the File 
menu. The AutoCAD Dist (Distance) command can then be used to measure the 
dimensions. X, Y and Z dimensions can then be set by manually entering or by using 
the spin controls.

Using the Pick Command  

With the object open in the active AutoCAD drawing, click on the Pick button. Switch 
to the AutoCAD drawing and click on the required offset point. The selected 
coordinates will be transferred to fixture Studio.

Example of Primary Merchandised Area settings: In the above example both Offset 1 
and Offset 2 have had their X coordinates set to -50 mm. This has the effect of moving 
the offset points outside the pallet in the X axis. This in turn increases the length of the 
merchandisable area by a total of 100 mm relative to the length of the pallet.

In the above example both Offset 1 and Offset 2 have had their Y coordinates set to -50 
mm. This has the effect of moving the offset points outside the pallet in the Y axis. This 
in turn increases the depth of the merchandisable area by a total of 100 mm relative to 
the depth of the pallet.

The effects in the Z axis are more subtle.

Positive Y coordinate Decrease depth of 
merchandisable area

Negative Y 
coordinate

Increase depth of 
merchandisable area

Positive Z coordinate Decrease height of 
merchandisable area

Negative Z 
coordinate

Increase height of 
merchandisable area
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Offset 1 (with its datum at the base of the pallet) has had its Z coordinate set to 180 
mm. This has the effect of moving the offset point inside the extents of the drawing. As 
it is moved inside by 180 mm and 180 mm is the height of the pallet, this sets the offset 
to the top of the pallet.

This has the effect of setting the base of the merchandisable area to the top face of the 
pallet.

Offset 2 (with its datum at the top of the pallet) has had its Z coordinate set to -1300 
mm. This has the effect of moving the offset point outside the extents of the drawing. 
The practical effect is to set the top of the merchandisable area to 1300 mm above the 
top face of the pallet.

The Further Areas Frame  

The further areas frame allows other merchandisable areas to be specified.

Figure 5–157 Further Areas Frame

It requires two sets of coordinates:

■ The first is a position specified position relative to the bottom, left, back of the 
fixture. This set of coordinate's details one corner of a cube.
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■ A size is then specified relative to the position. This specifies the second corner of 
a cube.

Setting the Offsets  

Figure 5–158 Setting the Offsets

Naming the merchandisable area  

To name the Further Merchandisable Area type in the name and press <Enter>. The 
name will be entered in the list of Further Areas.

Figure 5–159 Further Merchandisable Area type

You may not edit the Further Area until they click on the name in the list of further 
areas.

Manual Settings  
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Figure 5–160 Manual Settings

The Offsets can be set manually, but before they are, knowledge of the dimensions of 
the object is required. The basic length, depth and height can be obtained from the size 
tab. If more detailed dimensions are required, the drawing can be loaded into the 
active AutoCAD drawing using the Load Blocks into Drawing command from the 
File menu. The AutoCAD Dist (Distance) command can then be used to measure the 
dimensions.

X, Y and Z dimensions can then be set by manually typing or by using the spin 
controls.

Using the Pick Command  

With the object open in the active AutoCAD drawing, click on the Pick button. Switch 
to the AutoCAD drawing and click on the required offset point. The selected 
coordinates will be transferred to fixture Studio.

Setting the Datum Points - Position  

The datum point for position is specified relative to the bottom, left, rear corner of the 
object.

■ Positive X values move the position to the right on the object.

■ Positive Y values move the position forward on the object.

■ Positive Z values move the position up on the object.

Setting the Size of the merchandisable area  

The Size is set by defining a second datum point relative to the Position datum point.

■ Positive X values define the length of the merchandisable area to the right of the 
position datum.

■ Negative X values define the length of the merchandisable area to the left of the 
position datum.

■ Positive Y values define the depth of the merchandisable area forward of the 
position datum.

■ Negative Y values define the depth of the merchandisable area behind the position 
datum.

■ Positive Z values define the height of the merchandisable area above of the 
position datum.

■ Negative Z values define the height of the merchandisable area below of the 
position datum.
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Setting the Angles of the merchandisable area  

Both the vertical and horizontal angles can get for further merchandisable areas. An 
example of where this would be used would be if merchandisable areas were set up on 
shelving intended to display newspapers at an angle for sale.

Constrained and Unconstrained Merchandisable Areas  

Primary Merchandisable Areas can either be constrained or unconstrained.

■ Constrained Areas are areas that stay within the specified co-ordinates.

■ Unconstrained Areas may take up any volume in the specified direction.

These options are set by checking the check boxes in the Primary areas frame.

Primary Area Frame  

Unconstrained axes are shown visually in the Preview tab.

Any unconstrained axis will have a '+' or a '-' sign by it.

Shelf Tab
The Shelf tab can be used to define the permissible angles for shelves to be set at when 
placed on a fixture.



Styles

Fixture Studio 5-141

Figure 5–161 Shelf Tab

Currently defined Angle Categories can be seen from the drop down list.

Figure 5–162 Angle Categories
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Specifying Permissible Shelf Angles
Angle categories many be created, edited or deleted. To create an Angle Category, 
click on the Create button.

Figure 5–163 Create Angle Categories

This will bring up the Shelf Angles dialog box.

Figure 5–164 Shelf Angles dialog box

Type in the required Angle Category name then left click into the Angles box.

(Do not press <Enter> at this stage or it will close the dialog box). Type the required 
angle in and press <Enter>. Continue to type in the required angles and pressing 
return until the desired list of angles has been built up.
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Figure 5–165 Shelf Angles

When the required Angles have been entered, click on OK to save the information to 
the database and close the dialog box.

Editing an Angle Category
To Edit an Angle Category, click on the Edit button.

Figure 5–166 Edit an Angle Category

This will bring up the Shelf Angles dialog box.
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Figure 5–167 Shelf Angles dialog box

The Shelf Group Name cannot be edited. The Angles can be edited by typing in the 
required angle and pressing return. When the required changes have been made, click 
on OK to save the information to the database and close the dialog box.

Deleting an Angle Category
To delete an Angle Category, click on the Delete button.

Figure 5–168 Delete Angle Category

The selected category will be deleted without further confirmation.

Preview Tab
The Preview Tab allows users to visually see merchandisable areas, connection points, 
the origin (insertion point) and the position of the first product placed on a fixture.
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Figure 5–169 Preview Tab

In the above image, the shelf is enclosed by a red selection frame. While the selection 
frame is present the fixture can be rotated by holding down the left mouse key and 
moving the mouse cursor around the fixture.

The selection frame can be removed by holding down the <Ctrl> key and left clicking 
with the mouse on the fixture. Alternatively you can use the <Escape Key>. While the 
selection frame is removed, the fixture can be moved on zoomed in and out on by 
holding down either the left or right mouse buttons and moving the mouse cursor 
around the fixture.

The selection frame can be restored by holding down the <Ctrl> key and left clicking 
with the mouse on the fixture.

Preview Tab Toolbar
The Preview Tab Toolbar allows users to select the point of view for the displayed 
preview.
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Figure 5–170 Preview Tab Toolbar

Merchandisable Areas Option
The Merchandisable Areas option allows you to see the assigned merchandisable areas 
for a fixture. Activate it by selecting the checkbox.

Figure 5–171 Merchandisable Areas option

In the example below, the podium has two merchandisable areas.

Connection Points Option
The Connection Points option allows users to see the position of the connection 
points. Select it by checking the Connection Points box.

Figure 5–172 Connection Points option

This will bring up the connection point display. Each type of connection point is color 
coded.

Note: The preview will be more responsive to movement if only one 
option is checked at a time.

Note: The color coding of the connection points can be changed in 
the fixturing tab of the Configuration Module.

The preview will be more responsive to movement if only one option 
is checked at a time.
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Origin Option
The Origin Option allows users to see where the insertion point of the fixture is. Select 
it by ticking the origin check box.

Figure 5–173 Origin Option

In the example below, the origin can be seen as a set of red, green and blue lines set at 
90 degrees to each other.

First Product Option
Checking the First Product option will result in the position of the first product to be 
placed on the fixture being shown.

Figure 5–174 First Product option

In the example below, the fixture has two merchandisable areas. Accordingly, the 
position of the first product in both merchandisable areas has been shown.

Overview of Dragging Option
The dragging option allows users to manually change the positions of connection 
points or change the size and position of the merchandisable areas. The option is 
selected by ticking the Enable Dragging check box.

Table 5–8 Origin Option

Color Direction

Blue Line Direction of X Axis

Green Line Direction of Y Axis

Red Line Direction of Z Axis

Note: The preview will be more responsive to movement if only one 
option is checked at a time.

Note: The preview will be more responsive to movement if only one 
option is checked at a time.
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Figure 5–175 Enable Dragging option

Before any dragging operations can be carried out, the fixture must first be removed 
from its selection box by left clicking on it.

In the above example, the fixture on the left has a selection box, and the one on the 
right has it removed.

Once the selection box has been removed from the fixture, either merchandisable areas 
or connection points can be selected by left clicking on them.

In the example above, the left hand connection point has been selected by left clicking 
on it and is now enclosed by a red selection box.

Dragging or Rotating Connection Points
To drag a connection point, select a fixture that has had connection points assigned. 
Check the Connection Points and Enable Dragging check boxes.

Figure 5–176 Drag Connection Points

Ensure the fixture selection box is de-selected by left clicking on it (as per the fixture 
on the right).
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Select a connection point by left clicking on it. It will be enclosed in a red selection box.

Move the mouse pointer over the selected connection point and hold down the left 
mouse key. The connection point can now be dragged to its new position.

Rotating a connection point  

Select a connection point by left clicking on it. It will be enclosed in a red selection box.

Move the mouse pointer over the selected connection point and hold down the right 
mouse key. The connection point can now be rotated to its new position.

Figure 5–177 Connections Tab

Changes made to connection points by dragging or rotating will be reflected in the 
Connections tab. Similarly, small changes in position can be made by changing the 
co-ordinates in the Connections tab, then confirming in the preview tab.

Dragging Merchandisable Areas
To drag a Merchandisable Area, select a fixture that has had one or more 
merchandisable areas assigned. Check the Merchandisable Areas and Enable Dragging 
check boxes.

Figure 5–178 Merchandising Areas - Drag

Next ensure that the fixture is de-selected and the merchandisable area selected. This 
can be done by holding down the <Ctrl> key, then left clicking on the fixture to 
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de-select it. The merchandisable area can then be selected by holding down the <Ctrl> 
key, then left clicking on the merchandisable area to select it.

Figure 5–179 Merchandising area - Select

In the example above, the fixture is shown as selected on the left, while the 
merchandisable area is shown as selected on the right.

The merchandisable area can then be dragged by the mouse.

Move the mouse pointer over the merchandisable area and hold down the left mouse 
key. The merchandisable area can now be dragged to its new size.

Figure 5–180 Merchandisable Areas Tab

Changes made to merchandisable areas by dragging will be reflected in the 
Merchandisable Areas tab. Similarly, small changes in position can be made by 
changing the co-ordinates in the Merchandisable Areas tab, then confirming in the 
preview tab.

Fixture Creation

Basics of Block Creation
Blocks are created in three basic stages.
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1. Firstly, a drawing of a fixture or fitting is created in Planner and turned into a 
block. This block is then saved to a specific directory within Macro Space 
Management.

2.  The block is then imported into Fixture Studio and given properties beyond those 
that can be assigned to the basic block. These make the block 'intelligent' for 
retailing purposes.

3.  Finally, additional graphics are produced that allow the block to be used in 
Merchandiser as well as the Planner environment.

Creating a block in Planner
In order to create a block within Planner, the user must understand some basic 
concepts associated with block creation.

The drawing can be considered as being in two parts - a drawing area where you work 
and a block table where you store objects you have drawn. The drawing area is visible 
and the block table is not.

Creating a block in Planner goes through the following general stages:

Figure 5–181 Creating Fixture in Planner
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The fixture is created within a Planner drawing. This may well be a complex set of 
polylines aligned together using the Move command. At this stage the fixture only 
exists locally in the drawing area.

Store Fixture as Block in Block Table  

The collection of polylines making up the fixture is turned into a block stored in the 
block table. This operation turns the polylines into a single object. It also stores 
additional properties such as the insertion point.

This operation is carried out using the Planner 'Block' command. At this stage the 
block is still local in the drawing.

Block Saved to a Directory in the Macro Space Management File Structure

This operation converts the block from one that is only available locally in a single 
drawing, to one that can potentially be made available in all drawings within Macro 
Space Management.

This is done by means of the Planner 'Wblock' command and will result in the block 
(fixture) being stored in a directory within the Macro Space Management directory 
structure.

Inserting the Block into Multiple Drawings  

Once the block is in the Macro Space Management directory structure it can be 
imported into Fixture Studio. After intelligent properties have been assigned to it, the 
block will appear in hierarchy within also object browser both Planner and 
Merchandiser environments.

This will make the block/fixture available in any drawing within the Macro Space 
Management environment.

Importing a Block into Fixture Studio
Importing a Block into Fixture Studio takes place in four broad stages.

■ An appropriate Group in the fixture hierarchy is highlighted and the Add Block 
command selected.
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■ The block name is specified.

■ The block details are specified using the block details dialog box.

■ The block details are saved to the central Macro Space Management database, 
ensuring the block has 'intelligent' properties when used in the Planner or 
Merchandiser environments.

Select Add Block Command  

This can be selected from either the menu bar, toolbar or right click pop-up menu. The 
block will be added to whichever fixture group is highlighted.

Specify Block Name  

This has to be typed into the dialog box that will appear as a result of the add block 
command. It must be exactly the same as the block name that has been previously 
saved into the Macro Space Management directory structure by means of a Wblock 
command.

Specify Block Details  

Once the block name has been entered, the block Details dialog box will appear. This 
contains a series of tabs that allow the varying types of 'intelligent' properties to be 
assigned. One tab for example allows Connection Points to be assigned, another the 
Merchandisable Areas.

Save to Central Macro Space Management Database  

This results in all the assigned details being saved to the central Macro Space 
Management database.

Producing Graphics for Merchandiser
The dwg file imported into Fixture Studio serves as the graphic for the Planner 
environment. However, the Merchandiser environment requires a different form of 
graphic such as the 3DS files and Lightwave files.

3DS files

These are files that can be generated from dwg files using a built in function in Planner. 
3DS files provide basic 3 dimensional graphics.

Lightwave Files (.lwo)

These files can either be generated by a built in function in Merchandiser or via third 
party software capable of generating lightwave files. Lightwave files provide more 
realistic 3D graphics, but require more computer processing capacity.
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Creating a Fixture

The fixture is drawn in a Planner drawing. The block (fixture) is written to the block 
definitions table of the Planner drawing. The block is written from the block 
definitions table to a folder within the Planner directory structure. (This folder must be 
specified in the Configuration Module).

The Add Block command in Fixture Studio is invoked to start the process of adding 
the block to Macro Space Management and adding 'intelligent' detail. The name of the 
block is specified. The block details (intelligent properties) are specified in the Block 
Details dialog box.

The block details are saved to the central Macro Space Management database. A 3DS 
file is created for the graphics in the Merchandiser environment. If necessary a 
Lightwave Graphic is also created for the Merchandiser environment.

Drawing in the Planner Environment
The beginning point for creating a fixture is to create a drawing within the AutoCAD 
environment.

The drawing should be dimensionally accurate and showing the level of detail 
required for display in the Macro Space Management Planner and Merchandiser 
environments.
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Turning the Drawing into a Block
The Block command is used to turn a selected object in the drawing into a Planner 
Block by using the command line or the toolbar.

Figure 5–182 Block command

This brings up the Block Definition dialog box.

Figure 5–183 Block Definition dialog box

1. Type in a name for the block.

Note: Naming conventions should be used for blocks, for example 
[Purpose of block] - [Length] - [Width] - [Height]. This will make it 
easier to select the required fixture from the hierarchical trees in 
Fixture Studio and Merchandiser. It will also make it possible to 
define gondolas with multiple sizes.
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2. Select the object in the drawing to turn into a block by clicking the Select Objects 
button in the Objects frame. The object can then be selected by left clicking twice to 
set a selection box and right clicking to complete the selection. The radio button 
should be set to Convert to Block.

3. Specify the Base Point by clicking the Pick Point button in the Base Point frame. 
This will take you to the drawing where the Base point can be specified by clicking 
on a point in the drawing of the object. It is recommended that the base point be 
the origin of the drawing (co-ordinates 0,0,0)

The base point should also be specified with X, Y, Z coordinates of 0, 0, 0. If 
coordinates other than these are specified, the object will be inserted into the 
various Macro Space Management environments using these coordinates as an 
offset from the insertion point.

4. Set other parameters such as the block units to an appropriate unit, for example 
inches or millimeters. This unit should be kept consistent for blocks intended for a 
specific database. The Allow Exploding option should be checked for all drawings 
that have been made by combining two or more parts together into a composite 
drawing.

Making the Block Universally Available
The WBLOCK command (used on the command line) is used to save blocks local to a 
drawing to a specified file location so they can be used in any drawing. Until this is 
done the block can only be used in the drawing in which it was created.

Using Groups within Fixture Studio
It is possible to create a hierarchy within Fixture Studio to organize and store the 
various blocks. This hierarchical tree also appears in the Object Browser in the Planner 
and Merchandiser modules.

Note: The insertion point defined in Macro Space Management will 
reference this Base Point. It is strongly recommended that users pick a 
consistent Base Point - for example left, bottom, rear. If inconsistent 
base points are selected, it is probable that there will be alignment and 
adjacency calculation problems when the blocks are inserted into the 
various Macro Space Management environments.

Note: The directory the block is saved to must be specified in the 
Configuration module
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Figure 5–184 Fixture Studio - Create Hierarchy

It is recommended that a logical hierarchy is created and maintained to minimize the 
time it takes to identify and select equipment.

Adding a block to Fixture Studio
To add a block to Fixture Studio, click on the required Group to highlight it. Right 
click to bring up the pop-up menu and select Add Block. Alternatively, click the Add 
Block icon on the toolbar.
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Figure 5–185 Fixture Studio - Add Block

This will bring up the Add Block Name dialog box.

On clicking OK, the Block Details dialog box will become active.

Note: This name must be exactly the same name as the 
corresponding AutoCAD block. The block must also be in the 
currently active AutoCAD drawing.
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The dialog box contains a number of tabs. Each of these tabs allows you to configure 
intelligent properties on the block. Set the parameters within the tabs are required and 
click OK. The block details are now stored within Fixture Studio, but need to be saved 
back to the central Macro Space Management database.

Saving Block Details back to the Central Database
Blocks that have not been saved back to the central database have an ID that has a 
negative value.

In the example above, the Standard Wooden Pallet has an ID of -1. Other blocks 
requiring saving would have other negative IDs. To save the block(s) to the central 
database select the Save Blocks option from the File menu. Alternatively use <Ctrl> + 
S.
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Figure 5–186 Fixture Studio - Save Blocks

This brings up the Save Block Definitions Dialogue Box

Figure 5–187 Save Block Definitions Dialogue Box
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Check the Database, Add New Definitions and Enforce Save options. All blocks are 
then saved back to the database.

The newly created block is assigned an ID number and the yellow cube in the first 
column indicates it has been successfully saved.

Creating a 3DS Object
3D Studio Object (.3DS Object) is an alternative graphics file type to the DWG file used 
in the Macro Space Management CAD environment. 3DS Files are used in the 
Merchandiser environment. Highlight the fixtures for which 3DS objects are required. 
To create a 3DS object select the Create 3DS File(s) option from the File menu.

Figure 5–188 Fixture Studio - Create 3DS File

A confirmatory dialog box appears confirming the 3DS Files have been created.

Note: Fixture studio must be connected to AutoCAD for this option 
to be available.
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Figure 5–189 Create 3DS file - Confirm

Creating Lightwave Graphics
Lightwave Graphics can be created in Merchandiser. Lightwave graphics can display 
higher levels of detail than 3DS graphics, but will consequently slow processing of 
information when moving around the Virtual Reality Store.

Gondolas
Gondolas are assemblies of similar fixtures and fittings that are aligned to each other 
in a precise spatial relationship. Their building blocks are the fixtures and fittings that 
have been defined in Fixture Studio. Gondolas are made up of repeating units called 
bays.

A gondola consists of one or more bays. Each bay contains a specific arrangement of 
fixtures and fittings. A bay could be as simple as a simple fixture, for example a 
Freezer unit. Equally, a bay could be made up of a back panel, base, and upright.

Bays can be repeated any number of times specified by the user. If the user specifies 6 
bays when the gondola is added to a drawing, then six examples of that bay will be 
placed, each at a specific distance from the previous instance. This assembly of fixtures 
and fittings can be added to, edited in and deleted from the Macro Space Management 
Planner or Merchandiser environments in a single operation; thus saving time over the 
alternative option of manipulating individual components.

Basic Steps in Gondola Creation
There are a number of basic steps to gondola creation. Some of these steps must be 
taken at the time the database is first created; for example deciding on a naming 
convention.

To create a gondola, follow the below mentioned steps:

1. Decide on and implement a naming convention.

2. Import the blocks into Fixture studio. Ensure Insertion points are consistently 
located.

3. Assign Gondola Part Types.

4. Assign Gondola Sizes.

Note: Lightwave graphics are beyond the scope of this Help File and 
will not be discussed further here.
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5. Define Gondola:

a. Define name, main length and maximum bays.

b. Select and assign dimensions.

c. Specify the list of parts.

d. Define the part details.

e. Define the part size position and rotation.

Naming Conventions
Naming conventions are vital to the efficient operation of Macro Space Management. 
They must be decided upon before any blocks are imported into Fixture Studio.

Lack of a naming convention will result in users spending large amounts of time 
creating dozens (if not hundreds) of gondolas that could have been defined far more 
efficiently using a naming convention. A naming convention is a pre-thought out and 
logical way of assigning block names.

If you give blocks names like Widget-187567 and Gizmo-ADRTYN, it is not obvious 
what the blocks are, or what their dimensions are. With a well thought out naming 
convention, identifying gondolas is simpler.

In the above example, there are three types of block; Back Panels, L shaped uprights 
and T shaped uprights. The back panels have widths of 600 and 900 mm, and that they 
have heights of 1400, 1600, 2500 and 2900 mm. Similarly both the L and T shaped 
uprights come in four heights; 1400, 1600, 2500 and 2900 mm.

Widget-187567 might well be a back panel of width 600 mm and height 2500 mm, but 
it may not be clear from the block name. Naming conventions are of the general form:

Prefix-parameter-parameter-parameter-suffix

These can be any combination of numbers and letters, together with several separating 
characters. The separating characters can be either a '-', '_' or an 'x', so each of the 
naming conventions below are equally valid:

Prefix-Parameter-Parameter-Parameter-Suffix

Prefix-ParameterxParameterxParameter-Suffix

Prefix_ParameterxParameterxParameterxSuffix

However, the use of naming conventions must be consistent. Naming blocks with a 
mixture of '-', '_' or 'x' will lead to errors. For example you will have problems if you 
name blocks as in the example below:

Backpanel-600-1400

Backpanel-600x1600

This is because Macro Space Management expects to find the same separating 
character for blocks within a naming convention. When the program draws a gondola, 
if it expects to see:

Prefix-Width-Height

And some of the blocks are named:

Prefix-WidthxHeight

It will find blocks with name like Backpanel-600-1400 because these are in the expected 
form. It will fail to find blocks with names like Prefix-widthxheight because there is an 
'x' present where Macro Space Management expected to find a '-'.
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Similarly you must avoid wrong spellings. If you name a block Backpanal-600-1400 
rather than Backpanel-600-1400, Macro Space Management will fail to find the block 
because of the wrong spelling.

Examples of Naming Conventions
The examples below are all valid examples of naming conventions:

Example 5–6 Prefix-Size

Leg-1500
Leg-2000
Leg-2500

Example 5–7 Prefix-WidthxHeight

Backpanel-600x1500
Backpanel-900x1500
Backpanel-1200x1500

Example 5–8 Prefix-Width-Depth-Height

FreezerUnit-600-800-300
FreezerUnit-600-800-400
FreezerUnit-600-1000-500

Example 5–9 Prefix-Width-Depth-Height-Suffix

FreezerUnit-600-800-300-Lozier
FreezerUnit-600-800-400-Lozier
FreezerUnit-600-1000-500-Lozier
FreezerUnit-600-800-300-Hoffmann
FreezerUnit-600-800-500-Hoffmann
FreezerUnit-600-1000-500-Hoffman

Example 5–10 Prefix-Size

Podium-Small
Podium-Medium
Podium-Large
In general naming conventions should be specified such that the block name provides 
all the information required.

Prefix-Width-Depth-Height-Suffix  

Block names of the form allows defining gondolas so that at the time of addition into 
the Planner or Merchandiser environments you can choose the:

■ Specific type - for example Freezer Units

■ Specific width - for example 600, 800 and 1000 mm

■ Specific depth - for example 800, 1000 and 1200 mm

■ Specific height - for example 400, 500 and 600 mm

■ Manufacturer - for example Lozier

Note: Always check naming conventions for errors. If you have 
made an error when naming the block, Macro Space Management will 
not find it when drawing the gondola.
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Gondola Parts
Gondolas can be considered to be made up from a number of components. Looked at 
from above the gondola might have Side Bays, Back Bays, a Start Cap and an End Cap.

Looked at from the side, the bay might have two levels.

The base section might be a freezer unit, while the upper section might be shelving 
holding condiments. These sections can be defined as generic types in the Gondola 
Parts dialog box. This is accessed from the Gondola Parts icon on the toolbar.

Figure 5–190 Fixture Studio - Gondola Parts

This brings up the Gondola Parts dialog box.

Figure 5–191 Gondola Parts dialog box

Individual components of a gondola are assigned to a Gondola part. For instance a 
Side Bay might contain a Base Unit, Upright and Back Panel. If you then decide to 
manipulate that bay (for example moving or deleting it) the application applies that 
operation to all the components of the bay.

Tip: One well thought out gondola definition could allow you to 
place dozens of different variants of that gondola in Planner or 
Merchandiser.
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Assigning Gondola Sizes
When placing a gondola, you can only place it in permitted sizes. For example, a 
manufacturer might only make freezer units in widths of 600, 800 and 1000 mm, 
depths of 500, 600 and 700 mm and heights of 600 and 750 mm. These sizes are 
assigned in the Gondola Sizes dialog box. This is accessed by clicking on the Gondola 
Sizes icon on the toolbar.

Figure 5–192 Fixture Studio - Gondola Sizes

This brings up the Gondola Sizes dialog box.

Figure 5–193 Gondola Sizes dialog box

Here, names can be assigned to specific sizes within the gondola, and then a specific 
list of dimensions assigned to that size. In the above example the Size 'Slatwall Height' 
has been assigned the dimensions 35, 50, 82, 96, 98 and 114 inches. Only these sizes 
will be available in the Add Gondola dialog box if a gondola containing this 
component is placed in a drawing.

Ensure to:

1. Select Size names that will be unique to the dimensions being referenced

Backpanel Height has been used rather than Height. This is because we only want 
dimensions pertinent to the Back Panels; 1400, 1600, 2500 and 2900 mm

If we had a more general Heights size it might also contain heights of 1800, 2000, 
2100, 2300 and 3500 mm. As these sizes will not be used for this specific gondola, 
but would be available in the Add Gondola dialog box, they would only lead to 
errors when the gondola is placed in a drawing. (The software will search for 
non-existent block names).
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These may be appropriate to other fixtures, but they are not related to the Back 
Panel heights. This would lead to serious problems when adding a gondola to a 
drawing.

2. Specify only the dimensions required.

The Backpanels have heights of 1400, 1600, 2500 and 2900 mm. These are the only 
dimensions that should be entered as Backpanel dimensions. If we enter a 
Backpanel height of 2000 mm, the user will be presented with this as a size option 
when adding a gondola to the drawing. Because there is not a Backpanel 2000 mm 
high, drawing the gondola will fail.

Defining the Name, Main Length and Max Bays
The gondola name can be defined in the Gondola Definitions dialog box.

Figure 5–194 Gondola Definitions dialog box

The Name must be unique so that it can be identified in the central Macro Space 
Management database. For example, if you were adding sizes appropriate to Lozier 
equipment you may add: Lozier Height, Lozier Width, Lozier Depth

The Description can be used to give more information as to the gondola definition if 
desired. The Description appears in the Add Gondola dialog box when gondolas are 
added to the drawing. For example, you can change the descriptions to 1400 mm, 1600 
mm, etc., if this would make it easier for the person placing gondolas.

Main Length: If set to 0 then the main length is set automatically based on the naming 
conventions selected. If only a single size of block is to be specified, then the 
dimension can be entered manually in the Main Length text box.

MaxBays: If set to 0, then any number of bays can be specified. If set to a positive 
number, this will limit the number of bays that can be placed when the gondola is 
added to a drawing.

Specifying and Assigning Dimensions
When placing a gondola, you can specify dimensions that are applicable to that 
gondola. You can specify the permissible sizes in the Gondola Sizes dialog box.
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These sizes are available in the Gondola definitions dialog box when the gondola is 
added to a drawing. With the Sizes defined you can select the required sizes from the 
options on the left of the Dimensions tab (outlined in red).

Each dimension specified has to have a series of other parameters set including:

■ Label

■ Suffix

■ Name Order

■ Main Dimension

These are in the section outlined in blue.

Defining the Part Details
The gondola is made up of a series of parts. These are defined generically (for example 
Freezer Units or Back Panels). The parts are first named on the left hand side of the 
parts tab (outlined in red) then details are entered on the right hand size of the parts 
tab (outlined in blue).

Figure 5–195 Gondola Definition - Parts Tab

Entering Part Names  

Part names are entered by typing them into the text box marked with an asterisk then 
pressing return. Part names are for the convenience of the user, so should be selected 
for ease of use.

Entering Part Details  

The part details serve three main purposes:

■ They allow Macro Space Management to select the correct block when the gondola 
is drawn using name dependencies.
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■ Setting the type allows you to group together the individual components of a bay. 
For example a side bay might contain an Upright, Base Unit and Back Panel.

■ They allow you to specify which part of the gondola the part belongs to. For 
example a Start Cap would only belong to the First Bay and an End Cap would 
only belong to the Last Bay.

Specifying Size, Position, and Rotation
A gondola can contain a wide variety of parts. These have to be orientated as to size 
relative to the length of the bay, position relative to base point of the bay, and rotation 
relative to the initial insertion position of the block. This information is entered in the 
Size, Position and Rotation tab.

Figure 5–196 Gondola Definition - Size, Position, and Rotation tab

Size  

Size might be required if the part to be added is some fraction of the dimensions of the 
bay. For example, if the bay is to contain two parts alongside each other, they could be 
specified as being half the width of the bay.

Position  

A part might be offset relative to its insertion point in the bay. For example, if the 
gondola contains parts on two levels, parts on the upper level might be inserted at 
floor level, then require an offset in the vertical plane to put them in the correct 
position. Note that all offsets are relative to the un-rotated orientation of the block.

■ Offsets in the X axis are relative to length

■ Offsets in the Y axis are relative to depth

■ Offsets in the Z axis are relative to height

Rotation  

Blocks are inserted into the drawing with the front of the part facing down the 
drawing. However, some parts of the gondola (Start Caps, Back and End Caps) require 
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the front direction of the block to be changed so that it faces in the correct direction for 
that section of the gondola. Note that rotations are normally in the Z (Vertical) plane. It 
is unusual to rotate on the X or Y planes.

Calculating the Block Sizes, Positions and Rotations
To understand how to calculate Sizes, Positions and Rotations, it is necessary to 
understand how gondolas are drawn when they are added to the drawing.

■ When a gondola is specified in the Add Gondola dialog box, an imaginary base 
line is created in the drawing.

■ This baseline has a series of equi-spaced base points drawn along it. Each base 
point serves as the datum point for a bay.

■ The components of that bay are drawn relative to the base point in terms of size, 
position and rotation.

Baselines and Base Points
When a gondola is added to a drawing, the number of bays required is specified. Each 
bay emanates from a specific base point. Each successive bay is offset by a specific 
distance from the previous base point. This results in Macro Space Management using 
an imaginary baseline to construct the gondola along.

Insertion Points
Each block has an insertion point, shown as a blue square.

This is set in Fixture Studio and must be consistent for all blocks of the same type. For 
example all back panels must have their insertion point in one position, for example 
bottom, back, left. Similarly, all T uprights must have their insertion point in a 
consistent position. This might be bottom, middle, centre.

Note that the insertion point position has been selected to suit the geometry of the 
block.

Alignment of Bays to Base Points
Gondolas are made up of bays and each bay is positioned relative to a specific base 
point.

Note: The Insertion Point for any block can be seen in the Planner 
environment. Click on the block to select it, and the insertion point 
will appear as a blue square.
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In the above example the Start Cap, the first Side Bay and the first Back Bay are all 
positioned relative to the first base point. Similarly, the second Side Bay and the 
second Back Bay are positioned relative to the second base point.

As successive bays are added, the full gondola is created.

Note how the End cap is still positioned relative to the last base point, although it is 
some distance from it.

Sizes of Gondola Parts
The distance between base points is determined by the main dimension of the 
gondola.

If a part to be used in the gondola is a fraction of the distance between base points, this 
can be specified in the Gondola Definition dialog box. For example, if you want to 
place a shelf half the length of the bay, you could specify the main dimension and use 
a size of half of it.
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Figure 5–197 Gondola Definition dialog box

Rotations Of Gondola Parts
All fixtures and fittings have a designated front direction. This is normally set to point 
down the drawing when they are inserted.

When a gondola is created, some of the parts (Start Cap, Back, and End Cap) need to 
have their components rotated so that the front of those parts is facing in the right 
direction when the gondola is drawn.
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If you want to add a part to the End cap you can specify a 90 degree rotation in the 
Gondola Definition dialog box.

Rotation and Offsetting of Gondola Parts
When a gondola component is rotated to get it into the correct orientation, it is rotated 
around its insertion point.

In the case of a component to be used for the back of the gondola, it is rotated through 
180 degrees. Because it rotates around the insertion point its position changes. In the 
above example, you can see that the component to be used for the back of the gondola 
has been displaced to the left during the rotation.

You have to apply an offset to get it back into its intended position. These offsets will 
vary depending on which part of the gondola is being defined.

Note that all offsets are relative to the un-rotated orientation of the block.

■ Offsets in the X axis are relative to length

■ Offsets in the Y axis are relative to depth

■ Offsets in the Z axis are relative to height

Side  

The sides of a gondola do not require any rotations or systematic offsets.

Back  

The back of the gondola is rotated through 180 degrees to get the front facing in the 
correct direction.

It then needs a positive offset equal to the width of the block.
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Start Cap  

The Start Cap is rotated through 270 degrees to get the front facing in the correct 
direction.

It then needs a positive offset equal to half of the width of the block.

End Cap  

The End Cap is rotated through 90 degrees to get the front facing in the correct 
direction.

It then requires two offsets to get it into the correct final position.
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Firstly, it requires a positive offset equal to the width of the Side component of the 
gondola to move it to the right. Then it requires a negative offset of half its width to 
move it the correct distance down. (The negative offset is to move the block down, as 
opposed to up).

Offsetting of Gondola Parts
There are two reasons for offsetting gondola parts.

■ § To correct the relative position once a part has been rotated. An example of this 
might be a freezer unit that has been rotated to form the back of a gondola.

■ § To 'mate' parts within a bay. An example might be to get a Back Panel into 
correct alignment with its parent leg.

Specifying Gondola Parts
The range of possible parts for a gondola is specified using the Gondola Parts 
Dialogue Box. This is accessed by clicking on the icon in the toolbar.

Figure 5–198 Gondola Parts

This brings up the Gondola Parts dialog box.
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Figure 5–199 Gondola Parts dialog box

Parts assigned to a Part Type are deleted from a placed gondola when one of the parts 
in that section of the gondola is deleted. The List contains two classes of part types:

■ Side, Back, Start Cap, and End Cap are part types where it is intended deleting one 
part should delete all the associated parts.

■ Base, Leg, and Back Panel are part types where it is not desirable to delete all parts 
in the bay.

It is often helpful to put information in brackets after the part name. Base (Parent) 
indicates that any associated parts are deleted along with the base. Leg (Shared) 
indicated that the leg might be shared with 2 or 4 bays, and thus only the leg and not 
all components of the associated bays should be deleted.

Entering Part Names
To enter a part name type it into the Name text box then press return.
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Figure 5–200 Gondola Parts Types dialog box

The name appears in the list. Any data not yet stored to the central database will have 
a negative ID; for example -4.

Defining the Gondola
Gondola definition is a slow, methodical process. It is recommended users use a 
checklist to make sure they carry out all the required actions.

An example of a checklist is as follows:

Example 5–11 Block Preparation

Is the naming convention used for the blocks correct?
Are the positions of the Insertion points understood?
Are the dimensions of the blocks known?

Example 5–12 Size and Part Preparation

Has a specific list of sizes for the Gondola been defined in the Gondola Size 
dialog?
Are all the required parts in the Gondola Parts dialog?

Example 5–13 Basic Parameters

Have the Gondola Name and Definition been defined?
Has the main dimension been defined if required?
Has the maximum number of bays been defined if required?

Example 5–14 Dimensions

Have the required dimensions been selected from the list?
Has the main dimension been set to True?

Example 5–15 For each dimension:

Has the Label been set?
Has the Suffix been set?
Has the Name Order been set?
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Example 5–16 Parts

For each part of the gondola have the following details been set?

■ Type

■ Description

■ Prefix

■ Suffix (if required)

■ Optional (end caps, etc.)

■ Bay Group

■ Report Group

■ Include If (Bays required)

■ Name Dependency

For each part of the gondola have the following positional parameters been set?

■ Size (Delta size, Parameter Size, Size Scale Factor if required)

■ Offset (Fixed Offset, Parameter Offset, Offset Scale Factor if required)

■ Rotations (normally in Z axis)

Overview of Defining Dimensions
The dimensions are set in the dimensions tab of the Gondola Definitions dialog box.

Figure 5–201 Defining Dimensions

The required dimensions (1) are selected from the list of available dimensions. This is 
done by double clicking on them so they appear in the list of selected dimensions (2) 
on the right.
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Figure 5–202 Gondola Sizes

Once the dimensions have been selected, they have to be customized. This is done on 
the right hand side of the dimensions tab.

Note: Only Backpanel Height and Backpanel Width were selected 
from the available options. These two options contain all the 
dimensions required for this gondola. Note that you have to fill in 
information in the list of Selected Dimensions (2) on the right.

Note: The sizes are defined in the Gondola sizes dialog box.
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■ Number (1) is a parameter set by the software when the dimension is selected 
from the pane on the left.

■ SizeRange(2) is the name of the dimension; this is selected by double clicking on 
the available dimensions in the left hand pane.

■ Label (3) is the name that is given to that dimension in the Add Gondola dialog 
box. This can be entered by typing it in and pressing <Enter>.

■ Suffix (4) is associated with the naming convention. It indicates the separating 
character between the different parts of the naming convention. If the parts to be 
used have the naming convention Prefix-Width-Height then the width will require 
a suffix of - to match that present in the naming convention. The height will not 
require a suffix as it does not have one in the naming convention. Suffixes are 
entered by typing it in and pressing <Enter>.

■ Name Order (5) represents the sequence the dimensions appear in the naming 
convention. If you are using a naming convention of Prefix-Width-Depth-Height 
then width would be given name order 1, depth name order 2 and height name 
order 3. Name Orders are entered by typing it in and pressing <Enter>.

■ Main(6) indicates the dimension to be used to set the basic measurements of the 
bays in the gondola. One of the dimensions must be set to True by typing it in and 
pressing <Enter>.

Defining the Gondola - Basic Parts
The next stage is to define the list of parts that will make up the gondola. This is done 
in the Parts tab.
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Figure 5–203 Gondola Definition - Parts tab

Type the required name in the Parts text box and press return. For this gondola you 
will require:

■ Leg

■ Back Panel

■ End Leg

The first two parts go into every bay, the End Leg only into the last bay.

Defining the Gondola - Leg Details
Leg details are defined by clicking on Leg in the list of parts (1).
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Figure 5–204 Gondola Definition - Leg Details

Type (2) can be set using the drop down list.

Description (3) will default to that selected from the list of parts.

Prefix (4) defines the first part of the naming convention. Note that there are two types 
of legs in the list of available parts.

The L-uprights are suitable for the single sided racking you are setting up. 
Accordingly, you can set a prefix of L-Upright- to select these legs.

You do not need a Suffix (5) in this instance.

Select the required gondola sections in the Include If (6) check boxes. Check all the 
options if you want a leg in every section.

Only one of the Name Dependency boxes (7) is checked for height. This means in 
conjunction with the L-Upright- Prefix and the sizes defined in the gondola sizes 
dialog box, you can select the following blocks when the gondola is drawn.
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You may leave the fields Optional (8), Bay Groups (9) or Report Group (10) options 
blank at this stage.

If necessary, click the Gondola Mapping (11) option to define the block naming 
convention options set.

Do not at this stage click on the OK (12) button.

Figure 5–205 Gondola Part Types

Defining Gondola - Back Panel Details
Defining the back panel proceeds in similar manner to the leg, the completed dialog 
box looking as follows:

Note: The parts available in the drop down list are set up using the 
Gondola Parts dialog box.
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Figure 5–206 Gondola Definition - Backpanel Details

Note that the Prefix has been entered as Backpanel- and that both name dependencies 
have been checked. This will allow selecting blocks from the following list.

Defining Gondola - End Leg Details
The end leg is different from the other gondola parts that have been defined. It is only 
present in the last bay of the gondola and serves to finish the run of racking.
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Figure 5–207 Gondola Definition - End Leg Details

The Type has been set to End Cap and only the Last Bay in the Include If section. The 
other settings are as for the Leg.

Overview of Leg Size, Position, and Rotation

Defining Sizes
There are three parts to the gondola, Leg, Back Panel and End Leg. For the purposes of 
this gondola, there is no need to define the size as you will be using the defaults 
specified in the block definition.

Defining Offsets
The Size, Position and Rotation have to be defined for each part. This is to ensure that 
it is inserted in the correct position and orientation relative to its base point.

The y = mx + c Equation  

The offset for the part (if one is required) can be set using a y = c + mx equation. This 
can be written as Result = Constant + (Size x Factor)

This is not as difficult to understand as it seems. The Offset options can be found on 
the Size, Position and Rotation tab.
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Figure 5–208 Delta Size/Fixed Offset

The Delta Size corresponds to the constant c in the y = mx + c equation. If set to 50 
mm, this value will always be used when it comes to calculating the size of the offset.

Parameter Size  

This is the 'x' part of the equation. It can be selected from a drop down list that 
corresponds to the dimensions selected in the Dimensions Tab
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Figure 5–209 Dimensions Tab

As you have only selected two dimensions in the Dimensions tab, the drop down list 
only contains two options; Match Width and Match Height.

■ If you select Match Width (Length) then the final offset will depend on the width 
of the block chosen as a result of the name dependencies.

■ If you chose a width of 600 mm in the Add Gondola dialog, the calculated offset 
would be relative to the 600 mm width of that block.

■ If you chose a width of 900 mm in the add gondola dialog box, the calculated 
offset would be relative to the 900 mm width of that block.

Scale Factor  

A scale factor is a number that the Parameter Size is multiplied by.

■ If the scale factor is set to 0 then the offset will be set to the dimension set in the 
Delta size.

■ If the Scale Factor is set to 0.5, the calculated offset will be half that of the 
Parameter Size.
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■ If the Scale Factor is set to 2, the calculated offset will be twice that of the 
Parameter Size.

Examples

Size (y) = 50 mm + (1 x block size)

y = 50 mm + (0 x block size)

y = 50 mm + (0.5 x block size of 600 mm)

y = 50 mm + (1 x block size of 600 mm)

Rotations
Rotations can be set in the X, Y or Z planes.

Delta Size Parameter Size Scale Factor Result

50 mm None 1 Block size + 50 mm

Delta Size Parameter Size Scale Factor Result

50 mm None 0 50 mm

Delta Size Parameter Size Scale Factor Result

0 mm Width (600 mm) 0.5 300 mm

Delta Size Parameter Size Scale Factor Result

50 mm Width (600 mm) 1 650 mm

Note: Offsets can be used in conjunction with rotations - the final 
position of the part will be a combination of the offset and the 
rotation.
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For normal purposes you only have to be concerned about rotations about the Z axis - 
in the vertical plane. Typically use rotations of 90 or 270 degrees to bring parts into 
position at the start or end of a gondola.

Defining Sizes
The size, position, and rotation have to be defined for each part. This is to ensure that 
it is inserted in the correct position and orientation relative to its base point.

The y = mx + c Equation  

The Size of the part can be set using a y = c + mx equation. This can be written as 
Result = Constant + (Size x Factor). The size options can be found on the size, position 
and rotation tab.

Note: Rotations can be used in conjunction with rotations - the final 
position of the part will be a combination of the offset and the 
rotation.
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Figure 5–210 Gondola Definition - Define Sizes

Delta Size/Fixed Offset  

The Delta Size corresponds to the constant c in the y = mx + c equation. If it's set to 50 
mm, then this value will always be used when it comes to calculating the size of the 
part.

Parameter Size  

This is the 'x' part of the equation. It can be selected from a drop down list that 
corresponds to the dimensions selected in the Dimensions tab.
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Figure 5–211 Gondola Definition - Dimensions tab

As you have only selected two dimensions in the Dimensions tab, the drop down list 
only contains two options; Match Width and Match Height.

■ If you select Match Width (Length) then the final size will depend on the width of 
the block chosen as a result of the name dependencies.

■ If you chose a width of 600 mm in the Add Gondola dialog, the calculated size 
would be relative to the 600 mm width of that block.

■ If you chose a width of 900 mm in the add gondola dialog box, the calculated size 
would be relative to the 900 mm width of that block.

Scale Factor  

A scale factor is a number that the Parameter Size is multiplied by.

■ If the scale factor is set to 0 then the block will be set to the dimension set in the 
Delta size.

■ If the Scale Factor is set to 0.5, the calculated value will be half that of the 
Parameter Size.
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■ If the Scale Factor is set to 2, the calculated value will be twice that of the 
Parameter Size.

Examples

Size (y) = 50 mm + (1 x block size)

y = 50 mm + (0 x block size)

y = 50 mm + (0.5 x block size of 600 mm)

y = 50 mm + (1 x block size of 600 mm)

Defining Offsets and Rotations
Offsets and Rotations are required to put the parts in the correct position relative to 
the base point. Each part will generally require a different offset and/or rotation. 
Before Offsets and Rotations can be specified, the uses must ascertain the position of 
the insertion point of each block as the blocks will be placed relative to this insertion 
point.

Delta Size Parameter Size Scale Factor Result

50 mm None 1 Block size + 50 mm

Delta Size Parameter Size Scale Factor Result

50 mm None 0 50 mm

Delta Size Parameter Size Scale Factor Result

0 mm Width (600 mm) 0.5 300 mm

Delta Size Parameter Size Scale Factor Result

50 mm Width (600 mm) 1 650 mm
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For example, this L-upright has its insertion point specified at the bottom, centre, rear. 
It is also necessary to know any dimensions that might affect offsets. For example, the 
horizontal arm of the L Upright is 50 mm high.

Leg - Defining Offset and Rotation
The leg has its insertion point at the bottom, centre, rear. It does not require any offset 
to put it at over the Base Point of the bay. It does not require a rotation.

Figure 5–212 Leg - Defining Offset and Rotation

Backpanel - Defining Offset and Rotation
The Back Panel has an insertion point at the bottom, left, rear. The insertion point was 
specified as being 50 mm below the bottom of the Back Panel. The Back Panel requires 
a -Y offset of 50 mm to bring it in front of the vertical arm of the L upright.

It would have required a Z offset of 50 mm to bring it on top of the horizontal arm of 
the L Upright. However, this offset was built into the block definition when it was 
created. A Z offset is therefore not required. It does not require a rotation.
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Figure 5–213 Gondola Definition Dialog Box

End Leg - Defining Offset and Rotation
The end leg has its insertion point at the bottom, centre, rear. It requires an offset to 
put it on the opposite side of the final Back Panel to the Standard leg. This will be an 
offset by Width. It does not require a rotation.

Figure 5–214 Gondola Definition Dialog Box
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Add Gondola Dialogue Box
Once the gondola has been defined and saved, it can be placed into a drawing by 
means of the Add Gondola dialog box.

Figure 5–215 Add Gondola dialog box

Dimension Labels  

The Width (1) and Height (2) captions correspond to the Labels in the Dimensions tab.

Figure 5–216 Dimensions tab

Dimension Sizes  

The Dimensions (3) and (4) correspond to the sizes in the Gondola Sizes dialog box.
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Figure 5–217 Gondola Sizes dialog box

Relationships between Fixture Studio and other Modules
The settings made within Fixture Studio are affected by and interact with settings 
made within other modules within Macro Space Management.

Administration Module
The following can be configured within the Administration module:

■ List of Manufacturers
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■ List of Ranges

■ Available statuses

■ List of possible Styles

■ List of default units

■ User Defined Attributes

Configuration Module
Directory for graphics (dwg and 3DS) files can be configured within the Configuration 
Module.

Layers
List of aliased layers a block can be inserted on, and which connections are valid on. 
These can only be configured within Planner.

Levels
List of available levels to insert an block on - only configurable within database

Product Studio
List of available materials - this affects the appearance of the graphics.
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6Product Studio

Product Studio allows you to maintain a hierarchy of products. This hierarchy can be 
used for a variety of purposes including supplying placeholders for Planner and 
Merchandiser. It can also supply 3D Virtual Reality images for Merchandiser. Data can 
be imported from third party software, data can be manually entered, or some 
combination of the two can be used.

Figure 6–1 Product Studio

Placeholders, SKUs and Display Styles
A Placeholder is used as an indication of what form of product occupies a section of 
shelving or equipment. Placeholders can be used in Planner and can occupy the 
following levels in the hierarchy:

■ Company

■ Group

■ Division
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■ Department

■ Class

■ Sub-class

■ Style

■ Item

For example a placeholder could be placed at department level to indicate that a 
specific section of equipment has been allocated for the sale of men's clothing. 
Alternatively, a placeholder could be placed at class level to indicate a specific section 
of equipment has been allocated for the sale of men's shirts.

A SKU (Stock Keeping Unit) is a description of a specific item of merchandise - for 
example Men's shirts, white.

A Display Style indicates a specific way of displaying a SKU. Example of display 
styles for shirts includes Boxed, Folded, and Hung.

Placeholders can be used in both Planner and Merchandiser. Display styles can only 
be used in Merchandiser.

Product Studio and Other Modules
Product Studio interacts with other modules.

Figure 6–2 Administration Module

A number of lists used in Product Studio are configured in the Administration 
Module. Products marked for deletion can only be permanently purged using the 
Purge option in the Administration Module.

Note: If Display Style level products are placed in Merchandiser, 
they will not appear in Planner.
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Configuration Module
The locations of the directories for Image Capture and Image Root are specified in the 
Directories tab in the Configuration Module.

Data Import
Data can be imported from third party software. It can then be configured with 
additional information required by Macro Space Management.

Planner
The Product Hierarchy appears in the Object Browser and can be searched/selected 
from using the Object Grid. Products can be placed down to the SKU level as 
placeholders.

Merchandiser
The Product Hierarchy appears in the Object Browser and can be searched/selected 
from using the Object Grid. Products can be placed down to the SKU level as 
placeholders or as Display styles.

Administration Module
A number of lists used in Product Studio are configured in the Administration 
Module. In addition, Products marked for deletion can only be permanently purged 
using the Purge option in the Administration Module.

Table 6–1 Administration Module

Option Comment

Manufacturers Allows the user to 
configure the list of 
manufacturers (and 
suppliers) used to 
specify products.

Product Code Types Allows the user to 
specify the masks for 
UPCs.

Ranges Allows the user to 
configure the ranges 
for temperature 
scales and weights 
that can be allocated 
to a product.

Tax Codes Allows the user to 
configure the list of 
available Tax Codes 
that can be allocated 
to a product.

Styles Allows the user to 
add, edit or delete 
styles for products.

Units Allows users to 
configure the units 
used for defining 
products.
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Configuration Module
The locations of the directories for Image Capture and Image Root are specified in the 
Directories tab in the Configuration Module.

■ Image Capture is where imaged are stores after being captured by a camera.

■ Image Root is the starting point for storage of images after they have been 
assigned to a product.

Data Import
Macro Space Management provides a specialized Data Import module. This allows 
product details to be imported from third party software.

Figure 6–3 Data Import module

Macro Space Management users may have to add other information to the imported 
data. This could include information such as dimensions, style relationships or images 
for 3D Virtual Reality representation in Merchandiser.

Planner and Merchandiser

User Defined 
Attributes

Allows users to 
specify the User 
Defined Attributes 
required for 
products.

Note: It is not generally possible to import Display Style information 
from third party databases, as this represents an additional level of 
information to that normally present in those databases.

Table 6–1 (Cont.) Administration Module

Option Comment
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Planner
The Product hierarchy appears in the Object Browser in Planner. It can also be 
searched using the Object Grid.

Figure 6–4 Planner Module

Products can then be placed down to SKU level as placeholders.

Merchandiser
Like Planner, the Product hierarchy appears in the Object Browser in Merchandiser. It 
can also be searched using the Object Grid.
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Figure 6–5 Merchandiser Module

The Product hierarchy can either be placed as placeholders, or as 3D Virtual Reality 
objects at the Display Style level.

Setting up Product Studio

Identify the Product
Before the hierarchy is set up in Product studio, it must first be planned. Failure to 
plan the hierarchy properly may result in inefficient use of Macro Space Management.

When setting up the Product hierarchy, it is important to have a single, unique way of 
identifying the product. This is generally determined by how the product is indexed in 
other software used by a retailer. For example, their stock control and/or re-ordering 
systems might refer to the product by its UPC or by its SKU Code.

It is important that Macro Space Management use the same method of identification. If 
date is imported into the product hierarchy, this information will be included 
automatically. For manual entry, this is set by the UPC Type drop down list in the 
SKU dialog box. The mask for these is set in the Administration Module.
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Figure 6–6 Product SKU Dialog Box

Product Identification and EPOS data
It is important to use a unique method of identification as in other software used by a 
retailer. For example, some retailers use UPCs and others use SKU codes. Macro Space 
Management can use the Data Import module to import other forms of data (for 
example EPOS data). This EPOS data can then be used to color code the Macro Space 
Management drawings so that sales performance can be seen at a glance.

This color coding (Key Performance Indicators or KPIs) relies on the EPOS data having 
the same method of identification (UPCs or SKU codes) as the data in the Product 
hierarchy.

Structure of the hierarchy
The generic hierarchy can have up to 10 levels, 5 of them mandatory:

Table 6–2 Structure of the hierarchy

Level Comment

Company

Group

Division

Department Mandatory

Class Mandatory

Sub-Class Mandatory

Style

Item
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As product data will be generally imported from third party software, the required 
Macro Space Management hierarchy should be planned before the first import so that 
data is imported into a standardized hierarchy.

Making the Hierarchy User Friendly  

The Product Hierarchy consists of a series of levels which should be laid out in a way 
convenient for and familiar to store planners.

Configuring the hierarchy in the optimum manner can save considerable time and 
effort when products are being placed in Macro Space Management store plans.

Using Data Importer
Macro Space Management contains a Data Import module. This allows importing 
information from third party databases. Once the data import routine is set up, it is 
possible to repeatedly import data into the Product Studio hierarchy. However, before 
this import routine is set up, it is first necessary to decide whether to use UPCs or 
SKUs as the basis for indexing products. It is also necessary to determine the number 
of levels in the hierarchy as this cannot be readily varied once data import has started.

Data import from third party software works as follows:

SKU Mandatory

Display style Mandatory

Note: Any level in the hierarchy can be renamed to customer 
requirements by Oracle.

Table 6–2 (Cont.) Structure of the hierarchy

Level Comment
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■ Data is exported from the third party software into a spreadsheet saved in a CSV 
format. This data is structured in a standardized format with specific columns 
holding specific items of information.

■ Macro Space Management Data Importer is configured to accept data from this 
structured CSV format spreadsheet.

■ Data Importer then inserts the data in the structured CSV format spreadsheet into 
the central Macro Space Management database.

■ Data Importer can import a variety of data including:

■ Alphanumeric Information on objects at all levels in the hierarchy including 
Names, descriptions, UPC's, financial, physical and other data.

■ Product Images (providing they have been named in accordance with Macro 
Space Management conventions beforehand).

Menu Options

Menu Bar
The Menu bar has the following options.

Figure 6–7 Product Studio - Menu bar

■ File menu allows you to save or close files or configure Product Studio.

■ Edit menu gives you access to add or edit products or import products.

■ View menu allows you to display the product information and search products.

■ Window allows you to configure the display of open Product dialog Boxes

■ About gives access to Help and the version of the software.

File Menu
The File menu gives you access to various saving and exit options.



Menu Options

6-10 Oracle® Retail Macro Space Management  User's Guide

Figure 6–8 Product Studio - File Menu

■ Save - saves the currently active product definition.

■ Save All - saves all currently open product definitions.

■ Close - closes the currently active product definition.

■ Close All - closes all currently open product definitions.

■ Configure (F6) - opens the Configuration Module

■ Exit - closes Product Studio.

Edit Menu
The Edit menu allows you to modify the hierarchy.

Figure 6–9 Product Studio - Edit Menu

■ Add - adds another level to the hierarchy, adding a child object to the currently 
selected node.

■ Edit - opens the currently selected node in the hierarchy for editing.

■ Delete - deletes the currently selected note in the hierarchy.

■ Cut (<Ctrl + X>) - removes the selected item from the hierarchy and puts it on the 
clipboard.

■ Copy (<Ctrl + C>) - copies the selected item in the hierarchy and puts it on the 
clipboard.

■ Paste (<Ctrl + V>) - takes the current item on the clipboard and pastes it as a child 
object to the currently selected node.
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View Menu
The View menu gives you access to varying information.

Figure 6–10 Product Studio - View Menu

■ Find - calls the Find dialog box. More Info

■ Refresh - refreshes the hierarchy with the latest information from the database.

■ Show Extra Info - toggles the Product Description into view as well as the Product 
Name.

■ Display Product Tree - toggles the Product Tree on or off.

■ Display Newly Imported Products - display a list of recently imported products. 
More Info

■ Display Deleted Products - displays a list of products that have been deleted from 
the Product Tree. More Info

■ Materials - allows users to configure the way products display in Box or Textured 
Box form in Merchandiser. More Info

Window Menu
The Window menu allows you to arrange any dialog boxes open in Product Studio.

Figure 6–11 Product Studio - Window Menu

■ Tile Vertically - aligns all open product dialog boxes vertically.
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■ Tile Horizontally - aligns all open product dialog boxes horizontally.

■ Cascade - aligns all open product dialog boxes diagonally.

■ Minimize All - minimizes all open product dialog boxes.

■ Restore All - maximizes all open product dialog boxes.

About Menu
The About menu calls the help files and allows you to verify the version of the 
software in use.

Figure 6–12 Product Studio - About Menu

Options for Menus

Find Option
The Find option can be accessed from the View menu or by pressing <Ctrl + F>. To 
use the Find option, complete the following steps:

■ In the Find field, enter a value (wild cards such as ? are allowed).

■ Click the Search icon to bring up a list of products matching the search string.

■ Highlight the required item in the result list, and click OK to open the relative 
dialog box.

Figure 6–13 Find Product
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Newly Imported Products
The Newly Imported Products dialog box allows you to find recently imported 
products. These often require editing if imported from an external database. This is 
because products defined in an external system may lack information required by 
Macro Space Management such as dimensions or images.

It can be accessed from the View menu and will populate upon being selected with all 
products that have not been modified since the last import date.

Figure 6–14 Imported Products

The toolbar allows you to close the dialog, edit a selected item, find an item or refresh 
the list with the latest information from the database.

The Find dialog box is called from the toolbar.
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Figure 6–15 Find dialog box

It allows you to find items in the list of newly imported products.

Deleted Products
The Deleted Products dialog box contains the list of all products marked for deletion. 
The toolbar allows you to close the dialog box, edit a selected product, find a product, 
refresh the list of deleted products with the latest information from the database or 
restore a deleted product to the product hierarchy.

Figure 6–16 Deleted Products

Purging Deleted Products
Deleted products can only be permanently removed from the database in the 
Administration Module. From the Administration Module, select Tools > Purge. This 
will bring up the Purge dialog as follows:
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Figure 6–17 Purge Deleted Products

Checking the Products option will result in products in the deleted items list being 
permanently removed from the central Macro Space Management database.

Materials
The Materials option allows you to configure the Materials using color products. It is 
accessed from the View menu.

■ Material colors can be added, edited or deleted using the toolbar.

■ Transparency can range between 0 (opaque) to 100 (fully transparent).

■ Shininess can range between 0 (matt) to 100 (shiny).

■ Specular values can range between 0 (light only reflects in one direction) to 100 
(light reflects in all directions).

■ Diffuse values can range between 0 (light is not diffused) to 100 (light is diffused 
in all directions).
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Figure 6–18 Materials Dialog box

Hierarchy
The Product hierarchy can be built up using a series of levels. Some levels are 
mandatory (yellow) and some are optional (blue).
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Figure 6–19 Product hierarchy

When constructing the hierarchy, there are three dialog boxes involved.

The hierarchy is set up relative to the Product Root. It is set up in stages:

Dialog box Associated levels

Product Company, Group, 
Division, 
Department, Class, 
Sub-Class, Style and 
Item

SKU SKU

Display Style Display Style
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Each child is added by clicking on the parent level and selecting 'Add Product' from 
the right click menu.

Setting up Company, Group, Division, and Department Levels
Company, Group, Division and Department levels are set up based on the Product 
Root and set up using the Product dialog box. (Use right click menu to add).

Figure 6–20 Product dialog box

The Hierarchy Level Type can be set using the Type drop down list. The options are in 
the following sequence:

■ Company (Optional)

■ Group (Optional)

■ Division (Optional)

■ Department (Mandatory)

Once a level has been added, its child will only be available from those levels below it 
in the hierarchy.

Only when a Department is added that the Class option be available in the drop down 
list of Hierarchy Level Types.

Stage Action

1 Set up Company, 
Group, Division and 
Department Levels

2 Set up Class

3 Set up Sub-Class

4 Set up Style, Item and 
SKU Levels

5 Set up Display Styles
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Setting up Class and Sub-Class Levels
A class level in the products hierarchy can only be set up as a child of a Department 
and a Sub-class level in the products hierarchy can only be set up as a child of a class. 
Both levels are mandatory in the hierarchy, and both are configured by means of the 
Products dialog box.

Figure 6–21 Product dialog box

Only when a Sub-class id added, the next three options will be available in the drop 
down list of Hierarchy Level Types.

Setting up Style, Item, and SKU Levels
Style, Item, and SKU levels are set up based on the sub-class level in the hierarchy. To 
add a hierarchy level, complete the following steps:

■ Right-click and select Add. The Hierarchy Level dialog box opens.

■ Using the drop down list, select one of the following Hierarchy Level Types:

■ Style (Optional)

■ Item (Optional)

■ SKU (Mandatory)
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Figure 6–22 Hierarchy Types

■ Once a level has been added, its child will only be available from those levels 
below it in the hierarchy. Only when a SKU has been added, the Display Style 
option will be available in the drop down list of Hierarchy Level Types.

■ If the style or item levels are added in the hierarchy, the Product dialog box 
appears.

Figure 6–23 Product dialog box

If a SKU level item is added, the SKU Dialog box appears.
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Figure 6–24 SKU Dialog box

Setting up Display Styles
Display Styles are set up based on the SKU level in the hierarchy. Right click and select 
Add to set up a display style. The Display Style dialog box opens.



Menu Options

6-22 Oracle® Retail Macro Space Management  User's Guide

Figure 6–25 Display Style dialog box

Hierarchy Information
Hierarchy Information can be added at the Company, Group, Division, Department, 
Class, Sub-Class, Style, and Item levels.
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SKU Information
The SKU Information is used to configure the information for a specific unit of sale.

Figure 6–26 Product SKU Dialog Box

Table 6–3 Products window

Parameter Comment

Type Can select Company, Group, Division, Department, Class, 
Sub-Class, Style and Item levels.

Name Enterable by user.

Description Enterable by user.

Brand Enterable by user.

Code Enterable by user.

Client code Enterable by user.

Strategy Select from the drop down list. The list displays product 
strategies that were set up in the Administration module.

Manufacturer Selectable from a drop down list. The list can be configured 
using the Manufacturers option in the Administration Module.

Supplier Selectable from a drop down list. The list can be configured 
using the Manufacturers option in the Administration Module.

Status Selectable from a drop down list. The available statuses are 
configured using the Status option in the Administration 
Module.

Color Selectable from a standard color pallet.

Icon Selectable from a drop down list. The icon will default to a color 
specific to each level, but can be manually overridden.
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Details Tab
The Details tab is used to configure the details for the product.

Physical Tab
The Physical tab is used to specify details concerning the physical aspects of the SKU.

Table 6–4 Products SKU - Details Tab

Parameter Comment

Name The SKU name

Description A description of the SKU

UPC Type UPC type can be set from a drop down list. The list can be 
configured using the Product Code Type option in the 
Administration Module.

Code The Code for the product.

UPC The UPC for the product - it must conform to the mask set in 
UPC type option.

Category Role The category role allows to select a role from the drop down 
list of roles that were set-up in the Administration module.

Strategy Select from the drop down list. The list displays product 
strategies that were set up in the Administration module.

Manufacturer Selected from the drop down list - the list can be configured 
using the Manufacturers option in the Administration module.

Supplier Selected from the drop down list - the list can be configured 
using the Manufacturers option in the Administration module.

Status Selected from the drop down list - the list can be configured 
using the Status option in the Administration module.

Icon Selected from the drop down list.

Brand The Brand for the product.

Sub-brand The sub brand for the product.

Client Code The Client Code for the product.

Client Barcode The Client Barcode for the product.
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Figure 6–27 Products SKU - Physical Tab

Financial Tab
The Financial tab is used to record financial information on the SKU.

Table 6–5 Products SKU - Physical Tab 

Parameter Comment

Pack size The pack size is the number of items in a pack of the product - it 
can be set to any positive numerical value.

Pack Units Set from a drop down list - the list cam be configured using the 
Units option in the Admin Module.

Color The display color in the drawing - set from a color pallet.

Nominal color For information purposes only.

Nominal Size For information purposes only.

Hatch Style Select from the drop down list of hatch patterns set in the 
Administration module.

You may leave this field blank.

Flavor Optional

Gender Optional

Temperature Range This feature is not implemented yet.

Max, Min and Units This feature is not implemented yet.
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Figure 6–28 Products SKU - Financial Tab

Custom Tab
The Custom tab can be configured to hold customer specific items of information. The 
list of items displayed can be configured using the User Defined Attributes option in 
the Administration Module. A maximum of 15 items can be assigned.

Table 6–6 Products SKU - Financial Tab

Parameter Comment

Currency The currency associated with the products.

Price The sales price of the item

Cost The purchase cost of the item.

Profit The profit in the selected currency. Set the profit by using the 
up/down arrow or enter the digit.

Calendar Represents a period of time that the financial fields cover, for 
example a week,

month or year.

Sales Sales numbers in the selected currency.

Unit Movement The rate at which the item is consumed.

Lead Time The lead time between placing an order and receiving it.

Days of Supply The number of days of supply the system should hold.

Cost Basis Cost Basis can be selected from a drop down list.

Tax Code Tax code can be selected from a drop down list. The options are 
configured using the Tax Code option in the Administration 
Module.
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Figure 6–29 Products SKU - Custom Tab

Display Styles
Display Styles can only be used in the Merchandiser module. They allow products to 
be represented on equipment or shelves with differing degrees of accuracy ranging 
from a simple box to a virtual reality image.

Editing an Image
Images can be edited by right clicking on an assigned image in the Images tab. This 
brings up a pop-up menu. Selecting Edit brings up the Image editor.

Figure 6–30 Image Editor

The toolbar at the top allows basic editing operations including rotating, flipping 
vertically and horizontally and cropping. The edited image can saved back to the 
Image Root.

Images Tab
The Images tab allows you to specify the Images associated with the product. These 
will display when the product is placed in Macro Space Management Merchandiser if 
the Draw Products as Graphical option is selected to display the product.



Menu Options

6-28 Oracle® Retail Macro Space Management  User's Guide

Images can be imported into Macro Space Management (via Data Importer) or 
manually selected from the Image Capture directory specified in the Configuration 
Module.

Figure 6–31 Display Style Dialog Box

The Directory is the directory that the image is held in. The Mapping format specifies 
whether the images are to be shown using a box or a cross format.

In a Box format, the images are placed on each of the six sides of a cuboid, so the left, 
right, front back, top and bottom images can be seen depending on which direction the 
product is being viewed from.
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In a Cross format, the images are placed on the sides of a vertically aligned cross. This 
allows you to see images when rotating around it in the horizontal axis, but not when 
viewing it from above or below. Images that can be associated with a product are 
found in the Image Capture directory (specified in the Configuration Module). When 
assigned, they are stored in the Image Root and its associated sub-directories.

Locating and Storing Images
For an image to be added manually to the product, it must be located in the Image 
Capture directory specified in the Configuration Module.

Figure 6–32 Display Style Dialog Box

Clicking on the Browse button will take you to this directory, where an image can be 
selected and placed in the list of available images in the dialog box. The image can be 
dragged and dropped so it shows on the front, back, left, right, etc. of the product.

On clicking OK, a copy of the image will be saved in the image root. This will preserve 
all images allocated to the varying positions on the product, but images selected from 
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the Image capture directory and not allocated to a position on the product will not be 
saved when the dialog box is closed.

Images allocated to the product can be edited or deleted by right clicking and selecting 
the appropriate option.

Peg Holes
The Peg Holes tab allows you to specify the Peg Holes associated with the product.

Figure 6–33 Display Style Dialog Box - Peg Holes

The Peg Hole Toolbar allows you to add a new peg hole to the product, or to delete an 
existing, highlighted one. The Peg Hole Settings allow you to define the position of the 
peg hole. This may be done either using the radio buttons, or by using the spin 
controls to set the X, Y or Z offsets.

The Defined Pegs Holes show the settings defined for each peg hole. In this example, 
two peg holes have been defined; one at the left top of the product and one at the right 
top.

Size and Shape Tab
The Size and Shape tab allows you to specify the Size and Shape of the product.
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Figure 6–34 Display Style Dialog Box - Size and Shape

Table 6–7 Display Style Dialog Box - Size and Shape

Parameter Comment

Weight Can be set to any positive numerical value - the units are 
specified in 'Weight Units' below.

Weight Units Units are selected from a drop down menu and can be set to 
metric or imperial units.

Length Units Units are selected from a drop down menu and can be set to 
metric or imperial units.

Fingerspace Above Indicates space required above the product array when placed. 
Fingerspace Above values greater than 0 indicate that the product 
requires that amount of additional space above the product array 
when the product is placed. 

Fingerspace Beside Indicates space required to the right and left of the product array 
when placed. Fingerspace beside values greater than 0 indicate 
that the product requires that amount of additional space to the 
left and right of the product array when placed.

Shape Shape is selected from a drop down list. It specifies the Product 
Block used for the product, and hence the general type of shape 
that will be displayed - box, cylinder, etc.

Color This is the color used for simple representations of the product. It 
can be selected from a standard pallet.
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Styles Tab
The Styles tab allows you to specify the Style(s) associated with the product. These in 
turn determine which fixtures and shelves the product can be placed on. A product 
must have at least one style assigned before it can be placed - and that style must be 
compatible with the style on the object on which it is being placed.

Styles are selected or de-selected using the Selection Option buttons. Styles can be 
configured in the Administration Module. The Style Configuration button allows you 
to access this option.

Material This is the coloring form used when products are represented 
when shown as textured boxes. It is selected from a drop down 
list. (Materials are configured via the view menu)

Jumple Factor Indicates amount of additional space required in percentage. 
Jumble factor values greater than 0 indicate that the product 
requires that percentage of additional space when placed in a 
jumble bin. 

Size Length, depth can be set to any positive numerical value - the 
units being specified in 'Length Units' above

Nesting This specifies the degree to which one unit can be stacked inside 
each other. It is entered as a positive numerical value.

(For example, 5 vases of height 300 mm and a nesting height of 50 
mm would have a total height of 500 mm).

Crush Factor % This specifies how much the dimensions of soft items (such as 
cushions) cam be compressed when stacked. Crush factor does 
not apply to the top item in the stack as it is not being 
compressed.

(Three items of 100 mm height with a crush factor of 25% would 
have a combined height of 250 mm: 75 mm + 75 mm + 100 mm).

Gap This is the gap between multiple instances of a product. It can be 
set to any positive numerical value - the units being specified in 
'Length Units' above.

Half the gap is normally applied to each side of the product. 
Items stacked on top of each other will not normally have a 
height gap.

Min 
Stacking/Facings

This is the minimum number of products that can be placed in 
the facing, depth and height orientations.

Max 
Stacking/Facings

This is the maximum number of products that can be placed in 
the facing, depth and height orientations.

Table 6–8 Styles Tab

Parameter Comment

Available Styles This is the list of styles that can be assigned to the product

Selected Units This is the list of styles that have been assigned to the product.

Table 6–7 (Cont.) Display Style Dialog Box - Size and Shape

Parameter Comment
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Figure 6–35 Display Style Dialog Box - Styles

Orientation Tab
The Orientation tab allows you to set the orientation of product display.

Figure 6–36 Display Style Dialog Box - Orientation
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■ Preferred Orientation: You may select only one preferred orientation.

■ Legal Orientation: You may select multiple legal orientation. 
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7Batch Tools

This section provides a brief overview of Batch Tools for non-Admin users:

■ Overview

■ Automated Calculations

■ Data Importer Batch

■ Planogram Importer

■ Planogram Substitution

■ Update Status

Overview
Macro Space Planning provides Batch Tools for processing of bulk data. These tools 
are generally used by Administrators to carry out data processing operations when the 
application is not in normal use, that is, at night or over the weekends.

Each of these batch tools can be configured by an Administrator to carry out the 
required changes to the database. They can then be called on a regular schedule by a 
scheduling batch tool to run overnight or at the weekends.

For example, Automated Calculations might be run overnight Monday to Friday to 
ensure data for each file (floor plan) is up to date for reporting purposes. Products and 
Planograms might be imported each weekend to ensure that store planners have an up 
to date list of merchandise for placement.

Automated Calculations
Automated Calculations is used to carry out different types of calculations such as the 
Area Calculations, Face Plane Calculations, Space Measurements, Fixture Adjacency, 
and Product Adjacency Calculations on files of selected statuses.

Note: The exact schedule for batch operations will differ from 
organization to organization; consult your administrator for 
information on the schedule batch operations carried out.

Important: Each time a batch tool executes a scheduled task, changes 
are made in the database. Users must be aware of the consequences of 
these changes to the database.
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Figure 7–1 Automated Calculations Batch

When the batch tool is run, the selected calculations are carried out and updates are 
done to the Area, Face Plane, Space Measurements, Fixture Adjacency, and Product 
Adjacency Calculations in the database. This gives maximum reporting accuracy.

It does not normally need any action from a standard user.

Only users with Administrator's role have access to this batch tool. If a user has logged 
in as a common user, s/he may not be able to view this option. For more information 
on Automated Calculations, refer the Oracle Retail Macro Space Management 
Administrations Guide.

Data Importer Batch
The Data Importer batch allows users to import data from third party software into the 
MSM/ISSC database. The data is imported by a user with Administrator's role. This 
section briefly explains the type of data that can be imported using the Data Importer.

Figure 7–2 MSM Data Importer 

Some of the data that can be imported into any database table (or combination of 
tables):

■ Users and their User Groups

■ Stores and their hierarchy

■ Fixtures and their hierarchy

■ Product hierarchy

■ Product information at Stock Keeping Unit (SKU) and Display Style Level
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■ EPOS (Electronic Point of Sale) information

For more information on Data Importer, refer the section on Data Importer.

Planogram Importer
Planogram can be imported using Oracle data Integrator (ODI). Planogram Designs 
are often imported as part of a batch process. The batch process is run to import new 
planogram designs, updated versions of existing planograms, and updated financial 
information for planograms. 

When the batch is run, the users should be aware of the schedule that planogram 
imports are run on. This will affect the planogram available for placement. New 
planograms will be brought in, and some older planograms removed from the 
database.

Planogram Substitution
A planogram substitution is the automated way of replacing one or more planogram 
designs with the existing planograms. These substitutions can be universal for the 
selected floor, store or group of stores. It can be run manually for a single drawing, or 
for multiple stores by a user with Administrators rights or automatically as a batch 
process for multiple stores in the database.

Planogram need to be substituted when an existing planogram design version has 
changed and an updated version of the design is available. This results in older 
version of a planogram in one or more store plans being changed for the more recent 
version. For example, a planogram containing different brands of baked beans might 
be adjusted so that curried beans take up fractionally more space than in the earlier 
version of the planograms. When version change is carried out in a store plan, 
information in the database is changed to show that the planogram design has been 
changed from the old to the new.

Note:  Users should be aware of the schedule that data imports are 
run on. This will primarily affect the products available for placement. 
New products will be brought in, and some older products expired 
and made no longer available for use.

Note:  Planogram Substitution and Version Change cause change to 
be made in the database. If users open drawings in the Merchandiser 
module or in In-Store Space Collaboration, the drawing will 
automatically be updated with the changed planograms. If users open 
a drawing in the Planner module, the changes made in the database 
will not be reflected in the DWG file. Accordingly, the DWG file will 
require Synchronizing to Database to ensure that the database and 
DWG file contain the same information.
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Examples of Planogram Substitution
Planogram Substitution can be done in many ways. This provides users the complete 
flexibility in selecting planograms to be substituted and defining the planograms that 
are to be inserted as their replacements. Some of the examples of substitution of 
planograms are:

■ One to One
The simplest form of planogram substitution is a 'one to one' substitution. One 
planogram of a specified length is replaced by another planogram of equal length.

■ One to Many
Another form of planogram substitution is a 'one to many' substitution. One 
planogram of a specified length is replaced by two or more planograms whose 
combined length is the same as that of the planogram being replaced.

■ Many to One
In Many to One planogram substitutions, several planograms are selected and 
replaced by a single planogram equal in length to the sum of the lengths of the 
planograms being replaced.

■ Many to Many
A 'Many to Many' planogram substitution occurs when multiple planograms are 
selected for replacement and are substituted by multiple planograms occupying 
the same length as the planograms being replaced.

■ One to None
In One to None Substitution, you can remove a planogram without specifying a 
replacement. This might be called for when a planogram has to be removed for 
legal reasons, etc., but no replacement has been decided on.

■ One to None with Fixture Removal
In One to None substitution, it is also possible to remove the parent fixture. This 
might be because parts of a store are being assigned to a different purpose and the 
fixturing is changing as well as the planograms.

Revision Change
Revision change occurs when a planogram design has been updated with minor 
changes and the name of the planogram design has remained the same. If planogram 
substitution is being carried out on a drawing, any planograms in the drawing that are 
of an earlier version than those in the database will automatically be updated to those 
of the later version.

Accessing the Planogram Substitution
There are three broad levels of access to the Planogram Substitution functionality:

■ Administrator Level

Users with Administrator's access can control all aspects of planogram 
substitution functionality. They can configure the access to the planogram 

Note: Certain settings within Planogram Substitution can result in 
additional Authorized files being created if planogram substitution is 
being carried out on files of Current status. These additional files will 
be found in the same Store Manager Revision as the current file. The 
newly created Authorized files will also have had Publish and 
Effective Dates set, so can have their status changed by Update Status.
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substitution. This involves setting up user groups and assigning users to the 
appropriate ones. Administrators can define and run planogram substitutions and 
can also set up and control batch processes.

■ Merchandise Manager Level

Users with Merchandise Manager privileges have access to the planogram 
substitution module, but not to the Administration module. This enables them to 
define and bulk run planogram substitutions but not to control access to 
planogram substitution, or to control batch processes.

■ Common users

Users with normal privileges have the ability to run substitutions on individual 
active store plans in the Planner and Merchandiser modules. They do not have the 
privileges to define planogram substitutions or run them in bulk.

Planogram Substitution in Merchandiser
This section explains running the Planogram Substitution as a common user. 
Planogram Substitution can be run by a common user, only if the Administrator user 
has defined any substitutions for the active drawing.

As a common user, you can run the Planogram Substitution from the Tools menu of 
the Merchandiser module.

Figure 7–3 Planogram Substitution in Merchandiser

The Run Planogram Substitution option allows common users to manually run 
planogram substitutions. When the Run Planogram Substitution is selected, the batch 
is initiated in the background and no confirmatory message is displayed in the graphic 
user interface.

Planogram Substitutions are carried out if the following conditions are met:

■ The drawing must be checked in and not in use.

■ The planogram must be in 2D (imploded) mode. (Planograms in 2.5D or 3D mode 
will not be substituted).

Planogram Substitution in Planner
This section explains running the Planogram Substitution as a common user. 
Planogram Substitution can be run by a common user, only if the Administrator user 
has defined any substitutions for the active drawing.

As a common user, you can run the Planogram Substitution from the Tools menu of 
the Planner module.

The Run Planogram Substitution option allows common users to manually run 
planogram substitutions. When the Run Planogram Substitution is selected, the batch 
is initiated in the background and no confirmatory message is displayed in the graphic 
user interface.
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Planogram substitutions are carried out by making changes directly in the database. 
For example if the database tables show a fixture containing Planogram A before the 
substitution, the tables will show the fixture containing planogram B after the 
substitution. The Merchandiser module and In-Store Space Collaboration read data 
directly from the database, so will show the changes directly the drawing is next 
opened.

The Planner module stores information in an AutoCAD DWG drawing. If a drawing is 
opened in the Planner module after Planogram Substitution or Version Change, the 
changes will have been made in the database, but not in the DWG file. After 
planogram substitutions have been made and the information in the database 
changed, the information in the DWG drawing has to be synced with the drawing in 
the database by means of Synchronization. 

For information on how to synchronize the drawings, refer the section on 
Synchronization.

Update Status
Update Status allows the automatic updating of the statuses for stores and files under 
specific circumstances:

■ Proposed stores will be changed to Open status, if the Opened Date is exceeded.

■ Open Stores will be changed to Closed status, if the Closed Date is exceeded.

■ Floor Plans (files) at Authorized Status will be changed to Published Status, if the 
Published Date is exceeded.

■ Floor Plans (files) at Authorized or Published Status will be changed to Current 
Status, if the Effective Date is exceeded.

When the Update Status batch is run, the status of the files are updated from 
Authorized file status to Published status and Published status to Current status. Files 
for which status has changed recently can be identified in a report. 
Based on this report:

■ Files that have reached Published status can be sent to the pertinent stores so that 
they can prepare for implementation. Equipment and Product takeoffs can also be 
sent to the purchasing department so that any additional equipment and products 
can be placed on order.

■ Stores can be notified of files that have reached Current status so that they can 
implement the plan.

Only users with Administrator's role have access to this batch tool. For more 
information, refer the Oracle Retail Macro Space Management Administrations Guide.
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8Report Designer

The Report Designer tool is used to create customized planogram report templates for 
Macro Space Management. The report template is used to view (for example) multiple 
planograms. Each planogram is selected during the print operation and the printed 
output displays specific details of that planogram.

These reports can also be initiated (but not edited) in In-Store Space Collaboration. 
Report designer can be supplied as a stand-alone exe that can be used separately or 
integrated with the application and accessed from within the Merchandiser module.

Figure 8–1 Report Designer Relationship 

This chapter explains the Report Designer tool. It contains the following topics:

■ Overview

■ Creating a New Report

■ Menu Bar and ToolBar Commands

■ Designing the Report

■ Other Design Options

■ Accessing Existing Templates

■ Printing

Report Templates
The report template can be customized to user requirements with user specified titles, 
tables, planogram views, and other formatting.
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In the example below, the report template will result in a report output with following 
columns:

■ Planogram Name

■ Front view of planogram

■ Table of merchandise contained in the planogram.

Figure 8–2 Example of a report

Using Report Designer
Report Designer is used in two phases:

1. The necessary Report Templates are designed.

2. A Report is printed using a selected template and data.



Accessing the Report Designer

Report Designer 8-3

Figure 8–3 Designing Report Templates

Various report templates can be designed and stored in Report Designer. Each report 
template provides one way of outputting data on (for example) a planogram. One 
report template might provide a list of equipment required for the fixtures on which a 
planogram is to be placed. Another report template might provide a list of the 
merchandise in the planogram.

Generating Reports
To generate a report, first select the required template. Next select the print option. 
After the print dialog appears, the planogram section dialog will also appear. After the 
required planogram has been selected, a report containing the specified information 
on that planogram will be printed.

Accessing the Report Designer
Report Designer opens in a blank screen.
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Figure 8–4 Report Designer Opening Window

The Menu Bar (1) gives access to some basic options. The Toolbar (2) gives access to 
similar options. The Report Item Properties (3) Object Browser is not active at this 
stage.

Menu and Toolbar Options
The File menu allows you to create new reports, open an existing one, set some basic 
preferences or exit the program.

Figure 8–5 Report Designer File Menu

The Window menu allows you to tile multiple reports, either horizontally, vertically 
or in a cascade.
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Figure 8–6 Report Designer Window Menu

The Help menu provides access to the help files, or to get information on the version 
of the software.

Figure 8–7 Report Designer Help Menu

The Toolbar allows you to create a new report, open an existing one or set preferences.



Creating a New Report Template

8-6 Oracle® Retail Macro Space Management  User's Guide

Figure 8–8 Report Designer Toolbar

Creating a New Report Template
To create a new Report: 

1. Select the New option from the File menu or select New from the toolbar.

Figure 8–9 Report Designer - Create a New Report

This will bring up the New report dialog box.
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Figure 8–10 Report Designer - New Report Dialog Box

2. Enter the following details in the dialog box:

■ Name: Provide a valid name for this Report Layout. This name must be 
unique. A maximum of 40 characters can be entered.

■ Display Units: Select from the drop-down list. It determines the units that are 
shown in the view objects to indicate the height of shelves, etc. This displays a 
choice of inches or mm.

■ Paper Units: Select from the drop-down list. It determines the units for 
defining the size of the paper and the positions of objects on the paper. This 
displays a choice of inches or mm.

■ Display One Section per Page: Select the option if you want to generate a 
separate page for each section/profile in the planogram, or whether all 
sections will be shown on a single page.

3. When done, click on the OK button to complete the initial creation process. 

This will cause a Report Design dialog box to appear.

Report Design Dialog Box
The Report Design dialog box appears within the main Report Designer screen.
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Figure 8–11 Report Designer - Report Design Dialog Box

■ Rulers show the dimensions in the selected units. The units for the rulers is 
determined by the Paper Units for the current user. The origin for the rulers is the 
top left corner of the page. The rulers are updated as the page is panned or 
zoomed.

■ External Margins are areas outside the area that is printed. They can be used to 
hold data not intended for the printed output.

■ The Printable Area is the area inside the thick grey border. Only information 
inside of this area is printed.

Page Set Up Options
The Page Set Up for printing can be activated from the File menu.
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Figure 8–12 Page Set Up

This will bring up the Page Set up dialog box which allows the page set up to be 
configured before printing.
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Figure 8–13 Page Set up dialog box

All page setup values will be stored with the report layout, except the Source (e.g. 
Tray). The default values will where possible be derived from the settings for the 
default printer.

Click OK once all details have been configured.

Commands

General Commands
The majority of the commands that can be activated by the user are accessible from 
both the standard menus and from the toolbar. In all cases the operation of the 
command is identical regardless of how the user activates it.

For all commands, if the current state of the editing environment prevents the 
operation of that command, it will be disabled. For example, if no items are selected, 
the Cut or Copy commands will be disabled.

Some commands will also change display state to indicate if they are currently in effect 
or to indicate a item in an operational state.

In all cases, selecting a command before a previous command has completed will 
cancel the prior command.
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Toolbar Only Commands
These commands are only available from the main toolbar and provide quick access to 
several of the properties for the reporting items. All of these commands will also 
indicate the current state of the property by displaying the relevant button in a pressed 
state. The commands only available on the toolbar include:

■ Views

■ Text Justification

■ Text Style

Menus and Toolbars
The full menus and toolbars will appear when a report has been created, or is opened 
for editing.

■ The Menu Bar gives access to the varying drop down menus.

■ The Report Options allow users to create, edit and save reports.

■ The Select Planogram Option allows users to select a planogram for the report.

■ The Print Options allow users to print the report.

■ Preferences allows users to set some personal preferences.

■ The Edit Toolbar gives access to editing options.

■ The Grouping, Locking and Behavior Toolbar allows users to group, lock and 
move objects in front of or behind others.

■ The View Options Toolbar allows users to change the screen scale and focal 
point.

■ The Insert Options Toolbar allows users to insert various types of object in the 
report.

■ The View Directions Options Toolbar allows users to select which direction a 
planogram is viewed from.

■ The Text Options Toolbar allows test to be justified or changed to bold/italic.
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Commands common to Menu Bar and Toolbar

Table 8–1 Common Commands to Menu Bar and Toolbar

Menu Toolbar Description 

File The File commands allow the user to manipulate report layout documents. Also 
provided are commands to adjust user preferences and to exit the designer.

New This will create a new empty layout document and display 
the Report Properties dialog where initial parameters can be 
defined.

Open This will display the Report Layouts dialog allowing a 
layout to be opened for viewing or editing. If a layout is 
opened that has a read-only status, then all editing 
functionality will be disabled.

Multiple Report Layouts can be open at any one time and 
each will be contained in a separate document window.

Save This will save the layout, either updating the existing 
definition or adding a new one if this is a new layout.

Save As This will display the Report Properties dialog, where the 
user can enter a new name, it will then be saved as a new 
layout.

Page Setup This will display the Page Setup dialog. This will allow the 
report page dimensions and related options to be defined.

Report Properties This will display the Report Properties dialog which allows 
report specific information to be viewed or edited.

Select Planogram This will display the Select Planogram dialog, this will 
allow the designer to test the report using real data. If a 
planogram is loaded like this, it will be used by the editor 
to represent an example of the planogram during editing.

An option will also be provided to load a test planogram, 
this will be the default planogram when a layout is loaded 
and will contain generic test data.

The Print command will also allow planograms to be 
loaded.

Print This will display the Print dialog to allow the current 
layout to be printed. The Select Planogram dialog will also 
be displayed allowing the user to select what to print.

Print Preview This will display the Print Preview dialog, this shows an 
example of the printed report. The report will preview 
using the currently loaded planogram (see Select 
Planogram).

User Preferences Displays the Options dialog, this allows the user to 
configure certain aspects of the design environment to 
their own personal preference.

Exit This will close the application. It will prompt the user to 
save any pending changes.
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Edit The Edit commands allow the user to manipulate the individual items on a 
report layout.

Cut Copies the selected items to the clipboard and removes 
them from the layout. Any items already on the clipboard 
will be lost.

Copy Copies the selected items to the clipboard. Any items 
already on the clipboard will be lost.

Paste Copies all items on the clipboard to the current layout. The 
items will be retained on the clipboard for further use.

When items are pasted, they will be placed on the layout 
at the nearest point to the top left corner of the editing area 
but will retain their positions relative to each other. All the 
pasted items will be selected so that they can easily be 
relocated to the correct position on the layout. Any 
currently selected items will be automatically de-selected.

Note that the clipboard is shared by all open layouts.

Delete Deletes the selected items from the current document, the 
items will not be placed on the clipboard.

Undo Undoes the last change in the current layout document.

The undo stack is held per document but can only contain 
a limited number of undoes. The stack is lost when that 
layout is closed and is cleared when the layout is saved.

Group This will group selected objects, giving them a common 
group.

If items are grouped then, provided GROUP option is 
enabled in the status bar, all items will be selected if just 
one item in the group is picked.

This will enable users to move sections of the report 
around more easily, by treating them as a single object.

Turning the GROUP function off in the status bar will then 
allow objects to be manipulated singly.

Ungroup This will ungroup selected objects, reverting them back to 
independent items.

Lock This will lock the selected items to prevent them from 
being edited or deleted. Locked items can still be selected, 
have their properties inspected and can sill be copied to 
the clipboard.

Note that locked items placed on the clipboard will not 
retain their locked status.

Unlock This will unlock the selected items, allowing them to be 
once again moved or deleted

Bring To Front This will change the display order of the selected items 
and bring them to the front so that they are not obscured. 
The selected items will retain their relative display order.

Send to Back This will change the display order of the selected items 
and place them behind all other objects. The selected items 
will retain their relative display order.

Table 8–1 (Cont.) Common Commands to Menu Bar and Toolbar

Menu Toolbar Description 
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View The View commands are used to affect the view of the layout document.

Pan This will switch to pan mode. In this mode, clicking and 
dragging over the editing area will cause the view to scroll 
with the mouse.

Note that this mode will stay active until it is manually 
de-activated.

Zoom Window This will prompt the user to zoom into an area of the 
document defined by a rectangle drawn with the mouse. 
The area within the rectangle will be magnified to fill the 
editing area.

Zoom In This will increase the magnification of the design view by 
a factor when the mouse is clicked in the design area. The 
magnification will be centred at the position of the mouse.

Note that this mode will stay active until it is manually 
de-activated.

Zoom Out This will decrease the magnification of the design view by 
a factor when the mouse is clicked in the design area. The 
magnification will be centred at the position of the mouse.

Note that this mode will stay active until it is manually 
de-activated.

Zoom Extents This will make the entire layout document page fit into the 
design area. If any parts of the layout are off the actual 
page area, these will be included. An extra padding 
margin will also be included to aid visual clarity.

Insert The Insert commands are used to add the reporting items to the layout.

Label This will add a text label object to the current document, 
the cursor will be changed and the user prompted to mark 
out the bounds of the label.

The label when added will contain a default text string 
that is the same as the control name.

Field This will add a field object to the current document, the 
cursor will be changed and the user prompted to mark out 
the bounds of the field.

A dialog will then be displayed allowing the user to select 
the data source (held in the database) for the field.

Image This will add an image object to the current document, the 
cursor will be changed and the user prompted to mark out 
the bounds of the image.

A dialog will then be displayed allowing the user to select 
the source for the image. The image can be any of the 
following formats:

BMP, GIF, PNG, JPEG.

The image will be scaled to fit the bounds but will not 
maintain its aspect ratio.

Note that the image must reside on a network accessible 
path that can be resolved by the server for the client 
versions.

Table 8–1 (Cont.) Common Commands to Menu Bar and Toolbar

Menu Toolbar Description 
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Line This will add a line object to the current document, the 
cursor will be changed and the user prompted to mark out 
the line.

Rectangle This will add a rectangle object to the current document, 
the cursor will be changed and the user prompted to mark 
out the bounds of the rectangle.

View This will add a planogram view diagram to the document, 
the cursor will be changed and the user prompted to mark 
out the bounds of the view.

The diagram will default to a front view, but the user can 
change the view direction by pressing the appropriate 
button on the toolbar, or selecting the required option 
from the dropdown list in the Properties panel.

By default a new view item will not include any extra 
information, to configure the view, use the Planogram View 
Properties.

Table This will add a data table item to the current document, 
the cursor will be changed and the user prompted to mark 
out the bounds of the table.

Once the table bounds have been defined, the table data 
dialog will be displayed where the user can define the 
source for the data and how it is represented.

Window The Window menu is used to alter the way in which the document windows are 
arranged in the main editing area.

Tile Horizontally This will tile the open document windows vertically down 
the editing area. Each window will be stretched to fill the 
full width of the area.

Tile Vertically This will tile the open document windows horizontally 
across the editing area. Each window will be stretched to 
fill the full height of the area.

Cascade This will cascade the open document windows within the 
editing area. Each window will be positioned slightly 
down and to the right of the top-left corner of the previous 
one.

Document 1 A menu item will be included in the Window menu for 
each open document. This actual menu item text will be 
the name of the document contained in that widow, this 
will also be used for the title of the window. Selecting the 
menu option will select that document, this will make it 
the currently active one and display it on top of other 
document windows. The main designer window will also 
include the title of the active document within its title bar.

Help The Help menu provides information about the software.

Contents This will display the help contents page for the report 
designer.

About This will display the About dialog. This contains the 
software version as well as some other items of 
information.

Table 8–1 (Cont.) Common Commands to Menu Bar and Toolbar

Menu Toolbar Description 
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Designing the Report Template
There are seven types of objects that can be added to the report being designed. These 
are selected from the Insert menu or from the Insert toolbar.

Both sets of options work in an identical manner.

Figure 8–14 Report Designer Toolbar

Overview of Report Item Properties
Report Item Properties will be found on the left of the screen. It allows any of the 
seven types of object that can be placed in the report to be customized.

Figure 8–15 Report Item Properties

■ The Object to be edited can be selected from a drop down list

■ Buttons give access to some editing options



Designing the Report Template

Report Designer 8-17

■ Typing into Text Boxes allows other options to be customized.

■ Drop down lists allow other options to be customized.

■ Check boxes allow options to be turned on or off.

Adding a Label
To add a Label to the report:

1. Click on the Label icon on the insert toolbar.

Figure 8–16 Label Icon

Alternatively, select the Label option from the Insert menu.

2. To add a label, move the cursor to the required start position in the Report Layout 
Designer. 

3. Hold down the left mouse button and drag to form a rectangle.

Figure 8–17 Add Label

4. Release the left hand mouse button to complete drawing a rectangle containing the 
initial name of the label.
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Figure 8–18 Add label - Draw Rectangle

5. Edit the varying properties of the Label in the Report Item Properties Object 
Browser.
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Figure 8–19 Add Label - Example

■ Name is what the label is called in the drop down list. It can be edited by 
typing in a different value, or the default value can be used.

■ color is the color of the border of the label. It can be changed by clicking on the 
button and selecting a new color from the pallet that appears.

■ Background is the color of the background of the label. It can be changed by 
clicking on the button and selecting a new color from the pallet that appears.

■ Left, Top, Width and Height allow the position and size of the rectangle 
containing the label to be changed. They can be edited by typing in different 
values.

■ Font Name and Font Size can be changed by selecting new values from the 
drop down list.

■ Alignment can be changed from the drop down list. Alternatively, it can be 
changed using the alignment options on the toolbar.

■ Text is the text that will be displayed in the printed report. This must be set at 
design time.

■ Checking Locked means this item cannot be deleted.
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Adding a Field
To add a Field to the report:

1. Click on the Label icon on the insert toolbar.

Figure 8–20 Add Field

Alternatively, select the Field option from the Insert menu.

2. To add a field, move the cursor to the required start position in the Report Layout 
Designer. Hold down the left mouse button and drag to form a rectangle.

Figure 8–21 Add Field - Draw Rectangle

3. Release the left hand mouse button to complete the selection. After the selection, 
the Select Data Source dialog box appears.
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Figure 8–22 Data Source dialog box

4. Select the name of the required field by means of the radio button and drop down 
lists.

Figure 8–23 Add Field 

5. Edit the varying properties of the Field in the Report Item Properties Object 
Browser.
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Figure 8–24 Add Field - Example

■ Name is what the label is called in the drop down list. It can be edited by 
typing in a different value.

■ color is the color of the border of the label. It can be changed by clicking on the 
button and selecting a new color from the pallet that appears.

■ Background is the color of the background of the label. It can be changed by 
clicking on the button and selecting a new color from the pallet that appears.

■ Left, Top, Width and Height allow the position and size of the rectangle 
containing the label to be changed. They can be edited by typing in different 
values.

■ Font Name and Font Size can be changed by selecting new values from the 
drop down list.

■ Alignment can be changed from the drop down list. Alternatively, it can be 
changed using the alignment options on the toolbar.

■ Data Source can be changed by clicking on the button. It allows the label 
selected in the Select Data Source dialog box to be changed.

■ Format allows the form of the selected field to be changed. For example, 
Planogram Names could be changed from capitalized to uppercase.

■ Checking Locked means this item cannot be deleted.
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Adding an Image
To add an image to the report: 

1. Click on the Image icon on the insert toolbar.

Figure 8–25 Add Image Icon

Alternatively, select the Image option from the Insert menu.

2. To add an image, move the cursor to the required start position in the Report 
Layout Designer. Hold down the left mouse button and drag to form a rectangle. 

3. Release the left hand mouse button to complete the drawing. The Select Data 
Source dialog box appears.

4. Select the name of the required image by means of the radio button and drop 
down lists.

The selected image then appears in the report. It is scaled to fit the bounds but 
does not maintain its aspect ratio.

5. Edit the varying properties of the image in the Report Item Properties Object 
Browser.

Note: The image must reside on a network accessible path that can 
be resolved by the server for the client versions.
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Figure 8–26 Image Options

■ Name is what the label is called in the drop down list. It can be edited by typing in 
a different value.

■ Left, Top, Width and Height allow the position and size of the rectangle 
containing the label to be changed. They can be edited by typing in different 
values.

■ Font Name and Font Size can be changed by selecting new values from the drop 
down list.

■ Image Filename allows a different image to be selected.

■ Checking Locked means this item cannot be deleted.

Adding a Line
To Add a Line to the report, click on the Line icon on the insert toolbar.

Figure 8–27 Add a Line Icon

Alternatively, select the Line option from the Insert menu.

To add a Line, move the cursor to the required start position in the Report Layout 
Designer. Hold down the left mouse button and drag to form a rectangle.
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Figure 8–28 Add a Line

When the left hand mouse button is released, a line will be drawn from the first corner 
to the opposite corner of the rectangle. 

(If a horizontal or vertical line is drawn, no rectangle will appear).

Figure 8–29 Add a Line - Example

The varying properties of the Line can then be edited in the Report Item Properties 
Object Browser.
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■ Name is what the Line is called in the drop down list. It can be edited by typing in 
a different value.

■ color is the color of the Line. It can be changed by clicking on the button and 
selecting a new color from the pallet that appears.

■ Left, Top, Width and Height allow the position and size of the Line to be 
changed. They can be edited by typing in different values.

■ Thickness is the thickness of the line as drawn. It can be changed by selecting 
from the drop down list.

■ Checking Locked means this item cannot be deleted.

Adding a Rectangle
To Add a Rectangle to the report, click on the Rectangle icon on the insert toolbar.

Figure 8–30 Add a Rectangle Icon

(Alternatively, select the Rectangle option from the Insert menu).

To add a Rectangle, move the cursor to the required start position in the Report 
Layout Designer. Hold down the left mouse button and drag to form a rectangle.

When the left hand mouse button is released, a rectangle will be drawn.
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Figure 8–31 Add Rectangle - Example

The varying properties of the Rectangle can then be edited in the Report Item 
Properties Object Browser.

■ Name is what the Rectangle is called in the drop down list. It can be edited by 
typing in a different value.

■ color is the color of the border of the Rectangle. It can be changed by clicking on 
the button and selecting a new color from the pallet that appears.

■ Background is the color of the background of the Rectangle. It can be changed by 
clicking on the button and selecting a new color from the pallet that appears.

■ Left, Top, Width and Height allow the position and size of the rectangle 
containing the Rectangle to be changed. They can be edited by typing in different 
values.

■ Thickness is the thickness of the line as drawn. It can be changed by selecting 
from the drop down list.

■ Checking Locked means this item cannot be deleted.

Adding a View
To add a view to the report, click on the View icon on the insert toolbar.
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Figure 8–32 Add a View

(Alternatively, select the View option from the Insert menu).

To add a View, move the cursor to the required start position in the Report Layout 
Designer. Hold down the left mouse button and drag to form a View.

When the left hand mouse button is released, a View will be drawn.

Figure 8–33 Report Layout Designer - Add View

This view contains a dummy image. To add a planogram from the Oracle database, 
click on the Select Planogram option. Select a planogram from the Select Planogram 
dialog box.

Set the filter criteria, click on the filter icon, then highlight a planogram in the list of 
those available. Click on the OK button and the planogram will be added to the view.

Note: Ensure the filter is set. If there is no filter criteria set, then all 
available planograms will be displayed in the list. If there is a large 
number of planograms in the database, the software may stop 
responding.
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Figure 8–34 Add View - Example

The varying properties of the View can then be edited in the Report Item Properties 
Object Browser.

■ Name is what the View is called in the drop down list. It can be edited by typing 
in a different value.

■ color is the color of the border of the View. It can be changed by clicking on the 
button and selecting a new color from the pallet that appears.

■ Background is the color of the background of the View. It can be changed by 
clicking on the button and selecting a new color from the pallet that appears.

■ Left, Top, Width and Height allow the position and size of the rectangle 
containing the View to be changed. They can be edited by typing in different 
values.

■ Font Name and Font Size can be changed by selecting new values from the drop 
down list.

■ View Direction is the current direction the planogram is being viewed from. It can 
be changed by selecting from the drop down list.

■ Checking Locked means this item cannot be deleted.

Some details of the View can be customized using the Planogram View Options dialog 
box available from the View Directions toolbar.
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Figure 8–35 View Directions toolbar

Figure 8–36 Planogram View Options

Working with Views
The Views Toolbar allows users to change the direction the planogram is viewed from.

Note: The colors of the Fixtures in the view can be changed by going 
to Fixture Studio and changing the default color of the fixture. The 
colors of the Products in the view can be changed by going to Product 
Studio and changing the default color of the product. This will affect 
all instances of those fixtures or products. (See Fixture Studio and 
Product Studio help files for more information).
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Figure 8–37 Views Toolbar

It also allows some annotation of the planogram view.

It is also possible to view it from the right using the View Directions toolbar.

Figure 8–38 View Directions toolbar

It is also possible to annotate the planogram view with some information. This is done 
by clicking on the Planogram view option in the Views toolbar.

This will bring up the Planogram View Options dialog box.

Tick the required options and they will appear in the Planogram view.
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Figure 8–39 Planogram View

Adding a Table
To add a table to the report, click on the Table icon on the insert toolbar.

Figure 8–40 Add Table

(Alternatively, select the Table option from the Insert menu).

To add a Table, move the cursor to the required start position in the Report Layout 
Designer. Hold down the left mouse button and drag to form a rectangle.

When the left hand mouse button is released, the Select Data Source dialog box will 
appear. This allows the table to be customized.
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Figure 8–41 Select Data Source

■ Field Name cannot be altered.

■ If the Use Field check box is ticked, the data will be included in the table.

■ Field Width can be changed by typing in an alternative value.

■ Data Format can be changed using the drop down list

■ Data Alignment within the table can be changed using the drop down list.

■ When the OK button is clicked, the table will appear.
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Figure 8–42 Add Table

The varying properties of the Table can then be edited in the Report Item Properties 
Object Browser.

Figure 8–43 Report Item Properties

■ Name is what the Table is called in the drop down list. It can be edited by typing 
in a different value.
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color is the color of the border of the Table. It can be changed by clicking on the 
button and selecting a new color from the pallet that appears.

■ Background is the color of the background of the Table. It can be changed by 
clicking on the button and selecting a new color from the pallet that appears.

■ Left, Top, Width and Height allow the position and size of the rectangle 
containing the Table to be changed. They can be edited by typing in different 
values.

■ Font Name and Font Size can be changed by selecting new values from the drop 
down list.

■ Data Source can be changed from the drop down list.

■ Checking Locked means this item cannot be deleted.

Other Design Options

Using Snap to Neatly Align Items
The Snap Option allows users to align objects to an invisible grid.

Snap is turned on via the button on the Status bar.

The Snap Grid settings are set using the Preferences option called via the Preferences 
icon on the toolbar.

Figure 8–44 Preferences Icon

Figure 8–45 Preferences Options
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The Snap Grid spacing can then be set using the spin controls.

When the Snap option is selected objects can only be moved about in the design 
window to locations determined by the snap grid.

When the Snap option is turned off, objects can be moved to any location.

Changing Label and Field Text via Toolbar
The appearance of label and field text can be changed via the options on the toolbar. 
These options are grayed out until a label or field is selected to edit.

When a label or field is selected to edit, they become active.

Text can be justified Left, Centre or Right, and Top, Middle or Bottom.

It can also be changed to Bold or Italic.

Selected options are highlighted.

Selecting Multiple Items
Multiple Items can be selected by holding down the shift key while left clicking on 
the required objects.

In the example below the three objects on the left have been selected and are shown 
highlighted with selection boxes on the right.

Figure 8–46 Multiple Item Selection

Only items that can be collectively edited are available in the display.

If they cannot be collectively edited, that section of the display is blank.

In the example on the left, the Left, Top, Width and Height values cannot be added 
while multiple objects are selected.

Note: To see the effect of the Snap Grid for the first time, it is 
recommended that the value be set to a fairly large one. Useful values 
are 25 mm for metric settings and 0.25" for imperial settings.
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Using Grouping
Grouping allows all items in the group to be selected, even if just one item in the 
group is selected.

Grouping is turned on or off by using the Group button on the Status Bar.

(The Status bar also provides information on the number of items selected, etc.).

Figure 8–47 Status Bar

Multi-selected items can be grouped or ungrouped using the options available on the 
toolbar.

Figure 8–48 Group Options

Grouping Items

To Group items, ensure Group is selected on the Status bar. Multi-select the required 
items then click on the Group icon. Selecting any one of the grouped items will then 
select the others.

Un-grouping Items

To Un-group items, ensure Group is selected on the Status bar. Select the required 
group then click on the un-group icon. The items will now be ungrouped and will 
only select singly.

Bring to Front or Send to Back
Bring to Front or Send to Back can be used with superimposed objects.
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Figure 8–49 Bring To Front

In this example a view has been superimposed on top of a yellow rectangle.

The yellow rectangle is first selected (blue rectangle in left hand image), then the Bring 
to Front icon is clicked on the toolbar.

This brings the yellow rectangle in front of the view.

Figure 8–50 Bring To Front - Example

The process can be reversed by clicking on the Send to Back icon.

Opening an Existing Report Template
To open an existing report design template click on the open option in the File menu 
or in the toolbar.
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Figure 8–51 File and Toolbar Menu

This will bring up the Report Layouts dialog box.

Figure 8–52 Report Layouts dialog box

Select a report design template and click on OK to open it.

The report design template can then be edited, or used to product reports.

Printing the Report

Print Preview
Print Preview can be selected from the File menu or from the toolbar.
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Figure 8–53 Print File and Toolbar Menu 

This will bring up the Print Preview dialog box.

Figure 8–54 Report Layouts dialog box

The icons at the top allow the user to print, zoom in or zoom out, or see multiple 
pages.
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Printing
Printing can be initiated from the Print options on the on the File menu (or the toolbar) 
once a Report Design Template is open.

(Print Preview only allows test printing of a generic report. Reports on specific 
planograms must be initiated through the print option).

Figure 8–55 Print Report 

This will bring up the Print dialog box. Select the printer.

The Page Range and Collate options will be disabled. However, the user will be able to 
select the printer and set its preferences, as well as being able to set the number of 
copies that are printed.

When the options have been set, click on OK to print. This will bring up the Select 
Planogram dialog box.

Note: The print preview does not print information for a specific 
planogram - it just allows the user to confirm that the format of the 
printed report is correct. Using the print button from the print 
preview will send the current preview to the default printer. To print 
a planogram specific report, use the print option.
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Figure 8–56 Select Planogram dialog box

Select the required planogram (using the filter to reduce the number of planograms 
displayed).

Click OK. The report on the selected planogram will then print.
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9Troubleshooting

This section contains information on commonly experienced problems and its 
solutions.

Applications Problems and Solutions
The following is a list of some commonly encountered problems and their solutions.

Table 9–1 Applications Problems and Solutions

Issue Solution

Planner

I am having trouble changing 
the status of a Revision

If changing from Authorized to Current status, ensure that one drawing in 
the revision has Authorized status.

I cannot edit a drawing If you only have read only privileges, you cannot edit drawings. Ask an 
Administrator for your privileges to be changed.

I can't find a drawing If the drawing is no longer present within the Macro Space Management file 
structure, this will be indicated by the Lost icon.

I cannot manually set a 
drawing to current status

This option is not available. Drawings are automatically set to Current status 
when the status of a Revision is set to Current.

I cannot manually set a 
drawing to historical status

This option is not available. Drawings are automatically set to Historical 
status when the status of a Revision is changed to Historical.

I cannot manually set a 
Revision to Historical

Revisions cannot directly be changed to Historical status. They change 
when another revision becomes Current.

I'm having trouble comparing 
my Store to the Prototype

When comparing Stores to a Prototype, it is important to remember that the 
number of floors may be different.

I'm having trouble changing 
the status of a drawing

■ The status of a drawing cannot be changed if it has been associated 
with a floor. Check that the drawing is correctly associated with a 
Revision, (not a Floor).

■ The status of a drawing within a Revision can only be set to proposal or 
approved. Its status will change to current when the status of the 
Revision is set to Current.

My Revision has a status of 
Historical and I want to use it

It is not normally possible to reverse Historical status.

Create a new revision and copy the required files from the Historical 
revision.



Applications Problems and Solutions

9-2 Oracle® Retail Macro Space Management  User's Guide

My Store Root is different 
from the Configuration File

The Store Root can be changed from either the Configuration Module, or 
from within Store Manager.

If it is changed from the Configuration Module by another user while 
another person is working in Store Manager, then Store Manager will not 
immediately update.

Many of the file icons will change to the Lost icon:

To remove the problem, close the Store Manager Module, then reopen it. 
Store Manager will then see the same Store Root that was specified in the 
Configuration Module.

When I open a drawing it will 
only open in Read Only mode

Once drawings have been set to Current or Historical status they can only 
be viewed in Read Only mode. This is because they are either in use within 
the stores, or have been taken out of service.

Windows Explorer should also be used to check the status of the file. When 
Macro Space Management sets a file to Read Only status, it is just a flag in 
the database. If a File has been set to Read Only by the Windows operating 
system, then Macro Space Management will not be able to change the 
status.

I Cannot Access the 
Administration Module

The Administration Module is only available to users with administrative 
privileges. If you do not have these privileges, you will not be able to access 
the Administration Module.

I can't make a Group or 
Family

There are two possibilities if a user cannot make a family or group.

Firstly, the objects could be incompatible. Groups cannot for example 
include both shelves and products.

Secondly, groups and families can only be created when in the appropriate 
tab. For example fixture groups can only be created while in the fixturing 
tab in the Object Browser

I can't remove objects from a 
Group or Family

Objects can only be removed from groups and families when in the 
appropriate tab. For example fixture groups can only be modified while in 
the fixturing tab in the Object Browser

I'm creating a Group and I'm 
being told there is a fixture 
already in it

If a user has selected several objects with the intent of forming a Group, 
they could receive the following warning.

One reason for this is that there could be selected fixtures in the drawing 
other than the current view.

If necessary use <Ctrl> + D to de-select all objects in the drawing, then 
re-select the objects required.

Fixturing

Table 9–1 (Cont.) Applications Problems and Solutions

Issue Solution
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A recently created fixture in 
Fixture Studio doesn't show 
on the Object Browser

Fixtures created in Fixture Studio have to be saved there before they 
become available to the Planner module of Macro Space Management.

Newly added and saved fixtures from Fixture Studio will not show in the 
hierarchical tree on the Object Browser until the Refresh option has been 
run.

A recently created gondola in 
Fixture Studio doesn't show 
on the Object Browser

Gondolas created in Fixture Studio have to be saved there before they 
become available to the Planner Module of Macro Space Management.

Newly added and saved gondolas from Fixture Studio will not show in the 
hierarchical tree on the Object Browser until the Refresh option has been 
run.

I've placed a fixture and its 
very large

Macro Space Management is working in imperial dimensions, and the 
fixture was designed using metric dimensions.

I've placed a fixture and its 
very small

Macro Space Management is working in metric dimensions and the fixture 
drawing was dimensioned in inches.

I can't bay number a recently 
placed a fixture or gondola

Fixtures or gondolas cannot be bay numbered until the Synchronize and 
Adjacency options have been run.

I select a fixture and it zooms 
to the extents of the drawing

Whether or not a fixture zooms to the extents of the drawing is determined 
by the Highlighting frame in the Fixturing Tab of the Configuration 
module. If the user does not want the selected fixture(s) to zoom to the 
extents of the drawing, uncheck the zoom box in the Highlighting frame.

Message in Fixtures windows 
says object has no graphics

If an object in the Fixtures window, for example a fixture, fitting or gondola, 
has a message in bold saying it has no graphics file, this means the object 
was created outside AutoCAD and has no AutoCAD .DWG file associated 
with it.

An example would be fixtures in Fixture Studio. These are often created 
using an external graphics program such 3D Studio. The results are saved 
as .3DS files and will accordingly display in Fixture Studio. Other external 
graphics programs supported by Fixture Studio are LightWave 3D (file 
extension .LWO) and Harvard Graphics applications (file extension .TPL). 
The object without an AutoCAD dwg file will appear in the hierarchical tree 
in the Fixturing tab of the Object Browser with an error message like in the 
above example.

To correct the problem, Macro Space Management needs an MSM 
AutoCAD drawing. This can be done by typing 3DSIN in the MSM 
AutoCAD command line, then following the prompts to load the 3D Studio 
drawing into the current MSM AutoCAD drawing.

The Wblock command can then be used to write the required objects to the 
Macro Space Management.

The Fixture is very narrow The fixtures menu actually contains a mixture of fixtures and fittings. 
Fittings are typically used to close off the end of a row of fixtures, hold up 
display cabinets, etc.

Fittings can be quite narrow. Fittings cannot be populated with 
merchandise

Synchronization and Bay 
Numbering

Before Bay Numbering can be carried out, the Synchronization Module 
must be run to ensure the information from the drawing has been fully 
transferred to Macro Space Management's Central database. Next, the 
Adjacency option must be run so the central database has up to date 
information on which fixture is next to which fixture. Bay Numbering can 
then be carried out.

Fixture Studio

Table 9–1 (Cont.) Applications Problems and Solutions

Issue Solution
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Combinations using Naming 
Conventions

Naming conventions rely on a consistent approach being applied to block 
names. In the above example podiums have been named using a consistent 
convention.

There are available in widths of 1025 and 1200 mm, depths of 800, 1025, 
1200, 1500 and 1750 mm and heights of 200, 480 and 680 mm. This gives a 
theoretical number of 2 x 5 x 3 = 30 combinations, yet there are only 13 
actual blocks.

When specifying gondolas, care must be taken that the dimensions chosen 
minimize the number of potential combinations, or else more combinations 
will be generated than there are blocks to match them.

If a block name is generated while drawing a gondola that does not match 
the list of available ones, an error will result.

Problems with Naming 
Conventions

The Gondola Definitions dialog box is used to specify the components of a 
gondola. If there are errors in specifying the components, Macro Space 
Management will not be able to find the blocks to draw the gondola in the 
Cad or Virtual Reality environments.

The gondola can be saved without problems, but when an attempt is made 
to place it in a drawing an error message will result. All Prefixes and 
Suffixes must be correctly defined for Macro Space Management to 
reference the correct block.

Zones

I Cannot Delete a Zone Type Zone Types cannot be deleted if there is a Zone Definition associated with 
it. The associated Zone Definitions must be deleted or assigned to another 
category first.

I'm Trying to Add a Zone and 
an Error Message Comes Up

In order to add a Zone to a drawing, a drawing must first be opened via 
Store Manager. If a user tries to add a Zone to the default drawing, an error 
message is displayed.

I'm Trying to Draw a Zone 
and the Lines Will Only Draw 
to Specified Points on the 
Drawing

If the lines being used to draw a zone will only finish at corners, midpoints, 
etc, of existing zones, then the OSNAP command is on. Turn OSNAP off if 
trying to draw Zones of customized shape.

I've Created a Zone Type, but 
it Doesn't Appear in the Zone 
Descriptions List

It will only appear in the Zone Definitions list after it has been defined.

I've Tried to Cut a Hole and a 
Hole Problem Error Message 
Displays

When cutting a hole, the Zone into which the hole is to be cut must first be 
selected in the hierarchical tree in the Zone Definition window. Failure to 
do this will result in an error.

The Changes Made to Zone 
Definitions Have Had No 
Effect

Changes made in the to Zone Definitions in the Configuration Module only 
take effect the next time Macro Space Management is restarted.

The Changes Made to Zone 
Types Have Had No Effect

Changes made in the to Zone Types in the Configuration Module only take 
effect the next time Macro Space Management is restarted.

The Outline of a Previously 
Erased Hole has Reappeared

If a Hole has been erased using AutoCAD tools, then the drawing must be 
synchronized before another hole is drawn. If it is not, then a 'ghost' image 
of the AutoCAD erased Hole will reappear.

The View Zone Type and 
View Hatch Types Buttons 
Don't Appear to Be Working

If the Zone Description window is maximized, the View Zone Type and 
View Hatch Types windows will tend to appear behind the Zone 
Description window. It will have to be minimized before the new windows 
can be seen.

Data Importer

Table 9–1 (Cont.) Applications Problems and Solutions

Issue Solution
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Data Importer is reading the 
wrong data.

If the Start Line is incorrect, Data Importer will read the wrong data. The 
start line will typically be set to 1 during configuring the data Import.

It should be set to where the first line of actual data is (typically 2 or 3) 
before data is imported into the database using data importer. If it is left at 
1, errors will result as Data Importer reads in data incompatible with the 
database.

CSV file It is important to save the CSV file in the format that is appropriate for the 
system it will be used on. If you do not save the CSV file in the format 
appropriate for the system you are working on, errors may result. For 
example, if you are working on a computer with the Windows operating 
System, and you want to use the file on that computer, it is important to 
save the file in the CSV (Windows) format. If however, you are using 
Windows and want to use the text file on a Macintosh computer, save the 
file in the CSV (Macintosh) format. If you are using a Macintosh computer 
and want to use the text file on a system running Windows or Windows 
NT, save the file in the CSV (Windows) format

Table 9–1 (Cont.) Applications Problems and Solutions

Issue Solution
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About AutoCAD

AutoCAD is a software program that enables extremely sophisticated drawings to be 
produced. It is the platform on which the Planner module is based.

The information in this section only provides a brief overview of AutoCAD along with 
details regarding of some of the more common commands.

AutoCAD Window
The AutoCAD screen has several features as follows:

■ The menu bar at the top of the screen contains drop down menus that give access 
to varying AutoCAD and Macro Space Management features.

■ Immediately below the menu bar are the Macro Space Management and 
AutoCAD toolbars giving access to specific functions. Further toolbars on the left 
and right detail AutoCAD drawing options.

■ An icon detailing the User Co-ordinate System axes can be seen in the lower left 
corner of the screen.

■ The command window at the bottom of the screen contains a text based record of 
commands used within AutoCAD. A mirror image of the command window can 
also be brought up by pressing F2.

■ The status bar gives an immediate indication of which main AutoCAD features 
are turned on or off.
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Figure 0–1 AutoCAD Window

AutoCAD Command Line
All activities within AutoCAD are confirmed by text prompts on the Command Line, 
located at the bottom of the screen. If the activity has not been successful, AutoCAD 
will put an alert on the command line.

Moving About and Sizing the Screen
The scale of the drawing can be changed by means of the central wheel on the mouse. 
Each click of the wheel resizes the screen. The default is by 10%.

Double clicking on the mouse wheel automatically resizes the screen so the drawing 
occupies the full screen.

The cursor, which appears as a white cross, can be moved about the screen by means 
of the mouse.

Note: The AutoCAD command line can be brought up in its own 
window by pressing the F2 key.

Note: The rate at which the scale is changed can be altered by typing 
the command Zoomfactor into the command line. Values are allowed 
in the range 3 - 100, larger values resulting in bigger changes.
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Cartesian Coordinates
Cartesian coordinates are a way of describing the position of an object relative to a 
reference point. The reference point is normally called the origin, and has co-ordinates 
(0, 0). All other locations can be described relative to the origin.

The X ordinates are to the left or right of the origin. X ordinates with a positive value 
are to the right, negative ones to the left. The Y ordinates are above or below the 
origin. Y ordinates with a positive value are above the origin, negative ones below. 
Thus a reference of (10, 10) describes a point above and to the right of the origin. 
Similarly a reference of (-5, -15) describes a point below and to the left of the origin. 
The system can be extended to three dimensions by the use of a "Z" axis.

Any form of units can be used for Cartesian co-ordinates, although these must be the 
same when co-ordinates are being compared. Millimetres, inches, meters, yards, 
kilometres and miles are examples of valid units.

Polar Coordinates
Polar coordinates are a way of describing the position of an object relative to a 
reference point.

For polar coordinates, the offset relative to the current location is specified in the form 
of a distance and an angle, for example 5000 mm, 45 degrees.

The system can be extended to three dimensions if necessary.

Any form of units can be used for Polar coordinates, although these must be the same 
when coordinates are being compared. Millimetres, inches, meters, yards, kilometers 
and miles are examples of valid units.

Selecting Information in the Drawing
Individual fixtures, lines etc., can be selected by clicking on a line within the fixture.

Group of fixtures, etc., can be selected by clicking on the appropriate icon, left clicking 
to set the first position of the selection box, left clicking again to set the end position of 
the selection box, then right clicking to activate the selection.

If the mouse is taken to the right of the first selection point, the selection box will be 
blue. This means all features completely within the box will be selected.

Figure 0–2 Select Drawing

Note: An alternative form of coordinate system is Polar coordinates.

Note: An alternative form of co-ordinate system is Cartesian 
co-ordinates.
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If the mouse is taken to the right of the first selection point, the selection box will be 
green. This means all features that are within, or have a line cut by the box will be 
selected.

Figure 0–3 Select Drawing

In both cases completion of selection is signified by the solid lines within the block 
turning to dotted lines.

Multiple selections of objects can be made by repeatedly left clicking to define 
selection rectangles. All objects within the multiple selection rectangles will be selected 
when the terminating right mouse click is made

Continue left clicking, dragging and right clicking to define further rectangles.

Right click to select all define rectangles.

Lines and Polylines
Lines and Polylines behave slightly differently.

■ Lines can be linked together to form shapes, but each line behaves as an individual 
object.

■ A Polyline can define a complex shape, but the lines are linked so that the shape 
behaves as a single object.

Osnap Options
The Osnap option can be found in the status bar at the bottom of the AutoCAD 
window.

When Osnap is ON objects can be snapped, (attached), to each other in 3 dimensional 
views. Lines can only be drawn to specified end-points.

When Osnap is OFF objects can be moved, (but not attached to each other), in 3 
dimensional views. Lines can be drawn to any end-point.

2D and 3D options
The screen can be toggled between two and three dimensional options. The current 
mode can be seen from the icon in the lower left of the screen.

Note: It is helpful to confirm on the command line that each step of 
action is correct.
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Figure 0–4 2D and 3D options

Blocks
A Block is a generic term for one or more objects that have been combined to create an 
entity that behaves as a single object. Blocks have a name and an insertion point, 
together with information on the individual objects that have been combined to make 
the block.

Creating blocks allows pre-designed objects to be inserted into a drawing

Auto-Saving AutoCAD
AutoCAD has an auto-save option. To access this feature, complete the following 
steps:

1. Right-click to access the special menu. From the menu, select Options.

2. The Options dialog box opens. Select the Open and Save Tab.

3. From the File Safety Precautions section of the dialog box, check the Automatic 
Save check box. The AutoCAD drawing will be automatically backed up at 
interval specified in the Minutes between saves field.
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Figure 0–5 Automatic Save 

Useful Commands

Overview
This section details some of the useful commands in AutoCAD. Many of these 
commands have to be typed on the AutoCAD command line for them to take effect. 
Press Enter after typing the command for it to take effect. Alternatively, many can be 
activated from a menu or toolbar.

Zoom Extent, (ZE)
The Zoom Extent command centers any drawn objects on the screen and adjusts the 
scale of the drawing to the largest possible magnification.

The center button (or scroll wheel) of the mouse can be double-clicked to activate the 
Zoom Extent command.

Extrude, (EXTRUDE)
The Extrude command can be used to turn a two dimensional object, (such as a 
rectangle), into a three dimensional object with height, as well as length and depth. 
The command is invoked by typing Extrude <Return> on the command line.

Distance, (DIST)
The Distance command is useful for measuring objects. It is invoked by typing Dist 
<Return> into the command line.
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AutoCAD invites you to specify a start and then a finish point. It then reports on the 
distance between those two points.

Rotate, (ROTATE), command
The Rotate command can be used to manipulate objects.

It can be activated by typing Rotate <Return> in the command line. It can also be 
activated by selecting the Rotate icon in the Modify toolbar or the Rotate option in the 
Modify menu.

Objects are rotated by selecting them, specifying the base point, then specifying the 
rotation angle.

Object Snap, (OSNAP)
The OSNAP (Object Snap) AutoCAD command will have a significant effect on the 
way shapes are drawn in AutoCAD. OSNAP can be turned on and off by clicking on 
the button at the bottom of the AutoCAD window.

Figure 0–6 Osnap option

If OSNAP is On then when shapes are being drawn, the lines will snap to pre-specified 
points in any existing shapes. Depending on AutoCAD setting, a series of small boxes 
will appear as the mouse is moved about. These represent the points to which lines 
can be snapped.
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Figure 0–7 Select End Point

Lines can only be drawn to these points.

If OSNAP is Off, then lines can be drawn to any desired point within the drawing.

Move, (MOVE), Command
The Move command can be used to manipulate objects in 3D views. There are two 
options to activate the Move command as follows:

■ In the Command Line, type MOVE and press <Return>.

■ Select the Move icon from the Modify toolbar .

xref, (XREF)
XREF is a method AutoCAD uses to link drawings. When you attach a drawing as an 
xref, you link that referenced drawing to the current drawing. Any changes to the 
referenced drawing are then displayed in the current drawing when it is opened.

This is used within Macro Space Management where an architectural drawing can be 
attached as an xref to multiple drawings at the same time. This allows a single 
architectural drawing to be used as a framework on which multiple arrangements of 
zones, fixtures, aisles and merchandise may be planned.

Polyline, (PL)
The Polyline command tells AutoCAD to start drawing using Polylines. There are two 
methods that can be used to activate Polylines:

■ From the Command Line, type PL and press <Return>.

■ From the Draw menu, select Lines - Polyline.

Note: If OSnap is enabled in the status bar, objects can be snapped 
(attached) to each other. If OSnap is not enabled, object are moved 
without being attached. For more information about OSnap, see 
Object Snap (OSNAP).

Note: Using xref's reduces the quantity of data stored, as each 
architectural plan is only used once for each floor and not copied 
under multiple file names.

Note: Use Polylines in Macro Space Management to draw blocks 
instead of Lines.
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Polyline Edit, (PEDIT)
The Polyline Edit command brings up several useful options for Polylines. To edit a 
Polyline, complete the following steps:

1. Click once onto the desired Polyline to select it. The Polyline will change from a 
solid to a dotted line to confirm the selection.

2. To activate the Polyline Edit command, right-click to open the Polyline Edit menu 
or type PEDIT into the command line and press return.

Additional Polyline Edit Options
Close creates the closing segment of the Polyline and connects the last segment with 
the first to make a continuous Polyline.

Regenerate, (REGEN)
The Regenerate command regenerates the entire drawing. It also re-computes the 
screen coordinates for all objects in the current viewport and re-indexes the drawing 
database for the best display and object selection performance.

To use the Regenerate command, do the following:

1. From the command line, type Regen and press <Enter>.

Plan, (2D), views
To change from 3D to 2D view, do the following:

1. From the Command Line, type Plan and press <Enter>.

2. Type World and press Enter to select the type of 2D view desired.

Isometric, (3D), Views
AutoCAD will show three dimensional views if the required compass direction is 
typed in. There are four available: southwest, (SW), southeast, (SE), northwest, (NW), 
and northeast, (NE).

To show a three dimensional view, (or to move from one three dimensional view to 
another), type the compass direction and press <Return>.

For example SW <Return> gives a three dimensional view from the southwest 
direction.
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Figure 0–8 Isometric Views

Erase, (ERASE)
The Erase command can be used to remove lines, shapes, or other AutoCAD objects.

The Erase command can be activated by typing Erase <Return> into the command 
line. It can also be activated from the Modify toolbar, or the Clear option on the Edit 
menu.

After activating the Erase command, select the objects to be erased, then press 
<Return> or right click to erase the object.

Undo, (UNDO)
The Undo command takes you back one operation, undoing the effect of the previous 
operation. To activate the Undo command, do the following:

1. From the command line, enter UNDO and press <Return>.

2. AutoCAD requests the number of steps to undo.

3. Enter a number and press <Return>.

Purge, (PURGE)
The Purge command removes all obsolete or unwanted objects from the drawing.

To purge objects from a drawing:

1. From the command line, enter Purge and press <Return>.

Note: Using the Erase command removes the information from the 
AutoCAD drawing. It does not necessarily remove the information 
from the Macro Space Management central database. This can only be 
done by using the Macro Space Management Synchronize options 
which ensure that the contents of the drawing and the contents of the 
central database are the same.

Note: The previous action can also be undone by using the <Esc> 
key.
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2. The Purge dialog box opens.

3. Select items to purge using the hierarchical tree. After selecting items for purge, 
click Purge or Purge All.

Figure 0–9 Purge Option

AutoCAD Menu Options

File Menu
The File menu allows you to access to a number of general options.

Note: This section of the help file refers to the File menu associated 
with the 2009 version of AutoCAD. If you are using earlier versions of 
AutoCAD, the interface will be slightly different.
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Figure 0–10 Planner - File menu

Table 0–1 Planner - File Menu

Functionality Source Comment

Open Macro Space 
Management

Opens Store Manager

Close Macro Space 
Management

Closes the current 
drawing

Save Macro Space 
Management

Saves the current 
drawing

eTransmit AutoCAD See AutoCAD Help 
File for further 
information.

Export AutoCAD See AutoCAD Help 
File for further 
information.

Publish AutoCAD See AutoCAD Help 
File for further 
information.

Plot AutoCAD See AutoCAD Help 
File for further 
information.

Options AutoCAD See AutoCAD Help 
File for further 
information.

Configuration Macro Space 
Management

Opens the 
Configuration 
Module
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Edit Menu
The Edit menu gives you access to the AutoCAD functionality.

Synchronize Macro Space 
Management

Opens the 
Synchronization 
Module

Refresh Browser Macro Space 
Management

Refreshed the Object 
Browser with the 
latest information 
from the database

Drawing Utilities AutoCAD Calls varying 
AutoCAD utilities - 
see AutoCAD Help 
File for further 
information.

Send AutoCAD See AutoCAD Help 
File for further 
information.

Drawing Properties AutoCAD See AutoCAD Help 
File for further 
information.

Exit Macro Space 
Management

Exits the Module

Note: This section of the help file refers to the Edit menu associated 
with the 2008 version of AutoCAD. If you are using earlier versions of 
AutoCAD, the interface may be slightly different menu.

Table 0–1 (Cont.) Planner - File Menu

Functionality Source Comment
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Figure 0–11 Planner - Edit menu

Table 0–2 Planner - Edit Menu

Functionality Source Comment

Undo Macro Space 
Management

Allows the last 
command(s) to be 
undone. (The exact 
text will vary 
depending on what 
the last executed 
command was).

Redo Macro Space 
Management

Allows the last 
command(s) to be 
undone. (The exact 
text will vary 
depending on what 
the last executed 
command was).

Cut AutoCAD See AutoCAD Help 
File for further 
information.

Copy AutoCAD See AutoCAD Help 
File for further 
information.

Copy with Base Point AutoCAD See AutoCAD Help 
File for further 
information.

Copy Link AutoCAD See AutoCAD Help 
File for further 
information.
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View Menu
The View menu provides the following options:

Paste AutoCAD See AutoCAD Help 
File for further 
information.

Paste as Block AutoCAD See AutoCAD Help 
File for further 
information.

Paste as Hyperlink AutoCAD See AutoCAD Help 
File for further 
information.

Paste to Original 
Coordinates

AutoCAD See AutoCAD Help 
File for further 
information.

Paste Special AutoCAD See AutoCAD Help 
File for further 
information.

Clear AutoCAD See AutoCAD Help 
File for further 
information.

Select All AutoCAD See AutoCAD Help 
File for further 
information.

OLE Links AutoCAD See AutoCAD Help 
File for further 
information.

Find AutoCAD See AutoCAD Help 
File for further 
information.

Note: This section of the help file refers to the View menu associated 
with the 2008 version of AutoCAD. If you are using earlier versions of 
AutoCAD, the interface may be slightly different menu.

Table 0–2 (Cont.) Planner - Edit Menu

Functionality Source Comment
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Figure 0–12 Planner - View Menu

Table 0–3 Planner - View Menu

Functionality Source Comment

Redraw AutoCAD See AutoCAD Help 
File for further 
information.

Regen AutoCAD See AutoCAD Help 
File for further 
information.

Regen All AutoCAD See AutoCAD Help 
File for further 
information.

Display 2D Macro Space 
Management

Displays the drawing 
in Macro Space 
Management 2D 
Mode. (The blocks 
must have been 
configured 
accordingly).

Display 3D Macro Space 
Management

Displays the drawing 
in Macro Space 
Management 3D 
Mode. (The blocks 
must have been 
configured 
accordingly).

Zoom AutoCAD See AutoCAD Help 
File for further 
information.
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Insert Menu
The Insert menu provides ways to attach further information to the store plan.

Pan AutoCAD See AutoCAD Help 
File for further 
information.

Orbit AutoCAD See AutoCAD Help 
File for further 
information.

Walk and Fly AutoCAD See AutoCAD Help 
File for further 
information.

Aerial view AutoCAD See AutoCAD Help 
File for further 
information.

Rotate View AutoCAD See AutoCAD Help 
File for further 
information.

Viewports AutoCAD See AutoCAD Help 
File for further 
information.

3D views AutoCAD See AutoCAD Help 
File for further 
information.

Visual Styles AutoCAD See AutoCAD Help 
File for further 
information.

Toolbars AutoCAD See AutoCAD Help 
File for further 
information.

color Products Macro Space 
Management

Allows products be 
to colored according 
to their general type.

Reports Macro Space 
Management

Allows simple 
reports to be 
produced on objects 
within the current 
drawing.

Drawing Comparison Macro Space 
Management

Allows one drawing 
to be compared with 
another.

Show (Hide) Object 
Browser

Macro Space 
Management

Will show or hide the 
Object Browser.

Show (Hide) Object 
Grid

Macro Space 
Management

Will show or hide the 
Object Grid.

Note: This section of the help file refers to the Insert menu associated 
with the 2008 version of AutoCAD. If you are using earlier versions of 
AutoCAD, the interface may be slightly different menu.

Table 0–3 (Cont.) Planner - View Menu

Functionality Source Comment
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Figure 0–13 Planner - Insert Menu

Format Menu
The Format menu allows you to control the layers, dimensions and units associated 
with the drawing.

Table 0–4 Planner - Insert Menu

Functionality Source Comment

Block AutoCAD See AutoCAD Help 
File for further 
information.

External References AutoCAD See AutoCAD Help 
File for further 
information.

DWF Underlay AutoCAD See AutoCAD Help 
File for further 
information.

Add Architectural 
Plan

Macro Space 
Management

X-Refs an 
architectural plan to 
the currently active 
drawing

Add Title Block AutoCAD See AutoCAD Help 
File for further 
information.

Update Title Block AutoCAD See AutoCAD Help 
File for further 
information.

Bay Numbering Macro Space 
Management

Add numbering to 
the fixtures in the 
store plan
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Figure 0–14 Planner - Format Menu

Note: This section of the help file refers to the Format menu 
associated with the 2008 version of AutoCAD. If you are using earlier 
versions of AutoCAD, the interface may be slightly different menu.

Table 0–5 Planner - Format Menu

Functionality Source Comment

Layer Aliases Macro Space 
Management & 
AutoCAD

Calls a mixture of 
Macro Space 
Management and 
AutoCAD 
functionality.

Layer AutoCAD See AutoCAD Help 
File for further 
information.

Layer States Manager AutoCAD See AutoCAD Help 
File for further 
information.

Layer Tools AutoCAD See AutoCAD Help 
File for further 
information.

Dimension Style AutoCAD See AutoCAD Help 
File for further 
information.

Units AutoCAD See AutoCAD Help 
File for further 
information.
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Modify Menu
The Modify menu allows you to modify objects in the store plan.

Figure 0–15 Planner - Modify Menu

Drawing Set Up Macro Space 
Management

Allow the user to 
select the scales for 
Paper space.

Note: This section of the help file refers to the Modify menu 
associated with the 2008 version of AutoCAD. If you are using earlier 
versions of AutoCAD, the interface may be slightly different menu.

Functionality Source Comment

Properties AutoCAD See AutoCAD Help 
File for further 
information.

Match Properties AutoCAD See AutoCAD Help 
File for further 
information.

Change to ByLayer AutoCAD See AutoCAD Help 
File for further 
information.

Object AutoCAD See AutoCAD Help 
File for further 
information.

Table 0–5 (Cont.) Planner - Format Menu

Functionality Source Comment
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Calculations Menu
The Calculations menu enable you to initiate various calculations that enter data into 
the central Macro Space Management database.

Figure 0–16 Planner - Calculations Menu

Express Menu
The Express menu provides quick access to commonly used AutoCAD functionality.

Clip AutoCAD See AutoCAD Help 
File for further 
information.

Erase AutoCAD See AutoCAD Help 
File for further 
information.

Copy AutoCAD See AutoCAD Help 
File for further 
information.

Array AutoCAD See AutoCAD Help 
File for further 
information.

Move AutoCAD See AutoCAD Help 
File for further 
information.

Rotate AutoCAD See AutoCAD Help 
File for further 
information.

Blocks Macro Space 
Management & 
AutoCAD

Calls a mixture of 
Macro Space 
Management and 
AutoCAD 
functionality.

Attributes Macro Space 
Management

Allow the user to 
select the scales for 
Paper space.

Text Macro Space 
Management & 
AutoCAD

Calls a mixture of 
Macro Space 
Management and 
AutoCAD 
functionality.

Functionality Source Comment
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Figure 0–17 Planner - Express Menu

Help Menu
The Help menu contains a number of options that access Help and Assistance.

Note: This section of the help file refers to the Express menu 
associated with the 2008 version of AutoCAD. If you are using earlier 
versions of AutoCAD, the interface may be slightly different menu.

Note: This section of the help file refers to the Help menu associated 
with the 2008 version of AutoCAD. If you are using earlier versions of 
AutoCAD, the interface may be slightly different menu.

Table 0–6 Planner - Help Menu

Functionality Source Comment

AutoCAD Help AutoCAD See AutoCAD Help 
File for further 
information.

New Features 
Workshop

AutoCAD Not yet available

Planner Help Macro Space 
Management

Calls Macro Space 
Management's Help 
File for this module.
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Drawing Simple Objects

Drawing using Polylines
Simple objects can be drawn using the Polyline option.

It can be initiated by typing PL into the command line. Alternatively, it can be invoked 
from the Draw menu or from the AutoCAD drawing toolbar.

Figure 0–18 AutoCAD - Polyline

When drawn, Polylines can be edited using the Polyline Edit, (PEDIT), option.

Additional Resources AutoCAD See AutoCAD Help 
File for further 
information.

Customer 
Involvement 
Program

AutoCAD See AutoCAD Help 
File for further 
information.

About AutoCAD Gives the AutoCAD 
version.

About Planner Macro Space 
Management

Gives the Planner 
version

Table 0–6 (Cont.) Planner - Help Menu

Functionality Source Comment
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Drawing Rectangles
Rectangles can be drawn using the <Rectangle> option from the Draw menus or the 
drawing toolbar.

Figure 0–19 AutoCAD - Rectangle

Clicking on this icon will return the cursor to the drawing screen. Left click to establish 
the start point of the rectangle. The cursor can then be dragged with the mouse to the 
other corner and left clicked again to define the size.

Alternatively, the "X" and "Y" dimensions can be entered in the text box associated 
with the cursor after left clicking to establish the start position. Type in the "X" 
dimension; use the <Tab> key to move to the next text box and type in the "Y" 
dimension. Click <Return> to finish drawing the rectangle.

Drawing Polygons
Polygons can be drawn using the Polygon option from the Draw menu or the drawing 
toolbar.
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Figure 0–20 AutoCAD - Polygon

AutoCAD will require the number of sides. Enter a number and press <Enter>

AutoCAD will then require the position of the centre of the polygon. Either drag the 
cursor to the requited place and left click, or enter the required X and Y co-ordinates. 
(Use the <Tab> key to move between X and Y co-ordinates and press <Enter> to 
complete).

Select whether the polygon is to be inscribed within a circle or circumscribed about a 
circle. Press <Enter>.

Specify the radius of the circle. Either drag the cursor to the required radius and left 
click or entering the required dimension and press <Enter>

Drawing circles
Circles can be drawn using the <Circle> option from the Draw menus or drawing 
toolbar.
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Figure 0–21 AutoCAD - Circle

Clicking on the option will return the cursor to the drawing screen. Left click to 
establish the start point of the circle. The cursor can then be dragged and left clicked 
again to define the size.

Alternatively, the X and Y dimensions can be entered in the text box associated with 
the cursor to establish the start position. Next type in the required radius. Press 
<Return> to finish drawing the circle.

Making Objects 3-Dimensional
2 dimensional objects can be made 3 dimensional by using the Extrude command. To 
use the Extrude command, complete the following steps:

1. From the AutoCAD command line, type Extrude and press <Enter>.

2. AutoCAD will ask you to select an object. Click on the required object - the lines 
will turn from solid to dotted to indicate the object has been selected. Press 
<Enter> to confirm selection that object.

3. AutoCAD will then ask for the height to be specified. Type in the required 
dimension and press <Enter>.

4. Enter any angle required and press <Enter>.

The object will then become three dimensional.

Manipulating Simple Objects

Rotate, (ROTATE), command
The Rotate command can be used to manipulate objects.
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It can be activated by typing Rotate <Return> in the command line. It can also be 
activated by selecting the Rotate icon in the Modify toolbar or the Rotate option in the 
Modify menu.

Objects are rotated by selecting them, specifying the base point, then specifying the 
rotation angle.

Attaching objects to each other using MOVE
(OSnap must be enabled).

Type Move in the command line and press <Return>. Alternatively click on the Move 
icon in the Modify toolbar

Select the first required object by clicking on it. The solid outline will turn to dotted. 
Press <Return> to confirm.

Move the cursor to any corner of the object. A small cross will appear on the object. 
This is the base point. Press <Enter> or left click to confirm.

Move the cursor to the second object it is desired to attach, (snap), the first to. A small 
cross will appear by any corner the cursor is by. When the required corner has been 
located press <Enter> or left click to confirm. The two objects will then become 
attached.

Turning Objects into Blocks

Overview of Turning Objects into Blocks
A block is a generic term for one or more objects that have been combined to create a 
single object.

Converting object(s) into blocks that can be used in Macro Space Management is done 
in stages as described below:

1. The object is turned into an AutoCAD block.

2. The AutoCAD block is written to a Macro Space Management fixture library using 
the Wblock command. This turns the AutoCAD block into a Macro Space 
Management Block.

3. The Macro Space Management Block is given a slide to assist in visual selection.

4. The Macro Space Management Block is assigned Block properties. This makes it 
intelligent, allowing many of the more sophisticated Macro Space Management 
functions to operate.

This portion of the Help File deals with converting object(s) into AutoCAD blocks. 
Macro Space Management Block operations are dealt with in the Block section of the 
Help File.

Creating AutoCAD Blocks
When the Make Block option has been selected, the Block Definition dialog box will 
appear.
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Figure 0–22 Block Definition

It is recommended that any selection operations are carried out on 3D drawings.

Name is a unique identifying name of up to 255 characters.

Pick point is the insertion point of the block. It can either be identified in terms of X, Y, 
and Z co-ordinates; or it can be selected from the drawing.

If selected from the drawing then the dialog box will temporarily close while the pick 
point is selected. This is done by moving the cursor over the block. Available pick 
points will show as crosses. Left click or press <Return> to select. The dialogue box 
will then reappear.

Objects are selected by left clicking on the on the Select Objects button. This 
temporarily closes the dialogue box. Select the required objects by left clicking to 
identify the start position, dragging the cursor so the required objects are within the 
selection box, then left clicking again to define the selection box. Right click or press 
<Return> to complete selection and the dialogue box will reappear.

Settings allow the required dimensions to be selected. Ensure that these are set to 
metric or imperial units depending on which units Macro Space Management is using.

It is also possible to enter a more extended description of the block - for example 
Freezer Unit: Type A.

When all the required options have been selected, click on OK to create the block.

Accessing the AutoCAD Create Block Option
The AutoCAD Create Block option can be accessed in two ways.

Note: the selected insertion point of the block should be the same as 
the one that will be selected later for the Macro Space Management 
block details. If they differ, unpredictable effects could occur when 
inserted into a drawing.
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There is a Make Block icon on the Modify toolbar - click this to activate the option. 
Alternatively, the Block Description option can be selected from the Modify menus.

Figure 0–23 Block Definition
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Windows Terminology

Buttons
Buttons are used to select from available options.

In the screen above, there are three buttons available within the Action frame. These 
are labeled Add, Remove, and Exit.

Using the mouse cursor, left clicking on any of these buttons will initiate the relevant 
action.

Check box
Check boxes are used where one or more options can be selected from a list.
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In the figure above, there are five check boxes available in the Options Frame.

Selected options are shown by a small tick, while the box for unselected options 
remains blank. In this case only the Auto Close check box has been selected.

If the option is not available, then the check box is greyed out.

Control Key
In Macro Space Management and In-Store Space Collaboration Help Files there are 
references to keyboard shortcut keys such as <Ctrl + A>.

This means that you must hold down the Control key on the keyboard (marked Ctrl) 
and press the A key.

Similarly, <Ctrl + P> means holding down the Control key on the keyboard (marked 
Ctrl) and pressing the P key.

Dialog Box
A dialog box is a small window that appears when you click on a menu or toolbar and 
contains further options.
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In the above example, the dialog box contains a series of options for Bay Sequence 
Numbering. Note that the options can be accessed in different ways including buttons, 
check boxes, and radio buttons.

Drop down list
A drop-down list represents a list of alternatives for selection. Normally only the 
current value shows, the full list can be seen by clicking the down arrow on the 
selected field.

Drop-down lists are indicated by a small downward arrow to the right hand side of 
the current field.

Drop-down lists are activated by left clicking on either the selection box or the arrow. 
Selections can be made by highlighting the required option with the mouse pointer, 
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and then left clicking. Once an option is selected, the drop-down list collapses, leaving 
only the current value showing.

In the above example the current value for Opened Date field is Open. Clicking on the 
current value has revealed a list of alterative options, from which another can be 
selected.

If the full drop down list is not visible, scroll bars will appear to allow the user to run 
forwards or backwards through the alternatives.

Frame
Frames are sub-sections of a dialog box, toolbar, and so on.

In this example of a dialog box there are three frames.

Along with the Action frame that has been outlined, there are also Select Bays and 
Group frames.

Graying out
When buttons or other options are not available, the text turns from black to grey. 
Similarly check boxes turn from white to grey if they are not available.

In this example, the Extend if fixture is longer check box is not selected and the 
Extend Shelves and Fill with Product check boxes are grayed out and not available.

When the Extend if fixture is longer checkbox is selected, the Extend Shelves and Fill 
with product options will no longer be grayed out and become available.
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Maximize, Minimize, and Close Buttons
Maximize, Minimize, and Close buttons can generally be found at the top right side of 
the title bar.

■ The Minimize button appears on the left and minimizes the visible screen, leaving 
only an annotated button on the status bar at the bottom of the window.

■ The Maximize button appears in the center and restores the window to full size if 
it has been set to a smaller size.

■ The Close button appears on the right and closes the window. In most of the 
modules, a warning message appears that prompts you to save the data or 
changes before closing the window.

Menu
A Menu is a list of options.

Menus are accessed from menu bars or by right clicking the mouse in a suitable part of 
the window (pop-up menus).

Options are selected from the list by highlighting the one required with the mouse 
pointer, and then left clicking.

Menu bar
A Menu bar is a list giving access to a series of drop-down menus. Menu bars are text 
based.

In the example above, the menu bar gives access to a series of drop-down menus 
including File, Edit, View, and Insert.

Mouse Actions
Many actions in Macro Space Management are controlled using a Mouse device.

The Mouse device controls the movement of the mouse pointer. The mouse cursor is 
used to navigate on screen or through objects before the left or right buttons on the 
mouse are clicked to perform an action.

■ The left hand button is typically used to select and click items, position the cursor 
in a document, and drag items. Using the left button in this manner is called left 
clicking.

■ The right hand button is typically used to display menus of tasks or options that 
change depending on where you click. Using the right button in this manner is 
called right clicking.

■ The scroll wheel can be used to move the displayed area up or down. It can also be 
clicked to perform other functions.
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Some functions are activated by clicking a button twice in quick succession. This is 
called double clicking. Double click speeds can be changed using the Windows 
Control Panel.

Drop Down menu
Drop Down menus are normally activated from Menu bars. Left clicking activates the  
menu, from which further selections can be made.

In this example the Modify menu has been activated.

Radio button
Radio buttons are used when only one selection can be made from a list.
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In the above example two mutually exclusive options are available. The Add radio 
button has been selected to add bay numbers.

Clicking on the Remove button would switch to this option, with the Add option 
deselected.

Scroll bars
Scrollbars are used when the information to be displayed is larger than the available 
area. They can be used to move the displayed area left or right and up and down.

The scrollbar on the right of the displayed area has been highlighted in red. It can be 
used to move it up and down.

The scrollbar at the right of the displayed area has been highlighted in blue. It can be 
used to move it left and right.

Spin control
Spin controls are used when a variable has to be changed within a specified range.
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As an example Macro Space Management has a series of options in the Configuration 
module to change standard parameters within the software.

The Pointer Size and Line Size options in the Connection Points frame can be adjusted 
by clicking on the up or down arrows beside the figure.

Splitter bar
Splitter bars are used in the Macro Space Management environment. They are used to 
open and minimise windows in the Object Browser.
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In the above example the Merchandise and Properties windows are open, while the 
Summary and Preview windows are closed.

The Properties window can be closed by left clicking on the Properties splitter bar. It 
can be opened again by a second left click.

Status bar
The Status Bar is found at the bottom of the screen.

Within the Macro Space Management and In-Store Space Collaboration environments 
it often contains information as to selections made, or options that can be toggled on 
and off.

Sub-menus
Sub-menus are secondary menus that appear when an option is selected on the main 
menu.
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Sub-menus are always indicated by small triangles to the right of the option on the 
main menu. In this example three options on the main menu have a sub-menu.

Options on sub-menus are selected by highlighting the required option on the main 
menu with the mouse pointer, then bringing the mouse pointer over to the sub-menu 
to highlight the required option. The option can then be activated by left clicking with 
the mouse.

In the above example, the Lines option has been selected on the main menu and the 
Polyline option is about to be selected on the sub-menu.

Tabs
Tabs are used to organize options within a dialogue box when that dialogue box 
contains a large number of options.

In the above example of a dialogue box, the Fixturing tab has been selected. This has 
given access to a range of options that can be modified as required.

Clicking on the Zones or Merchandising tabs would give access to alternative options 
appropriate to those functions.
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Title bar
The Title Bar is a small panel at the top of a window or dialog box that displays the 
name of that item.

In the example above, the dialog box has been labeled as Bay Sequence Numbering so 
the user is aware of its purpose.

Toolbar
Toolbars are similar to menu bars, in that they are used to activate further options. 
The primary difference is that the options within toolbars are indicated by icons rather 
than text.

Toolbar Icons and Tool Tips
Icons are pictorial representations of options that can be accessed.

Icons are selected by pointing the mouse cursor over the icon, and then clicking the 
icon.

If the mouse pointer is left over the icon for a few seconds, a tool tip for the icon will 
appear. In the example above, the text "Polyline" appears for the icon.

Here the Polyline icon is about to be selected. This is shown by its slightly raised 
appearance compared to the other icons.
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Definitions - A

Access Rights
Access Rights are the privileges that users have to access the various parts of Macro 
Space Management. Some users, for example Administrators, will have new universal 
access rights. Other users will have more restricted access rights and will only be able 
to use a limited number of the parts of Macro Space Management. Access rights are 
sometimes called Privileges.

Aisle
An Aisle is designated by a line and represents a theoretical path though a store. It is 
generally bordered on one or both sides by fixtures. The line representing the aisle is 
an AutoCAD Polyline and can take the form of any number of interconnected straight 
lines and arcs. Aisles are used to further define the relationship between fixtures and 
products.

Aisle adjacency
Aisle adjacency establishes which planograms share a common aisle. It is similar in 
concept to product adjacency, but enables the correlations between planograms to be 
analyzed over a larger area than the more specific correlation done for product 
adjacency. Planograms can have aisle adjacency if they are in bays or bay groups that 
share a common aisle. The exact method used to calculate the adjacency depends of 
settings within Macro Space Management. Aisle adjacency is calculated by 
establishing the distance to the nearest aisle in four 90 degree opposed directions. The 
aisle selected is the closest aisle to the fixture that falls within a predetermined 
tolerance.

Annotation
Annotation is the information printed on the drawings containing information on the 
fixtures and products placed on that drawing. Annotation is customizable within the 
Configuration Module.
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Architectural Drawing
An Architectural Drawing is a detailed dimensional drawing of the floor of a store. It 
may also include other information such the position of gas, electrical and water 
services, etc. It is often used, (by means of xrefs), as the basis for store plans.

Adjacency
Adjacency is the relationship of certain classes of object within Macro Space 
Management to one another. There are three different types of adjacency; fixture, 
product and aisle. They are used for differing purposes.

Fixture adjacency is used to establish which fixtures are treated as having a 
relationship with each other. This could be for bay numbering, gondola numbering 
and other purposes. Planograms can have two forms of adjacency to one another. The 
first depends on the relationship of their parent fixtures to each other and is known as 
product adjacency.

Planograms can also have a relationship with each other depending on the 
relationship of the parent fixtures to any aisles that may have been placed. This is 
known as Aisle Adjacency. It is important to note that slightly different rules apply for 
aisle, fixture and product adjacency. For example a specific bay might be adjacent to 
another bay by the rules of fixture adjacency, but the product in those bays might not 
be adjacent by the rules of product adjacency.

Area calculations
Area calculations are performed to establish what area a fixture is visible from for 
sales purposes. It is calculated by measuring out in the specified directions from the 
fixture until another object is reached, or the measuring reaches the limit of the 
tolerances set in the Configuration Module.

The area is then adjusted to allow for any overlaps it might share with nearby features. 
It is also adjusted to allow for any zone or departmental boundaries. The resulting 
calculated area is a good indication of the space from within which the customer can 
view the fixture.

Authorized Status
Authorized status is given to objects or plans that have been approved for use, but 
have not yet reached their Effective Date and gained Current status.

Definitions - B

Base Height
Base height is the minimum height at which any product can be placed.

Base Linear
See Nominal Base Linear.
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Bays
Fixtures and gondolas are sub-divided into bays. These bays are allocated numbers to 
simplify identifying locations.

A fixture will be assigned a single bay number. Gondolas, which comprise a number 
of fixtures, may have two or more bay numbers associated with them.

Bay Groups
Bay Groups are two or more fixtures that have been linked together to so they are 
treated as a single bay during bay numbering operations. Bay groups may also be 
treated as a single bay during adjacency calculations.

In the above illustration the yellow bays have been designated a bay group and have 
been numbered accordingly.

All other bays have been numbered as single fixtures.

Birth Date
The Birth Date is the date at which an object becomes active.

Birth Dates are associated with the Status of Stores, Floors and Revisions.

The Birth Date is the date at which the Store, Floor or Revision becomes active.

Block
A Block is a collection of data describing (for example) a fixture or fitting. It can be 
regarded as a drawing in its own right which, when inserted into a floor plan, also 
inserts all the information associated with that drawing.

Macro Space Management contains a library of blocks.

Blocks are normally drawn within AutoCAD and imported into Macro Space 
Management.

Block types
There are a variety of block types. These include:

Note: There is a difference between AutoCAD blocks and Macro 
Space Management blocks. AutoCAD blocks are normally called 
blocks. Macro Space Management blocks are called MSM blocks.
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■ Composite Blocks

■ Fitting Blocks

■ Fixture Blocks

■ Other Blocks

■ Part Blocks

■ Product Blocks

■ Reference Blocks

■ Shelf Blocks

■ Title Blocks

■ Unknown blocks

There are also:

■ Database Blocks

■ Drawing Blocks

See individual entries for more information.

Brown goods
A term often used to describe goods that will be used in the living room and bedrooms 
of a house.

Such goods include televisions, sound systems, computers, etc.

Definitions - D

Database Block
A Database Block is a block that has been read from the Macro Space Management 
Central Database. (Conversely, a Drawing Block is a block that has been read from an 
AutoCAD drawing).

Death date
The Death Date is the date at which a current object is no longer active.

Drawing Block
A Drawing Block is a block that has been read from an AutoCAD drawing. 
(Conversely, a Database Block is a block that has been read from the Macro Space 
Management Central Database).

Dumb Block
A Dumb Block is one that has not yet had any block properties associated.

Definitions - E
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Effective Date
The Effective Date is the date at which an object becomes active.

Exclusion
Exclusion is an option within Block Properties.

Any object set for exclusion will not appear in calculations or reports.

Explode on Insert
Explode on Insert is an option in the Block Details Module. Selecting it means a 
composite block is split back into its constituent parts on insertion into a drawing. The 
individual components can then be manipulated separately.

Definitions - F

Fence
A Fence is an AutoCAD method of selecting objects on a drawing. It is invoked by 
typing Select into the AutoCAD command line, followed by Fence to specify the 
method. The user can then use the mouse to specify a multi-segmented line on the 
drawing. Any object by the line will be selected.

File
Files can exist at every level in the hierarchy with the exception of clusters.

Files can be of multiple types and formats. The icon in the example above is that of an 
AutoCAD file, but Word, Excel, Bitmap and many other file types can also be used 
within Macro Space Management.

Files can be imported, linked to, copied, created or deleted using the various Store 
Manager Tools. They can also be displayed in varying ways.

Filtering of planograms
A retail operation may create many thousands of planograms. When populating a 
store, the required planograms must be quickly and efficiently filtered from those 
available. This operation is often called profiling.

Some profiling/filtering is done by the use of layers. When populating a fruit and 
vegetable fixture, Macro Space Management automatically selects fruit and vegetable 
planograms.

Other profiling is user controlled. For example, it is possible to select all planograms 
over a certain height, or those designed for a specific season.

Within Macro Space Management, planogram selection is done via the Profiling 
sub-module.

First Slot
First slot is the height of the first slot, (for example on a peg board), above the height 
of the base of the fixture.
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Fitting blocks
Fitting Blocks are blocks containing details of specific fittings.

Fixture adjacency
Adjacent fixtures are fixtures that are touching, or within a specified proximity to 
each other.

In the diagram all yellow colored fixtures are adjacent to the white fixture.

All fixtures that Macro Space Management identifies as having adjacency in a drawing 
are treated as a gondola for planning purposes.

Note: There is a difference from product adjacency.

Fixture blocks
Fixture Blocks are blocks containing details of specific fixtures.

Note: Base Height can be set using the Base Height in the Fixture 
Dimensions Frame of the Size Tab in the Block Definitions dialog box.
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Fixture Dimensions

Actual Height is the specified height of the block.

Actual Depth is the specified depth of the block.

Base Height is the minimum height at which product could be placed.

Inside Height is the height to the inside of the upper part of the fixture.

Lip Height is the height to the top of the lip of the fixture.

Product Offset is the dimension that has to be subtracted from the Actual Depth to 
give the available depth that can be populated by product.

Product Depth is the depth to which it is desired to populate the fixture with product.

Fixtures, fittings and shelves
Fittings are items within a store that aid the retail effort, but do not themselves hold 
merchandise. Examples are display material and checkout counters.

Some fittings are used to support or augment fixtures. For example a shelving unit 
could be made up of support legs, (a fitting), and shelves, (a fixture).

Fittings always remain separate items on the drawing, (and can be hidden from view 
using the Hide Fittings command).

A Fixture is a structure designed to hold products for sale. It can take many forms 
including runs of shelving, display cabinets and kiosks.

A fixture can hold product directly, or via shelves. A shelf always has a parent fixture.
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As well as the obvious definition of a Shelf, it can be used as a generic description as 
equipment within a fixture which can hold product.

For example a backboard might hold several support bars. The support bars could in 
turn have rods attached. Product could then be hung from those rods. The 
arrangement of rods emanating from a single support bar is generically called a shelf 
for planning purposes.

Each shelf or fixture always has a product base associated with it. This serves as a 
placeholder for any merchandise placed on it.

Fixtures and fittings are often color coded as to purpose. As an example, fixtures 
holding groceries might be drawn in green, fixtures holding chilled goods in blue.

Floors

A Floor is a distinct physical level within a store. It can only be associated with a 
specific store and will not be found elsewhere in the hierarchy.

A Floor can have architectural drawings associated with it. These can only be 
associated at this level.

A floor can also contain single or multiple revisions, (specific arrangements of fixtures 
and fittings). The drawings associated with these revisions have to be contained at the 
revision level.

Any connection between drawings in revisions and architectural drawings has to be 
made using xrefs.

Footprint
The Footprint is calculated from the X and Y dimensions of an object; in effect by 
multiplying the length and the width.

This calculation works best for square and rectangular objects. It is less effective for 
circular and polygonal objects.

In these cases it may be preferable to input a nominal area in the Sizes tab of the Block 
Details module.

Nominal Area

Front
All fixtures have a designated Front direction. This is the section of the fixture where 
the customer typically stands to select their products.

Front directions are set in the Block Details Module.
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Global Change
A Global Change is a change made to Macro Space Management that affects all users 
simultaneously.

If, for example, the Update Database option is used in the Configuration Module to 
change the name of a specified database, then all Macro Space Management users will 
read and write information to that new database.

A record of all current settings is stored in a Profile.

Gondolas
A Gondola is an arrangement made up from two or more fixtures linked together by 
means of connection points or in sufficiently close proximity to meet the definition of 
adjacency. An example might be a run of 10 fixtures placed back to back, with end 
caps on each end to maximize the area devoted to sales.

Gondolas are internally sub-divided into sections, each new section beginning where 
fixtures go through more than a 30o change of angle when connected.

Gondolas are often color coded as to purpose. For example gondolas holding groceries 
might be drawn in green, fixtures holding chilled goods in blue.

Note that single fixtures are numbered as gondolas if the Gondola Numbering option 
is used.

Gross Area - Zones
The Gross Area of a Zone is the total area of a Zone before any Holes or other 
non-usable areas have been taken into account.

Groups
Groups are collections of fixtures and gondolas that have been linked within Macro 
Space Management so they can be subjected to collective operations such as moving or 
rotating.

Definitions - H

Hierarchical structures
A Hierarchical structure is one where objects are organised in the form of a tree. The 
more fundamental data is close to the trunk, while the more dependent data is further 
out on the branches. The most fundamental part of the hierarchical structure is the 
root.
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Hierarchical structures are used to allow objects to be set out in a logical relationship 
to each other.

The Stores cluster contains the Prototypical sub-cluster. This sub-cluster contains the 
Large Prototype store. The Large Prototype store has a 'Level 1' floor, and that floor 
contains the Prototype revision.

The Store cluster is closest to the trunk, while the New Dover Layout revision is the 
most dependent data.

Historical Status
Anything that was once current and has now been taken out of service has Historical 
status.

Generally drawings with Historical status can only be viewed in read only mode, and 
cannot be directly re-used within Macro Space Management.

Hole - Zones
A Hole is an area cut into a Zone to represent a pillar or similar obstruction.

Its area is subtracted from the Gross Area of the Zone to give the Net Area.

Definitions - I

Insertion points
The Insertion Point is the point at where a fixture, fitting or gondola is located on the 
drawing. It can be designated anywhere within the fixture during the drawing stage 
and appears as a small blue square.

Insertion points can be revealed by left clicking on any line within the drawing of the 
fixture, fitting or gondola.
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The position of the Insertion Point is defined in the Block Details module.

Inside Height
The Inside Height of a fixture is the height after the thickness of any top section not 
suitable for merchandising has been subtracted.

For example, if a fixture is 2000 mm high, but it has a 100 mm pelmet, then the Inside 
Height is 1900 mm.

Internal Area
The basis for any store plan is normally an Architectural Drawing. This is normally 
xrefed to another AutoCAD drawing to act as a blueprint for the arrangement of 
zones, fixtures, fittings and merchandise.

The first zone to be drawn is often the Internal Area Zone. This defines the maximum 
area available for sales activities.

The Internal Area can include both Sales and Non-Sales areas.

It is also possible to draw both sales and non-sales Zones outside of the internal area. 
Any Zones outside the Internal Area will not be included in any Area Calculations.

Definitions - K

Key Performance Indicator
Key Performance Indicators, (KPI's), are used to give an overview of the efficiency of 
the merchandised layout.

They are presented in the form of color coding to show performance against specific 
criteria.
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KPI's present a general view of how sales income is performing.

KPIs
This abbreviation means Key Performance Indicators. See the appropriate section.

Definitions - L

Layers
AutoCAD drawings are often divided into Layers. Each layer contains a specific type 
of information. For example one layer might contain information on fixtures, another 
data on electrical wiring.

Layers can be further sub-divided into aliases. Each aliased layer will contain very 
specific information. For example, one aliased layer might contain derails of all the 
fixtures capable of holding chilled goods; another all fixtures holding fruit and 
vegetables.

Layers are one method used by Macro Space Management to filter fixtures, 
planograms, etc.

Local Change
A Local Change is a change made to Macro Space Management that affects only the 
user's computer - typically the Registry settings will be changed on that computer.

Local changes are often made to customize the operation of the software so that it 
meets the user's individual preferences. An example of this would be enabling or 
disabling Sounds in the Configuration Module.

A record of all current settings is stored in a Profile.

Log File
Log files are files recording problems during operation of Macro Space Management. 
This enables problems to be investigated at a later date.

Their location is specified in the Directories tab of the Configuration Module

Definitions - N

Net Area - Zones
Net Area is the area remaining in a Zone after Holes have been taken into account.

Nominal Area
Nominal Area is a value that can be set in the Size tab of the Block Definitions module 
by the Macro Space Management user.
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It overrides the Footprint that would otherwise be calculated from the X and Y 
dimensions of the object.

Nominal Areas are often used when the object is not a square or rectangular shape.

For example a circle would have a footprint calculated from the product of two 90 
degree opposed diameters. This Footprint would be 27% greater than the area of the 
equivalent square.

Footprint

Nominal Base Linear
Nominal Base Linear is a measurement used when the populatable length of a fixture 
is different from the actual length.

An example would be a chest freezer, where the actual length of the unit would be 
greater than the length available to place product.

Another use would be a non-rectangular fixture, such as a curved one. In this case a 
Nominal Base Linear dimension would be entered to facilitate Area Calculations.

Definitions - O

Objects
There are varying classes of data used within Store Manager. Each distinct class of 
data is described as an Object. Objects include:

· Store root.

· Clusters.

· Sub-clusters.

· Stores.

· Floors.

· Revisions.

· Files.
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For administrative purposes, these objects are organised within a hierarchy. They 
often have a status, and their use is governed by rules.

Other block
An Other Block is a block that contains architectural information.

Definitions - P

Parent-Child Relationships
Some objects within Store Manager are linked together in such a manner that changes 
to one object may result in changes to other objects linked to it. Such objects are 
described as being in a Parent-Child relationship. The object that has dependent 
objects associated with it is known as the parent, while the objects that are associated 
with the parent object are known as the children.

In a hierarchical structure, children of one parent can be parents of their own children 
in turn.

When the status of a parent object is changed; it can result in changes to the status of 
child objects. Similarly, the status of parent objects can sometimes only be changed 
when the status of the appropriate child object is correct.

When a parent object is deleted, it affects all the associated child objects. Conversely, a 
child object can often be deleted without affecting the parent.

Part Blocks
A Part Block is a block that contains information on a specific type of part.

P_Base
Also called a Product Base, a P_Base is a class of object within Macro Space 
Management that is capable of showing the presence of a planogram.

Planograms cannot be placed unless the fixture has had a generic P_Base designated. 
Every fixture must therefore contain at least one P_Base.

When the planogram is placed, a simple rectangular slab will be drawn on each shelf 
on the fixture to show that product has been placed.

P_Bases are a type of Product Base.

PDA File
A PDAfile is a form of AutoCAD file that is produced when a Revision is made 
Current.

A PDA file can be used in hand held devices or for In-Store Space Collaboration.

Perimeter Gondola
A gondola that follows a wall or other structural feature.
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Planogram substitution
Planogram Substitution allows the replacement of a currently planogram type with 
that of a selected replacement.

Depending on the options available and specified, replacement can be universal for 
the selected floor, store or group of stores - all required planograms are replaced in a 
single operation.

More complex substitutions require Macro Space Management Enterprise - a version 
with automatic updating facilities.

Planograms
Planograms are objects within Macro Space Management that hold details of 
merchandise to be placed into the fixtures within a store. Planograms define the type, 
quantity and arrangement of the sales goods to be placed in the bay(s). They are 
designed to maximize sales revenue by placing the optimum combination of products 
into the available sales space.

Planograms are infinitely flexible and can be configured to hold any combination of 
products.

Planograms are placed in fixtures and gondolas, but must be of suitable configuration 
for that specific fixture or gondola.

Privileges
Privileges are the rights that users have to access the various parts of Macro Space 
Management.

Some users, for example Administrators, will have near universal access rights.

Other users will have more restricted access rights and will only be able to use a 
limited number of the parts of Macro Space Management

Privileges are sometimes called Access Rights.

Product adjacency
Product Adjacency is used to establish which planograms are in proximity to each 
other. A product can be adjacent to the products on the fixtures to its left and right, 
and to other planograms that might share the same fixture.
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The products in the yellow fixtures are adjacent to the product(s) in the blue fixture. 
Product in the red fixtures is not adjacent to the product(s) in the blue fixture.

Note: There is a difference from Fixture Adjacency

Product adjacency can then be used establish if two of the planograms fall within 
previously determined rules.

These rules might determine if planograms should be associated to improve product 
sales; for example pasta being adjacent to pasta sauces.

These rules might also determine if planograms should not be associated. For 
example, fresh meat planograms should not be placed in proximity to planograms 
containing dairy products.

Product Base
A Product Base is also called a P_Base.

See the entry for P_Base for the definition.

Product block
A Product Block is the generic description of block that will be used to locate 
planograms. Planograms cannot be placed without a product block being present on 
the fixture.

Product Bases, (P_Bases), are a specific type of Product Block.

Product colors
An alternative form of presentation for the efficiency of the merchandised layout is in 
the form of Product colors. Each bay is allocated a color relative to the class of layout 
group it belongs to. This enables the general form of the layout to be seen at a glance.

Product coloring allows the Macro Space Management user to concentrate on specific 
details of the merchandising arrangement within the store.

Product Depth
Product Depth is the maximum depth a product can occupy on a shelf.

For example a fixture might be 1000 mm deep. The back wall might be 100 mm thick 
and the front lip 100 mm thick.

This leaves a Product Depth of 800 mm.

Product Offset
Product Offset is the distance that has to be allowed from the back of a fixture for 
anything that might reduce the depth. For example a fixture might be 1000 mm deep 
with a back wall be 100 mm thick.

This leaves a maximum available depth for product of 900 mm.

Products
A Product is a single type of merchandisable item.

■ Jasmine rice is one type of product.

■ Basmati rice is another type of product.
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■ Japonica rice is a third type of product.

■ Short grained rice is yet another type of product.

Products can be combined in a Planogram to give a planned combination of products 
filling part of all of a fixture.

For example, a Rice planogram might contain specified amounts of Jasmine, Basmati, 
Japonica, short-grained, and other types of rice.

Profiling
See filtering of planograms.

Promotional Fixtures
Promotional Fixtures can be assigned within a gondola by selecting a fixture or 
fixtures and clicking on the Fixture Attribute icon in the toolbar.

Promotional Fixtures are normally used for reporting purposes.

They are assigned by selecting a fixture then selecting the appropriate option from the 
toolbar menu.

Fixtures designated as Promotional can be identified by using the highlight option. 
Alternatively, they can be identified by running a report on the drawing or by using a 
KPI.

Prototype store
A Prototype Store is a store that is used as a basis for comparison for other stores 
within the Store Manager hierarchy.

Prototype Stores can be theoretical; designed by marketing staff as an exemplar of 
what a store should be. They can also be practical examples selected from operational 
stores.

There can be many Prototype Stores, but each operating store can only have a single 
Prototype Store assigned to it at one time.

Prototype status can be assigned to a store by editing its properties.
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Publish date
The Publish Date is the date at which a previously authorized file is issued to the 
stores.

The file will not become current until the Effective date is reached.

Definitions - R

Reference Block
A Reference Block is a block containing information on how to present Bay 
numbering.

Depending on the type of Reference Block chosen, bay numbering can be written onto, 
(for example), oval, round, elliptical or rectangular backgrounds.

Report Studio
Report Studio is a module within Macro Space Management that contains a number 
of standard reports.

This module is now being superseded by BI Publisher.

Additional customised reports can be produced by Oracle at the customer's request.

Revision
A Revision is used as a folder to hold a set of files that refer to one specific 
arrangement of the fixtures, fittings and merchandise on a floor.

Floors can have many revisions. For example a floor could have Spring, Summer, 
Autumn and Winter revisions, each representing a planning arrangement to be used at 
the appropriate time.

Floors can also have different revisions showing different marketing mixes, fixture 
arrangements, etc.

Any connection between drawings in revisions and architectural drawings has to be 
made using xrefs.

Only one Revision can be Current at any one time.

RFBin
The RFBin is Macro Space Management's equivalent of the Recycle Bin. Files marked 
for deletion are sent to the RFBin, but will not be permanently deleted until the Purge 
option is used in the Admin menu.

Definitions - S
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Scaled size block
A Scaled Size Block is attached to an object of some sort to append visual 
information. The scale of the scaled size block is determined by the block onto which it 
is attached.

Security Server
This part of Macro Space Management - Security Server - retains a record of the user's 
access rights.

Each time a user attempts to open another module, Security Server will either allow or 
prevent it, depending on the user's rights.

This means that a user only has to log into once per session.

Shelf Block
A Shelf Block is a block containing details on a specific type of shelf.

Shelf Types
Shelves can be of any number of user defined types. Examples include:

■ Open shelves

■ Heavy shelves

■ Obstruction shelves

■ Peg Boards

■ Lateral Rods

■ Rods

Shelf type is assigned in the Fixtures Tab of the Block Details dialog box.

Shelf Category
Shelf Category is found in the Shelving Frame of the Block Details dialog box

Shelf Category allows the aliased layer to be occupied by the shelf to be further 
sub-divided. The default is 0, but shelves can be assigned to further vertical categories 
within the aliased layer. For example generic goods could be assigned to Shelf 
Category 1, branded goods to Shelf Category 2…

Slot Spacing
Slot Spacing is the distance between slots in certain types of shelving, (for example 
peg boards).

It is set using the spin controls within the Shelving Frame in the Fixtures Tab in the 
Block Details dialog box.

Snake Gondola
A single sided gondola that may go through a number of changes of angle - hence 
'snake gondola'.
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Status
Status defines the current standing of an object within the system.

For example an arrangement of fittings and fixtures for a floor layout can be defined as 
either a Proposal, (at the design stage), Authorised, (approved for use in the future), 
Current, (in use), or Historical, (taken out of service).

The status of an object will change as Macro Space Management users move through 
the business cycle.

Status of clusters and sub-clusters
Clusters and sub-clusters are not objects. As such, they do not require a status.

Status of files
The status of a file can have one of several potential status's, typically including:

Proposal - a trial layout currently being considered for adoption.

Authorised - a layout that has been set to become current at a specific date. Such 
layouts have birth dates.

Published - a layout that has been sent to the stores for future implementation at an 
agreed date.

Current - the layout currently in use. Such layouts can have death dates where they 
revert to an inactive status.

Historical- layouts that have once been current and have reverted to inactive status. 
Such layouts can be reactivated by a change of status.

Status of floors
Floors can typically have one of three statuses:

Proposed - where the floor is at the design stage.

Existing - where the floor is in use.

Demolished - where the floor is no longer available.

Status of revisions
The status of a revision, (or layout of a floor), can be set to the following typical 
options:

Proposal - a trial layout currently being considered for adoption.

Authorised - a layout that has been set to become current at a specific date. Such 
layouts have birth dates.

Current - the layout currently in use. Such layouts can have death dates where they 
revert to an inactive status.

Historical- layouts that have once been current and have reverted to inactive status. 
Such layouts can be reactivated by a change of status.

Status of stores
Stores can typically have one of three statuses:

Proposed - the store is in the design or purchase stage.
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Open - the store is in use.

Closed - The store has been taken out of service.

Store Root
The Store Root is the origin of the hierarchical tree. All other data emanates from the 
Store Root.

Normally, stores are grouped in clusters and sub-clusters for ease of organization.

However, it is possible to add stores directly at the root level without them being 
associated with a cluster or sub-cluster.

Stores
A Store is the unique description of a specific retail outlet. Stores are made up of one 
or more floors. Stores are normally associated with one or more clusters; although they 
can, (less usually), be directly associated with the Store Root.

Stores can be associated with more than one cluster. However, this multiple 
association is merely a series of links to the same store within the central database. 
Stores act as containers for floors and their associated files.

Sub-clusters
A Sub-cluster is a sub-division of a Cluster. Sub-clusters are used to allow a finer level 
of detail when analyzing the performance of groups of stores.

For example the cluster of stores labelled England might be further sub-divided into 
sub-clusters called north, central and south.

If necessary, this process could be continued further, with the north sub-cluster being 
further divided into, for example, city and suburban sub-sub-clusters.

Synchronisation
Macro Space Management and In-Store Space Collaboration can modify drawings in a 
number of ways.

This may result in different information being held in a drawing in the Planner 
module and in the central MSM database.

At intervals Macro Space Management needs to ensure that both drawing and 
database contain the same information. This process is called synchronisation and is 
controlled by the Synchronisation module.

System Variable
A System Variable is a parameter within the Macro Space Management database that 
makes a permanent and fundamental change in the way Macro Space Management 
operates.

System variables are often used as switches to toggle features on and off.

System variables are not accessible through the standard Macro Space Management 
interface and should only be changed by system administrators.

It is strongly recommended that system variables are only changed after consultation 
with the Oracle Technical Support Team.
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Definitions - T

Tierage
Tierage is activated when the Has Shelves tick box is unchecked in the Fixtures Tab of 
the Block Details dialog box.

The fixture then has tiers, (often used for displaying sample products), rather than 
shelves.

If Tierage is selected then the number of tiers can be selected using the spin control for 
Tierage.

Title block
A Title Block is a block associated with a floor plan. It contains information such as 
drawing title, drawing number, drawing issue, drawing date, revision history, 
designer, etc.

It may contain information on floor area, merchandisable area, non-sales area, etc.

In short, a Title Block specifies all the information contained within a drawing.

Trusted connection
A Trusted Connection for users is one where access right are assigned when the 
computer starts up there is no need to sign on with passwords, etc.

User ID Passwords will always be required for Oracle databases.

If a connection is not trusted, then the Macro Space Management User Name and 
password will be required to connect to the central database.
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Turn Grouping Off
When Grouping is turned off interconnected objects within, for example, gondolas are 
treated as individual objects.

Individual fixtures within a gondola can then be manipulated as separate entities.

Turn Grouping On
When Grouping is turned on all interconnected objects within, for example, a gondola 
can be manipulated as a single entity.

For example a gondola can be moved to a new position by "dragging and dropping".

Definitions - U

Unregistered Block
An Unregistered Block is a block that exists in an AutoCAD drawing but has not yet 
been registered in the Macro Space Management Central Database.

Definitions - V

Vertical Category
Vertical Category is a way of sub-dividing an aliased layer.

Found in the Fixtures Tab of the Block Details dialog box, Vertical Category allows the 
aliased layer to be further sub-divided.

The default is 0, but (for example) fixtures can be assigned to further vertical 
categories within the aliased layer. For example TV's could be assigned to Vertical 
Category 1, CD Players to Vertical Category 2…

Definitions - W

White Goods
White Goods is a term often used to describe electrical goods for kitchen or bathroom 
applications.

Definitions - X

Xref
XREF is a method AutoCAD uses to link drawings. When you attach a drawing as an 
xref, you link that referenced drawing to the current drawing. Any changes to the 
referenced drawing are then displayed in the current drawing when it is opened.
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This is used within Macro Space Management where an architectural drawing can be 
attached as an xref to multiple drawings at the same time. This allows a single 
architectural drawing to be used as a framework on which multiple arrangements of 
zones, fixtures, aisles and merchandise may be planned.

Note: Using xrefs reduces the quantity of data stored, as each architectural plan is only 
used once for each floor, not copied under multiple file names.

Definitions - Z

Zone
The purpose of a Zone is to allow Macro Space Management users to represent space 
within a floor plan

It is a sub-division of the total available floor area that can be used to designate that 
area as a sales or non-sales area. The description of the purpose can then be further 
defined. A Zone can be allocated to a specific type of sales; for example fruit and 
vegetables or electrical goods. Alternatively it could be allocated to a more specific 
non-sales function, for example offices or storage purposes.

The Zone can also contain information on pillars or other obstructions that might 
affect the area of merchandisable space.

The Zone can be used to filter the total list of fixtures, fittings and Planograms in the 
store, enabling the Macro Space Management user to establish which have been placed 
in that particular part of the store.

The Zone can also be used for specific reports, again giving more information on what 
is in a specified part of a store.

Zone Definitions
After Zone Types (broad classes of Zones) have been defined, individual types of 
Zones can be defined.

Examples of Departments (Sales Zones) Definitions might include:

■ Chilled Goods

■ Furniture

■ Ladies clothing

Examples of Non-Sales Zone Definitions might include:

■ Corridors

■ Offices

■ Toilets

As well as name and zone type, Zone Definitions can include the type of hatching 
used in the drawing, the color of the hatching and a user defined code.

Zone Types
A Zone Type is the broad class a zone falls into. Zone Types are user defined and can 
include:

■ Internal Areas
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■ Departments

■ Non-Sales areas

Each Zone Type is drawn onto its own AutoCAD layer - only Zones on the same layer 
will be detected as clashing, (overlapping).
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